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Section 1: Introduction 

Video: Course Introduction  

Deb: Hello everyone and welcome to Excel 365 for Beginners. My name is Deborah Ashby, 

I'm a Microsoft MVP and Course Instructor; and I am so, excited to host this course for you.  

 

Excel 365 is Microsoft's evergreen version of Excel. It's part of Microsoft 365; a subscription 

service that ensures you always have the latest version of Excel with the latest features. No 

more lagging behind with old versions and no more having to purchase a new version of 

Excel to get the latest features.  

 

Microsoft 365 also, comes with a handy Online Portal that allows us to access and use Excel 

and other applications on the go wherever we have an internet connection. So, we no longer 

need to be using the desktop version of Excel in the office to work on our files. Do you want 

to know the really good news?  

 

Well, if you're already familiar with older versions of Excel, then upgrading to Excel 365 will 

be a complete breeze. Many of the features and utilities are the same, but we have so, much 

more available to us in Excel 365. For example, we have a whole heap of brand new 

Formulas such as FILTER, XLOOKUP, SORT, SEQUENCE, UNIQUE, and so, much more.  

 

We have new utilities, such as Picture in Cell and new charting options. We have greater 

sharing and collaboration options as well. And, we can co-author our Workbooks with our 

colleagues in real time. Now, because Excel 365 is part of Microsoft 365, it integrates 

seamlessly with other Microsoft 365 applications like Teams and SharePoint.  

 

Now this course is a beginner’s course, and it's designed for people who are brand new to 

Excel in general, or people who are new specifically to Excel 365. It would also, be perfect 

for anybody looking for a refresher on some of the basic but fundamental Excel skills that we 

all know and love.  

 

Now, the only thing you need to complete this course is a working copy of Excel 365. So, if 

you haven't already, now would be a great time to sign up for a Microsoft 365 subscription, 

which in turn is going to give you access to Excel 365.  
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Now the way that this course is structured is that we have a series of video lessons divided 

down into different sections. And these sections are arranged logically so, that you can build 

your skills throughout this course. Each lesson has a video demonstration of roughly between 

5 and 10 minutes in length; so, it's super bite-sized, you can do a lesson whenever you have 

some free time.  

 

All of the files I use in this course are available for you to download. So, you can follow 

along each lesson with me. And you'll see the files are named according to their lesson 

number, and there's a Start file and a Finish file for each lesson. That means that if you want 

to skip over a lesson for whatever reason, it's really easy for you to pick up the flow in the 

next lesson. So, make sure you download those from the Course Files folder before we begin.  

 

You'll also, find an exercise at the end of each section so, you can really practice the skills 

that you've learned. And you'll find all of the files that you need for this in the Exercise Files 

folder. And that is pretty much it. I think we're ready to dive in to our first lesson.  
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Video: Excel 365 Online Portal  

Deb: One of the biggest advantages of using Excel 365 is that unlike the standalone versions 

of Excel, we have access to a really handy Online Portal. And you can access the Online 

Portal through any browser wherever you have an active internet connection.  

 

So, the first thing we're going to do here is we're going to fire up a browser. I'm going to use 

Microsoft Edge, but if you prefer to use something like Google Chrome, then that's not a 

problem. And then we can either go to microsoft.com, or office.com. Now I'm going to go to 

office.com, simply because that's what I'm used to going to.  

 

Now notice that mine logs me straight into my Online Portal. It might be that you get taken to 

a sign-in screen where you'll be asked to enter in your email address and your password. And 

the sign-in credentials that you use is basically the email address that you assigned to your 

Microsoft 365 subscription during the setup phase. So, type in your email address and your 

password and it's going to jump you to the screen that I'm in now.  

 

Now, once again, yours might look slightly different, or it will look different to mine, 

because this main page is kind of like a hub that shows you all of your latest activity. Now if 

this is the first time that you're logging into Microsoft 365, then it might be fairly empty in 

here. You're not going to have any recommended documents, you might not even have any 

recently opened in the list below. But in general, this is what you're going to see.  

 

You're going to have a recommended section at the top. And again, these are just files that 

I've opened recently, we then have a quick access area at the bottom with various different 

filters to allow us to find files that we might want to open quickly. Notice we have a recently 

opened list, files that have been shared with us, and we can also, add any file into our 

favourites list.  

 

Notice that I also, have an Excel filter just here. So, if I click this, it's going to show me only 

Excel files. Because remember, when you're working in the Microsoft 365 portal, this 

includes all files, so, things like Word documents, PowerPoint presentations, not just simply 

Excel. And if we click the plus here, we can set up more content filters to filter that list of 

files. For example, if I want to have a filter that filters just Word documents, I can set that up 

as well. So, I can toggle between just seeing Excel files and just seeing Word documents.  
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Also, notice at the top, we have a Search bar. This is a universal search. So, whatever 

keywords we type in here, it's going to search across all applications in Microsoft 365, for 

content that matches. And that might be files. You can see here, I have all the files that 

contain the word ‘sales’. It might be bookmark. So, obviously, I've got the word ‘sales’ 

included in here somewhere.  

 

It's also, found any people that have the word ‘sales’ in their job title. And it's also, found a 

couple of SharePoint sites which contain the word ‘sales’. So, don't forget that this is a 

universal search when you're working in the hub.  

 

Now the hub is a centralized area that you can come to to access all of the online versions of 

your applications. Notice on the left hand side, we have a big long list of different apps that 

we can access. And if we click the app launcher, which is that little thing that looks a little bit 

like a waffle in the top left hand corner, that's going to show us all of our apps.  

 

Now the list of apps that you see in here will vary depending on the type of Microsoft 

subscription that you signed up for. For example, I have a Business Standard Microsoft 365 

account, which includes things like SharePoint and Teams; applications that are more geared 

to business use.  

 

If you have a personal subscription, you'll find that you won't have things like that. But you 

will always have access to Outlook, Word, PowerPoint, Excel, so, on and so, forth. So, just 

be aware of that. The main point is your list might not look exactly the same as mine.  

 

So, we can use this apps list to open any of our applications in a browser, so, let's open up 

Excel. Because what you'll notice is that a new Tab opens, and I'm basically taken to Excel 

Online. And this is why Excel 365 is more flexible than the regular standalone versions of 

Excel. With those versions, we can only access Excel on our computer. Whereas with Excel 

for Microsoft 365, we can simply do exactly what we've done here; fire up a browser, go to 

the portal, and launch Excel.  

 

So, if I'm sitting on a train, as long as I've got a Wi Fi connection, I can still work on my 

documents without having to be at my desk. So, from here, I could fire up a blank Workbook, 

and it takes me into a pretty comprehensive version of Excel.  
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Now there are a couple of things to be aware of when you're working in the online versions. 

You might not necessarily have access to all of the functionality that you'll find in the 

desktop version. And I will say this has greatly improved over the years. More and more 

features have been added to Excel Online to bring it more in line with the full version.  

 

But I will say that if you're just wanting to take a look at spreadsheets, make minor edits, we 

can do all of our formatting from here. We can insert Pivot Tables, Charts, pretty much most 

of the things we're going to want to do when we're on the go, we can find in this version. But, 

you will find that some of the more complex stuff isn't always available.  

 

The other thing to know about working within the Online Portal is that everything 

automatically saves. So, what you'll notice is that if we click the File button, we don't actually 

have a Save button, we only have a Save As button. And that's because if I start typing in 

here, so, let's just say I type in date, and we'll say, ‘Product’, everything saves automatically 

back to the cloud. So, I don't have to remember to press Ctrl + S to Save or go to File > Save.  

 

What we do need to do though, is rename the file because notice here, it just says ‘Book 2’. 

But if we click up here, we can do that very simply. So, I'm just going to call this ‘Test 1’. 

Notice the location, it's saving it into my OneDrive into my Documents folder. And I can hit 

Enter to give that file a name.  

 

When we close down this Excel file, and we just do that by closing the browser window. If 

we were to now go back to our Office 365 homepage, and let's take a look at all of our 

documents, notice there is ‘Test 1’ at the top.  

 

If I want to jump back into it to edit, I can simply click to open it up, and I can make my 

changes. So, let's just make these headings bold. Again, everything saves; I don't need to do 

anything else. I can simply close it down, and those changes will be saved.  

 

So, when you're working in Excel for Microsoft 365, just be aware that everything saves back 

to OneDrive to the cloud, and all changes are automatically saved. 
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Video: Exercise 1  

Deb: It's time now to do Exercise 1. And as you can imagine, we don't have a great deal to do 

in this exercise because we've only just started the course. So, the idea of this exercise is 

really just to set yourself up ready to begin the first lesson.  

 

So, I'd like you to ensure that you have a working Microsoft 365 account that has access to 

Excel 365. I'd like you to sign in to office.com and ensure you're familiar with the Microsoft 

365 interface and where to go to access applications including Excel Online. And if you'd 

like to follow along with me, I want you to make sure that you've downloaded both the 

course files and the exercise files from their respective folders.  

 

That is it. There is no answer to this exercise. Just make sure you've done those things, and I 

will see you in the next section. 
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Section 2: Get Started in Excel 365 

Video: Launch Excel  

Deb: In the last lesson, I showed you how easy it is to work in Excel Online. We simply log 

into the Microsoft 365 portal and launch Excel from the app launcher. But it's safe to say that 

if you're sitting at your desk working in your office, you're probably going to want to use the 

full version of Excel. And indeed, that is what this training course will be conducted in 

predominantly. So, how can we launch the desktop version of Excel?  

 

Well, as we've already seen, if you do sign up for Microsoft 365 subscription, you have the 

opportunity to install the full versions of all of the Microsoft 365 applications onto your PC. 

And this is where you'll get that full desktop version. So, if you haven't done that already, go 

to ‘Install apps’ on the homepage of the portal and click on ‘Microsoft 365 apps’. That will 

kick off the download process and download all of the applications.  

 

So, once the applications have downloaded, how do we access Excel? Well, this is very much 

going to be determined by the operating system that you're using. I'm using Windows 11. 

And if I push my mouse down to the bottom of the screen, notice the icons that I have. You 

can see that I have the Excel icon pinned to the taskbar.  

 

Now, Excel isn't pinned down here by default. So, you're going to find it underneath your 

Start menu. Now for me, I access my Start menu by clicking on the Windows icon just here. 

Alternatively, I can press the Windows key on my keyboard to pop open the menu.  

 

Now if you can't see Excel, Word, and PowerPoint amongst these icons here, you can simply 

click in the search bar at the top and search for the application that you're looking for. So, if 

I'm looking for a new installation of Excel, I can just type in ‘excel’. There it is at the top; 

Excel app.  

 

I can either click to launch the application directly, but what I would suggest you do is that if 

Excel is an application that you use every day, you do pin it down onto your taskbar. What 

we can do is right-click, and we can choose to ‘Pin to taskbar’. Now notice that mine says 

‘Unpin from taskbar’, because I already have it pinned. But if you don't, it's going to say 

‘Pin’.  
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So, I highly recommend you do that because it means you're always going to have access to 

Excel pinned to this taskbar at the bottom. And you can see I've pretty much repeated this 

process for all of the applications that I use frequently.  

 

So, once we have it pinned, to launch Excel, it's a simple case of just clicking on the icon. 

And this will take you to what we call the Start page. Now you only ever see this Start page 

when you first fire Excel up every single day.  

 

And from here, we can choose to create a new blank Workbook, we could possibly start from 

a template, and then underneath we have a list of all of our recent documents to make them 

super easy to open and access. We can see any documents that we have pinned, and we can 

see any documents that have been shared with us by other people. So, this recent list will 

constantly be changing.  

 

As we work and open new files, those will go to the top of this list. So, my recommendation 

is that if you do have maybe a spreadsheet that you work on every single day, and you don't 

want that to keep moving around in this recent list, I do recommend that you pin it.  

 

So, let's just say that I always access Budget Analysis.xlsx. If we take a look towards the 

middle here, we have a little Pin icon. So, I could click on the pin, and you can see that that's 

now pinned to the top of the recent list. And I can also, find it under the Pinned section. You 

can see there it is. Now, there are lots more to explore in here and we're going to get into that 

in the next few lessons. But for the time being, that is how you can launch Excel. 
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Video: Explore the Interface  

Deb: We ended the last lesson by firing up Excel and just having a quick look at the Start 

page. And in this lesson, we're just going to get ourselves a bit more comfortable with the 

Excel interface. So, to do that, we're going to just very quickly create a new blank Workbook.  

 

Now when it comes to creating new blank Workbooks, there are a couple of different 

methods that you can use. Notice on the Start page, here, we have a ‘Blank Workbook’, we 

could click to select that. Alternatively, if we go to ‘New’ just here, we have the option to 

select a blank Workbook from here as well.  

 

Now if you're somebody that loves Keyboard Shortcuts, you might be trying to use the 

Keyboard Shortcut Ctrl + N just here to create a new blank Workbook. But notice, if I press 

it, it doesn't actually work when you're on the Start page. So, we're going to need to click to 

select the blank Workbook. Now a couple of things to know when you first create a new 

Workbook. Notice the terminology that I'm using there, you may hear people refer to 

Workbooks and Worksheets. So, what is the difference between the 2?  

 

Well, if you take a look right at the bottom, here, we have a Tab that says Sheet1. So, this 

grid structure that we're looking at right now, this is called a Worksheet. Now we can have 

multiple Worksheets. And if you notice, to the left, we have a little plus where we can add 

new sheets. So, these are all Worksheets, but the container, the file that contains all of these 

Worksheets is what we refer to as a Workbook. So, just make sure you have those 2 pieces of 

terminology straight in your mind.  

 

So, I'm going to click on Sheet1, and let's just do a quick tour of the interface. So, right at the 

top in the Title Bar, notice this is where we have the title of the document. Now when you 

create a new document, you're just going to get the default title, which is going to be Book1, 

Book2, and Book3.  

 

Now, of course, that is very generic, I would highly recommend that you do rename your 

documents. So, we can rename this file by simply clicking in the Title area, and then we can 

change the file name. So, I'm going to call this ‘My First Workbook’. We can choose a 

location to save.  
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Now notice by default, it's going to save into OneDrive. And the advantage of saving it into 

the cloud is that every time you make a change, it's going to automatically update, you don't 

have to keep pressing Save. It also, means that you can access this file from anywhere 

through the Online Portal.  

 

So, in general, I would always recommend that you start saving your files into the cloud. 

Now, I'm not going to worry too much about any of the rest of this stuff at this stage, let's just 

get this Workbook saved. I'm going to click on Save. Notice that the title changes at the top.  

 

Now as soon as we named this Workbook, another thing happened. You may or may not have 

seen it as it was pretty quick. The AutoSave button just here toggled itself on. Previously, this 

was toggled off. 

So, this means that now every time we click and start typing and working in this Workbook, 

all of the changes I'm making are constantly saving back to the cloud so, this file is always up 

to date.  

 

Also, notice that we do have a little Save button just here. But it has this little cycle; this little 

Green cycle icon on it. Because this now acts as more of a refresh between what we're 

working on and the cloud.  

 

So, now we have this Workbook saved underneath the Title Bar, this is where we have our 

Tabs and our Ribbons. If you're used to using older versions of Excel, you might remember 

that we used to have dropdown menus to access all of our commands. But in around 2010, 

that completely changed, and we now have these horizontal Ribbons with all of our 

commands on them.  

 

So, our commands are organized logically on 2 different Ribbons. We have Home, Insert, 

Draw, Page Layout, Formulas, Data, Review, so, on and so, forth. So, the Home Tab, for 

example, will contain commands that our most common. These are the things that people use 

most when they're working in Excel. And you can see that all of our commands are then 

divided into different groups.  

 

And at the bottom, we have the group name. So, we have Clipboard, Font, Alignment, 

Number, Styles, so, on and so, forth. And you'll find that pattern across all of the Ribbons; we 

always have groups that contain our commands.  
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Now if you're brand new to Excel, it is going to take a while to kind of really get to know 

where all of your commands are located on these Ribbons because there are so, many 

different commands in Excel. And I might add not all of them are on the Ribbons.  

 

Another thing that you should be aware of is that with some of these groups, you'll see that 

they have a little diagonal Arrow in the bottom corner. For example, the Alignment group, we 

have this little diagonal Arrow. If I hover my mouse over it, we can see the ScreenTip pop up 

there that says; ‘Alignment Settings’. And if we click this, it's really going to open up more 

options related to this specific group.  

 

So, if you can't find what you're looking for in the Alignment group on the Ribbon, click the 

diagonal Arrow to reveal more options. And you'll find that that follows through. If we go to 

the one for Fonts, we have more font options underneath there. So, don't forget, we have 

those little hidden dialog boxes underneath these diagonal Arrows.  

 

Another thing to be aware of is that when you hover your mouse over any of these 

commands, you're going to get what we call a ScreenTip. And that's just really a helpful little 

pop up, that's going to tell you the command name, and also, give you a brief description. So, 

this is super useful if you're not really sure what a command does. And you can always click 

‘Tell me more’ underneath to open up the Help File related to this command. So, Tabs and 

Ribbons are really important aspect of working in Excel.  

 

Now underneath our Ribbons, notice that we have this mostly empty horizontal bar. But we 

do have some icons on this bar on the left hand side. This is where we have that AutoSave 

toggle. And currently I have a Save button, I have Undo, and I have Redo. Now both of these 

are greyed out at the moment, so, I can't click them because I haven't actually done any work 

to undo.  

 

If I was to type something, I'm just going to type ‘Hello; in here. Notice that they're now 

accessible. And if I want to remove that, I could click on Undo. Or I could press the 

Keyboard Shortcut Ctrl + Z to undo my last action. So, Undo and Redo really useful.  

 

Now this little group of icons is referred to as the Quick Access Toolbar, and we have a 

whole lesson dedicated to customizing this area. This is basically somewhere where we can 

add commands that we use frequently to make them easy to find so, we don't have to go 
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hunting through the Ribbons looking for specific commands. So, we're going to talk a lot 

more about this in a couple of lessons time.  

 

Underneath the Quick Access Toolbar, we have the Name Box, and that's going to display 

whatever Cell I'm clicked in. So, it's telling me I'm clicked in Cell D4. If I click somewhere 

else, it's telling me I'm clicked in Cell F7. Now there are a lot more you can do with this 

Name Box, which we'll get into a bit later on in the course.  

 

And then next to that we have the Formula Bar. So, this is where we come to type Formulas 

and also, edit Formulas. And then the main part of this screen is taken up with our 

Worksheet. And all Worksheets in Excel are based on Columns and Rows, which gives this 

kind of grid structure. We have Columns labelled with letters and Rows labelled with 

numbers. And this makes it super easy for us to reference specific Cells.  

 

For example, if I click here, I can see that that is Cell H8. Notice Column H is highlighted in 

Gray, and so, is Row 8. I can also, see in the Name Box that I'm currently clicked in Cell H8. 

And we use these Cells to house our text, numbers, and other information. And then right at 

the bottom, this is where we have our different Worksheets.  

 

As I said, you can have multiple, and by default, they're going to be named generic names. 

So, Sheet1, Sheet2, Sheet3. Now of course, we can rename our Worksheets to make them 

more meaningful. And again, we'll look at that in another lesson.  

 

But just be aware, this is how you can switch between your different Worksheets. You can 

either click on them. Alternatively, if you like Keyboard Shortcuts, you can move through the 

different Worksheets by pressing Ctrl + Page Down to go to Sheet2, Page Down again to go 

to Sheet3, Page Up to go the other way.  

 

On the right hand side we have a scroll bar; a horizontal scroll bar, I should say. And then 

running right across the bottom, this is where we have the Status Bar. So, the Status Bar is 

where you're going to find different pieces of useful information. And what you see down 

here will change depending on what you're doing.  

 

This is also, the area that houses the different Views because there are different ways that we 

can view a Worksheet in Excel. And you can see those over on the right hand side and we can 
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switch between them simply by clicking on the icon. Now these aren't going to make much 

sense to you at the moment. So, we're just going to stick with Normal View.  

 

And then finally we have this little Zoom Slider. So, the default is 100% Zoom. If we click 

the plus (+), it's going to zoom in. If we click the minus (-), it's going to zoom out. So, that is 

entirely personal preference. But those are the main elements that make up the interface when 

you're working in Excel. 
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Video: Work with Contextual Menus, Ribbons, and Panes  

Deb: So, since the last lesson, I've gone in, and I've added some data and an image into my 

Worksheet. Now, I don't want to skip ahead too far here because we haven't even spoken 

about data entry or how to insert images, but I wanted to get something in this Worksheet so, 

that I can demonstrate to you Contextual Menus and Contextual Ribbons.  

 

Now, what do we mean when we say Contextual Menu? Well, pretty much what it says on 

the tin, it's contextual to wherever we clicked. So, if I click in my Table of data just here, I'm 

going to click on Cell B4. And in B4, I simply have a piece of text, it's an order number.  

 

Now, aside from being able to do things with this piece of text, so, maybe I want to go up and 

change some of the formatting options from the Ribbon, we can also, right-click on the Cell, 

and we get a Contextual Menu. Now, the reason why this is contextual is because the items 

that we see in this menu are very much based on the type of data that we've clicked on in the 

Cell.  

 

So, what we see in this menu, when we're right-clicked on a piece of text is going to be 

different if we clicked on, let's say, a Picture. For example, I have a Picture just here, let's 

right-click. The options I get are different and are related to the Picture.  

 

For example, we have Save as Picture just here. But when I'm clicked on text, and I right-

click, we don't have that option in here. So, the point I'm trying to make is that depending on 

what you've right-clicked the mouse on, you're going to get different menu options.  

 

Now along the same vein, we also, have Contextual Ribbons. So, if you take a look at my 

Ribbons at the moment where we have Home, Insert, Draw, Page Layout running across the 

top, we will also, see up here from time to time, other Ribbons as well, because not all 

Ribbons show as Tabs by default.  

 

For example, this dataset that I have here that are showing these products and the prices, this 

is actually an Excel Table. And again, we haven't spoken at all about Excel Tables at this 

stage, but just be aware that I've put this into a Table.  
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Now keep your eyes on these Ribbon Tabs at the top, because when I click in the Table, 

notice I get a new Ribbon called Table Design. So, this is in effect contextual as well. When I 

click on it, I'm going to see all of the commands related to Excel Tables.  

 

For example, I can change the Table Style from here, I can do some various things with the 

Table Style options. I can insert Slicers, which are like Filters, I can create Pivot Tables and 

Charts. So, everything on this Ribbon is contextual.  

 

Now when I'm not clicked in this Table, so for example, if I click in a blank Cell just 

somewhere else on the Worksheet that Contextual Ribbon is going to disappear. So, this is 

pretty good because it prevents your Ribbons from being too cluttered. We don't have 

everything visible all the time, things appear when they're needed and relevant. The same 

thing will occur if you insert a Picture into your spreadsheet.  

 

So, I have a Picture just here. Again, keep your eye on the Tabs at the top. When I click on 

the Picture, I get a Picture Format Ribbon. When I click on that, I have all of the options 

related to formatting, resizing, and managing Pictures. If I click away, it disappears. So, 

you'll find that with lots of elements when you're working in Excel. For example, if you've 

inserted a chart and you click on the chart, you're going to get a few extra Ribbons up here 

related to formatting, editing the data, and designing your chart.  

 

If you click on a Pivot Table, you're going to get Ribbons related to Pivot Tables. So, don't 

forget when you're click somewhere to glance up at these Tabs, just to make sure that you 

don't have a Contextual Ribbon with more options that you didn't know were there.  

 

The final thing to point out in this lesson is that we also, have panes that will open up on the 

right hand side. For example, if I click on the Picture, right-click and go to Format Picture at 

the bottom, it's going to open a Format Picture pane. And again, this is something that you'll 

commonly see, there's always going to be some kind of Format Option that will open a pane.  

 

For example, if I click in the data, right-click, I don't have Format Picture, but I do have 

Format Cells. And this time it pops open a dialog box as opposed to a pane. So, just be aware 

of these right-click menus, hidden Contextual Ribbons, and also, panes that can pop up at any 

time depending on what you're working in in your Excel spreadsheet. 
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Video: Customize the Quick Access Toolbar  

Deb: In a previous lesson, we briefly spoke about the Quick Access Toolbar. And just a 

reminder, in case you've forgotten it, you'll find the Quick Access Toolbar lurking underneath 

your Ribbons. It's this little thing here where we can see AutoSave, Save, Undo, and Redo 

icons.  

 

Now, as I mentioned, this is an area that we can customize. So, this is brilliant if you have 

commands that you use frequently, and you don't want to have to hunt through the Ribbons in 

order to find them. Because we can customize this with whatever commands we like to make 

them easily accessible.  

 

So, in this lesson, we're going to take a look at the different methods you can use to add 

commands to your Quick Access Toolbar, and then I'll leave it to you to customize your own. 

Now by default, you're always going to have AutoSave, Save, Undo, and Redo on your Quick 

Access Toolbar.  

 

So, if you launch Excel straight out of the box, this is what you're going to see. But of course, 

we can add to that. And the simplest way to add any command to the Quick Access Toolbar 

is to find the command on the Ribbon. For example, let's say that I always use Bold font 

formatting, right-click on the command and choose ‘Add to Quick Access Toolbar’. As soon 

as I click that, you can see there it is easily accessible.  

 

Maybe I want to add something else. So, let's go across to the Data Tab. Maybe I'm always 

sorting data. So, I'm going to right-click on ‘Custom Sort’ and choose ‘Add to Quick Access 

Toolbar’. And there it is. So, we can build up a long list of commands that we use frequently. 

So, I'm just going to add a few onto here.  

 

Now aside from adding commands that way, notice that at the end of the Quick Access 

Toolbar, we have this little Dropdown Arrow. When we hover over it, it says ‘Customize 

Quick Access Toolbar’. So, when we click this, it's going to pop open a menu. And notice in 

here we have 20 or so, commonly used commands. So, these are the commands that 

Microsoft think will be most useful to you to add to the Quick Access Toolbar.  

 

Now the ones that we already have added have a tick next to them. But we could add any of 

these others simply by selecting them. So, yeah, I'm always spellchecking my spreadsheets. 
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So, maybe I want to add Spelling, maybe I want to add Quick Print, maybe I want to add 

New. So, that is another way that you can add your commands.  

 

Incidentally, if you want to remove commands from the Quick Access Toolbar, you can 

simply right-click and choose ‘Remove’. Alternatively, if you've added them via this method, 

you can just deselect them from the list.  

 

Now it's worth noting that not all commands in Excel are available on these Ribbons. There 

are many other commands that kind of lurk in the background, which aren't as accessible as 

others. It also, might be that you want to add a specific command to the Quick Access 

Toolbar, but you can't actually find it on the Ribbon.  

 

If that is the case, what I would recommend is that you click this dropdown and go to ‘More 

Commands’ just here. What that's going to do is it's going to jump you across to Excel 

Options. And again, this is an area that we'll look at a bit later on, and straight to the Quick 

Access Toolbar section. Because what we can do from here is pull up a list of all commands 

available in Excel, and add them to the Quick Access Toolbar that way.  

 

So, on the right hand side, this is where we can see the commands that we currently have on 

the Quick Access Toolbar. And you can see all of the ones that I've just added. And then on 

the left hand side, this is where we can choose commands to add to the Quick Access 

Toolbar, divided down by category.  

 

So, currently, I'm displaying in this list all of the most popular commands. But if I want to see 

everything, I could click the dropdown and choose ‘All Commands’, and then I get a list of 

absolutely everything that's available in Excel. And fortunately, these are listed 

alphabetically. So, if you're looking for something specific, it makes it a little bit easier to 

find.  

 

So, let's add some Alignment options. I would just select the command and click on the Add 

button in the middle to put it over on the Quick Access Toolbar. So, I'm going to add a few. 

Let's just add a few Alignment commands like so; really nice and simple.  

 

Similarly, if you want to remove items from the Quick Access Toolbar, you can select; so, 

let's go for Convert Text to Table and click on ‘Remove’. And also, when you're working in 

this view, it's very simple to rearrange or reorder our commands. If I want Flash Fill to be 
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further up the top, I can simply click the Up Arrow to the right hand side to move it or I can 

move it back down again.  

 

And the final thing that's quite useful in here is that we can give our Quick Access Toolbar a 

little bit of structure by adding Separators. Now I already have 2 Separators on my Quick 

Access Toolbar. And you can see them just here; it's these lines.  

 

So, these serve as a visual way of grouping together commands of similar type. And what 

you'll find is if you want to add a Separator, if you scroll up to the top of any of these lists, 

you'll have the option to add a Separator. So, if I add a couple into here, I can then arrange 

them how I want them to be arranged.  

 

So, I'm going to grab this Separator, I'm going to move it down because I want Undo and 

Redo to be grouped together. I'm going to grab this Separator, and I'm going to move it up 

because I want to separate my formatting from my sorting and filtering. And maybe I want to 

take this Separator and place it just there so, that all of my Alignment options are grouped 

together. So, how you arrange these is very much personal preference. Let's click on OK, and 

it's going to rejig our Quick Access Toolbar, and you can see that that now looks a little bit 

more organized.  

 

The final point to mention here about the Quick Access Toolbar is that you can change its 

position. So, mine is currently underneath my Ribbons. But if you don't like it there, you can 

choose to display it above your Ribbons as well. If we click the dropdown again, notice that 

we can show Above the Ribbon and it's going to put the Quick Access Toolbar up here.  

 

Now it's not my preference to have it up there because I tend to forget it's up there when it's 

shoved in the corner like that. I like to have mine shown below the Ribbon. And if you don't 

like the Quick Access Toolbar at all, and you think you're never going to use it, you can 

simply turn it off by choosing ‘Hide Quick Access Toolbar’. It gets rid of it, and you get a 

little bit more screen space back.  

 

If you want to get it back, if you customize all the way over to the right hand side. Notice on 

the Ribbons we have this Dropdown Arrow that says ‘Ribbon Display Options’. If I click 

this, this is how I can bring back the Quick Access Toolbar. So, this is a super useful way of 

customizing your copy of Excel. 
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Video: Keyboard Shortcuts  

Deb: Using Keyboard Shortcuts in Excel is the best way to improve your efficiency and 

productivity. The Keyboard Shortcuts are just a series of keyboard strokes that will execute 

commands, meaning that we don't have to use our mouse and click around on the Ribbons. 

And a lot of people find that simply working with their keyboard is a lot quicker than 

constantly reaching for the mouse, or switching between the two.  

 

Now, if you're anything like me, you'll probably use a combination of both. I use my mouse 

for a lot of things, but I also, have a set of Keyboard Shortcuts that I commonly use. So, I 

would highly recommend learning some basic Keyboard Shortcuts that will execute common 

commands quickly.  

 

So, in this lesson, I'll demonstrate a few of my favourite Keyboard Shortcuts. But I'll also, 

show you a couple of places you can go to print out a full list of all Keyboard Shortcuts 

available in Excel. You can then print this out, have it on your desk, and over time, you'll 

commit some of the most popular to muscle memory.  

 

Now Keyboard Shortcuts generally involve holding down the Ctrl, or the Shift key, or in 

some cases, both and pressing a number or a letter. For example, if I wanted to select all of 

the data within this Table, I can click inside the Table and press Ctrl + A, and it's going to 

select everything.  

 

If I want to select just this Column of data, I can press Ctrl + Shift + Down Arrow. If I want 

to select the entire Row of data; Ctrl + Shift + Right Arrow. And of course, the opposites of 

these work as well. So, if I'm clicked at the bottom, I can do Ctrl + Shift + Up Arrow to select 

all of the data. If I'm clicked on the right in the last Cell Ctrl + Shift + Left Arrow to select 

the entire Row.  

 

Now, if we're not clicked within data, maybe we're just down here in a blank Cell, I can press 

Shift + Spacebar to select the entire Row, or Ctrl + Spacebar to select the entire Column. And 

then of course, we have some of the most popular Keyboard Shortcuts for things like copying 

and pasting. So, if I want to copy, let's say I want to copy this section of this Table, I can 

press Ctrl + C to copy.  
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Notice as soon as I do that, I get these little marching ants, that's what we call them in the 

Excel world, round the outside of my selection, and I can then scroll somewhere else and 

press Ctrl + V to paste that data in. If I want to undo my last action, Ctrl + Z will do that. And 

if we have a selection still flashing like we do here, we can press the Escape key to deselect 

that selection area.  

 

We have formatting shortcuts. So, I can select some text, I'm going to select this Row; Ctrl + 

B, will make it bold, Ctrl + I will make it italic, and Ctrl + U will underline. And we can 

simply press all 3 of those Keyboard Shortcuts again to remove them. So, Ctrl + U will 

remove the underline, Ctrl + I will remove the italic, and Ctrl + B will remove the bold.  

 

Now there are so, many other shortcuts other than those simple ones that I've just shown you 

just there. So, let's take a look at a few ways that we can find out more about our Keyboard 

Shortcuts. If we jump up to the Home Ribbon, and if I hover my mouse over Bold, for 

example, notice that it's showing the Keyboard Shortcut in brackets in the ScreenTip.  

 

So, you'll find that for some of these commands, you can find out what the Keyboard 

Shortcut is simply by looking at that ScreenTip. Now, this doesn't apply to everything. If I 

hover my mouse over Middle Align, you can see it's not showing the Keyboard Shortcut. So, 

this is a little bit hit and miss. But for a lot of things, you will be able to see the shortcut in the 

ScreenTip.  

 

Now another really popular way of using Keyboard Shortcuts, and this has really come more 

into prominence over the last couple of years is to use Alt key tips. So, what are those? Well, 

if we press the Alt key on our keyboard, check out what happens to our Ribbon. I now get a 

letter or a number assigned to all of my Tabs. Now to come out of this mode, we can press 

Escape, and it's going to get rid of those letters.  

 

So, what I'm going to do here is I'm going to select this Row; Ctrl + Shift + Right Arrow, I'm 

going to press Alt, and I want to make this Row bold. So, I can go to the Home Tab by 

pressing H. Notice I then get a different set of shortcuts for each of the commands. And I can 

see that the number 1 is assigned to Bold. So, I can then press 1, and it's going to apply that 

formatting.  

 

So, by pressing Alt + H + 1 Keyboard Shortcut, I've managed to apply Bold. Alt + H + 1 

again is going to remove Bold. So, you have all of these different Keyboard Shortcuts. We 
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can jump across to other Ribbons. So, if I go to the Insert Ribbon, I can press N just here. If I 

want to insert Picture, I can go to P, so, on and so, forth. Escape to come out of that mode. 

So, don't forget about those as well.  

 

Again, you'll find that you'll have a few combinations that you commit to memory, and you'll 

use those most often. Now what if we just want to see a big long list of all of the Keyboard 

Shortcuts in Excel? Well, we have 2 options. The first thing we can do is jump into the Help 

Files by pressing the F1 key on our keyboard.  

 

Notice it opens Help in a pane on the right hand side, and we can simply search for 

‘Keyboard Shortcuts in excel’, and hit Enter. It’s brought up a list of search results. I'm going 

to select the top item just here, we get some information about Keyboard Shortcuts. And if 

we scroll down, you can see that we have our shortcuts divided into different categories.  

 

So, if we go to ‘Frequently use shortcuts’, it's going to jump us down to that section of the 

document. And you can see here we have a list of all of the Keyboard Shortcuts; to close a 

Workbook - Ctrl + W, open a Workbook - Ctrl + O, so, on and so, forth. So, this is quite a 

nice way of being able to find your Keyboard Shortcuts.  

 

But the other way that we could use; the much more modern way I might say is to utilize 

ChatGPT. And I'm sure by now, there's been so, much buzz about ChatGPT that most of you 

are familiar with exactly what it is. And ChatGPT can be brilliant for things like this.  

 

So, I've simply fired up a browser, I've searched for ChatGPT. And it is worth noting that you 

will need to create an account in order to use ChatGPT. But you can use GPT-3.5 for free, 

which is the version that I'm using.  

 

So, all we need to do down here is where it says ‘Send a message’, we can type, ‘please show 

me a list of all Keyboard Shortcuts in excel’. Hit Enter to send that through. And it's going to 

go away, it's going to give us some information, but then it will start to produce all of those 

Keyboard Shortcuts.  

 

Now there are a lot of Keyboard Shortcuts in here, so, we're not going to sit here and wait for 

this to finish. I'm just going to choose ‘Stop generating’, because what we could then do is 

scroll up to the top and notice we have a Copy button just here. So, I could choose to copy 

this information and maybe paste it into something like a Word document.  
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So, I'm just going to open Word Online from the Microsoft 365 portal. Let's create a new 

blank document, and then I can simply press Ctrl + V to paste all of those shortcuts in. Now, 

you're probably going to have to do a little bit of formatting here. But once you've got these 

in here, you can then save this file, you can print it off, and you can have it on your desk.  

 

So, those are some useful Keyboard Shortcuts, and some different methods for accessing the 

full list of Keyboard Shortcuts in Excel. 
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Video: Exercise 2  

Deb: It's time now to do Exercise 2. And in this exercise, we're going to practice some of the 

skills that we've learned in this section of the course.  

 

So, the first thing I'd like you to do is to launch the desktop version of Excel and simply 

create a new blank Workbook. Now once you have that Workbook open, I'd like you to be 

able to identify the following interface elements; The Status Bar, The Ribbons, The Title Bar, 

The Grid, and The Quick Access Toolbar. Make sure you know where all of those are 

located.  

 

Next, I'd like you to add some commands to the Quick Access Toolbar. Now I don't mind 

which commands you add, but just as a suggestion, you might want to add, Print Preview and 

Print, AutoFormat, and Sort. And I'd also, like you to add a Separator that separates those 

commands from the other commands on the Quick Access Toolbar.  

 

And the final part of this exercise is to know which keystroke will show key tip shortcuts on 

all of the Ribbons. That is it for this exercise. If you'd like to see my answer, then please keep 

watching.  

 

So, the first thing I asked you to do was to launch the desktop version of Excel. Now you're 

going to find Excel either pinned to the taskbar at the bottom as mine is just here. 

Alternatively, you might have to search for it underneath the Start menu.  

 

Now, how you search for Excel will differ depending on if you're using Windows 11, 

Windows 10. So, just do your normal search that you would do to find any application. As 

long as it's installed, you'll be able to find it. So, I'm going to click on the Excel icon just 

simply to launch Excel 365 on my desktop, and I simply asked you to create a blank 

Workbook. So, in the new area up here, let's click on ‘Blank Workbook’.  

 

The next thing I asked you to do was to identify certain elements of the Excel interface. For 

example, the Title Bar, that is this area in Green that we have running across the top. Our 

Ribbons are just below that, and we can click to switch to different Ribbons. Remember, the 

Ribbons house are commands. I asked you to find the Status Bar and the Status Bar is this bar 

that runs across the bottom. Currently, this is where we can go to change our zoom levels and 

also, switch between different views.  
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I asked you to be able to identify the Grid; that is our big Worksheet in the middle just here. 

And finally, I asked you to be able to identify the Quick Access Toolbar. And you'll either 

find this below your Ribbons like mine is here, or you might have it above your Ribbon like 

that.  

 

The next thing I asked you to do was to customize this Quick Access Toolbar and add some 

commands. And I don't mind which commands you added, but I did give you some 

suggestions. Now as always, there are a few different ways that we could do this.  

 

For example, you can click on any command, right-click, and choose ‘Add to Quick Access 

Toolbar’. Alternatively, you can click the dropdown and you can choose one of the 

commands from this list; Print Preview and Print. And if you can't find the command that 

you're looking for, you can jump into ‘More Commands’, and you can choose what you want 

to add from one of these menus.  

 

So, let's add email, let's add it across to the Quick Access Toolbar. I also, asked you to add a 

Separator. We find our Separators at the top of each list. We can simply click on Add, and 

then we can use our Up and Down Arrows to move that into position, and then click on OK.  

 

The final thing I asked you to do was make sure that you know which keystroke you press in 

order to bring up all of those key tip shortcuts. And if you recall from the lesson, we need to 

press the Alt key to bring those up. That's it for this exercise; I will see you in the next 

section. 
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Section 3: Create an Excel Spreadsheet 

Video: Excel Templates  

Deb: So, far in this course, we've seen how to create a brand new blank Workbook. But there 

are lots of other methods that we can use to save time, and one of those methods is to use 

Templates. So, we're going to close out of this file that we've been working on.  

 

Now when it comes to closing files, there are a couple of really important points to note, 

because I know from experience that this can trip people up. A lot of people think that to 

close the Workbook that they're working on, they click on the cross in the top right hand 

corner.  

 

Now just be aware, this will close all of Excel, not just the Workbook that you're working on. 

So, if you accidentally do this, it means you're going to have to restart Excel and then reopen 

your files. If you want to just close the Workbook, but leave Excel open, you need to go to 

File, and you have a Close button just here.  

 

Another way that you can close is to simply use the Keyboard Shortcut Ctrl + W. Notice it's 

closed the Workbook, but it's left Excel open. So, this time, we're going to create a new 

Workbook, but we're going to use a Template instead.  

 

Now we get to our Templates, simply by going to File, and then we can jump to New. 

Alternatively, we could use Keyboard Shortcuts to do this, we could press Alt+ F + N; that's 

going to take us to where we need to be. And I'm going to press the Alt key again, to get rid 

of those Keyboard Shortcuts. You can press Esc or Alt.  

 

Now notice at the top there, we have a new blank Workbook. That is by far the most common 

Template, I guess, that you're going to select. But if we scroll down, check out what we have. 

We have a Tab called Office, and then we have all of these Online Templates. And these are 

Templates provided by Microsoft, which are prepopulated with formatting and information to 

give you a head start when you're creating spreadsheets.  

 

So, which one of these Templates you choose really depends on what it is that you're trying 

to do. You will see that they are organized into different categories. So, we have Business, 
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Personal, Planners, and trackers, so, on and so, forth. Alternatively, you can simply click at 

the top here and type in what you're looking for.  

 

So, maybe I'm looking for an Invoice Template, I'm going to type in ‘invoice’, I can press 

Enter, or click the magnifying glass, it's going to search through all of the Online Templates 

and produce a list of all of the ones that match invoice. So, I can then scroll through, and I 

can find one that I think looks quite nice. Let's go for this one just here.   

 

When we click on it, we're going to get a little bit of information about the Template, we can 

see the download size, and then we can click on Create. That's going to download the 

Template and open it up in Excel. And the cool thing about these Templates is that a lot of 

them are prepopulated with things like Formulas, so, that you don't really have to do anything 

yourself.  

 

For example, this is an Invoice Template. So, what I'm probably going to do down here is I'm 

going to enter the Quantity, the Description, and the Unit Price of whatever service I'm 

invoicing for. But check out where we have Line Total, if I click in this Cell, if we look in the 

Formula Bar, can you see there's already a Formula in here? And this Formula is going to 

calculate what the Line Total is based on the Quantity and the Unit Price.  

 

The Template also, comes nicely formatted. So, we don't have to spend any time designing a 

nice looking invoice. All we would probably do here is insert our own logo, and if we wanted 

to change the colours we could come in and we could do that; everything in here is 

customizable, but it just gives you a really nice base to start from.  

 

Now if this Invoice Template is a Template that I want to use over and over again for 

different clients or customers, it's beneficial to save this blank invoice as a Template that we 

can reuse over and over again.  

 

So, if we go up to the File menu, this is where we need to go into; Save As. Now when you 

come to this Save screen, it can look a little bit complicated at first. But what you should see 

in here is your OneDrive account that's associated with your Microsoft 365 account. And if 

you have a SharePoint Site, you're going to see that in there as well. So, you can see I have 

access to my OneDrive and also, my site in SharePoint. So, I can choose to save into either of 

these locations.  

 

http://www.simonsezit.com/


 

 

 

 

 

 

       © Copyright 2023 Simon Sez IT, INC. All Rights Reserved. 33 

Alternatively, if you're more familiar with saving via File Explorer, then if you click the 

Browse button just here, that's going to open up the File Explorer window that might be more 

familiar to you. And you can navigate to whichever folder you want to save this Template 

into.  

 

Now one thing to note here when you're thinking about where to save your Template, notice 

underneath, we have ‘Save as type:’ and currently it says ‘Excel Workbook’. All Excel 

Workbooks when you save them will have the default file extension of .xlsx.  

 

Now if you want to save something as a Template, you need to change this to this file type 

just here; Excel Template (.xltx). Now when I select this type, it jumps me to a very specific 

folder. Notice that I'm now in Documents > Custom Office Templates. And in here, this is 

where I'll find all of my Excel file Templates.  

 

Now, I would highly recommend that you save your Templates into this default folder that it 

takes you to, and I'll show you in a minute why. Let's just give our invoice a name. So, I'm 

going to say Customer Invoice Template and click on Save. So, now that we have this saved, 

let's close it down; Ctrl + W.  

 

And if we go back to File, and New, if I want to reuse that Template, all I would need to do is 

click on the Personal heading just here. Because underneath Personal, this is where we can 

see all of the Templates that we've saved.  

 

So, I have quite a few in here. This is the one we just saved. When I click to open it up, you 

can see there it is, and it's automatically been given a name of Customer Invoice Template1. 

So, any changes we make here are not going to overwrite the original because we saved it as 

Customer Invoice Template.  

 

So, that is the reason why I will always save into that Custom folder to make it easy to access 

from underneath Personal. So, don't forget about these Office Templates; there are so, many 

useful ones in here. As I said, they are brilliant for giving you a head start when creating 

Excel Worksheets. 
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Video: Work with Workbooks and Worksheets  

Deb: In this lesson, we're going to take a look at how we can work with Worksheets in a 

Workbook in a little bit more detail. Now, currently, I don't have anything open in Excel, so, 

let's reopen the file that we were working on earlier.  

 

Now to open a file, we can either go to File and Open. Alternatively, we can press the 

Keyboard Shortcut Ctrl + O, and that's going to jump us to where we need to be. Now, if 

you're looking to open a file that you've accessed recently, then if you cast your eyes over to 

the right hand side of the screen, notice that we have the Workbooks Tab selected at the top, 

and then we have our most recent files.  

 

They're divided down into groups. So, you're going to see any files that you've pinned to the 

top of the list first, then you're going to see all of the files that you've opened today, this 

week, and then older. So, we're looking for the file My First Workbook. I opened that today, 

and there it is just there. So, let's click to reopen.  

 

Now as we mentioned previously, a Workbook can contain multiple Worksheets. And you 

can see that within this Workbook, we have 5 Worksheets at the bottom. I showed you how 

to add them by clicking on the + just here to add more. Now notice that when I've added 2 

more, Sheets 6 and 7 are now appearing out of sequence. It goes Sheet1, Sheet6, Sheet7, and 

Sheet2. So, how can we move these Worksheets?  

 

Well, it's a simple case of dragging and dropping. And if we need to move multiple, we can 

simply hold down the Ctrl key and select the other Worksheet, in this case Sheet6, and then 

we can drag all the way across to the end, and drop them. And now everything is back in 

order. So, really simple to move your Worksheets around via drag and drop.  

 

What else can we do with these Worksheets? Well, we can rename them. And I would highly 

recommend that you rename your Worksheets to make them more meaningful for not only 

yourself, but anybody who's looking at this Workbook. Now to rename a Worksheet again, 

there are 2 different ways that we can do this, we can right click on the Worksheet and 

choose Rename.  

 

Or alternatively, we can simply double click on the sheet name and then over type. So, I'm 

going to call this Product Sales and hit Enter. You can go through and you can rename your 
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Worksheets whatever you want to name them. So, I'm just going to name a few of these. 

What else can we do with our Worksheets?  

 

Well, if we right click on the first Worksheet, we do get a Contextual Menu with other 

options in here. For example, we can change the Tab Colour. Now, not only does this make 

your Workbook look a little bit more colourful and interesting, it’s also, quite useful for 

grouping together Worksheets of similar type.  

 

For example, I have 3 Worksheets here called Chart1, Chart2, and Chart3. So, these are all 

charts. Maybe I want to visually indicate that by making all of the Tabs the same colour. So, 

once again, I can hold down Ctrl and select all of the Tabs, right click, go to Tab Colour, and 

then I can choose whatever colour I like. I'm going to go for this Purple colour.  

 

Maybe I want Pivot and Dashboard to be the same colour. Again, we can hold down Ctrl to 

select them, and then choose colour from the palette. And for these ones, I'm going to give 

budget an Orange colour and for Product Sales, let's go for this Blue. So, using colour to 

group your Worksheets together is a really nice way to visually indicate data that kind of 

belongs together.  

 

Now what about if I wanted to make a copy of a Worksheet? So, I've got data on this Product 

Sales Worksheet, maybe I want to reuse this data but just update the order dates. So, instead 

of creating a brand new Worksheet and retyping all of this, I can simply copy the Worksheet.  

 

Now when it comes to copying, if we right click on this Tab and go to Move or Copy, we 

need to make sure that we select ‘Create a copy’ at the bottom. Because notice we come to 

this same area to move or to copy. So, if we don't have this selected, it’s going to move the 

Worksheet. If we select this, it's going to create a copy.  

 

We can specify where we want to move it to. So, I want to keep it within this Workbook, but 

I want to move it to the end. Let's click on OK, and you can see exactly what we get. We now 

have Product Sales (2) because we can't have 2 Worksheets named the same thing. So, you 

could go in and rename this or you could just leave it as Product Sales (2). So, very easy to 

make a copy. And if we want to delete this Worksheet, once again, we can right click and we 

have a Delete option in here.  
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Now if we go back to here and go back into Move or Copy, if we don't select ‘Create a copy’ 

and just choose ‘Move to end’, it's going to actually move it as opposed to making a copy. 

But it's also, worth noting that we don't have to use the right click menu to move or to copy.  

 

If I want to move a Tab, I can simply click and drag, as we saw at the beginning of this 

lesson. And if I want to create a copy, I can simply do the same thing but add in the Ctrl key. 

So, if I hold down Ctrl, click and drag, I'm going to get a copy as opposed to just moving the 

Worksheet. So, really nice and straightforward.  

 

And the final thing to mention here, when it comes to adding Worksheets, we've already seen 

one of the methods, we can click on the + at the end. And I would say that tends to be the 

method I use most often. But we could also, right click and go to Insert, that's going to insert 

a Worksheet.  

 

Or alternatively, we could go to the Home Tab, into these Cells group, and underneath Insert, 

we can insert a sheet from here as well. Notice I do that, it's called Sheet11. I can then move 

it to the end and rename it to whatever I like.  

 

And notice if we go back to Insert Sheet, we do also, have a Keyboard Shortcut, which 

provides us with another method. The Keyboard Shortcut is Shift + F11. So, when I do that, 

notice I now have another sheet called Sheet12. Now I don't want either of these sheets, so, 

I'm going to hold down Ctrl, select them both, right click, and then choose Delete.  

 

So, a few different options there when it comes to renaming, changing the Tab Colour, and 

also, moving, copying, and deleting Worksheets. 
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Video: Save Workbooks to OneDrive  

Deb: In this lesson, I just wanted to take the opportunity to explain a little bit more about 

how saving Excel files into OneDrive works. Because I find that this tends to be a bit of a 

sticking point for some people.  

 

Now, when you're working in OneDrive, you're effectively working in the cloud. And cloud 

storage has been around for a number of years now. One of the advantages to saving your 

files into the cloud is it makes them easily accessible to other people. So, it means we're not 

having to attach files to emails if we want to share them.  

 

We can simply save them to a shared cloud folder, and everybody can access the file that 

way. And the best thing about it is that whoever opens that file and makes changes, all of 

those changes are automatically saved back to the cloud. So, you're always going to have the 

most up to date copy.  

 

Now OneDrive is installed onto your PC when you work through the setup process for 

Microsoft 365. So, what you should find is that when you're working in Excel, if you go to 

File and go down to Save a Copy, you should be able to see your OneDrive sitting just here.  

 

So, you can see mine is called OneDrive, it has MSFT after it, because there are 2 different 

types of OneDrive account. You can have a Personal OneDrive, which goes with Personal 

Microsoft 365 subscriptions, or if you have a Business subscription, you're going to have the 

business version of OneDrive. And that's exactly what I have here.  

 

Now I'm clicked on it in this list, and then on the right hand side, I can see all of the files and 

folders that are located within my OneDrive folder. And what I'm going to do here is I'm 

going to create a new folder, and I'm going to call it Course Files. Let's click on OK.  

 

So, now if I wanted to save this Workbook, I can simply click on Course Files, and either 

keep the current name or I can rename it as something else. So, I'm going to call this Product 

Sales and click on Save. So, notice now this document’s name has changed in the Title Bar, 

and this is saved into OneDrive.  

 

Now if we close down this file, Ctrl + W, and then go back to File and into Open, again, 

notice we have quick access to OneDrive just here. So, to reopen, I would just select my 
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drive, go to the folder, and there is my file, I can double click to open. But it's also, worth 

noting that if you're somebody who tends to work predominantly in File Explorer, you tend to 

do a lot of your file opening from there, your OneDrive folders get synced to File Explorer.  

 

So, if I open up my File Explorer, you can see at the top here, these are my different 

OneDrives. The one that I've been working in is Deb – MSFT. If I click this, I can see all of 

the folders and all of the files. If I double click on Courses Files, there is that Product Sales 

Workbook. Now I'm going to go back a level because I want to rename this. So, let's rename 

this Course Files as opposed to Courses Files, that's a little bit better.  

 

Now what you'll notice is that when you're working with OneDrive files within File Explorer, 

we have this Status Column just here. And this will basically tell you what status this file or 

this folder is in terms of the cloud. So, when we're making changes to things, you might see a 

little circular icon just here. For example, if I just go in and rename again, I'm going to 

change this to Course Files1.  

 

Notice what happens when I hit Enter, that icon changes to a little Refresh icon. And that 

shows it's synchronizing with the cloud version to keep everything up to date, whether we're 

accessing our files online through the portal or on our PC. When we have a Green tick, it 

means it's fully synchronized with the cloud.  

 

Now notice that some of these other folders just have a little cloud icon next to them. And 

that means that these are actually stored in the cloud only. So, I can still see them in File 

Explorer on my PC, but when I double click to open, it basically needs to download from the 

cloud first of all.  

 

And of course, when we save our files into OneDrive, it means that we can open them 

through the Microsoft 365 portal as well. So, if we go to the app launcher and open up 

OneDrive, we should find that underneath Recent right at the top here, there is our Product 

Sales Workbook. So, it doesn't matter where I open this from, it's always going to be the most 

up to date copy. 

 

So, that's just a little bit more information about how to work with OneDrive and Excel files. 
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Video: Enter Texts, Numbers, and Dates  

Deb: In this lesson, we're going to start actually working in Excel. And we're going to begin 

in this lesson by taking a look at some of the rules and quirks of entering in text, numbers, 

and dates into Cells. Because there's some really important things that you need to know here.  

 

So, we're still working in our Product Sales Worksheet, but notice that I've removed all of the 

data that I had in here previously. So, in Cell B4, we're going to start by entering in an order 

number. Now to start typing into Cells, all we need to do is basically click on the Cell and 

start typing. So, I'm going to enter in my order number ORD-0001.  

 

Once you've finished entering in your information, you have a couple of different options. If 

you then want to move across to the Order Date Column, you can press the Tab key, and it 

will move you straight across. Otherwise, if you press Enter, it's going to move you to the 

Cell below.  

 

Now, if I now wanted to go in and maybe make an amendment to what I have in this Cell, I 

can either double click to go into Edit Mode, you can see my cursor is now there, and I can 

make changes, like so. Or alternatively, we can press the F2 key, that's also, going to put us 

into Edit Mode, and we can go in and make whatever changes we need to make.  

 

Now if I'm in Edit Mode, and I don't want to Tab across to the next Cell, and I don't want to 

go to the Cell below, maybe instead I want to stay in the Cell that I'm working in. We can 

press Ctrl + Enter; it will take us out of Edit Mode, but keep us in the same Cell. So, that's 

another really handy little shortcut. Now I am going to press Tab to go across to the Order 

Date Column. So, I'm currently working in Cell C4. Remember, we can see that in the Name 

Box.  

 

Now when it comes to entering dates into Cells, this can seemingly be a little bit quirky 

sometimes. And just for the record, throughout the balance of this course, I'm using US Date 

Format (mm/dd/yy) and US Currency ($). So, let's say that this is 07/12/2023, press the Tab 

key. All looks good so, far.  

 

I can then enter in the item. So, we're just going to type in Product A and press Tab. Quantity, 

let's say 3, the Price is $5. And the Total, we're going to leave for the moment because that's 

http://www.simonsezit.com/


 

 

 

 

 

 

       © Copyright 2023 Simon Sez IT, INC. All Rights Reserved. 40 

going to be a calculation of Quantity * Price. Now, we haven't had too many issues there 

when we're entering in our data. But there are a few things that you need to be aware of.  

 

Now we're going to delve into this topic in more detail a bit later on. But notice here for the 

Quantity and Price Columns, I don't really like the way that these numbers are displaying. I 

don't just want 5 in there, maybe I want to have 5.00, that might look a bit better. Or maybe I 

want to have the currency symbol at the start.  

N 

Well, this is where we get into the realm of Number Formatting. And if you go to the Home 

Tab, you'll notice that we have a group called Number where we can find all of our different 

Number Formats. And we have various different Number Formats in here. So, General is no 

real specific format. We have Number, Currency, Accounting, Short Date, Long Date, so, on 

and so, forth.  

 

I don't want to go too far down a tangent into Number Formatting, because we have a whole 

lesson dedicated to this later on. But just to show you an example, I want the Price Column to 

show as currency, so, I'm going to choose the Currency option just here. And you can see 

what we get, we get $1 symbol and we get 2 decimal places. So, that looks a lot better.  

 

Now Quantity, that's fine, I just want it to say 3. Product A, that's fine as well. But notice the 

difference between text and numbers. Text in a Cell will always be aligned to the left of the 

Cell. Whereas when we have a number such as the quantity just here, numbers are always 

aligned to the right. Notice in Column C that we have our dates aligned to the right as well.  

 

Now another little quirk that you sometimes come across when you're entering dates into a 

spreadsheet is that you'll type the date in and it won't look like a date, you'll get a strange 

number. So, let me show you what that looks like. So, let's say you type a date into a Cell, 

and instead of getting the date, you get a number that looks like this.  

 

Now again, this is related to Number Formatting. It just means that you have the wrong 

Number Formatting applied to the Column or the Cell. If you check out the Number 

Formatting that I currently have applied, it says General at the top here, and what I really 

want this to be is date.  

 

Now just as a side note, if you're wondering what this strange looking number is, this is 

actually the number of days past the first of January 1900. That date is kind of Day 0 for 

http://www.simonsezit.com/


 

 

 

 

 

 

       © Copyright 2023 Simon Sez IT, INC. All Rights Reserved. 41 

Excel. And to Excel, dates are simply numbers with formatting applied over the top. So, we 

are 45,119 days past the first of January 1900.  

 

So, to fix this, if you do see a Column of numbers that look like this, we simply just need to 

go in and we can apply either Short Date or Long Date format. If I was to choose Long Date, 

that's what it looks like. Most of the time, you're going to prefer to have Short Date. Now in 

Column B, we have an order number. And this is one of those pieces of data where we have a 

mixture of different things. So, we have text, but we also, have numbers.  

 

Now, because text is the first thing in the Cell, it's aligning it to the left as if it's text. Now 

what about if I was to edit this Cell, double click and remove ORD-? Check out what happens 

when I do this. I'm going to remove it so, we just have 0001, press Enter, and Excel changes 

it to 1. And that is an expected behaviour in Excel; it always removes leading zeros.  

 

Now there are a couple of different ways that you can get around this, the most common one 

is people will put an apostrophe and then have their 3 0s in there. And what that will do is 

effectively turn this number into text. And we can see that it's now text because it's aligned to 

the left hand side of the Cell. So, just be aware of that when you're inputting numbers that 

start with 0.  

 

Now, so, far when we've been editing and entering information into the Cells, we've been 

working in the actual Cells themselves. But it is worth noting that you can come up to the 

Formula Bar up here and you can make changes in here. So, sometimes this is a bit easier 

because you've got quite a wide area, and you can see exactly what you're typing; it's not 

going to run into any other Columns. So, I'm going to change this back to ORD-0001, and hit 

Enter.  

 

So, those are some of the basics of entering text, numbers, and dates into Cells in an Excel 

Workbook. 
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Video: Custom Lists  

Deb: Custom Lists are a great way to make data entry quick and simple. And Excel has quite 

a few different inbuilt Custom Lists ready for you to use. But of course, you can also, build 

your own Custom Lists.  

 

Now, if you're not sure what I'm talking about, let me show you an example. So, I'm currently 

working on the Budget spreadsheet, and I just have some Column Headings in here. Now, if I 

enter in a day, let's say Monday, and press Ctrl + Enter to stay in the same Cell, notice that in 

the corner of the Cell, I have this little Green Square. And this is what we call the AutoFill 

Handle.  

 

When we hover our mouse over it, notice that the cursor changes to a small Black cross; that 

means we're in AutoFill Mode. So, if I have a spreadsheet, and I need to fill down the days of 

the week, instead of typing those all out, I can simply type in the first one, hover over the 

corner until I see that blank cross, click and drag down. And check out what happens; it's 

going to fill in all of those days for me. That's a Custom List that's inbuilt in Excel.  

 

This would also, work the same if we were using the short version of the day. So, if I type in 

Mon, press Ctrl + Enter, and do the same thing, have my mouse over and drag down, it's 

going to fill those in just the same way. And this will just carry on looping around until you 

choose to stop filling. We have the same thing for month. So, I can type in January, or Jan 

whichever I prefer, Ctrl + Enter to stay in the same Cell, and then I can drag those months 

down, makes data entry so, quick.  

 

Now notice here, it doesn't quite work the same when it comes to years. If I enter in, let's say 

I'm going to go for 2008, Ctrl + Enter. If I just drag down, it just repeats 2008 over and over 

again. And that is because years are not set up as a Custom List in Excel.  

 

Now, of course, you could create your own Custom List, which I'll talk more about in a 

moment. But there is an alternative method when it comes to AutoFill. So, if we delete this 

out, let's just type 2008 again.  

 

What I can do is if I drag all the way down and let go, notice that I get this little tag pop up 

with some AutoFill Options. So, if I click this dropdown, I can choose Fill Series. And that 
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will fill in those dates. So, don't forget about that little AutoFill Handle, we will be using that 

quite a bit more in later lessons in this course.  

 

The same thing when it comes to numbers. If I enter in number 1, and then number 2, you'd 

think that would be fairly straightforward to drag this down. But it works in exactly the same 

way as the years. We would need to click the AutoFill Option and choose Fill Series to get 

those to input correctly. So, again, neither of these 2 are Custom Lists, but we can get around 

that by using AutoFill Options.  

 

Now just sticking with this topic of Custom Lists, let me show you where these live, and then 

I'll show you how you can generate your own. Now if we jump up to the File menu, we're 

going to find our Custom Lists buried down in our Excel Options. They’re under the 

Advanced page. And if you're wondering what this whole Excel Options area is all about, this 

is where we can come to kind of personalize our copy of Excel.  

 

So, if we scroll all the way down to the bottom, notice we have something here called ‘Edit 

Custom Lists’. So, this is going to open up and show you all of the Custom Lists that you 

have access to. So, you can see the ones that are built in to Excel, it's these top 4 here: Sun, 

Mon, Tue; Sunday, Monday, Tuesday - Jan, Feb Mar; January, February, March.  

 

The ones that you see underneath there are Custom Lists that I've created. So, you can see 

here, I created a Custom List that shows all of my work colleagues. Because quite often I 

have to enter all of their names into a spreadsheet, and I just want to be able to do it by 

dragging that fill handle down. The first name in this list is Brian Gosling.  

 

So, if I click on Cancel just here, let's click on OK. If I needed to enter in staff members’ 

names, I could type in Brian Gosling. And then because that's a Custom List, I can simply use 

the same method by clicking the Fill Handle, dragging down, and it's going to fill in those 

names. So, we can effectively create our own Custom Lists.  

 

So, let's say I have a list of companies and I want to set these companies up as a Custom List. 

Well, what we can do is go to File, Options, Advanced, scroll all the way down and go to 

Edit Custom Lists, and then we can choose to import from Cells. So, if we click down here, I 

can just select the Cells in my Worksheet, click on Import, and it's going to import those list 

entries.  
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So, now when I click on OK, and OK, again, I can delete these out of the spreadsheet. I can 

type in the first one Gaggle; Ctrl + Enter, and I can use the AutoFill Handle to drag those 

down. So, very easy to create your own Custom Lists.  

 

And the final thing to point out when we're in this Custom Lists area, we don't necessarily 

have to import lists from Cells that we have in our Worksheet. If we don't have the list that 

we want to use in Cells in the Worksheet, we can simply type the list entries up here. So, if I 

just type a few names and click Add, I can then use that in the same way. Ctrl + Enter and 

drag to fill down.  

 

So, that's the basics of Custom Lists. As I said, you do have 4 which are included in Excel out 

of the box. And then if you want to use a Custom List for anything else, you can very easily 

create your own. 
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Video: Exercise 3  

Deb: It's time now to do Exercise 03. And in this exercise, we're going to practice some of 

the skills that we've learned in this section of the course.  

 

So, the first thing I'd like you to do is to create a new Workbook based on the Template 

‘Monthly Bank Reconciliation’. I'd like you to save into the default Custom Templates folder, 

and make sure that you understand the advantage of doing this.  

 

I’d then like you to create a new blank Workbook and save it into a folder of your choice in 

OneDrive. And I’d just like you to name the Workbook ‘your initials-practice.xlsx’. I’d then 

like you to open the file ‘Exercise03.xlsx’ from the Exercise Files folder. And I'd like you to 

apply some bold formatting to the heading Row.  

 

And then using the students listed in Column K, I'd like you to create a Custom List. And I'd 

like you to use that Custom List to fill down the student names in the Table. So, a few 

different things to do there. If you'd like to see my answer, then please keep watching.  

 

Now the first thing I asked you to do in this exercise was to create a document based on the 

Template ‘Monthly Bank Reconciliation’. So, we're going to jump up to File, we're going to 

go into New, and we're going to search our Templates. There it is just there. Let's double 

click to open this up and load it into Excel.  

 

I then asked you to save this Template into the default Custom Templates folder. So, we're 

going to jump up to File, we're going to go into Save As, and we're going to choose Browse. 

Now the first thing we need to do here is we need to change the Save as type dropdown, 

because we're saving this as an Excel Template. And you'll see that the moment that we do 

that, it's going to jump us to the Custom Templates folder. I didn't ask you to rename this. So, 

we're going to leave it as ‘Monthly Bank Reconciliation’, and simply click on Save.  

 

I also, asked you to make sure that you understood why it's advantageous saving it into this 

Custom folder as opposed to a folder of your own choosing. Well, it just means that if we 

want to create a file based off of this Template, we can go to File, New, and then underneath 

this Personal Tab, we're going to be able to find our Template. And you can see there it is just 

there ‘Monthly Bank Reconciliation’.  
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The next thing I asked you to do was to create a new blank Workbook and save it into an 

OneDrive folder of your choice. So, we're going to go up to File, we're going to say Blank 

Workbook, you could have pressed Ctrl + N to do this, and we're going to save it into 

OneDrive. I'm going to put mine in my Course Files folder, and I'm going to name it ‘DA-

Practice’ and click on Save.  

 

Next, I asked you to open up the file Exercise03 from the Exercise Files folder, and apply 

some bold formatting to the heading Row of this Table. So, we're just going to select it and 

we're going to click on bold. I then asked you to create a Custom List of all of the students 

listed in Column K.  

 

So, for this, we need to jump up to File, go down into Options, and then into Advanced. And 

if we scroll all the way down towards the bottom, this is where we have our Edit Custom List 

button. We're going to import our list from Cells, I'm going to select the Cells that contain my 

list, and click on Import and click on OK.  

 

I then asked you to use the Custom List to fill the student names down in Column B. So, 

when we have a Custom List, we simply need to type in the first one and then we can literally 

just drag the AutoFill Handle to fill those names down. And that is it. I hope you got on okay 

with that, and I will see you in the next section. 
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Section 4: Introduction to Excel Formulas 

Video: The Order of Operations (BODMAS Rule)  

Deb: So, now that we have the basics of Excel covered, it's time to move on to exploring 

Formulas. Because Formulas are the backbone of Excel. They allow us to perform different 

types of calculations; we can analyse data with Formulas, we can tidy up data, and so, much 

more. And if you're new to Formulas and Functions in Excel, then don't worry, we're going to 

start from the beginning, so, you completely understand what you're doing.  

 

Now, there are over 450 Functions in Excel. Notice I'm using the terminology ‘Functions’. 

And you'll hear people use Functions and Formulas interchangeably. But what is the real 

difference between the 2? Well, Functions are what we use in a Formula. And in Excel, we 

have a number of inbuilt Functions ready for us to use.  

 

Now you'll find all of the Functions on the Formulas Tab, in this group here Function 

Library. Because all of the Formulas are divided down into different categories, we have 

some Functions in here related to financial calculations, we have our logical Formulas 

underneath here, you might have heard people speak about IF, AND, TRUE, FALSE, 

LAMBDA, things like that.  

 

We have a Text group for all of our Text Functions, a Date & Time group, Lookup & 

Reference; this is where we have things like VLOOKUP, HLOOKUP, XLOOKUP, MATCH, 

and OFFSET. And then finally, we have a Math & Trig group.  

 

And then underneath More Functions, we have more groups. But I would say that these ones 

underneath More, these are more niched to specific industries. You also, have a ‘Recently 

Used’ dropdown just here. And this is going to show you the last 10 or so, Functions that you 

use, making them super easy to find again.  

 

Now in the next lesson, we're going to use some of these Functions to create a simple 

Formula. But before we get on to that, it is important to understand some basic principles of 

working with Formulas in Excel because it's really important to understand the order of 

operations. And this lesson is probably going to take you all the way back to your maths 

lessons at school. Notice I have written out here in the spreadsheet, BODMAS and PIDMAS.  
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Now the reason why I have both of these is because in different countries, different 

terminology is used. For example, in the UK, where I'm from, when I was growing up, we 

used the BODMAS rule. Whereas I know in other countries, you might see it written as 

PIDMAS, or even PIDMAS. Basically the same thing, we just use different words for some 

of these items. For example, in the UK, we tend to say ‘brackets’, whereas in the US, they 

tend to say ‘parenthesis’.  

 

Now for the purpose of this demonstration, I'm going to call it BODMAS simply because 

that's what I'm more familiar with. And if you're not familiar with the BODMAS roll, let me 

show you how this works because this carries through all Excel Formulas.  

 

Now it might be I have a series of numbers in Excel. So, let's say I've got 6, and I've got 3. 

Now if I wanted to add these 2 numbers up in Excel, that's a very simple calculation. Now we 

need to tell Excel that we're doing a calculation. So, we do that by typing equals (=) into the 

Cell. Now I could type 6 + 3, and hit Enter. That's going to work and give me the correct 

result.  

 

Now when we type numbers directly into the Formula, we call this hard coding. We're hard 

coding these numbers in. And it means that if either of these numbers up here, change, so, 

maybe this one goes to 5, and this one goes to 2, the Formula down here isn't going to update 

because we've hard coded the numbers into the Formula.  

 

So, in general, the way that we work with calculations in Excel is that we use the Cell 

Reference as opposed to the actual number. So, instead of typing in those numbers, I would 

do =G5+G6, and hit Enter. Because now if I were to change these numbers, you can see that 

the Formula updates because it's referencing the Cell that the number is in.  

 

So, the number one rule of creating Formulas is to always make sure that wherever possible, 

and it's not possible in all scenarios, you use the Cell Reference, as opposed to hard coding 

the number. So, that's all good, but where does this BODMAS rule come in?  

 

Well, let's say we were doing a calculation that was a little bit more complicated. So, let's say 

I wanted to do =10+2/2. So, the answer in my head that I'm looking for here is 6. 10 + 2, 

which gives us 12, and then divide by 2, which gives us 6. So, let's see how Excel calculates 

this Formula. Let's hit Enter, we get 11. Why are we getting 11?  
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Well, if we take a look at this, what Excel is doing is 2/2, which gives us 1, and then it's 

adding the 10. Now the reason why it's calculating that way is all down to this BODMAS 

rule. Because, this is the order that Excel will perform calculations in. So, it will calculate 

everything that is contained within brackets or parentheses first, it will then do any orders or 

indices, so, things like Square roots, then division, then multiplication, and then finally, 

addition and subtraction.  

 

So, because division comes before addition in the BODMAS rule, it's going to do the part of 

the Formula where we have that divide symbol. So, it's going to do 2/2, and then it's going to 

add the 10. So, in this case, it's not the answer I was hoping for, this Formula is wrong. So, 

how could we change this according to BODMAS to make this calculation correct?  

 

Well, what we could do is we could add brackets and let Excel know which part of that 

Formula we want it to calculate first. So, I could type it like this instead; we can say 

=(10+2)/2. So, according to BODMAS, it's going to do what's in brackets first and then it's 

going to do the division and that then gives us the correct answer.  

 

So, this is the basic principle that runs through all Excel Formulas. And it's really important 

to get your head around this before you move on to starting to use Excel Functions and 

building out your own Formulas.  

 

And another thing to note when you're working with Formulas in Excel is that if you want to 

do an addition, we use a plus (+), a minus is a dash (-), a multiplication is the asterisk (*) 

symbol, and division is a forward slash (/). So, the order of operations are a really important 

point to get your head around before you move on to more complex calculations. 
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Video: A Simple Formula  

Deb: In this lesson, we're going to take a look at how we can construct a very simple Formula 

in Excel. And as we mentioned in the last lesson, we can find all of the Functions that we use 

in Formulas on the Formulas Tab. So, we're going to use one of the inbuilt Functions to 

simply calculate the revenue and profit in this spreadsheet.  

 

So, I'm going to start out with the revenue, let's click down in the Total Column; Cell C26. 

Now we mentioned in the last lesson that in order to add numbers together, we preferably 

select the Cell Reference, as opposed to hard coding the numbers in. And if you have a longer 

list of numbers like this, and this is a pretty small dataset if I'm honest with you, typing in all 

these numbers manually would take forever. Even using the Cell References would take 

forever.  

 

If I wanted to add up all of this revenue by using the Cell Reference, I would need to type 

equals, then select the first one plus, then select the second one, so, on and so, forth. Now that 

is extremely slow. Imagine how slow it would be if you had 20,000 or 30,000 Rows of data. 

Fortunately, there is a much better way to do this.  

 

If you want to just add up a single Column, we can use the SUM Function. Now the SUM 

Function is probably the most commonly used Function in Excel; it simply adds up a list of 

numbers. Now if you're looking for the SUM Function, you're probably going to find it 

underneath your Recently Used. As I said, we use it so, often, it's normally in here. You can 

see there it is for me. But the SUM Function is actually a Math & Trig Function. So, if we 

scroll down, we'll find it in this list as well. 

 

Now what if you're looking for a Function, and it's not in your Recent, and you don't know 

which group it's going to be in? Well, we can actually search through the Function Library 

for what we're looking for. So, notice, the first button that we have on the Formulas bar is 

Insert Function. This has a Keyboard Shortcut of Shift + F3.  

 

If we click to open, it's going to produce this little dialog box where we can type in a brief 

description of what we want to do, and it's going to present us with a list of Formulas that 

match. So, I'm going to type in ‘sum a range of numbers’, click on Go, and you can see it's 

returned a few different Functions here, but the top one is SUM.  
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So, once you find the Function that you're looking for, if you double click, it's going to open 

up the Function Arguments box. So, this is great if you're new to working with Formulas, 

because it sort of gives you a guide as to what needs to go in where.  

 

So, with this SUM Formula, we need to provide the numbers to add together. So, what I 

would do in here is simply select everything in this Column. Now notice what it's put in 

there; C6:C25. Now this is what we refer to as a Cell range; we're going from one Cell to 

another Cell. And those 2 dots in the middle basically mean ‘to’; C6 to C25. And that's all we 

need. We can click on OK, and you can see it's given us the total in Cell C26.  

 

Now, cast your eyes up to the Formula Bar, check out what we have in there. It says 

=SUM(C6:C25). Now instead of actually opening up the Insert Function dialog box and 

doing it this way, you could simply type the Formula into the Cell. And for a lot of people, 

this is their preferred method, it's definitely my preferred method as well.  

 

So, let's delete out that total. And take a look at typing Formulas directly into Cells. So, we're 

going to do this calculation again; we’re going to say =SUM. Now check out what happens as 

soon as you start to type in the Formula. It pulls up a list underneath, and we call this 

IntelliSense of all of the Formulas that match what you've just typed. And we can use our 

arrow keys to scroll through them.  

 

And as we do, we're getting a little ScreenTip pop up, which gives us a bit of an explanation 

as to what this Function is going to do. So, we want to use SUM, it adds all numbers in a 

range of Cells. Now the next thing that we need to put in and this is usually the case after you 

enter in a Function is we need to open a bracket. Now you can type the bracket or 

alternatively, if we press the Tab key, it's going to put the bracket in for us.  

 

Now check out what happens and you'll see this no matter what Formula you're using; 

underneath, you're going to get this little ScreenTip pop up, which kind of gives you a guide 

as to what needs to come next in the Formula. So, you can see here it's basically saying 

number1, number2, and it will carry on number3, number4. We need to enter the numbers 

that we want to sum.  

 

Now where we have number1 and number2, we call these ‘Arguments’. That's the 

terminology when you're working with Formulas. So, our first argument here is this Formula 

requires a number to add. Now it has number1 and number2 there, because we could go like 

http://www.simonsezit.com/


 

 

 

 

 

 

       © Copyright 2023 Simon Sez IT, INC. All Rights Reserved. 52 

this, select one number, press comma, and then you see it moves across to number2, we could 

add another number, press comma, number3, press comma.  

 

We could do it that way. But we can also, utilize Cell ranges. So, instead of typing those in 

individually, I can just select the entire Column, it's going to put in C6:C25, close the bracket, 

hit Enter, and we get our total. Let's do the same for the profit. We can do =SUM, press Tab 

to put in that bracket, and then we can select the profit range of Cells.  

 

Now, we can also, use Keyboard Shortcuts to make our selection. So, instead of dragging 

your mouse all the way down to select the range, you can click in the first one and press Ctrl 

+ Shift + Down Arrow; that will select everything, close the bracket, hit Enter, and we have 

our total.  

 

So, a couple of points to remember there if you're brand new to Formulas. Remember, you 

can go to the Formulas Tab, you can use the Insert Function dialog box if you find that easier, 

or you can type directly into a Cell and you have the Formula arguments there to guide you in 

the right direction.  

 

So, that's the basics of a simple Formula. In the next lesson, we're going to start to take a look 

at 6 of the most popular Formulas that you'll use when you're working in Worksheets. 

  

http://www.simonsezit.com/


 

 

 

 

 

 

       © Copyright 2023 Simon Sez IT, INC. All Rights Reserved. 53 

Video: The ‘Big 6’ Functions  

Deb: So, now that we understand the basic principles behind Excel Formulas, it's time to take 

a look at the 6 most popular. And in general, these are the 6 Functions that people tend to 

learn first when they're learning Excel, but they're also, some of the most useful. You'll find 

yourself using these Formulas on a daily basis, so, it's a good idea to understand exactly what 

they do right off the bat. And fortunately, these are very simple Formulas.  

 

So, I'm working with the same dataset that we were working with in the previous lesson. We 

just have a list of company names, and these are completely made up company names, we 

have their revenue, and then we have a Column containing the profit. And what I've got in 

Column F are the 6 Formulas that we're going to be taking a look at. 

 

Now, the first one SUM, we took a brief look at this in the previous lesson. So, we should be 

reasonably familiar with how this one works. SUM just simply adds up a range of numbers. 

So, if we type equals into the Cell to let Excel know that we want to type a Formula, we can 

then type in SUM, press Tab to select it from the list and put in that first bracket, and then we 

can select whatever it is that we want to add up.  

 

Now in these examples, we're going to add up the revenue. So, I'm going to click in the first 

Cell, Ctrl + Shift + Down Arrow to make my selection, close the bracket, hit Enter, and oops, 

what do I have here? Well, if you ever see these hash symbols in a Column, it simply means 

that the Column is not wide enough to display all of the numbers. So, all we need to do is 

widen out this Column.  

 

Now notice, if I hover my mouse between Columns G and H, I get a little double headed 

arrow cursor. So, I can either click and manually drag back and forth, or alternatively, if I 

double click, it will auto expand that Column to the width of the value that's in the Cell. And 

now we can see the sum.  

 

Now the next most common Function is COUT. So, what exactly does COUNT do? Well, 

COUNT will allow you to count the number of items in a selected Cell range. So, for 

example, if I wanted to know how many companies I have in this list, I could use COUNT. 

But there is a caveat to this; when you use COUNT, it will only count the number of items in 

a Column that contains numeric data.  
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So, if I type in =COUNT, again, press the Tab key to select it from the list. If I decide that I 

want to count the number of companies, and then I go in, and I select this range just here, 

close the bracket and hit Enter, it's going to tell me that there's 0. And that is because the 

Column that I've used contains text as opposed to numbers.  

 

Now we can do this, we just simply need to count one of the other Columns. So, I'm going to 

select this Column instead, close the bracket, hit Enter, and it's telling me that I have 

effectively 20 items in this list. And 20 items in this case would relate to 20 companies. So, 

just remember, COUNT only counts numeric data.  

 

If we did want to perform the same calculation on a Text Column, that is where we use 

COUNTA. Because COUNTA stands for ‘count all’, and it will count everything no matter if 

there are numbers or text in the Cell. So, if we use COUNTA for this one, Tab to select, I 

could then count the number of companies, close the bracket, hit Enter, and of course, I get 

20. So, just remember that distinct difference between these 2.  

 

AVERAGE, well, that works pretty much in the same way. So, maybe I want to find out what 

our average profit was across all of these companies. I can type in =AVERAGE, select the 

Profit Column, close the bracket, and hit Enter. And I can see that the average profit was 

26,386.  

 

Now the next one is MIN. And what MIN will do is it will produce the lowest value in a 

range of Cells. So, if I want to find out what the lowest profit is in here, I could use MIN. so, 

we can type in =MIN, press the Tab key, select the Profit Column, I'm going to use the 

Keyboard Shortcuts this time Ctrl + Shift + Down Arrow, close the bracket, hit Enter, and I 

can see that 9535 is the lowest amount of profit. So, SynthoTech Solutions had the least 

profit.  

 

And if I want to do the opposite of that and find out which company had the most profit, I 

could use MAX. Again, it's the same deal; Ctrl + Shift + Down Arrow, close the bracket, hit 

Enter. 44,142 is the highest profit and that is this one just here; QuantumWare Technologies. 

So, these are the 6 most basic Formulas that you can find in Excel.  

 

Now the final thing that I want to mention in here is that for these big 6 Functions, we also, 

have access to this information in the Status Bar. So, what do I mean by that? If I select the 
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entire Profit Column, cast your eyes down to the Status Bar right at the bottom. Notice what 

we have in there, we have all of the answers that we have in the spreadsheet.  

 

And if you're wondering why the SUM value is different in the Status Bar to what we have in 

the spreadsheet, it’s because for the first one, I summed up the Revenue as opposed to the 

Profit, and we currently have the Profit Column highlighted. So, these are brilliant, because it 

means that I don't actually have to do the calculation in order to see those totals.  

 

So, you can imagine if I'm sitting at my desk, and my manager comes over and says; ‘What's 

the total of all of the revenue’? I don't have to sit there messing around with Formulas, I can 

simply go Ctrl + Shift + Down Arrow, and I can tell him the total simply by looking down in 

the Status Bar.  

 

Now if you highlight a range of Cells, and you can't see any of these, right click on the Status 

Bar, and make sure that you have a tick next to AVERAGE, COUNT, NUMERICAL 

COUNT, MINIMUM, MAXIMUM, and SUM. Once these are ticked, you'll be able to see 

those values in the Status Bar. So, that's a very quick rundown of the 6 most basic Formulas 

that you'll use in Excel. 
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Video: Absolute vs Relative Referencing  

Deb: Another really important thing to understand when you're working in Excel is the 

concept of Absolute versus Relative Referencing. So, what exactly does that mean? Well, 

let's start out by talking about Relative Referencing. And we're going to start there, because 

Relative Referencing is the default when you're working with Excel Formulas.  

 

So, if we take a look at this dataset that we have in the Worksheet, you can see that I have 

some Order Numbers, some Customers, Order Date, the Product that they've ordered, then we 

have the Quantity, so, the number of items that they've ordered, and then the Price. And we 

have 2 Columns; Columns H and I at the end here, which don't have anything in them, we 

need to complete those.  

 

So, the first one that we need to complete is we need to work out or calculate what the total is 

going to be for each Customer. So, this is a reasonably straightforward calculation in Excel, 

we just want to multiply the Quantity by the Price to get the total.  

 

Now there are a couple of ways we can do this, we can type in equals, and then we can 

simply use the Cell References. We don't actually have to type in SUM in order to get this to 

work. And another thing to remember is that you don't necessarily have to use your mouse to 

click on these Cells, we can use the arrow keys on our keyboard.  

 

So, if I want to select the Quantity Cell, I can use the Left Arrow, press it twice to go to Cell 

F5. I then want to multiply it so, we're going to put in an asterisk there by Cell G5. So, again, 

if I press the Left Arrow on my keyboard, I can select Cell G5. Now that's all we need to do. 

Hit Enter, and we get our answer. Incidentally, if you do use SUM, it will still work.  

 

So, if we type in =SUM, we can do exactly the same thing. We can select, so, F5*G5, close 

the bracket and hit Enter, and it's still going to work. So, for very basic calculations, where 

you're just multiplying or adding one number to another, you don't necessarily have to have 

SUM at the start there, you can just use the Cell References.  

 

Now one of the cool things about Formulas is that once you've typed the Formula once into a 

Cell, you don't then have to go to the Cell underneath and type the same Formula, you can 

simply copy this Formula all the way down the Column. And we do that by using the 

AutoFill handle.  
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So, if you take a look at this Cell just here, notice the little Green Square in the bottom right 

hand corner. If we hover our mouse over it, we get that little small Black cross. And we 

actually saw this in a previous lesson. Now what I can do is I can either click and drag the 

Formula down. Alternatively, I can simply double click, and it's going to copy the Formula 

down. So, now you can see all of these calculations are correct.  

 

Now the important thing to note here is that this is utilizing Relative Referencing. So, what 

do we mean by that? Now I've copied this Formula down, which means that Excel has had to 

make an adjustment to the Formula each time it moves down a Row.  

 

For example, if we double click on this one just here and take a look at the Formula, you can 

see that it's multiplying F12 by G12. And that is absolutely correct. You can see the Cells 

there highlighted in Blue, and Red. So, every time we drag this Formula down one, Excel 

modifies the Cell Reference, and moves those down one as well. And that is what we call 

Relative Referencing.  

 

Now in a lot of situations, Relative Referencing is going to be what you need. But sometimes 

we don't want to use Relative Referencing, we need to use something called Absolute 

Referencing. And that is kind of the opposite. When we utilize Absolute Referencing, it 

means we're locking the Formula to a specific Cell. So, when we copy down, it doesn't 

actually move down.  

 

So, a scenario where we might have Absolute Referencing would be if we wanted to work 

out the sales tax for these totals. So, let's say that we have our totals here in Column H. But 

we want to work out what the total is going to be when we add on 20% sales tax. And we 

have the sales tax value in Cell I1. So, the Formula to work this out would be equals, I am 

going to do a sum here, let's press the Tab key. And we want to do the total multiplied by the 

sales tax.  

 

Now if I was just to leave it at that and hit Enter, it's going to give me the tax amount. But 

what I want is basically the total plus the tax. So, if we double click to edit the Formula, I 

need to add on to the end here, plus the total again. So, we're utilizing brackets based on the 

BODMAS rule. I want it to calculate H5*I1 first of all, so, it's going to work out the tax 

amount, and then I want to add it to the total. So, when I hit Enter, I get the correct result.  
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Now, if I was just to drag this Formula down in the same way, I'm going to double click, 

check out what happens, it all goes a little bit crazy; we've got lots of value errors in here, and 

these Formulas are just incorrect.  

 

And that is because if we choose one of these down here as an example, check out what's 

happening here. It's calculating Cell H15, the total, which is correct, but when it comes to the 

sales tax, it's using I11. And that's because by default, we use Relative Referencing, and when 

we drag the Formula down, it's going to move the Cell References down.  

 

Now in this instance, we always want this Formula to refer to Cell I1, and that is what we call 

Absolute Referencing. So, let's do this again. I'm going to delete out everything. Let's do our 

FormulA1 more time, I'm going to type in =SUM, we're going to do the total, multiplied by 

the sales tax, but we need to lock this Cell in place so, it doesn't move when we copy the 

Formula.  

 

Now, the way that we do that is to put $ symbol in front of the Row and the Column. Now a 

quick way to add in $ symbols is to simply press the F4 key on your keyboard that basically 

says lock the Column lock the Row. So, now, I can close the bracket, we can do plus the 

total, I'm going to do Ctrl + Enter to stay in the same Cell. And this time, when I copy the 

Formula down, the Formula is going to be correct. 

 

If we double click to take a look at one of these Formulas a bit further down, you can see it's 

now referring to the correct Cells. So, H14, we haven't locked because we're fine for it to 

move those Cell References down as we drag the Formula down, it's only I1 that we need to 

lock in place.  

 

So, that is the difference between Relative and Absolute Cell Referencing. There is also, a 

third option which is called Mixed Referencing, and that's where we either lock the Row or 

the Column. That's a little bit more advanced, so, we'll be taking a look at that a little bit later 

on.  

 

But for now, this is one of the fundamental concepts in Excel that you need to be comfortable 

with, so, it's definitely worth having a practice. 
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Video: Quick Calculations with AutoSum  

Deb: In previous lessons in this section of the course, we've spoken quite a bit about the 

SUM Function in Excel. And there is good reason for that. The SUM Function is by far the 

most common Function that you'll most likely use on a daily basis.  

 

Now, due to this, Microsoft have a little feature that makes it even easier for us to execute the 

SUM Function quickly. And that is called AutoSum. So, if you take a look at the spreadsheet 

just here, you can see that I have 4 small Tables of data. And these simply represent Q1 to Q4 

sales for 3 companies; Gaggle, Gramazon, and Oracled.  

 

Now maybe what I need to do here is I need to add up the totals for both the Column and 

also, the Row. So, we want to see the totals for the company for that particular quarter. But 

we also, want to see the totals for January for each company. So, we need to basically do a 

sum calculation in these Cells just here, and also, these Cells just here.  

 

Now, what we could do is we could click in the first Cell, and we could say equals, and then 

we could do SUM, select this Cell range, close the bracket, hit Enter, and then we could copy 

that down. And then we could do exactly the same thing over here; we could say =SUM, we 

could select the numbers that we want, close the bracket, hit Enter, and then we could pull the 

AutoFill handle to copy that across.  

 

Now, we could do that for each of these Tables. But that is pretty slow, particularly if we 

have a lot more Tables than we have here. So, let's get rid of this and take a look at a much 

quicker method. Now if you notice, if we go up to the Formulas bar, we have an AutoSum 

button just here. And when we click the dropdown, notice that not only can we utilize 

AutoSum for performing this SUM calculation, we can also, use it for AVERAGE, COUNT, 

MAX, and MIN.  

 

But the difference here is that with SUM, we also, have a really useful Keyboard Shortcut. 

And you can see that in the ScreenTip just there; Alt + =. This will automatically add up all 

of the selected Cells. So, what we could do here is I could select everything, including the 

blank Cells, press Alt + =, and it's going to perform all of those calculations. How cool is 

that?  
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I can even do it on multiple Tables at the same time. I could simply make my selection, hold 

down the Ctrl key, make my second selection, keep the Ctrl key held down, make my third 

selection, then press Alt + =, and it's going to perform all of those calculations. How quick 

was that? This is such a time saving utility.  

 

Now, it's not quite as quick if you want to utilize it to do AVERAGE, COUNT, MAX, and 

MIN, because we don't have that helpful Keyboard Shortcut. So, let's delete these out. If I 

wanted to do the AVERAGE instead, I could select all of the Cells, go to AutoSum, select 

AVERAGE, and it’s going to perform that calculation. So, it's still a lot quicker than typing 

in the Formula, we just don't have that Uber-quick Keyboard Shortcut.  

 

Now I'm going to undo that because I actually want the SUM in here instead. So, don't forget 

about that AutoSum button and also, the Keyboard Shortcut. Now I want to finish off just by 

showing you a quick instance where AutoSum doesn't quite work as expected.  

 

Now AutoSum is built to add up numbers that are either above or below or to the side of it. 

So, if we delete out all of these totals again, and maybe instead of January, February, March I 

had in here 2021, 2022, and 2023. So, maybe we have years in there instead.  

 

Now Excel doesn't know the difference between a year and a number that we want to add up. 

So, when we select our Cell range, just here and press Alt + =, it performs the calculation. It 

doesn't include the years in the calculation, but it's showing this little Green triangle in the 

corner of these Cells. So, what exactly is that Green triangle?  

 

Well, when you see a Green triangle, it basically means that there's some kind of warning or 

error on the Cell. And you'll always have this little warning triangle next to it. If I click the 

dropdown, it's telling me; ‘Formula Omits Adjacent Cells’. Now it's giving me this little 

warning because it's recognized that there are numbers above my selection. And those 

numbers in this case happen to be the dates that I added; the years.  

 

So, basically, Excel is recognizing that I have numbers next to my selection that I haven't 

included in the Formula. It doesn't realize that these are years and I don't want to include 

them, so, it's giving me this little warning telling me that the Formula Omits Adjacent Cells.  

 

Now in this case, that doesn't matter. I don't want to include these years in these Formulas. 

So, I can simply select the Cells which have an error, click the Yellow triangle, and choose 
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‘Ignore Error’. So, if you see that little Green triangle in the corner when you're working with 

your Formulas, just remember that that is always some kind of warning that you should 

investigate further. 
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Video: Auto-Fill and Flash Fill  

Deb: Being able to input data quickly into a spreadsheet is going to be one of the most useful 

things you can learn when working in Excel. And in Excel, we have a couple of different 

features that are really going to quicken up this process. So, we're going to explore both of 

those in this lesson. And we're going to start out by talking about AutoFill, or Fill Down as 

it's most commonly known.  

 

Now, we've already seen in earlier lessons that Excel contains inbuilt custom lists to help you 

input common data quickly. If we just refresh ourselves on that, you can see here, in Cell A3, 

I have the Column Heading Months. If I wanted to Fill Down the months of the year, I can 

either type in Jan or the longer January, and simply use the little fill handle in the bottom 

corner, that's this little Green Square that you can see, drag down and you can see it's 

automatically going to fill those months in for me, because this is a built in custom list in 

Excel.  

 

The same applies to days. So, I can either type in Mon or Monday, I'm going to press Ctrl + 

Enter to stay in the same Cell, and then I can use my AutoFill handle to Fill Down the days of 

the week. Now, those are the only 2 inbuilt lists that you have in Excel. If you want to utilize 

this method for other things, such as dates, or maybe sequences of numbers, then you need to 

get familiar with the Fill Down option.  

 

Now let's add another Column of data, and we're going to call this one Dates. And I'm going 

to type in 01/01/2023, Ctrl + Enter to stay in the same Cell. Now if I just want to have a 

sequential list of dates, then I can simply grab the AutoFill handle, and I can drag it down. 

And you can see by default, it just puts these in sequential order. So, we have 1/1, 1/2, 1/3, 

so, on and so, forth. But we do have some other options.  

 

Let's Ctrl + Z, and drag down again. Because notice off to the right, we have a little AutoFill 

tag. So, when we click on this, it's going to show us more AutoFill options. So, I now get a 

menu where I can choose exactly what I'm interested in filling. So, currently, I just have 

sequential dates, but maybe I'm only interested in showing dates that are weekdays.  

 

So, effectively, I want my list of dates to exclude the weekends. So, if I go down to the Fill 

Weekdays option, watch the data very closely. Did you see that some of those numbers 

changed because we're now excluding weekends? So, I know that the 1/1 is actually a 
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Sunday. So, then we have Monday, Tuesday, Wednesday, Thursday, Friday, and then it skips 

over Saturday and Sunday. And then we start back again on Monday, 1/9. Let's Ctrl + Z to 

undo.  

 

Now what if I had a Background Fill Colour applied to this Cell. So, let's just select 

Turquoise, Accent 4. When I now drag down and click on my AutoFill options, I can choose 

if I want to Fill Formatting Only or Fill Without Formatting. So, if I choose Fill Formatting 

Only, you can see what that does; it carries across the formatting, but not the value.  

 

If I select this again and choose Fill Without Formatting, it's going to do the opposite. So, it's 

going to fill sequential dates down but it's not going to carry across that formatting. So, we 

have a couple of different options in there. That AutoFill menu can be really useful.  

 

Now, what about if we need to Fill Down numbers in our spreadsheet? Well, we could go 1, 

2, 3, 4, so, on and so, forth. And if we just have a few numbers to fill out, that might be okay, 

but what about if I want to fill down numbers for 1000 Rows or 10,000 Rows? That's going 

to be really tedious.  

 

Now the other way we could do this is we could type in the first 2 numbers, select both of 

these and use the AutoFill handle to drag down. But if I've got 10,000 Rows to fill in, I'm 

going to be dragging down and down and down for a long time. So, let's take a look at a 

better way of doing this Ctrl + Z to undo.  

 

What we can do instead is we can type in 1, I'm going to press Ctrl + Enter to stay in the 

same Cell. And let's say that I want to fill down a number for every day of the year. So, down 

to 365. What we can do is make sure we have the first Cell selected, go to the Home Tab and 

in the Editing group we have a Fill Down button and we want to select Series. And this is 

going to open up the Fill Series dialog box.  

 

So, the first thing we need to specify here is if we're filling across the Row or down the 

Column. So, we're filling down the Column. We then get to choose our Type. Now if it's just 

numbers that we're filling down, we just want to make sure we have Linear selected in here. 

We can then determine the Step value. So, by how many numbers do we want it to go up 

each time?  
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Now, if we're just doing a sequential list 1234, the step value is just 1. And then we can add 

in the Stop value. So, for me, that's going to be 365. But you could have 10,000, 100,000, and 

200,000 in here. And then when we click on OK, you can see it automatically inputs all of 

those numbers so, quickly. So, we've saved ourselves a lot of hard work.  

 

Now, it's also, worth noting, if we type 1 in again into this Cell, if we wanted to fill these 

across, so, running horizontally, again, if we go to Fill Down and go into series, this is where 

we would choose the Rows option just here. Again, we're going to do Linear, and I'm just 

going to do 5, click on OK, and it's going to fill those numbers across. So, don't forget about 

those little Fill Down options that you have in here.  

 

So, now that we understand how to use AutoFill, let's move on to probably one of my 

favourite things in Excel, and that is Flash Fill. Now Flash Fill is often referred to as the 

superhero utility in Excel, because it is so, useful, and so, time saving in many different 

situations. And I just have 3 very small datasets just to demonstrate this to you.  

 

Now notice here in the first little Table, we have a list of first names and a list of last names. 

Now maybe my boss has asked me to combine the first name and the last name into one 

Column just to save a bit of space in the spreadsheet. So, I basically want a Full Name 

Column here where we have the full name combined into one Column. Now doing this 

manually, particularly if you have a lot of names to fill in, is going to be time consuming. So, 

we can use Flash Fill to help us out with this.  

 

Now the way that Flash Fill works is it recognizes patterns. So, we need to provide the first 

pattern that we're looking for. And that basically means just typing out the first record as we 

want it to look. So, I'm going to type in Brian Gosling, I'm going to press Ctrl + Enter to stay 

in the same Cell, and then there are a few different ways that we can invoke Flash Fill.  

 

By far, the easiest is simply to use the Keyboard Shortcut Ctrl + E. And check it out, it 

recognizes the pattern, and applies it to every record in our dataset. How quick was that? We 

can then, if we wanted to, delete out Columns B and C, and we have everything combined 

into Column D. Let's do it again, but in a slightly different way.  

 

In this second Table here, I have a list of Products and if they are in stock or out of stock. 

And you'll see this quite often; you might be sent a dataset where numerous different pieces 

of information have been combined into one Cell. And in an ideal world, we always want to 
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make sure we just have one piece of data in a Column. So, I want to break this up so, that we 

have the Products listed in this Column just here, and whether they're in stock, out of stock, 

or pending in this Column just here. So, we effectively need to split this data up.  

 

Now again, we can use Flash Fill to do this. So, we're going to give it our pattern. So, the first 

Product here is Alarm Clock. And is that in stock? Yes, it is. We're going to type in In Stock. 

And then, we can use Flash Fill.  

 

Now I could simply press Ctrl + E on both of these Columns. Alternatively, I could go up to 

the Data Tab. And in the Data Tools group, here is the Flash Fill button. If I click this, it’s 

going to copy it down, I can click in the next Column, click Flash Fill again, and it's going to 

copy that information down. How simple is that?  

 

Now there is a third way that we can do this. So, in the final Table at the bottom here, you 

can see I have some SKUs. And this SKU is made up of a catalogue number at the beginning, 

we then have a country code and then we have a part number. And I want to separate out the 

country code and the part number from this SKU.  

 

So, once again, I could type in the first one, so, GBR in this case, and another way of 

invoking Flash Fill is to simply click in the Cell below and just start to type the second one. 

As soon as we do that, Excel recognizes the pattern and can you see it's ghosted the rest of 

those down.  

 

So, if that is correct, I can simply hit Enter and it's going to Flash Fill it down. So, simple. 

And then finally, the part number, we're going to type in 222, Ctrl + Enter to stay in the same 

Cell, and this time, I'm just going to use Ctrl + E to copy those down.  

 

Now Flash Fill is brilliant but it does have a couple of drawbacks. One of them being that you 

can't have any Blank Columns in the middle of your data. So, if I show you what I mean here, 

I'm just going to delete out this information up here and we'll add in a Blank Column Ctrl + 

Shift + to put that in there.  

 

Now, if I have this Blank Column in here and I tried to do a Flash Fill, so, let's type in Alarm 

Clock Ctrl + Enter, Ctrl + E, it's not going to work, because it needs to have the data right 

next to it. If I delete out this Column, and then try and do Ctrl + E, it's back to working.  
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So, just be aware of that. There are some disadvantages when it comes to Flash Fill, where 

you might need to consider other methods such as Text to Columns, or maybe using a 

Formula to split up your data. 
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Video: Exercise 4  

Deb: It's time now to do Exercise04. And in this exercise, we're going to practice some of the 

skills that we've learned in this section of the course.  

 

So, the first thing I'd like you to do is to open the exercise file ‘Exercise04.xlsx’. Now this 

exercise has 2 parts. And in Part 1, I'd like you to use Excel Formulas to answer the questions 

listed in Column I. And in Part 2, I'd like you to calculate the new term fee for each student. 

So, open up the exercise, all of the instructions are in there. If you'd like to see my answer, 

then please keep watching.  

 

So, you can see in Part 1, we're practicing basic Formulas. And we have a Table below that 

shows some students and the mark or the score that they achieved in 4 different tests. And I 

asked you to answer the questions that we have listed in Column I. So, the first question here; 

‘What is Pradeep’s total score out of 400’? Because they have a maximum of 100 points 

available for each test.  

 

So, this is a very basic SUM calculation. We can type in =SUM, press the Tab key, and then 

we want to make sure that we select all of Pradeep’s scores. Close the bracket, hit Enter, and 

you can see he scored 347 out of a possible 400. Well done Pradeep.  

 

The next question; ‘What is Adele's total score for Test 2 and Test 4’? So, again, we're going 

to do a SUM calculation. But our selection, it needs to be a little bit different because Test 2 

and Test 4 are not next to each other. So, our first number, let's just find Adele, there she is. 

We're going to select Test 2, and you could either put a + symbol in here, or you can simply 

do a comma and select Test 4. Let's close the bracket, hit Enter, and you can see the answer is 

134 points.  

 

The next question is; ‘How many students sat a test’? So, we simply want to count the 

number of students in this list. So, I'm going to use COUNTA, because I want to count the 

text. Remember, when you use COUNT, it’s only going to count numeric values. So, I'm 

going to make my selection of all of the students, close the bracket, hit Enter, and we have 14 

students in the list.  

 

The next question; ‘What was Cressida’s average score’? So, for this, we're going to use the 

AVERAGE Function. And all we want to do is find Cressida, there she is right at the bottom, 
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select all of her scores, close the bracket, and we can see that she's got an average score of 

81.25.  

 

The next question to answer is; ‘What was the overall minimum score for Test 3’? So, for 

this, we want to use the MIN Function. And we're just going to select all of the scores in Test 

3, close the bracket, hit Enter, and 45 was the minimum score for this test.  

 

And then finally; ‘What was Olivia’s maximum score’? So, for this one, we're going to use 

MAX. Let's find Olivia, there she is. And we're going to select all of her scores, close the 

bracket, hit Enter, her maximum score across all of the test was 77. So, that part of the 

exercise got you to have a good practice of some of those basic Formulas.  

 

Now Part 2 of this exercise is where we practice Absolute Referencing. And again, we have a 

list of student names, we have the amount they pay for their term University, and over in Cell 

G24, we have a fee increase next year of 5.2%. So, I asked you to calculate what next year's 

term fee is going to be with this increase.  

 

So, for this, we need to do a SUM calculation. And we're going to do the term fee multiplied 

by the fee increase; the percentage. Now because we want to drag this Formula down, we 

need to lock this Cell in place because we don't want it to move. Remember, that's the 

difference between Absolute and Relative Referencing.  

 

So, I'm going to press F4 to lock those Cells in place, close the bracket, and then I'm going to 

add on top of this the term fee. Let's hit Enter, widen out that Column, and then we can 

double click to copy down. And now, we have the new term fee for each of those students.  

 

So, that is it. That is what was required for Exercise 04. I hope you got on okay with that, and 

I will see you in the next section. 
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Section 5: Used Named Ranges 

Video: What are Named Ranges?  

Deb: In this section of the course, we're going to start to take a look at Named Ranges. 

Because again, these are something that you'll come across frequently when you're working 

in Excel. So, what exactly is a Named Range?  

 

Well, if I'm honest, it’s pretty much what it says on the tin. It's a name that we give to a range 

of Cells. So, as we've already established, when we click in a Cell, that Cell effectively has a 

Cell Reference; I6, and we can also, select ranges of Cells.  

 

So, I can click my mouse and drag. This is effectively a range H5 to H13. And if I was to go 

to my Table of data and select everything in the Revenue Column, again, this is a range of 

Cells. But this time, the range is C5 to C24. Now, instead of referring to the Cells by their 

Cell References, we could give them a user friendly name instead.  

 

So, instead of this range being effectively called C5 to C24, I could simply name this range 

‘Revenue’. Similarly, I could name this range of Cells here ‘Profit’ instead of D5 to D24. 

And that is effectively what a Named Range is. So, what is the advantage of using Named 

Ranges?  

 

Well, we're going to get into that in more detail in the third lesson of this section when we 

take a look at Formulas and Named Ranges. But in general, they make your spreadsheets a lot 

easier for not only yourself, but other people to interpret and understand.  

 

Now in the next lesson, I'm going to show you all of the different methods you can use to 

create Named Ranges, because there are quite a few of them. But once you do create a 

Named Range, you can access that Named Range in a couple of different ways. You can 

access it by typing the name into the Cell. Or alternatively, we can access them via the Name 

Box.  

 

If you recall in an earlier lesson, next to the Formula Bar, just to the left here, we have a little 

Name Box. If we click the dropdown, this is going to show you any Named Ranges that you 

have set up in your Workbook. And you can see that I have one in here called Blank_Cells.  
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Now if I click on this, it's going to show you the range of Cells that that refers to, and you can 

see it’s just a bunch of blank Cells K5 to K11. So, you can also, use Named Ranges to 

effectively navigate around your Workbook, because it will jump you directly to wherever 

that Cell range is.  

 

Now let's say I added some numbers into this blank Cells Cell range. So, I'm just going to add 

numbers 1 to 7. So, now that this Cell range is populated, I could use the Named Range in a 

calculation. So, if I wanted to do a sum, I could say =SUM, and then I could just start to type 

the Named Range. You can see there it is in the list; Blank_Cells, I can press the Tab key to 

select it, close the bracket, and it's effectively going to add up all of those numbers.  

 

Now I'm not going to linger too long on this because we are going to do a lot more on 

Formulas and Named Ranges a bit later on, but that's the general concept. So, in the next 

lesson, I'm going to show you the different methods you have to create Named Ranges. 
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Video: Create Named Ranges  

Deb: In the previous lesson, we started discussing Named Ranges. And I briefly showed you 

what a Named Range is. So, now, it's time to create some Named Ranges in our Worksheet. 

And then in the next lesson, I'm going to show you how to use them in Formulas.  

 

So, we're working with our PROFITS FOR Q1 Table over here. And you can see that this 

Table is made up of 3 Columns; we have Company, Revenue, and Profit. Now, maybe I want 

to name this range of Cells Company, this range of Cells Revenue, and this range of Cells 

Profit. So, let's take a look at the different methods.  

 

Now, probably the simplest method is to simply use the Name Box. What I could do here is 

select this range of Cells, go up to the Name Box and click in it, and then just type what I 

want to call this range of Cells. So, I'm going to call this Company.  

 

Now it's worth noting that when you are naming ranges, you can't have any spaces in the 

name. So, if I wanted to call this Company Name, I would either need to separate the 2 words 

with an underscore, or I need to make them all one word like that.  

 

Now, I'm not going to have Company Name, I'm just going to have Company, but we must 

also, remember to hit enter to get that name to set. And then when we click the dropdown, we 

can see that there is the Named Range.  

 

If I'm clicked elsewhere on the Worksheet, and I quickly want to jump back to this range of 

Cells, I can click the dropdown and select Company, and it's going to move me to that area. 

So, Named Ranges are really good for navigation as well. So, that's the first method to create 

a Named Range, we can simply use the Name Box.  

 

Now the next way that we can do this is we can select the range that we want to name, go up 

to the Formulas Tab, and notice we have a Defined Names group in the middle. So, what I 

can do here is click on Define Name. And if you cast your eyes down to the bottom, where it 

says ‘Refers to’, it's picked up the Cell range that I've selected.  

 

So, now all I need to do is give this a name. But again, it's picked up that I have the word 

‘Revenue’ above, and I might want to use that. So, in this case, that is true. If it wasn't I could 

simply overtype with a new name. Let's click on OK, and check the Name Box to make sure 
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it's there, which it is. Now in both of those examples, I've just selected the actual data, I 

haven't selected the header when I've been naming my ranges.  

 

Now the third method includes the header. So, we need to select the header and all of the 

data. We can go up to the Formulas Tab, and we can choose ‘Create from Selection’. Because 

what this will do is it will recognize that we have a header and it's going to say; ‘Do you want 

us to create the name for this range based on the information in the top Row’? So, if I want to 

name this range Profit, and I have Profit in the top Row, I can simply click on OK, and it's 

going to create that Named Range called ‘Profit’.  

 

Now there is another way that we can do this. And this time, we're going to select the entire 

dataset just here, and we're going to go to the Name Manager Button. Now the Name 

Manager serves a few different purposes. We can come in here to take a look at all of the 

Named Ranges we've set up, or we can create a new range from here by clicking the New 

button. So, I'm going to call this All_Data, and click on OK.  

 

Now, once we're in here, it’s worth noting that this is where we come if you want to make 

any changes to our Named Ranges. So, if I want to change the Cell range that these refer to, I 

can click on the Named Range, click the Edit button, and then I could change the Cell range 

that this is pointing to. I can also, delete Named Ranges from here as well. So, if I don't need 

them anymore, I have a Delete button.  

 

So, now, I have 4 new Named Ranges in this dropdown list. And as I mentioned, we can use 

them for quick and easy navigation. But the best way to use these is when you're working 

with Formulas, and that's exactly what we're going to do in the next lesson. 
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Video: Use Named Ranges in Formulas  

Deb: In the previous lesson, I showed you some different methods for creating Named 

Ranges in your Worksheets. And in this lesson, I'm going to show you how simple it is to use 

them in Formulas.  

 

Now we can see the Named Ranges that we've created by clicking the Dropdown Arrow in 

the Name Box. And you can see we have All_Data, Company, Profit, and Revenue. Blank-

Cells is one that we created in a previous lesson that isn't really relevant for this particular 

lesson. So, we're just going to focus on these 4.  

 

Now, once you've created your Named Ranges, you can use those as opposed to Cell 

References when you're putting together a Formula. For example, if I wanted to sum the 

Revenue Column just here, instead of typing in =SUM and selecting this range of Cells, I 

could simply use the name. Now there are a couple of different ways that you can do this.  

 

If you know the name of the range, you can simply start to type it. So, I've typed in rev, and 

you can see underneath it's recognized the Named Range Revenue. I can simply press the Tab 

key to select it, and you'll see that it will highlight the corresponding range in the Table of 

data. I can then simply close my bracket, hit enter, and it's going to perform that calculation.  

 

Similarly, if I wanted to count the number of items in the Profit Column, remember with 

Count, we can only count numerical values, I could type in =COUNT. Now I could start to 

type in profit, there is the Named Range. But what about if I can't remember what the name 

of the range is?  

 

Well, another method that we can use is to simply press F3. What that will do is bring up the 

full list of Named Ranges in your Workbook. So, you can then take a look through these and 

select the one that you want. So, for me, that's going to be Profit, close the bracket, hit Enter, 

and I now get my count.  

 

Let's do one more, let's type in COUNTA. This time, I am going to count the companies. So, 

I can use Company, press the Tab key, close the bracket, and hit Enter. So, hopefully, you get 

the idea as to how these work.  
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Now, if we just look back at these Formulas that we've created here, another advantage of 

using Named Ranges is that they're a lot easier for people to understand. If I was to send this 

spreadsheet to my colleague down the corridor, and it just had SUM and then some Cell 

References, it's not immediately obvious what those Cell References refer to.  

 

They'll have to look in the Worksheet and marry up the Cell References with what they're 

seeing. Whereas if we just have SUM(Revenue), it's fairly obvious that we're summing the 

Revenue Column. So, it really does add to the readability of your Worksheets.  

 

And of course, we can use more than one Named Range in a Formula. So, let's say I wanted 

to add up the Revenue and the Profit Columns. I could type in =SUM, and I could say 

Revenue. Let's select it (,) and then I could choose Profit, close the bracket. And remember, if 

we want to check if this number is correct, we can simply select both of these Columns and 

glance down in that Status Bar at the sum total.  

 

So, Named Ranges are super useful not only when it comes to navigating around your 

Worksheets, but also, for putting together readable Formulas. 
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Video: Exercise 5  

Deb: It's time now to do Exercise 5, where we're going to practice some of the skills that 

we've learned in this section of the course.  

 

So, the first thing I'd like you to do is to open the exercise file ‘Exercise05.xlsx’. I'd like you 

to create Named Ranges for each of the Columns in the Table. And I'd like you to name the 

ranges according to the Column headers. I’d then like you to use those Named Ranges in 

Formulas to answer the questions in Column I. See how you get on with that. If you'd like to 

see my answer, then please keep watching.  

 

So, the first thing I asked you to do here was to create Named Ranges for all of the Columns 

in this Table. Now, there are numerous different methods that you could have used, but I'm 

going to do it the quickest way, which is to select all of the Columns like this, jump up to 

Formulas, and choose ‘Create from Selection’. So, I'm going to say ‘Use the top Row’ as the 

name for the Named Ranges, and click on OK.  

 

Now, I'm just going to check to make sure those have worked by clicking the dropdown in 

the Name Box. And you can see we have Amount, Customer, Date, Description, and Invoice 

Number. So, now, I can use these Named Ranges in these calculations in Column J.  

 

So, the first thing we need to do here is we need to calculate the total invoice amount. So, we 

basically want to sum the Amount Column. So, we're going to type in =SUM, open the 

bracket, but this time, we're going to use the Named Range. So, if I start to type in the Named 

Range, which is called Amount, there it is, I can select it, close the bracket, hit Enter, and we 

get our total. And I'm just very quickly going to apply some dollar formatting so, that it's the 

same format as the Table.  

 

So, next, we need to find out the total number of invoices. So, for this, I'm going to use 

COUNTA, and we could use any Column just here. So, I'm just going to pick a Column. Let's 

pick the Description Column. Now I'm going to use the Named Range again, but this time, 

I'm going to press the F3 key on my keyboard and I'm going to select it from here. So, let's 

choose Description, let's close the bracket, hit Enter, and we have 22 invoices in the list. 

That's how we solved this exercise, I'll see you in the next section. 
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Section 6: Format Numbers and Cells 

Video: Apply Number Formats  

Deb: In this section of the course, we're going to take a look at how we can format our 

Worksheets and make them more readable. And we're going to start out in this lesson by 

taking a look at something really important. And that is Number Formatting. We've briefly 

touched on this in previous lessons, but now, it's time to really do a deep dive, so, you can 

understand how some of the most important Number Formats work.  

 

Now, the first thing you need to remember about Number Formats is that they are simply a 

mask. Number Formats don't change the underlying number, they just apply formatting on 

top of the Cell. For example, if I click in any Cell that contains a number, so, I'm going to go 

for B6. If you take a look in the Formula Bar up here, you can see that it says 2000; it's 

reflecting exactly what's in the Cell that I'm clicked in.  

 

And you'll see in a moment, when we apply formats to these numbers, even if the number 

looks different in a Cell, maybe it has a currency symbol in front of it, when we click on the 

Cell and take a look in the Formula Bar, the number is always going to be 2000, no matter 

what formatting we've applied over the top. So, the number underneath will always stay the 

same.  

 

Now why do we apply Number Formats? Well, a lot of the time, when you type a number 

into a Cell, we want it to look a little bit different. If we're dealing with currency may move 

on to have the currency symbol in front of it. Or maybe we want to apply Date Formats or 

Time Formats. Or maybe we want to make numbers look like a percentage. We can do all of 

this using Number Formatting.  

 

Now you'll find your Number Formatting options on the Home Ribbon in the Number group 

just here. And notice we have a big old dropdown with quite a few different formats in here. 

We can also, click More Number Formats at the bottom, which will open up the Format Cells 

dialog box. And this dialog box, we're going to use this throughout the entire balance of this 

section.  
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And on the Number Tab, this is where we have more details about each of these different 

Number Formats. So, let's go through and start applying some of these because there are a 

few little things that you need to know when you're working with your Number Formatting.  

 

So, if we take a look in Column B, you can see that we just have a list of plane numbers. Now 

if I just want my numbers to look like this in the Cells, that's absolutely fine, I can leave 

them. Notice that currently I have the General Number Format applied.  

 

Now General is something that gets applied to most Cells when you first type something into 

them; it doesn't have any specific format. Pretty much what you type, that's what you're going 

to see in the Cell. But notice underneath we have a specific format for numbers. So, if we 

click on this, notice what it does, we now have 2 decimal places, and a (.) in the middle.  

 

Now if that's what you want this number to look like then you can leave it as it is. But we 

could also, do some modifications to the way that this looks. For example, if I don't like the 

number of decimal places, I can go up to the Number group, and notice I have 2 little arrows 

here to increase the decimal or decrease the decimal. So, if I decrease, I can take that down to 

1, or I can take it away entirely. Or I can click the other one and increase the decimal places. 

So, this is really entirely up to you.  

 

Also, notice that if I want something completely different, I have a Comma Style Separator. 

So, if I click this, it's going to put a comma between the 1 and the 0s. And again, I could take 

those decimal places down if I wanted my numbers to look like that. So, you have a few 

different options in there when it just comes to formatting plain numbers. I generally like to 

have mine with a Comma Separator. Let's move on to the next Column where maybe we 

want to format these as currencies.  

 

So, once again, I'm going to select everything let's do Ctrl + Shift + Down Arrow this time, 

and I'm going to click on the little diagonal arrow to jump me into the Format Cells dialog 

box. And I'm going to choose Currency from here.  

 

Now it's worth noting that you don't have to come into this Format Cells dialog box. If you 

take a look at the Number group again above, notice I have a little Currency symbol just here. 

So, I could simply click this to apply whatever my default currency is. But I like to come into 

here because I get a few additional options that I can adjust.  
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So, the first thing to do here is really to select the currency symbol that you want to use. Now 

the default for me is the dollar symbol. But if you click the dropdown, you have all of the 

different currencies in here. And we can choose how many decimal places we want. Notice 

just above we have a little preview. If I were to take these down, it's going to show me in the 

preview what that's going to look like.  

 

So, I'm actually going to have 2 decimal places this time. And I can also, choose how I want 

to format negative numbers in this list. So, if I had some minus figures in here, I could choose 

if I want to format those in Red, if I want to have them in brackets, or maybe even Red in 

brackets. Now in this list, I don't have any, so, we're just going to stick with our 2 decimal 

places, click on OK, and that's what it looks like.  

 

Now, Accounting Format, this is an interesting one; let's Ctrl + Shift + Down Arrow. Again, 

we're going to open up Format Cells, and if you want a quick way to get into that Format 

Cells dialog box, you can press Ctrl + 1 on your keyboard.  

 

Now Accounting Format is pretty similar to Currency Format. We come in here when we 

want to apply a currency symbol to the front of our number, and we can also, adjust the 

number of decimal places. But the big difference here between Accounting Format and 

Currency Format is that Accounting Format will line up in the Column the decimal place. So, 

if I click on OK, you'll see that it does look slightly different from Currency Format.  

 

If I widen out these Columns to make it more obvious, Currency Format has the currency 

symbol pushed right up against the number, whereas Accounting Format has the currency 

symbol flush with the left hand margin. And what you'll find is that no matter what number 

you type into here, whatever the length of the number is, it's always going to line up the 

decimal place.  

 

And the idea behind Accounting Format is that it's really been built for accountants who 

maybe have to read down long lists of numbers. The decimal place being in the same place 

makes the number easier to read, and also, easier to perform at calculations. So, that's the 

difference between Accounting Format and Currency Format. The next one that we have is 

Date. So, let's Ctrl + Shift + Down Arrow.  

 

Now if we were to click the dropdown here, notice that we have options of Short Date or 

Long Date. So, I currently have Short Date applied, if I was to apply a Long Date and just 
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widen out that Column, you can see that that's what I'm going to get. If we go into Format 

Cells and go into Dates, you can see we have many more different formats we can choose 

from in here.  

 

So, if I wanted to display the year first, then the month, then the day, I can click on OK, and 

it's going to apply that format. So, lots of different Date Formats for you to choose from. The 

same thing goes with Time; Ctrl + Shift + Down Arrow. Again, if we click the dropdown, we 

have Time in here.  

 

Alternatively, Ctrl + 1 to see more options, let's go into Time, we can choose the Time 

Format that we want. So, maybe you want to have these on a 12-hour clock, but you want to 

specify if it's am or pm. You can select this one just here, click on OK, and it's going to put in 

that am and pm text.  

 

Now when it comes to Percentages, this is where it's a little bit different. I've got some 

regular numbers that I've typed into the Cells, and maybe I just want to convert these into 

Percentages. So, you might think that you can just make your selection Ctrl + Shift + Down 

Arrow, go up to the Number group, and notice we have a Percentage icon just here.  

 

Now if I click on this, check out what happens; this isn't really what I wanted it to look like. 

So, let's Ctrl + Z to undo, why isn't it just giving me 5%, 10%, 15? Why is it putting in all of 

these extra 0s? Well, it's because Percentages work a little bit different in Excel.  

 

If you want to simply apply Percentage Style to a list of numbers and have them look correct, 

your numbers need to be written out slightly differently. So, instead of 5, we will need to 

have 0.5 in the Cell. You can see as soon as I do that and click on the Percentage symbol, I 

then get 50%.  

 

Now that can be a little bit of a pain; if you have a long list of numbers already written out 

like this, do you need to go back in and convert them essentially divide them by 100? And the 

answer is, yes, you kind of do. So, how can we get around this? What if we have numbers 

like this in our spreadsheet, and we just want to apply Percentage Style and have these look 

correct? Well, there is a little trick using Paste Special.  

 

Now we haven't got to the section on cutting, copying, and pasting in this course as yet. So, 

we're going to revisit this once we've learned a little bit more about those features, and I'm 
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going to show you how you can quickly convert all of these to Percentages. Another note 

about this is if you have Percentage Formatting applied to the Column, before you put the 

numbers in, then it works fine.  

 

So, if I was to select Column I and choose the Percentage Style, if I was to then go in and 

type in 50%, that's going to work no problem. So, if you don't have any numbers in the 

Column, you can apply Percentage Style first, and you can just type your numbers in. If you 

already have numbers in here and you're just trying to convert them to Percentage, you're 

going to get these weird numbers. So, just be aware of that. We will revisit this a bit later on.  

 

Now the final Column that I have in this Table is just a mixture of positive and negative 

numbers. If we Ctrl + Shift + Down Arrow and press Ctrl + 1 to open up Format Cells, we 

can go to Number Formatting and as I said, we can choose if we want to apply Negative 

Number Formatting as well. So, I'm going to say that I want 0 decimal places, I want to use a 

1000 separator, and I want any negative numbers to show in Red and in brackets. Let's click 

on OK, and you can see how that applies formatting to those numbers.  

 

And as I mentioned with any of these Number Formats that we've applied, if I click on any 

Cell, so, let's go for H6, notice in the Formula Bar, it doesn't have the formatting up there, it 

just has the actual number that's underneath in the Cell.  

 

The same with Cell C6, you can see it just has the plain number, it doesn't show the 

formatting, because the formatting is just a mask that sits on top, and the formatting is applied 

to the Cell. So, if I was to delete out all of these numbers and start typing other things, the 

formatting is still going to be there. So, whatever I type into these formatted Cells is going to 

take on that Number Formatting.  

 

Now the final thing to note here is notice that I have a little phone number over in Cell K4. 

Now there is a format specifically for things like phone numbers, zip codes, and social 

security numbers. Now, this very much applies to the US only. If we press Ctrl + 1 to open 

up Format Cells and go to Special down here, notice we have these 4 in here.  

 

So, other countries don't necessarily have zip codes. For example, in the UK, we have 

postcodes that take on an entirely different format to the US. Also, our phone numbers in the 

UK are a completely different format. So, if you're in any other country other than the US, 

then this section is pretty useless.  
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But just for all of the US viewers, if you do have a list of phone numbers, you can simply 

select the Phone Number Formatting in here, click on OK, and it will apply that formatting. 

Now you can see it hasn't changed a great deal. But if I maybe had numbers, which didn't 

have the dashes in there, you can see now it updates.  

 

Now there are other formats in this list, which we haven't taken a look at as yet. For example, 

Custom Formatting is where you can basically build your own formatting. And this can be 

really useful. Now, it's outside the scope of this course because this tends to fall under more 

advanced topic, but just be aware of all of the different Number Formats that you have in 

here, and have a little play around with them. But those are the basics of Number Formatting 

in Excel. 
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Video: Format Cells, Rows, and Columns Manually  

Deb: In this lesson, we're going to take a look at how we can make our Worksheets look a 

little bit more interesting and engaging by applying formatting to Cells, Columns, and Rows 

because we have so, many options when it comes to formatting. And we're going to start by 

taking a look at how we can manually format our Worksheets in this lesson.  

 

So, if you take a look at the Worksheet on the screen, you can see that I have a little Table of 

data, but it looks a little bit strange at the moment. Notice that all of the Columns are kind of 

collapsed on top of each other. And you can see that for some of these Columns, we have 

these hash symbols, which means there isn't enough space in the Column to accommodate 

whatever's in the Cell.  

 

Now, quite often, you'll see Worksheets that look like this where you need to widen out all of 

the Columns. And a common mistake is that people try to do this manually. So, what they'll 

do is they will, let's take the first Column for example, they'll move their mouse until they're 

between Columns B and C, notice the little Black double headed arrow, and they'll click and 

they'll drag the Column out to widen it.  

 

Now there isn't anything particularly wrong with that; you could go through and do all of 

your Columns in the same way, it’s just very tedious and slow. My dataset here is pretty 

small. But imagine if you had a lot more Columns than this; going through and manually 

changing this is going to take up time. Fortunately, there is a much quicker way of doing this.  

 

What we can do is select all of the Columns. And we do that by hovering our mouse over the 

first Column until we see that little Black downward facing arrow, click, and select all of the 

Columns. And then, we simply can hover our mouse over any of the Column boundaries, I'm 

going to hover mine between E and F, and double click. And that is a quick way of auto 

fitting all of the Columns.  

 

It's worth noting that that little double click trick is also, available on the Home Ribbon. If 

you go to Home, go to Format, notice you have ‘AutoFit Column Width’ just here. So, if I 

was to undo, let's Ctrl + Z to put everything back, I could go up to Format and choose 

AutoFit Column Width, and it's going to do the same thing. So, either of those 2 methods are 

brilliant for quickly auto fitting all of your Cells.  
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Now looking at this dataset, what else might I want to do to it to make it more readable? 

Well, I can see that the Column Headings just here, they don't really stand out from the rest 

of the data. So, what can I do here? I could apply some Bold Formatting, maybe I want to 

apply a Background Fill.  

 

Now if I want to apply bold again, on the Home Ribbon, we have all of our Font Formatting 

options. I have the Bold option just here. But as we know, there is a Keyboard Shortcut of 

Ctrl + B, that's quickly going to apply Bold.  

 

Now notice as soon as I apply Bold Formatting Column F; Price Per Unit, is now cut off 

because when you apply Bold, it effectively makes the font a little bit bigger. So, you might 

have to go in and just double click again to adjust that Column Width. What else could I do?  

 

Well, let's select the heading Row again. This time, I'm going to use Keyboard Shortcuts; Ctrl 

+ Shift + Right Arrow, maybe I want to apply a Background Fill. So, I can click the little 

paint bucket icon and notice that I get a palette of Theme Colours and Standard Colours.  

 

Now I'm not going to go too much into what the difference is between these 2 at the moment. 

But just be aware that when you're working in Excel, you have a default theme, which 

controls the fonts that you use in your Worksheets and also, the colours. So, I'm using just the 

default Standard Theme for Excel, and these are the Standard Colours.  

 

So, I can go in and I can choose anything from the palette just here. We have what we call 

Standard Colours. Or if I want to be very specific about the colour that I'm using, I could go 

to More Colours, I can choose a colour from this little colour palette just here. Alternatively, 

if we click across to the Custom Tab, we could click around in this to find the colour that we 

want.  

 

Alternatively, if we know what the hex code is, we can type it into here. A lot of the time if 

you're working at a company, they'll have very specific branded colours; it might be the 

colours of the company logo, and your organization might like you to use those very specific 

colours in your spreadsheets. And a lot of the time your marketing department will have a list 

of all of the hex values for those colours. So, you would simply just copy and paste it in if 

you need it to be very specific.  
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Now I'm not going to use any of these colours. I'm just going to choose one from the 

Standard Palette. So, let's go for this dark Purple. So, now that I've done that and applied that 

dark Purple fill, it's a little bit harder to see those Column Headings. So, I'm going to select 

them again Ctrl + Shift + Right Arrow, and this time, I'm going to change the font colour.  

 

So, we can click the little font dropdown and I can choose the colour from the palette. I'm 

going to go for White to make those stand out. So, just with a few clicks, we've very quickly 

been able to make this look a little bit more readable.  

 

What else might we want to do here? Well, notice at the top here, I have 2023 Order 

Summary. So, this is kind of a title. And I really want this to be running across the top of my 

data, but I want it to be in the middle. Now notice on the Home Ribbon, you do have an 

Alignment group just here. And this will allow you to align text within a Cell either vertically 

or horizontally.  

 

If I give you an example, I'm just going to make this Row a little bit taller. Notice I'm just 

dragging it down, you can see Order Summary aligns to the bottom of this Cell. But if I was 

to use my Alignment tools, notice here currently I have Bottom Align selected, but I could do 

Middle Align, that's going to move it up, or I can align it to the top.  

 

Similarly, if this Column was a little bit wider, I could align it to the left as it currently is, I 

can align it to the middle, or I can align it to the right. So, if I wanted this dead in the centre, I 

would align it to the centre, horizontally and also, vertically. So, don't forget about your 

Alignment tools. I just want it aligned to the left and to the bottom.  

 

Let's double click to put that back how it was, because what I actually want is to align this 

across all of my data. So, you might think that what you can do here is select all of these 

Cells, and then just click the Centre Alignment. But that's not going to work, it's only going 

to align that text in the Cell that it's in. Now what we can do is we can effectively merge all 

of these Cells together to make them one Cell, and then align the text to the centre.  

 

Now notice that in the Alignment group, we have a Merge & Centre button. And I will say 

that this is a little bit controversial, because it can throw up some problems. But let me just 

show you what it does. If I click Merge & Centre, you can see it merges all of those Cells 

together to make one Cell, and it moves the text to the middle, which is pretty much what I 

want.  
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Now the reason why people don't like this so, much is that if you have merged Cells in your 

spreadsheet, it makes it a lot more difficult to make selections, and it can sometimes throw 

your Formulas off. If I now want to select Column D, and I click and start to drag down, you 

can see that when it gets to that merged Cell, it expands out. So, when I carry on dragging 

down, I'm not just highlighting Column D, I'm highlighting everything. So, it makes 

selections a little bit more difficult.  

 

So, let me show you an alternative method where you don't have those problems. I'm going to 

Ctrl + Z to put everything back to how it was, because instead of doing it that way using 

Merge & Centre, if we click on the little diagonal arrow in the corner, it's going to open up 

that Format Cells dialog box, but it's going to take us to the Alignment Tab.  

 

What we could do instead is where we have Text alignment > Horizontal, we could choose 

Centre Across Selection, click on OK. It's going to give the same effect, but it means that if I 

just want to select Column D, I can click and drag down, and we don't get the same issue that 

we get with Merge & Centre.  

 

So, in general, I always advise people to Centre Across Selection instead. So, now that we 

have that, I can select all of this, maybe I want to make this bold, and I'm going to change the 

background colour to a Blue colour and change the font to White.  

 

We can also, do things like increase the Font Size. So, again, in the Font group, if we click 

the dropdown just here, we can make the font a lot bigger, or we can make it smaller. And if 

you want to just increase in increments, we have an Increase Font Size and a Decrease Font 

Size just here. So, if I click this a couple of times, it's going to make that heading a bit bigger. 

 

Now I can see here that during all of that formatting process, Column B is now very wide. 

So, I'm going to double click on the Column boundary just to re-size that. Now what else can 

we do here?  

 

Well, maybe I want to put Borders around my Table. So, what I'm going to do is I'm going to 

select all of my data, and we're going to use a Keyboard Shortcut; we're going to press Ctrl + 

A, which means select all. So, when we're clicked within a Table of data, when we press Ctrl 

+ A, it will select everything. If I was clicked in a random Cell over here and I press Ctrl + A, 

it's going to select the entire Worksheet. So, just be aware of that difference.  
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Now when it comes to Borders, you'll find your Border options, again, in the Font group, it's 

this little dropdown just here. And you can see that we have lots of different Borders that we 

can apply. So, maybe I just want to apply Borders to the bottom of the Cell, the top, the left, 

the right, I could apply all Borders, so, on and so, forth. 

 

Now in general, when I'm applying Borders, I like to go into more Borders at the bottom to 

pull up the Format Cells dialog box, and I like to set my options from here. So, maybe I want 

a thin dark Purple Border around all of my Cells. What I could do here is I could select my 

line styles. I'm going to go for this one, I can select the colour of the lines. I'm going go for 

this Purple colour. And then I can choose very specifically where I want those Borders to 

appear in the Cell.  

 

Now notice we have some pre-sets just above to make this a bit quicker. So, I basically want 

a Border around everything. So, I want an Outline, and I also, want an Inside Line as well. 

Now notice with these, you can click on them to remove them, and you can click to put them 

back again. So, if I wanted Borders just running down the Columns and not across the Rows, 

I could remove this middle one and just have it like that.  

 

So, you can really get very granular about how your Borders look in this Borders area. Let's 

click on OK, and you can see what that does. And in general, people tend to use Borders if 

they have their Gridlines turned off. If we go up to the View Tab, notice here in the Show 

group, we have Gridlines selected. So, that means we can see all of these Cells in the 

background.  

 

Now a lot of people once they finish their spreadsheet will deselect Gridlines to give it a 

cleaner look. But if we have Borders applied, it still allows that data to kind of stand out and 

not just blend into the background. So, I'll leave that up to you to decide if you want to do 

that.  

 

So, pretty much all of the options that you have when it comes to formatting Cells, Rows, and 

Columns, you're going to find in the Font group, and in the Alignment group. Remember, 

when you press Ctrl + 1, it pulls up that Format Cells dialog box. Remember, this is where 

we were when we were applying Number Formatting. But we also, have an Alignment Tab, a 

Font Tab, a Border Tab, and a Fill Tab in here. So, pretty much a lot of the things that you 
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can do working with these icons in the Font group, you can do in the Format Cells dialog box 

as well.  

 

But you do have more advanced options in here also. For example, with this Fill section, we 

could choose to fill the background with some Fill Effects. This is where we could fill the 

background of the Cell with a gradient. We could choose what colours we want to use, so, on 

and so, forth. If we want it vertical or diagonal, up, horizontal. We can click on OK and OK 

again, and you can see that it's just applied that to the one Cell because that's all I had 

selected. Ctrl + Z to undo.  

 

The final option to point out here is the Wrap Text option. What this will do is it will wrap 

extra-long piece of text round in the Cell. So, maybe I have over here, let's just widen this out 

a little bit. I'm going to type in a reasonably long sentence; ‘The quick brown fox jumps over 

the lazy dog’.  

 

Now this sentence, even though it's running across the Columns, it is just contained in Cell 

J5. But because it's longer than the Column Width, it's running over into other Columns. 

Now, what I could do here is double click to make that Column as wide as what I have in it. 

But sometimes you might want to have the Column Width set to this and you just want the 

text to wrap around. So, that is where we can use the Wrap Text option in the Alignment 

group.  

 

If I click on Wrap Text, it’s going to do exactly that. It's going to wrap the text around to fit 

the width of the Cell. So, just bear that in mind as well. I'm going to Ctrl + Z just to undo all 

of that. So, those are some of the options you have when it comes to formatting Cells, Rows, 

and Columns. 
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Video: AutoFormat Data  

Deb: In the previous lesson, I showed you some tips and tricks for applying manual 

formatting to your spreadsheets to make them more readable and engaging. And in this 

lesson, I just want to show you a quick trick for applying AutoFormat. And what AutoFormat 

is, is basically automatic formats. So, it takes all of the heavy lifting out of applying 

formatting manually.  

 

We can select a little template from the available Gallery, and it will apply all of the 

formatting in one go. And this is a little option that used to be really popular quite a few years 

ago in Excel, and then it kind of disappeared from the Ribbon. The good news is it is still 

there, but we need to add it to the Quick Access Toolbar, because we can't find it on any of 

these Ribbons. So, let's start out by doing that.  

 

Now remember, with this Quick Access Toolbar, if we click the little dropdown just here, we 

can go to More Commands, and that's going to jump us across to our Excel Options and 

straight to the Quick Access Toolbar section. Now I'm going to select All Commands from 

the dropdown, and let's scroll through and find AutoFormat.  

 

As I said, these are in order, so, it does make it a little bit easier to find, but there is the button 

that we're looking for. So, I'm going to select it and I'm going to add it to my Quick Access 

toolbar. You can see there it is at the bottom. Let's click on OK.  

 

So, now, when I'm clicked in my dataset, if I click this AutoFormat button, it's going to pull 

up a gallery of different formats that we can apply to our dataset. And if we scroll through, 

you can see that we have quite a few different ones in here. So, it really depends how you 

want your formatting to look.  

 

Now if we scroll up to the top, let's go for this one just here; Classic 3. Once you've selected a 

template to apply, we have an Options button in the bottom left hand corner. So, if we click 

this, we can effectively choose which formats we want to apply to our dataset, we don't 

necessarily have to apply everything.  

 

Now by default, everything is selected. So, it's going to apply the Number Formatting, the 

Borders, the Font, the Patterns, the Alignment, the Width, so, on and so, forth. Now, I don't 

want this formatting to change the width of my Columns. So, I'm going to deselect Width and 
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Height. And it might be that I don't necessarily want to apply the Number Formatting 

contained within the template either.  

 

So, go through and specify what you want to apply, deselect what you don't want to apply, 

click on OK. And check out what we have. It applies that formatting. And you can see here 

it's applied formatting to the header Row, we have a Background Fill on all of the Cells, it’s 

changed the Font Colour, and we have an Outside Border.  

 

So, that is a lot quicker than going in and doing all of that hard work manually. And if you 

decide that you don't like this, you can click on the AutoFormat button again, and maybe 

choose something else. So, I'm going to go for Classic 2. Let's select Options. Again, I don't 

want it to apply Width and Height or Number, let's click on OK, and I get some different 

formatting. And I think that looks really nice.  

 

And of course, you could use this as a base and you can go in and you can apply manual 

formatting as well. So, maybe I want to make these headers a bit bigger. I want to make them 

bold, maybe I want to align them to the left or even to the centre, so, on and so, forth.  

 

So, you can tweak these AutoFormat templates once you've applied them. But I think you'll 

agree AutoFormat is a really handy little button to have on your toolbar so, you can just 

quickly format your datasets. 
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Video: Find and Replace Formatting  

Deb: In this lesson, we're going to take a look at how we can use the Find and Replace utility 

in Excel to find Cells that have specific formatting applied and replace it with other 

formatting. And again, this is a really useful time-saving hack if you've got a lot of data, and 

you just want to replace the formatting on the Worksheet, or even in the entire Workbook.  

 

Now the Find and Replace utility can be used for many things, not just replacing formatting. 

We can also, replace values, text, and many other things. But in this context, we're going to 

take a look at it specifically for replacing formatting.  

 

Now you're going to find the Find and Replace utility on the Home Ribbon in the Editing 

group. Notice we have a Find & Select option. And when we click here, we get a dropdown 

where we can find Find and Replace.  

 

Now personally, this is one of those utilities that I prefer to use the Keyboard Shortcut to 

access, I just find it a lot quicker. So, if you want to quickly jump into Find, you can press 

Ctrl + F, that's going to bring up Find and Replace. But notice that this has 2 Tabs; Find and 

then Replace. So, if you want to go directly to the Replace Tab, what you can do is press the 

Keyboard Shortcut Ctrl + H; basically brings up the same dialog box, but you get taken to the 

Tab that you need.  

 

Now when you first open up Replace, it's going to look like this. Now this is fine if you just 

wanted to replace some texts. So, maybe I wanted to replace the word ‘shipped’ with ‘sent’. I 

could do that from here, I could say ‘Replace All’, and you can see what that's done. In the 

dataset, wherever it finds the word ‘shipped’, it's now replaced it with ‘sent’. That is a very 

basic text based replace.  

 

But what if we want to replace the formatting. So, maybe where we have ‘pending’ 

highlighted in Grey, maybe I want that to be a completely different colour. Well, this is 

where we need to open up the Options. Now when we open up Options, we get exactly that; 

more options that we can set as our criteria.  

 

Now the first thing I'm going to do here is I'm just going to remove the text from ‘find what’ 

and ‘replace with’ because we don't want to find that criteria again. This time, we want to 

find the formatting. So, notice next to ‘find what’ all the way over on the right hand side, we 
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have a Format button just here. And if we click the dropdown, we can choose Format or 

Choose Format From Cell.  

 

So, if you have a Cell in the spreadsheet that contains exactly, then you could use this second 

option. So, let's go for Choose Format From Cell. Notice that that box disappears and our 

cursor changes to a little eyedropper. Now I'm looking for everything that has a Grey 

background. So, I'm going to select any of these Cells. So, let's go for this one just here.  

 

Notice that the preview updates with what we're looking for. And then we can choose what 

we want to replace it with. So, if I click the Format dropdown again, this time, I'm going to 

go into Format. So, this is going to open up another dialog box. And it's going to jump me to 

the Fill Tab. So, maybe instead of having a Grey Background Fill, I want a light Green 

Background Fill. I could even add in more options.  

 

So, if I go to Font, maybe I want it to be in light Green, but also, have bold font. Let's see 

what that looks like. I'm going to click on OK, I can now see what I'm finding and what I'm 

replacing it with. And then I can set the scope.  

 

So, if I just want to find and replace on this Worksheet that I'm currently on, I could choose 

Sheet. But if I wanted to replace the Grey Background Fill across the entire Workbook, I 

could choose Workbook from this dropdown. Now we're going to keep ours on Sheet.  

 

We also, get to choose if we want to search by Row or by Column. Now I have my 

formatting running across Rows, so, I'm fine with it searching across the Rows. The last 

option here is also, going to look in Cells that contain Formulas. So, I'm going to click the 

Replace All button and check out what happens; it's made 20 replacements.  

 

Now notice something a little bit curious. If we click on OK, and close this down, you can 

see that it's worked for some of the Cells in the Row but not for all of them. And that's 

because for these 2 Cells; Price Per Unit and Total, we have different formatting applied; we 

have Currency Formatting. And because I chose to find just formatting that had a Grey 

Background Fill, it hasn't found these because we have slightly different formatting applied. 

So, how can I get around this?  

 

Well, if we go to Ctrl + H again, if I was to then say ‘find what’ > Choose Format From Cell, 

and select one of these Cells, and replace it with Green, let's do replace all, check it out. Let's 
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click on Close. And you can see that it's now found those. So, you do have to be a little bit 

careful when using the Choose From Cells option.  

 

Now, if you do have a dataset that has lots of different formats applied to different Columns, 

then sometimes it's worth removing the formatting, doing your Find and Replace, and then 

reapplying the formatting. For example, with these 2 Columns just here, I might decide to 

select them. And let's just give them General formatting, so, we don't have any specific 

Number Formatting applied.  

 

So, now if we do Ctrl + H, we can say ‘find what’, so, let's go Choose Format From Cell. I'm 

going to choose this Blue one just here. And we're going to replace it with let's go for a 

Purple Background Fill, and let's also, make that bold as well. And click on OK. So, now, 

when we do Replace All, it's made 35 replacements, and you can see that we have exactly 

what we're looking for.  

 

So, because we changed that formatting just to General, the Find and Replace has now 

worked. And we can then just go back in; Ctrl + Shift + Down Arrow, and apply whatever 

formatting we want. So, sometimes that is a quicker method; remove the formatting first of 

all so, it's all fairly standard, then Find and Replace, the Background Fill Colour, and then 

reapply the formatting.  

 

I'll leave that up to you to have a little play around with, but that's how you can utilize the 

Find and Replace utility to replace formatting in your datasets. 
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Video: Copy Formatting: Format Painter  

Deb: In previous lessons in this section, we started to take a look at how we can quickly 

apply formatting to data to make it more interesting and more readable. And in this lesson, I 

just want to show you a really quick trick when it comes to copying and applying formatting 

across different datasets.  

 

Now if you take a look at the spreadsheet here, you can see that we have a Table on the left 

that has some formatting applied. The heading Row has some formatting, we've got some 

Grey shading for all of the orders that have a status of Pending, and also, notice in the Total 

Column, we have some Currency Formatting applied.  

 

Now, it might be that I want to take this formatting and apply it to a different dataset. So, 

what I've done here is I've copied the dataset, that's the dataset you can see on the right hand 

side, but it doesn't have any of the formatting. Now I could go through, I could use 

AutoFormat, I could then go in and manually apply some of these other formats. But that's 

going to take a really long time. So, let me show you a quicker way of doing this using a 

utility in Excel called Format Painter.  

 

Now you're going to find the Format Painter icon on the Home Ribbon, in the Clipboard 

group, it's this little Paintbrush icon just here. And when we hover over, we have quite a bit 

of information about the Format Painter. It says; ‘Like the look of a particular selection? You 

can apply that look to other content in the document. To get started, select the content with 

the formatting you like, click Format Painter, and select something else to automatically 

apply the formatting’.  

 

So, let's deal with that first of all. Maybe I want to copy this formatting that we have in the 

header Row across to the header Row in the other dataset. So, what I could do here is click in 

Cell B5, let's use our Keyboard Shortcut Ctrl + Shift + Right Arrow to make our selection, 

and then I'm going to click the Format Painter icon. Let's click it.  

 

Now notice what immediately happens, we now get the marching ants around our selection. 

And when I move my cursor onto the spreadsheet, check it out, it's changed to a little 

Paintbrush icon. So, what we can do now is simply select the area where we want to apply the 

same formatting.  
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So, I'm going to select all of this Row up here. And when I let go, it applies that formatting 

and the Format Painter deactivates. How simple was that? And you can use this method for 

any formatting that you want to copy.  

 

Now, one thing to note here, once I’d copied this formatting across, the Format Painter 

deactivated. So, let's take a look at that again. I'm going to select this Row that has the Grey 

shading, I'm going to click on Format Painter, and I'm going to select this Row in the Table to 

copy the formatting across. So, let's select this Row again, but this time, I'm going to double 

click on the Format Painter.  

 

So, now when I go down to the next pending order, I can copy that formatting across. But 

notice the cursor is still showing that my Paintbrush or my Format Painter is activated; so, I 

can carry on painting. I can go to the next one, select it, and then finally go to the last one and 

select that as well. So, I stay in Format Painter mode.  

 

Now when you're finished, and you want to deactivate and just go back to your regular 

cursor, you can either click on the Format Painter icon again, or simply press the Esc key on 

your keyboard. Now one final thing to know here, it will copy across all of the formatting 

from the selected Cells.  

 

So, notice that because in the Table on the left, I have Currency Format applied to the Totals, 

it's also, copied across the Currency Formatting just here. And you'll find that if you just want 

to copy across the Currency Formatting, if we select these Cells just here, click on the Format 

Painter once and copy that across to Total, that's going to allow us to copy that formatting 

across.  

 

Also, notice that because we've copied that entire Column of formatting, I now have that 

bottom Border, but it's applied to just Column O. So, once again, if I want to take that entire 

Border, I could select everything just here, click on Format Painter, and paint that across to 

apply that formatting.  

 

So, you can carry on using your Format Painter until your heart's content. I'm just going to do 

the Price Per Unit as well. And now we should find that everything in the Table on the right 

looks exactly the same as the Table on the left.  

 

So, utilizing Format Painter is a lot quicker when you have a lot of formatting to copy across. 
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http://www.simonsezit.com/


 

 

 

 

 

 

       © Copyright 2023 Simon Sez IT, INC. All Rights Reserved. 96 

Video: Clear Cells  

Deb: In the last lesson, we saw how we can quickly copy formatting from one dataset to 

another using Format Painter. And in this lesson, I just basically want to show you the reverse 

of that and how you can clear formatting once it's been applied.  

 

This is a particularly useful thing to know because a lot of the time, you'll receive datasets 

from maybe other people, or maybe you've downloaded a dataset from an external system. 

And often, that data will come across with formatting that you don't necessarily want. So, you 

need to know the techniques when it comes to clearing formatting from data.  

 

Now, once again, we're starting with our 2 datasets. Now I've made a bit of a change to Table 

number 2; you can see I've added a Column that just houses a web address in there. Now the 

reason why I've done that is because we do have numerous different options when it comes to 

clearing formatting. So, we're going to say that we want to clear all of the formatting that 

we've applied to this Table on the right hand side.  

 

Now when it comes to clearing formatting, you're going to find all of your options on the 

Home Tab. In the Editing group, where we have this little Eraser icon just here. If we click 

the dropdown, you can see that we have a few different options. So, let's go through each one 

so, that you understand the difference.  

 

Now when it comes to clearing, we must first make a selection. So, let's say that I want to 

clear the formatting from this heading Row just here. I'm going to select the area, I'm going to 

click the dropdown next to Clear, and let's see what happens if we choose Clear All. That is 

pretty much going to do what it says on the tin; it is going to clear everything from that Cell, 

not just the formatting.  

 

So, it's going to remove any text or numbers that you have in those Cells as well as the 

formatting. If you just want to completely get rid of everything, then that is a perfectly good 

option to use. But I'm going to undo because that's not exactly what I want. Let's take a look 

at the second option; Clear Formats.  

 

Now if we click on this, that is more like what I was looking for. I wanted to retain the text 

that's in the Cell, I just wanted to remove any additional formatting. So, it's removed that 
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Purple Background Fill, and it's also, removed the Borders. Let's undo to put it back and take 

a look at the third option.  

 

Now the third option we have is Clear Contents. And if we take a look at the ScreenTip here, 

it says; ‘Clear only the contents in the selected Cells. The formatting and comments are not 

cleared’. So, this is kind of the opposite of Clear Formats.  

 

If we click on Clear Contents, it’s going to clear the text or the numbers out of the Cells, but 

it's going to leave the formatting there. And sometimes, that can be really helpful if you just 

want to switch out the text you have in some Cells, but retain that background formatting.  

 

Now let's click it one more time. Notice we also, have Clear Comments and Notes. Now this 

is currently greyed out for me because I don't have any comments or notes in my Worksheet. 

Now we are going to get onto that subject a bit later on in the course, so, we'll take a look and 

revisit this option then.  

 

The final option we have in this menu is Clear Hyperlinks. So, this is going to clear any 

hyperlinks from the selected Cells. Now notice here that I have some hyperlinks in Column 

Q. And hyperlinks, again, is not a subject that we've covered, but you've probably seen these 

before. If you type any kind of website address into a Cell, it's automatically going to turn it 

into a clickable hyperlink. So, if I was to click, it's going to jump me across to the 

SimonSezIT website.  

 

Now it might be that you want to keep the web address in here, but you want to remove the 

actual clickable hyperlinks. That is what this option is for. So, I'm going to click in the first 

Cell, let's do Ctrl + Shift + Down Arrow to select everything, and then when we go to Clear, 

notice that ‘Remove Hyperlinks’ is now active as well. So, we can clear the hyperlinks or we 

can remove them.  

 

Now if I clear hyperlinks, it looks like it's done nothing. But now when I hover my mouse 

over any of these hyperlinks, my cursor doesn't change to a little clickable hand icon, because 

these are no longer hyperlinks. I can't click on them to jump to the website, but the actual text 

is still there. Let's Ctrl + Z to come out of here and put those hyperlinks back. You'll see now 

when I hover over, I get that little clickable hand icon.  
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Now the other option that we have, Ctrl + Shift + Down Arrow to make our selection, is 

Remove Hyperlinks altogether. So, if we remove the hyperlinks, it's actually going to remove 

that underline. So, now, they're basically just regular text in a Cell; they're not linked to 

anything else. So, that is the difference between those 2 options.  

 

Now I don't actually want this Website Column in my Table. So, I'm going to select the entire 

Column, I'm going to go to Clear and Clear All simply to get rid of it. Now I don't actually 

want this second Table, so, I'm going to select the entire Table; Ctrl + A, I'm going to go up 

to Clear, and I'm going to say Clear All. And you can see that that is a nice quick way just to 

get rid of everything. So, those are the options that you have when it comes to Clearing Cells. 
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Video: Exercise 6  

Deb: It's time now to do Exercise 06. And in this exercise, we're going to practice some of 

the skills that we've learned in this section of the course.  

 

So, the first thing I'd like you to do is open the exercise file, ‘Exercise06.xlsx’. And then I 

would like you to simply format the Table so, that it matches the screenshot below. And you 

can see here we've got some Borders, we've got some Background Fills, I've changed the font 

of the heading Row.  

 

And you can see on the right hand side, the exact font I've used not only for the heading Row, 

but also, for the text and the numbers within the Table. And don't forget to apply formatting 

where necessary. Also, note that we don't have any Gridlines showing in the background.  

 

And then once you've done that, I'd like you to Find and Replace the Grey Fill Colour in the 

‘Total’ Column with a different colour of your choice. So, a few things to do there. If you'd 

like to see my answer, then please keep watching.  

 

So, the first thing I asked you to do in this exercise was simply to format this dataset you can 

see here the same as the screenshot. So, I'm going to start with the heading Row, let's select 

this Ctrl + Shift + Right Arrow, and I'm going to change the font to Dosis ExtraBold, and 

we're just going to type that in. There we go. Now we need to apply the Background Fill 

Colour and change the font colour.  

 

Now I could do this manually by selecting from the dropdowns. Alternatively, I could use my 

Format Painter. So, I'm going to select Cell I5, let's click on the Format Painter, and we're 

going to drag that across this heading Row to apply that formatting. That's a nice quick way.  

 

The next thing I'm going to do is I'm going to change the Table Font. So, let's do Ctrl + Shift 

+ Right Arrow, and then Down Arrow to select everything, and we're simply going to change 

the font to Georgia, and hit Enter.  

 

The next thing I'm going to do is I'm going to sort out the formatting of the Dates and also, 

the Amounts. So, let's select the Date Column, go up to our Number Formatting, and I'm 

going to change this to Short Date. And then in the Amount Column, we're going to give that 

$1 sign. And I think I had 2 decimal places in the screenshot.  
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Final couple of things to do here. I'm going to select the Amount Column; Ctrl + Shift + 

Down Arrow, and we're just going to apply a light Grey Background Fill. And then the final 

thing to do is simply apply Borders around the outside. So, let's do Ctrl + A to select 

everything, I'm going to go up to my Borders, and we're going to say All Borders.  

 

And then the very final thing is simply to remove the Gridlines. So, let's jump up to the View 

Tab and deselect Gridlines. And there we go. That Table is now formatted the same as the 

Table in the screenshot.  

 

The final part of this exercise was to practice using Find and Replace to find Cells with a 

specific Background Fill and replace them with something else. So, I asked you to replace 

this Grey Background Fill with a Background Fill of your choice. So, I'm going to select this 

Column Ctrl + Shift + Down Arrow, and then I'm going to press Ctrl + H to jump directly to 

Replace.  

 

Now in the ‘find what’ area, we're going to go straight into Format, and I'm going to choose 

the Format From the Cell. So, I'm going to choose this Cell just here, and then we're going to 

replace it with let's go to format this time, and I want to make sure that I still have that 

Georgia fonts.  

 

Let's make sure that we still have Georgia selected and let's choose a different Background 

Fill. I'm going to go for something fairly light; let's just go for this light pink. Click on OK, 

and we can do Replace All, OK, and Close. And there we go; we've replaced that 

Background Fill Colour.  

 

That's all I needed you to do. I hope you got on okay with that, and I will see you in the next 

section. 
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Section 7: Excel Tables 

Video: Excel Tables Explained  

Deb: In this section of the course, we're going to explore the wonderful world of Excel 

Tables. Because if you've never come across Excel Tables before, then you're going to find 

them extremely useful when it comes to analysing data.  

 

Now in this lesson, we're going to really get an understanding of what exactly an Excel Table 

is and why they're so, useful. So, we're going to start here on this basic Tables Worksheet. 

And if you notice, at the top, here, I have a very simple dataset; I just have some fruits listed, 

and I have the total sales that say the total revenue for January, February, and March. So, 

effectively the first quarter. Now this data isn't in any kind of Excel Table.  

 

Now you might be a little bit confused by that. I think a lot of the confusion lies in the fact 

that Excel by its nature kind of has a Table looking format. We have a grid structure, which 

could be mistaken for a Table. But it's worth noting that there is a big difference between 

simply entering data into Cells and actually formatting your data as an Excel Table.  

 

Now, this Table of data at the top here is not formatted as a Table, whereas the one 

underneath which pretty much looks exactly the same is formatted as a Table. So, how can 

we tell the difference between these two? Well, this Table up here, I've basically just typed in 

some text and some numbers into Cells, and then I've manually formatted them.  

 

So, I've literally selected each Row, and I've changed the formatting the Background Fill 

manually, just to make it a little bit easier to read. Whereas with this Table underneath, this is 

formatted as an Excel Table. If I click inside the dataset, notice that we get a Table Design 

Contextual Ribbon at the top here. And if I click on it, it opens up all of the options that I 

have when it comes to formatting and organizing my Table.  

 

If I scroll back up and click inside this first dataset, you can see that Table Design Ribbon 

disappears, which means that this data is not in a Table. Now in the next lesson, I'm going to 

show you how to create a Table and we're going to take a look at some of the various 

different ways that you can use a Table, but I just want to illustrate what the difference is 

here.  
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Now most of the time, when you're working in Excel and you have a dataset, that dataset 

doesn't remain static. And what I mean by that is usually we're always adding additional 

Rows on to the bottom of our Tables.  

 

For example, this dataset could grow. Maybe I want to add a different fruit onto the bottom 

here. So, let's say Strawberry, let's say the sales for January, well, let's go for 500. For 

February, we'll say 400. And for March, we'll say 300. So, I've managed to add that data onto 

the bottom, no problem. But if I had a Chart attached to this data, the data wouldn't 

automatically update. So, let me show you what I mean.  

 

I'm going to insert a quick Chart. So, let's go to the Insert Tab, and I'm going to insert a 2-D 

Column Chart. So, this is pretty much the same as the Chart that we have below. Now 

currently, it's showing everything that I have in the Table. If I was to add another Row on the 

bottom here, so, let's go for Kiwi, and we'll say 400, 250, and let's go for 100. Notice that my 

Chart doesn't update.  

 

You can see that Kiwi hasn't been automatically added to the Chart. And when I click on the 

Chart, you can see exactly the data that the Chart is using; it's not including the Kiwi Row. 

Now we could fix this, we could go in and we could drag this little Blue handle down, which 

will then include it in the Chart. And you can see the Chart immediately updates to include 

Kiwi, but if you're doing this all the time, you don't want to have to keep going in and 

dragging this little handle down. It's also, really easy to forget to do that. So, let's take a look 

how a Table behaves differently.  

 

If we scroll down, as I mentioned, this little dataset is in a Table I've already added in my 

Chart. So, let's do the same thing. Let's add another item on the end, we're going to go for 

Strawberry and press Tab. As soon as I press Tab, the Chart starts to update. I can then add in 

my values. Let's go for 500, 400, and 300, and everything automatically updates. And that is 

because Tables have an auto-expand capability.  

 

So, if your data is in a Table, as soon as you add more data onto the bottom, it's going to 

automatically expand to accommodate that new data. Which means that if you have things 

like Pivot Tables or Charts hanging off of this data using this data, they're going to 

automatically update. So, it really is a great time saving hack.  
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Let's take a look at one more example, I'm going to go across to the Employees Worksheet. 

And here we have a dataset that is a little bit larger. We have Employee IDs, Employee 

Names, we have the Department that they're in, their Job Title, their Salary, and their Job 

Rating out of 5. Now, I've already put this data into a Table. We can tell that because we have 

a Table Design Ribbon. And another thing that happens when we turn a dataset into a Table 

is that we automatically get these Filter dropdowns at the top of each Column.  

 

So, if I wanted to just see all of the information for a specific Department, I could go in, I 

could deselect everything apart from the Department that I'm looking for, click on OK, and 

it's going to filter the data. Now, I'm not going to do that right now, because we don't want to 

get too far ahead of ourselves. But just remember that when you create the Table, you get 

these useful Filter dropdowns.  

 

Now the Chart that you can see on the right hand side, you can see that this is showing the 

Average Salary broken down by Department. Now this is actually a PivotChart. I've created a 

Pivot Table just below of the data above.  

 

Now, we haven't discussed Pivot Tables at all so, far, but just really to illustrate the point that 

this also, works if you've created a Pivot Table, if I were to add another Employee on to the 

bottom here, not only is my Pivot Table down here going to update, my Chart is also, going 

to update. And that is because this dataset is in a Table.  

 

So, I'm going to add on to the bottom here, the next member of staff. This person is going to 

be Carly Watson, she's going to work in Sales. So, keep your eye on the Sales Column in the 

Charts. She is a Sales Associate. And let's make her Salary quite a bit larger than everything 

else, we're going to go for 100,000. I’m going to give this person a Job Rating of 5.  

 

Now you might be looking at this Chart thinking well, that hasn't actually updated, it looks 

exactly the same. Now that is because when we're dealing with a Pivot Table, and as I said, 

we have a Pivot Table that is feeding off of this Table data, in order to get a Pivot Table to 

Update we need to right click and refresh it.  

 

So, as soon as I do that, it pulls those new totals through and check out the Sales Column in 

the Table now; it's a lot bigger. Remember, these are just Average Sales by Department. Now 

none of this would be possible if our data wasn't in a Table.  
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So, the important thing to take away from this lesson is always put your data into a Table. It’s 

going to make your life so, much easier when it comes to updating that Table and keeping all 

of your Charts updated and refreshed with the latest information. 
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Video: Format Data as an Excel Table  

Deb: So, now that we've learned what an Excel Table is, and we've seen some of the benefits 

of putting our data into an Excel Table, it's time to go through exactly how you put your data 

into a Table. And we'll also, go through some tips and tricks when working with Excel 

Tables.  

 

So, you can see in the spreadsheet just here we have some Employee data, and this currently 

is an unformatted dataset. And maybe we want to perform some kind of analysis on this data. 

And as I mentioned in the last lesson, I would always highly recommend that you put any 

dataset that you want to analyse into an Excel Table first.  

 

Now when it comes to actually formatting this data as a Table, we have two different 

methods that we can use. If we click our mouse anywhere within this data, go up to the Home 

Tab, notice in the Styles group, we have a ‘Format as Table’ dropdown. So, when we click 

this, it's going to open up a big gallery with all different kinds of Table Styles that we can 

apply. And by selecting one of these, it will do two things; it will convert our data into an 

Excel Table, but it will also, apply some formatting.  

 

Now the different colour schemes that you see in here, these are very much based on the 

Theme that you have in use within Excel. So, let's just take a look at that for one moment. If 

we go up to the Page Layout Tab, notice we have a Themes group just here. And when we 

click the Themes dropdown, you're going to be able to see the Theme that you have in use.  

 

Now for most people, the default Theme is just going to be this Office Theme just here. And 

it is worth noting that this Office Theme has changed in the last couple of months. Microsoft 

released an update for Microsoft 365 users, so, we now have a different set of Theme Colours 

as our default. And if we go to the Home Tab and just click the Fill Colour dropdown, you 

can see that these are the new Theme Colours. It's also, worth noting that with this new 

Office Theme, we get a new font as well.  

 

So, instead of the default being Calibri, the default is now Aptos. And that is exactly what I 

have in use in this spreadsheet. So, the point I'm trying to make here is if you don't like the 

colours that you see when you click the Format as Table dropdown, maybe you want to use 

something else, you can simply change those by changing the Theme that you're using. So, 

you could choose one of these other Themes.  
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Let's go for Facet for example. And now when I go to the Home Tab and click Format as 

Table, I get a different set of Theme Colours. So, just be aware of that. I'm going to switch 

mine back to the default Office colours.  

 

So, when we click on Format as Table, I can choose one of these. Let's go for this Green one 

just here; Dark Green Table Style Medium 4. Now, as soon as I click this, Excel is going to 

do its best to work out where my data is. And if you're clicked inside your dataset, it should 

select everything around the outside.  

 

Now I need to confirm that this is correct. So, it says; ‘Where is the data for your Table’? 

And then it's giving me a Cell range. And I can see the marching ants around the outside, so, 

this is correct. It's also, worth noting that you must have my ‘Table has headers’ selected if 

your Table does in fact have a Header Row. So, let's click on OK. And my data is now in a 

Table. How do I know?  

 

Well check out my Ribbons, I now have a Table Design Ribbon. And on this Table Design 

Ribbon, we can do many different things. I could change my Table Style from here. So, if I 

decide I don't like this Green, I could go in and maybe choose something else. So, let's go for 

this Blue. Notice we have some Table Style options, and some of these little checkboxes are 

already selected.  

 

Notice here Filter Button is selected. Because when you put your data into a Table, it's 

automatically going to add these little filters to the top of each Column. And these are really, 

really useful. For example, if I just wanted to see in this Table, only the people who work in 

let's say HR, I can use this filter to select HR, click on OK and it's going to filter out my list.  

 

Notice as soon as I do that, I get this little filter icon. If I want to clear the filter, I can choose 

Clear Filter from Department to put everything back so, those Filter dropdowns are really 

useful. But if you don't want to have them on your Table, you can simply deselect the Filter 

Button from Table Style Options. I quite like them there, so, I'm going to keep this selected. 

Notice also, we have Header Row selected. If I deselect this, it's going to remove that Header 

Row from my dataset.  

 

Another cool feature of Tables is that we can add a Total Row. So, if I click Total Row, 

notice what happens to my dataset. I get a new Row added to the bottom, and it's giving me 
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the total of all of the Job Ratings. Now in this instance, that doesn't particularly make much 

sense, I'm not really going to want to add up the Job Ratings. But I might want to add up all 

of the salaries just to get an idea as to how much we're paying in total for everyone's salaries.  

 

If I click in the Total Row, notice, we get a little dropdown just here. If I click it, I can choose 

to sum all of those salaries. We have other options in here as well, maybe I want to find out 

what the average Salary is, I could do that also. And I don't have to have anything in this Job 

Rating Column, I can simply choose None. So, that Total Row can be really nice, and it’s a 

quick way of performing calculations on Table data. Now, in this case, I don't want to Total 

Rows. So, let's just deselect that from Table Style Options.  

 

Also, notice that with this particular Table Style that we've applied, we have alternating Row 

colours. And this is what we refer to as Banded Rows. Now Banded Rows, in general, 

improve the readability of your data, it's easier for people to read across lines. But again, if 

you don't like the way that this looks, you can simply deselect Banded Rows in Table Style 

options, and it will remove those bands.  

 

You could instead have Banded Columns, we have a little option for that. And it's going to 

give us alternating Column colours. We can apply formatting to the last Column of data, it's 

going to make the last Column bold. Or we can apply formatting to the first Column of data. 

So, that is what all of these little Table Style options do.  

 

Now, the External Table Data Ribbon, this is where we can do things like export our Table 

data to SharePoint lists. Now that's outside the scope of this particular course, but just be 

aware that that button is there. Also, notice we have a Refresh button just here. So, this 

enables us to quickly pull through any updates to this Table.  

 

In the Tools group, this is where we have things like Summarize with Pivot Tables. So, if I 

wanted to create a Pivot Table based off of this data, I can do that from here. I can remove 

duplicates, or I can convert my Table to a range. So, this is really interesting, and a question 

that I get all the time.  

 

Sometimes people will put their data into a Table, and then they will say to me, ‘Deb, how do 

I take it out of the Table? I don't want it to be in a Table anymore’. Well, this is this button 

just here. So, let's click it, it’s going to say; ‘Do you want to convert the Table to a normal 
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range?’ I'm going to say ‘Yes’, and that effectively takes it out of the Table. Notice that when 

I'm clicked in this data, I no longer have that Table Design Ribbon.  

 

Now whilst it does remove the Table, it will keep the formatting. If you wanted to remove all 

of this formatting, you could select everything Ctrl + A, go to that Clear Formatting button 

that we've seen previously, and click on ‘Clear Formats’, and we're basically back to where 

we started.  

 

Now this is a really good opportunity to show you the second method when it comes to 

creating a Table. Because instead of using Home and Format as Table, we can simply use the 

Keyboard Shortcut Ctrl + T. Again, it's going to give us that same little Create Table pop up, 

I'm going to say yes, my Table has headers, and I'm going to click on OK.  

 

Now the Table Style that you get when you use the Keyboard Shortcut is basically the default 

Table Style. So, for me, that is this Blue colour just here. Once again, now we have the Table 

Design Ribbon back, we could go in and we can change that to something else if we want to. 

So, now we have our data in a Table again, I'm just going to apply some formatting to the 

Salary Column.  

 

And this is another little tip; when you're working with Table data, it makes it a lot easier for 

you to select your Columns and your Rows. For example, if I want to format everything in 

this Salary Column, instead of selecting all of the Cells, I can simply hover my mouse over 

that Table header. And notice I get that little Black downward pointing arrow.  

 

Click once; it's going to select everything in that Table Column. I can now go to Home and I 

can apply whatever formatting I like. So, I'm going to apply Accounting Number Formatting 

and I'm going to take the decimal places down to 0.  

 

The final thing to point out here and another thing that I would advise you to do is to give 

your Table a meaningful name. If you take a look on the Table Design Ribbon, in the first 

group here; the Properties group notice that my Table is currently called Table2, and this is 

just Excel’s generic default name. So, if I was to create another Table, it would be called 

Table3, the next Table would be called Table4.  

 

Now whilst you can leave them with those generic names, it makes each Table really hard to 

identify later on. If I was to come back to this spreadsheet in 6 months’ time, and I want to 
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work with a specific Table, if it's just called Table2 or Table3, I'm not really going to know 

what Table that refers to. So, I would always recommend giving your Table a more 

meaningful name.  

 

So, I'm going to click in my data, I'm going to go to Table Name and I'm going to call this 

Employee_Data. Now it's worth noting with these Table names, you can't have any spaces if 

you have 2 words. So, I have 2 words; Employee_Data, so, I've separated them with an 

underscore. I could also, just have them like that all as one word. I'm going to keep the 

underscore in. Hit Enter, and your Table is now named.  

 

So, those are 2 methods for putting your data into a Table, and some of the options that you 

have on that Table Design Ribbon. 
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Video: Table References in Formulas  

Deb: In the previous couple of lessons in this section, we've seen how to turn our data into a 

Table, and we've also, discussed some of the benefits of doing this. So, now in this lesson, it's 

time to see how putting our data into a Table affects our Formulas. Because this is something 

that does tend to throw beginners off.  

 

Now currently, we're looking at the Employee data. This is the same data that we used in the 

previous lesson, but I have made a little change here. I've actually taken this data out of the 

Table. And we saw how to do that in the last lesson. So, we still have these Blue Banded 

Rows, that's absolutely fine. But what I want to do now is I want to perform some 

calculations on this data.  

 

Now notice in Column I, I have 3 separate things that I want to find out from this data. And 

the first one is that I want to know what the sum of all salaries is. So, I want to find out the 

total. Now of course, I could put this into a Table and turn on Total Row and select Sum; that 

is one way that you could do this. But if you just want to perform a calculation over in Cell 

J3, we could type in =SUM, press the Tab key, and we could simply select all of these 

salaries.  

 

So, I'm going to select the Cell range F4 to F23. Let's close the bracket, hit Enter, and I get 

my total. And we can very simply check that total is correct by highlighting the Salary range 

again. And if you take a look down in the Status Bar at the bottom all the way over on the 

right hand side, we have our Sum Total, which is matching what we have in the Cell. So, that 

is the Sum of Salaries.  

 

Now when we double click on this Cell to take a look at that Formula, we are using Cell 

References in this Formula; F4 to F23. And so, far in this course, that is pretty standard. 

That's what we've been using for all of our Formulas. Let's take a look at the next one 

Average Job Rating. So, this time, we're going to type in = we're going to start to type 

average, Tab key to select it, and we want to find the Average Job Rating.  

 

So, for this one, I'm just going to select the Job Rating Column. You can click and drag or 

click in the first Cell Ctrl + Shift + Down Arrow to make your selection. Once again, if you 

take a look at that Formula, we're using Cell References G4 to G23. Close the bracket, hit 

Enter, and we get an Average Job Rating of 3.4.  
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The final thing here is to simply do a Count of Employees. Now I want to count on one of the 

text Columns. So, I need to make sure that I use COUNTA. Remember, COUNT will only 

count numerical values; COUNTA allows us to actually count the Employees. So, we're 

going to use Cell References again, C4 to C23, close the bracket, hit Enter, and it's telling me 

that I have 20 Employees in this list.  

 

So, that was all fairly straightforward, pretty much stuff that we've covered before. But the 

thing to note here is the point that we're using Cell References in all of these calculations. 

Let's put our data into a Table and check out how these Formulas change as soon as we do 

that. So, I'm going to escape out of here, I'm going to delete out all of the calculations we've 

done so, far, and we're going to put our data back into a Table. So, I'm clicked inside it, let's 

press Ctrl + T Keyboard Shortcut. Yes, my Table has headers, let's click on OK, and my data 

is now back in a Table.  

 

The first thing I'm going to do is name my Table. So, let's go up to the Table Design Ribbon 

all the way across to the Properties group, and where we have Table 3, I'm going to call this 

EmployeeData again, let's hit Enter. So, now that my data is in a Table, let's try and perform 

the same calculations in Column J. So, I want to work out the Sum of Salaries. So, we're 

going to start off the same =SUM press the Tab key, and I want to sum the Salary Column.  

 

Now once your data is in a Table, remember, you can simply hover your mouse over that 

Salary Column, and to get that blank downward pointing arrow, click once and it's going to 

select that whole Column. But take a look; this looks very different from when we were using 

Cell References. The Formula now says EmployeeData[Salary]. So, what exactly does that 

mean?  

 

Well, these are what we call Table References, and you'll see them when you're trying to 

perform calculations on Table data. Instead of using the Cell References, it uses the Table 

name and the Column Heading in the Formula. So, you can see there it's saying, ‘Okay, you 

want me to sum the Salary Column in the EmployeeData Table. That is exactly correct. I just 

need to close my bracket hit Enter and get exactly the same result.  

 

Once again, we can check it by highlighting all of the data and glancing down to the Status 

Bar. Let's do it again. So, =AVERAGE, this time I want to find the Average Job Rating. I'm 
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going to select the entire Column, we get the Table name, EmployeeData followed by that 

Column. Let's close the bracket, hit Enter, and we get the same result.  

 

Now, it's also, worth noting that you could type in =SUM and you could simply start to type 

in the Table name. So, if I start to type in EmployeeData, it comes up in IntelliSense 

underneath. I can press the Tab key, and then I simply need to open a Square bracket, and it's 

going to list all of the Columns in that Table, and I can simply go in and select.  

 

Now I actually don't want to do a sum here, do I? I want to do a COUNTA. So, let's do that 

again. I’m going to go for EmployeeData, open the Square bracket, and I want to do a count 

of the Employees, so, I'm going to count the Employee Name. Let's press Tab to select it. 

Close the Square bracket, close the round bracket, hit Enter, and we get our results.  

 

So, this is really the point I wanted to illustrate in this lesson. Don't be thrown off by the fact 

that when your data is in a Table, and you're putting together a Formula, you're going to see 

Table References as opposed to Cell References. Table References are actually pretty good.  

 

If you send this spreadsheet to somebody else, it's a lot easier for people to understand what 

your Formula is doing, because we have meaningful labels in there. We can see that we're 

doing a sum of the EmployeeData Table, the Salary Column. Sometimes, when we just have 

Cell References, it's not quite so, obvious. So, that's how Table References work in Formulas 

as opposed to Cell References. 
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Video: Excel 07  

Deb: It's time now to do Exercise 07. And in this exercise, we're going to practice some of 

the skills that we've learned in this section of the course. So, the first thing I'd like you to do 

is open the exercise file, ‘Exercise07.xlsx’. And I'd like you to format the data as an Excel 

Table, and name that Table ‘Invoices’.  

 

I'd like you to choose a Table Style, and I don't mind which Table Style you do choose and 

make sure that you turn off Banded Rows. I'd also, like you to make sure that you have filters 

turned on, and I'd like you to add a Total Row.  

 

And then finally, I'd like you to calculate the average invoice amount using Table References 

in the Formula. So, a few different things to do there. If you'd like to see my answer, then 

please keep watching.  

 

So, the first thing I asked you to do here was to convert this data into a Table. So, we're going 

to click somewhere within the data and press Ctrl + T. Yes, my Table has headers, let's click 

on OK, and we're going to name this Table Invoices. So, let's make sure we're on the Table 

Design Ribbon, let's go over to the Properties group, which is the first group on the Ribbon, 

and we're simply going to type in Invoices and press Enter.  

 

Now, I then asked you to change the Table Style, and I didn't mind which Table Style you 

used. So, I'm going to go for this Green Table Style. I asked you to remove Banded Rows. 

So, in our Table Style options, let's deselect Banded Rows to turn those off. I wanted you to 

make sure that we had filters turned on which we do, and I asked you to add a Total Row. So, 

we want to make sure we have a tick in this box just there.  

 

And then the final thing is we need to perform a calculation in Cell I5. We need to work out 

what is the average invoice amount. And, I asked you to include Table References in the 

Formula. So, what we're going to do here is we're going to type in =AVERAGE, and we're 

simply going to go over to the Amount Column, hover our mouse just above until we get that 

Black downward pointing arrow, and click to select that Column.  

 

And notice that we now have Table References in the Formula; we have the Table name 

Invoices, followed by the Column name. Let's close the bracket, hit Enter, and we can see 

that that is the average invoice amount.  
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Now I'm going to apply some formatting. Let's change that to dollar and that looks a lot 

better. I hope you got on okay with that. I will see you in the next section. 
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Section 8: Format Worksheets 

Video: Work with Rows and Columns  

Deb: In this lesson, we're going to take a look at some of the options that we have when it 

comes to working with Rows and Columns in a spreadsheet. And we're going to start out with 

this reasonably large dataset.  

If I click somewhere in my dataset and press Ctrl + Down Arrow, it's going to jump me all 

the way down to the last Row of data. And you can see that we have just over 51,000 Rows in 

this dataset, so, a fairly sizable amount of data. Ctrl + Up Arrow to jump to the top. And if we 

press Ctrl + Right Arrow, it’s going to jump us to the last Column. So, we have quite a few 

Columns of data as well.  

Now the first thing that you'll notice about this data is that it's not laid out in the best format. 

You can see that some Columns are too narrow, and some are a little bit too wide. If we scroll 

across and take a look at the Quantity Column, this is taking up far too much room more than 

it needs to. Whereas some of these Columns at the beginning of the dataset are showing these 

hash symbols, but they're not actually wide enough to display the data in the Column.  

Now we've seen this little trick previously, and that is the AutoFit Columns trick. What we 

can do here is select all of our data. And one way that I like to do this, if I have a particularly 

large dataset is to click this little area in between Column A and Row 1. If we click this, this 

will select not only all of the data, but all of the Columns as well. And that is really 

important.  
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If I was just simply clicking the data and press Ctrl + A, it's not going to actually select those 

Column Headings. So, I'm going to click in this Square just here. And then we can double 

click on any of these Column boundaries, you can see I'm hovering my mouse between 

Column G and H, and double click to widen out all of those Columns. So, effectively, what 

we've done here is we've AutoFit the width.  

Now I'm going to press Ctrl + Z, just to undo that and put it back to how it was because the 

other method we can use is to go to the Home Ribbon, and then underneath Format, we have 

this just here; ‘AutoFit Column Width’, that's going to do exactly the same thing. So, you 

have the 2 options just there.  

Now, it's worth noting that this applies to Rows as well. So, all of my Rows are fairly 

standard. These are the default Row height. But if you have a dataset where maybe you have 

Rows which looks something like this, and you want to AutoFit them, you could follow a 

similar process.  

So, we can click in this area in the corner, you can go to the Home Tab, go to Format, and 

you also, have an AutoFit Row Heights in here. Click it, and it's going to put those back. Let's 

do Ctrl + Z one more time, because we can also, double click. So, the double click trick 

works for Rows as well.  

So, all I would need to do is hover my mouse over any of these Row boundaries, mine's in 

between 2 and 3, double click, and it's going to resize or AutoFit those Row heights as well. 

So, it's a really useful trick there to quickly format your dataset and put it into a more 

readable format.  
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Now some other things that you might want to do when you're working with Columns and 

Rows is you might want to insert additional Columns or additional Rows. And you might 

want to insert those somewhere within the current dataset. So, maybe I want to have a new 

Blank Column in between Columns F and G.  

So, what I can do here is select Column G simply by clicking in the header area. And you can 

press the Keyboard Shortcut Ctrl + Shift + +. Now for some of you, that might be Ctrl + on 

your keyboard. For me, it's Ctrl + Shift + +, and that's going to insert a brand new Blank 

Row. If you want to insert more, you can simply carry on pressing it. So, Ctrl + Shift + + + is 

going to insert more Columns.  

If I want to insert, let's say another 3, I could select 3 Blank Columns, press Ctrl + Shift + +, 

and it's going to insert 3 more Blank Columns. And if you want to do the reverse of that, 

again, you can use a Keyboard Shortcut. For me that is Ctrl + -. And you can see as I press 

Ctrl + -, it's deleting out those Blank Rows. I can also, delete multiple by selecting them both, 

Ctrl + -, and they're gone.  

It's worth noting for all of these little tricks, you do also, have a more manual way of doing 

this. You could select Column G, right click to pull up the Contextual Menu, and you could 

choose Delete from here. That is also, going to delete the Column.  

We can also, delete Columns by going to the Home Tab, going to the Cells group, and under 

the Delete dropdown, we can choose to Delete Sheet Columns. Click this and that's also, 

going to get rid of it. So, a few different methods there for inserting and deleting Columns. 

But what about Rows? Well, happily, this works in exactly the same way.  
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I can select a Row, for example Row 4, Ctrl + Shift + + or Ctrl + depending on your 

keyboard, and that's going to add in more Rows. Again, we can select multiple, like this, Ctrl 

+ Shift + +, and it's going to insert 5 more Rows. The same thing applies; Ctrl + - is going to 

delete them, Ctrl + - again, to get rid of them. And of course, underneath that Delete menu, 

you have a Delete Sheet Rows option as well.  

Now what about moving and copying Rows in Worksheets? Well, there is a little trick to this. 

So, once again, I'm going to select the Customer ID Column. And you can't simply pick up 

this Column and drag and drop it because it will try to replace the data wherever you drop it.  

So, if you want to move this Column, you need to make sure that you hover your mouse over 

this Green Border until you see that crosshair, hold down Shift, and then drag it. Notice as I 

drag, it’s showing me where it's going to get dropped by that Green line. So, I want to drop it 

just in here, and that is going to move it.  

If I want to copy the Column, so, maybe I want another copy of the Customer ID Column, I 

would do exactly the same thing. But instead of holding down Shift as I drag, I need to hold 

down Ctrl. So, I'm going to make sure that I have that crosshair, hold down Ctrl, drag, and 

I'm going to drop it just here. And you can see that that has now made an exact copy of that 

Column.  

Now I don't want that. So, I'm going to select this Column, I'm going to right click, and I'm 

going to choose Delete. So, very easy to move or copy Columns. And the exact same process 

applies to moving Rows of data as well.  

Now, sometimes, particularly when you're working with very large datasets, you can see that 

this dataset stretches all the way across; so, I have to use my horizontal scroll bar in order to 
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see all of the data, you might decide that you want to hide some of the Columns that you 

don't necessarily need. That's going to allow you to see just the Columns that are important to 

you on the same page without having to scroll.  

So, let's say that I'm not particularly interested in any of these Columns. I can select them, 

and instead of deleting them, which will actually remove them from the dataset, I can simply 

choose to temporarily hide them from view. So, if I right click, notice I have a Hide option in 

here.  

It's also, worth noting that you have this same Hide option on the Home Ribbon, in the 

Format group, we have Hide & Unhide, and we can choose to Hide Columns. That's going to 

collapse those up. You can see we've got this Green line, which shows there hidden Columns, 

and notice that now my dataset starts at Column F. So, that's a good indication that there are 

some Columns that have been hidden underneath there.  

I can go through and just do the same for any data that I'm not interested in. So, maybe I'm 

not interested in any of this, I can right click, and I can choose Hide. So, now, I have only the 

data that is of interest to me all on the same page, and I don't have to use my horizontal scroll 

bar to see everything. So, this can sometimes be a really useful little trick.  

Now if you have hidden Columns in your dataset, and you want to bring those back, what 

you have to do here is you have to make sure that you highlight the Column before and after 

where we have the hidden Columns, right click, and choose Unhide. And that's going to bring 

those back again. And if you want to unhide all Columns, you could select everything, right 

click and go to Unhide, and it's going to bring everything back again. And exactly the same 

works for Rows.  
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If I were to select some Rows in my dataset, right click and choose Hide, it's going to hide 

them. And notice now that the Row numbers are no longer consecutive; we jumped from 3 to 

11, showing that there are hidden Rows in this dataset.  

And once again, you can either select the Rows at the side of the hidden ones, or you can 

select the entire dataset, right click, choose Unhide, and that's going to bring those back 

again. So, those are some tips and tricks when it comes to working with your Rows and 

Columns in a large dataset. 
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Video: Align Text and Numbers  

Deb: In this lesson, we're going to take a look at how we can utilize Alignment tools to line 

up and change the alignment of text and numbers in our Worksheet.  

So, once again, we're working with this very large dataset. If you recall, this is the dataset that 

has roughly 51,000 Rows. Now I have made some changes to this dataset, I've hidden a few 

of the Columns, you can see that we've got quite a few Columns hidden just here, so, that we 

can see these Columns that have values in a little bit better.  

Now, when it comes to alignment, we're mainly talking about 2 different things. And that is 

the position of the text or the numbers within the Cell. And if you take a look at the Home 

Ribbon, you can see that we have a whole group of tools in this Alignment group. So, if we 

work our way through these, you can see that the ones in this top Row are Top Align, Middle 

Align, and Bottom Align. So, this is dealing with how the text is aligned vertically in the 

Cell.  

Now, this is illustrated a little bit better if I make this first Row a little bit taller. So, I'm going 

to drag Row 1 down a little bit. And that is going to show you that everything in this first 

Row is aligned to the bottom of the Cell. And we can in fact confirm that if we select the 

Row and take a look at our Alignment tools, you can see that Bottom Alignment is 

highlighted in Grey, meaning that that is the one in use.  

But what I could do is I could choose to align these to the middle that will move them up, or I 

could align them to the top of the Cell. And I'm going to put mine in the middle, the 

Alignment tools that we have underneath deal with the Horizontal Alignment.  
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So, we can choose to have them left aligned, aligned to the middle or aligned to the right. So, 

currently, all of my text is aligned to the left. And it is worth noting that by default, when you 

enter text into a Cell, it is aligned to the left of the Cell. But I could choose to align these to 

the middle or I could align them to the right-hand side of the Cell. So, again, this is very 

much personal preference.  

Now aside from those basic vertical and Horizontal Alignment tools, we have some other 

cool things that we can do in this Alignment group. So, if you check out this little button just 

here, this is related to the orientation of the text or values that are in the selected Cells. So, 

from here, we can rotate our text diagonally or vertically. And as it says in the ScreenTip, this 

is a great way to label narrow Columns.  

So, what we could do here is we could click the dropdown, and you can see that we can 

change the angle of labels. So, I have the heading Row selected, I could choose to angle those 

headings counter clockwise. And you can see exactly what that does.  

Now I'm going to widen out this Row so, that those all sit neatly. So, this is sometimes a way 

to make your Columns a little bit narrower. Because these are on a diagonal, we could then at 

double click to AutoFit, the width of these Columns, and they take up a lot less space, we 

have other options underneath here as well, we can angle them clockwise. Or we can do 

vertical text that doesn't look so, great. And it's quite hard to read, we can rotate the text up, 

you might want to use that at some points, or we can rotate the text down.  

So, this is entirely up to you as to how you want to use this. And if you want to put it back, 

you just need to deselect the one that you originally selected. Another thing you have in this 

little group here are in dense, so, you can choose to decrease the indent or increase the indent. 
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So, if I was to increase the indent, can you see it kind of Tabs, the headers across the Cell. So, 

if you need to have that indented effect, you could use these indentation tools.  

Now another thing that we have in here is the Wrap Text option. So, we looked at this briefly 

in another lesson. This allows us to wrap extra-long text into multiple lines, so, you can see 

all of it. For example, let's take this Column just here, Column P, let's imagine that this 

Column is a lot narrower than it currently is, you can see that some of these product names 

are kind of being hidden because there isn't enough space in this Column to accommodate the 

width of the text.  

Now, we could of course, drag the Column out to give it more space. But if we want to have 

a much narrower Column, but we still want to be able to see all of the text, we can simply 

select the Column and click on Wrap Text. And you can see exactly what that does. It wraps 

the text around so, it breaks the line at the end and wraps it onto another line. So, this is fine. 

Just remember that this can give you inconsistent Row heights, because if we take a look at 

what we have in Row 2, that all fits nicely on one line.  

Whereas what we have in Row 3, it needs to wrap around so, this Row needs to be a little bit 

taller. Now the option underneath Wrap Text is merge and centre. And we have a whole 

video dedicated to this because there are a couple of things that you need to be aware of when 

you're using merge and centre.  

The final thing to point out when it comes to alignment is if you notice in the corner of the 

Alignment group, we have this diagonal arrow. As we've already seen, this opens up more 

settings for this particular group of tools. So, it's going to jump us across to the alignment 

Tab. And once again, we have some text alignment options in here. But we have a few more.  
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So, when it comes to Horizontal Alignment, we've got left centre, right we have fill, we have; 

justify, centre, across, selection, so, on and so, forth. So, a few more options in there. We 

also, have the same for and vertical alignment, we have top centre bottom, justify and 

distributed in the text control group. Again, we have wrapped tags, that's the same as clicking 

the button that we have on the Ribbon, we also, have something called shrink to fit.  

So, let me show you what that does. Again, we're going to use Column P. Let's make this 

quite a bit narrower. If I was to select this Column and go back into my Alignment tools and 

choose a shrink to fit, check out what happens to the text in these Cells. When we click on 

OK. You can see what it does, it actually shrinks the Font Size so that each item fits in the 

Cell. And you don't have to change that Column Width.  

Now I don't particularly like this option, because again, it gives you very inconsistent Font 

Sizes. But just remember that that option is there, there might be a time when you need to use 

it, we can also, do things like change the text direction in here.  

So, the default is left to right, you could choose to have this right to left. And then finally 

over on the side here. This is where you can change your orientation. So, again, if we were 

dealing with the headings in this document, let's select the top Row, go back into our 

alignment options, I could choose to rotate these headings 45 degrees, click on OK. And it's 

going to give us the same effect as choosing angle counter clockwise from this dropdown. So, 

remember, a lot of the things that you see in these additional options areas are repeats of what 

we already have in the Ribbon. But in some instances, you will have more options in here as 

well.  

Now I'm going to take this back to a zero-degree rotation and click on OK. And I'm also, 

going to remove shrink to fit and click on OK, again.  
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Now the final thing to point out here is, as we've mentioned previously, the default is for all 

tags to be aligned to the left-hand side of the Cell. And for numbers or values to be aligned to 

the right. And you can see evidence of this in Columns Q to U.  

These Cells contain text and values, we have text in the header, which is aligned to the left, 

and we have values in the Column. And those are aligned to the right. And how these 

numbers are aligned against each other are very much controlled by the Number Formatting 

that you have in play. So, I have Accounting Formatting selected for these Cells. And that 

means that all of my numbers are going to line up at the decimal place.  

It also, means that the currency symbol is going to be pushed all the way over to the left-hand 

side of the Cell, keeping it out of the way of the actual number. And this formatting this 

Accounting Format has been specifically created for accountants who have to read down long 

lists of numbers.  

Remember, the other type of formatting that we have is currency. And you'll find that with 

currency format, you have the dollar symbol pushed right up against the number. And in a lot 

of cases, the decimal places won't necessarily always lined up.  

So, again, remember with numbers, the type of formatting that you have applied to them can 

also, affect their alignment. But aside from all of that, that is pretty much all there is to 

Aligning Text and values within Cells in your Worksheet.  
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Video: Merge Cells vs Center Across Selection  

Deb: In this lesson, we're going to discuss merging Cells and merging Cells is quite a 

controversial topic in Excel. So, I'm going to show you how to merge Cells, I'm going to 

show you some of the issues that this can cause. And then we're going to take a look at a 

better way of doing it.  

So, let's start out by talking about exactly what we're doing when we merge Cells. Now, you 

can see that I have a dataset, just here, this is just a selection of the Columns from the dataset 

that we were using previously. And you'll notice here that in Cell A3, we have sales 2011. 

And then we have some records that relate to 2011 sales, we then have sales 2012, and the 

same thing, sales 2013, and then sales 2014. So, these are going to act like headers just to 

break up the data and make it really obvious which sales pertain to which years. 

Now we could leave these little labels where it says sales 2011, for example, in the Cell that 

they're currently contained in. So, this is in Cell A3 currently, however, this would look a lot 

better if it was kind of centred across our data. So, somewhere in the middle here.  

Now when you type something into a Cell, it is contained entirely within that Cell. So, if 

you're thinking that you can maybe select all of these Cells, and then in the Alignment group, 

click on centre, it's only going to centre that text within the Cell that it's contained in, it's not 

going to centre it across the selection.  

So, a way that people generally tend to get around this and get the effect that they want is to 

use the merge and centre option. Because what merge and centre will do is it will merge 

together all of the selected Cells and effectively make them one Cell. So, you can then use 

your Horizontal Alignment tool to centre the text into the middle of this big merged Cell. So, 
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if we go to the Home Tab in the Alignment group, we have a merge and centre option just 

here.  

Now, it's worth noting that if we click the dropdown, we have a few other options in here, but 

the one that we want is merge and centre. Now as soon as I do that, check out what happens. 

The individual Cells now all become one Cell. And this Cell is effectively A3. And because 

we chose to merge and centre, it centred that text in the middle of the merged Cell. So, we 

could then do is maybe change the background colour of this to let's go for a light Purple. 

And that kind of gives the effect that I was looking for. I could then do this for the rest of 

these headings.  

Now of course, once you've done it once, you can use the format painter to copy that 

formatting. So, I'm going to click in Cell A3, let's double click on the Format Painter. Let's 

paint that across, just here. And we're going to do the same for this one. And then if we scroll 

down, we're going to do the same for this one as well. And escape to deactivate the Format 

Painter. So, that is the exact effect that I was looking for. And we've achieved it very simply 

using merge and centre.  

However, there is a caveat to using this method. When you do use merge and centre, it then 

becomes a lot more difficult to make Cell selections, and it can sometimes cause problems 

with any Formulas that you have.  

So, let me show you what I mean. If I now decide that I want to go in and I want to select all 

of the values in the Quantity Column, check out what happens if I click in Cell f2 and start to 

drag down to make my selection. It won't just let me select the quantity Column. Because we 

have that merge Cell in there, effectively one Cell it expands to the width of that, and then it 

kind of uses that with the entire way down.  
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Even if I was to use a Keyboard Shortcut Ctrl + Shift+ Down arrow, you can see it only goes 

to there. And I would need to do it again and again. And it just doesn't work well with this 

merge Cell sitting in there. So, making selections then becomes a problem. Now we can get 

around this and achieve the same effect. But using a method that still allows us to make 

selections and ensures that our Formulas will still work correctly.  

So, let's undo and try this again. So, we're back where we started. And what we're going to do 

is we're going to select this Row of Cells, but instead of going to merge and centre, we're 

going to open up our alignment settings, we're going to go to Horizontal Alignment. And if 

we click the dropdown, we have an option here called Centre Across Selection. So, if we 

click on this and choose OK is going to do something very similar.  

The Cell looks like it's one Cell and it centres that text in the middle. So, I can then go in and 

I can apply my Background Fill Colour and I get exactly the same effect. The difference here 

is the It hasn't actually merged the Cells, it just looks like it has noticed that I can still click in 

Cell A3, and it is just Cell A3, I can click in Cell B3, C 3, D 3, E 3, so, on and so, forth.  

So, these are all still individual Cells, they haven't been merged into one big Cell called A3. 

And what that means is that if I want to go in and select the quantity Column, I can still do 

that, because we still have our individual Cells there. So, this method gives us the same nice 

effect, but it causes us far less problems.  

Now I have seen some people, particularly when this topic is discussed on LinkedIn, say that 

there are certain scenarios where merging and centring is better than centring across 

selection. And you may well come across those in your working life. But in terms of the look 

and feel, and also, the usability, my recommendation is to go with Centre Across Selection 

whenever you can.  
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So, now we can simply double click the Format Painter, and copy this formatting across to 

the other Rows. And just to finish off this lesson, when we were looking at merge and centre. 

If you click the dropdown, notice that we have other options in here as well. So, if you are 

going to use this method, you don't necessarily have to merge and centre the text, you could 

just choose to merge across.  

So, this will merge all of the selected Cells together. But it's not going to centre the text, the 

text will stay on the left-hand side where it was originally, we can choose to just merge Cells. 

So, that's just going to merge the Cells together. It's not going to do anything with the text. 

And then we have an unmerge Cells option which will basically allow us to come out of that 

merge mode and split the big merge Cell into separate Cells again, so, just be aware that you 

do have other options in there aside from merge and centre.  

Have a little play around with those have a little practice and I will see you in the next lesson. 
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Video: Apply and Modify Themes  

Deb: I've mentioned Excel themes sporadically throughout this course so, far.  

So, in this lesson, it's time to delve into themes. Because themes control the look and feel of 

our spreadsheets. And how our spreadsheets look is a really important aspect of Excel.  

When it comes to designing our spreadsheets, particularly if we're going to send them to 

other people, we want to make sure that our data is consistent, that it's readable, and it's easy 

to interpret. And some themes and some colour schemes are definitely easier on the eye than 

others. So, it's important to make sure that you're picking a colour scheme, fonts and styles 

that are going to assist the viewer and not distract and make things more difficult.  

Now, the first thing to talk about when it comes to themes is if we go up to the Page Layout 

Ribbon, this first group here themes, this is where you're going to find all of your settings. 

Now what you'll notice is that when you click the Themes dropdown, you can see your 

themes, that gallery, and that Themes gallery will be divided into 2 distinct sections. We have 

custom themes at the top, and then we have Office Themes.  

Now in this custom area, this is where you're going to find any custom themes that you 

design yourself. Because yes, as you might have guessed, you can create your own themes in 

Excel. Now if you're wondering why on earth would you want to create your own theme? 

Well, sometimes companies or organizations require you to use the same colours that match 

your company's branded colours.  
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For example, maybe your company has a Yellow, Green and Blue logo. And they like you to 

use those colours when you're working in your Excel spreadsheet. So, you can build your 

own custom theme, and specify which colours you want to use.  

Now, we will get onto that a little bit later. But for the time being, let's just take a look at 

some of the inbuilt Office Themes. So, we have a selection just here. And if we scroll down, 

we have a lot more. So, there are quite a few different themes to choose from.  

Now a theme generally contains 3 different elements colours, fonts, and effects. So, when 

you select a theme, it's going to have its own colour palette, its own fonts that it uses, and its 

own effects. Now the default theme in use when you just open up, Excel is going to be the 

Office Theme.  

Now as I mentioned, Microsoft have recently changed the way that this Office Theme works, 

we have a different colour palette, and we have different fonts. So, depending on if you've 

downloaded the latest update for Microsoft 365, your colour palette for this Office Theme 

might be different to mine, you might be still using the old one, it's not a problem.  

Just be aware that that is why there might be a difference between what you're seeing on my 

screen and what you have on yours. So, I have the Office Theme applied. But I could also, 

choose the older Office Theme.  

So, this might be the one that you're seeing as your default. We have other themes just here. 

So, you can see as I hover over these, we get a live preview, and it's changing the colours in 

use in the spreadsheet. So, you could choose any one of these colour schemes.  

http://www.simonsezit.com/


 

 

 

 

 

 

       © Copyright 2023 Simon Sez IT, INC. All Rights Reserved. 132 

So, let's go for Wisp and see what that looks like. And if you want to see the actual colour 

palette in use, you can go to the Home Ribbon. And if you click on the Fill Background icon, 

you can see here are the Theme Colours.  

Now if I go back to page layout, notice that we also, have colours dropdown just here. So, by 

default, when you select a theme, you're going to get its default palette of colours like we just 

saw. But if you decide that you don't like those colours, you could just change the colours in 

use in the theme. So, essentially, we'd still be using the Wisp Theme, we'd just be using a 

different colour palette. So, maybe I want to go for let's go for this Red Orange colour palette 

just here.  

So, when you select a theme and change the colour palette, it's not going to change any of the 

fonts or any of the effects but it will change the colours in use. The same thing here we could 

go in and we could change the font. So, if I decide that I don't like this font, I could change it 

to something like Arial. The same thing would apply to the fonts and effects.  

If you don't like the fonts that are standard as part of the theme that you've selected, you can 

click the dropdown and go in and change the font to something else. And the effects if you're 

wondering just relate to things like the type of shadow or the type of Border you have when 

you start adding in things like shapes into your spreadsheets.  

Now another really important thing to understand when it comes to themes is that there is a 

big difference between using Theme Colours and using standard colours in your Worksheet. 

Let me show you what I mean by that. If we go to the Home Tab, and let's select this heading 

Row up here. I'm going to go to the Fill Background Colour and instead of picking a colour 

from my Theme Colours palette I'm going to choose a standard colour down here. So, let's go 

for this navy colour like that.  
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Now, if you choose a colour from the standard palette, and then you go back and try and 

change your theme, so, if I try and change it back to this Office Theme, notice that all of the 

colours in this spreadsheet change depending on which theme I'm currently hovering over. 

But that heading Row doesn't change colour, it's always dark Blue.  

So, when you choose a standard colour, that won't update according to the theme that you've 

chosen, as soon as you put this back to using a Theme Colour, so, let's select it again. And 

let's choose one of these Theme Colours. Let's go for this dark Red. Because this is now a 

Theme Colour. When I go back and hover over my different themes, you can see that that 

heading Row is now updating, okay, so, just be aware of that big difference between using 

standard colours and Theme Colours.  

Now I mentioned towards the beginning of this lesson that you can create your own themes in 

Excel. So, what I could do here is maybe I want to have these the same colour as my 

branding. So, I'm going to go to more colours. And I can either choose something from here, 

or if I have a specific Hex code for the colour that I want to use, I can type it into here, you'll 

find that if you do work at an organization that uses branding pretty heavily, your marketing 

team are going to have a list of all of the colours that are used in the logo and templates and 

things like that. And they'll also, have the hex code values. So, you can ask them for those 

values, copy them in and you're going to get the exact same colour as your logo, for example.  

Now, I'm just going to choose a random colour from the palette here. Let's go for a dark 

Green. Let's click on OK. And let's change this Yellow. And I'm just going to select all of 

these. Let's change this to let's go to more colours again. And we're going to do let's do a light 

Green. Click on OK. So, I've made a couple of changes there. Maybe I want to save this as a 

theme so, I can quickly switch to it. In other words, it's going to jump you to the Folder page 

layout template.  
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So, right to the bottom, now I say folder, don't navigate to another folder that you have on 

your PC, because we want to save into this document themes folder. So, I'm going to call this 

I'm just going to call this my initials, and theme, and click on save.  

So, once you save a theme, when we go back to the themes dropdown, you're going to see 

that theme underneath custom. So, I'm just going to undo and take this all the way back to 

how it was originally. And now if I wanted to apply my theme, I could simply go to themes, I 

could choose da theme, and that is applied. And the final point worth noting here is that 

themes will come into play in every aspect of Excel.  

So, if I was to insert a little chart, the colours in use in the chart are going to be based on the 

theme that you have in use. If I was to insert anything like a shape into the spreadsheet, the 

default colours are going to be taken from that default colour palette. So, themes are really 

important thing to get your head around. Make sure you're using one that suits the 

spreadsheet that you're trying to construct. 
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Video: Exercise 08  

Deb: It's time now to do Exercise 08. And in this exercise, we're going to practice some of 

the skills that we've learned in this section of the course.  

So, I'd like you to start out by opening up the exercise file ‘Exercise08.xlsx’. Now I'd like 

you to insert 2 Rows anywhere in the dataset and add the following 2 records. Once you've 

done that, I'd like you to apply Number Formatting to the Sales Column. And I'd like you to 

use the format that lines up the decimal places.  

I'd then like you to apply Bold Formatting and add a Background Fill to the heading Row. I’d 

then like you to centre the title in Row 3 across all Columns. And finally, apply bold and 

Italic Formatting to that heading Row. If you'd like to see my answer, then please keep 

watching.  

So, the first thing I asked you to do here was to insert 2 Blank Rows and complete the 

information for Hawaii and Idaho. Now if we take a look at our data, let's go to the State 

Column, I can see that these are organized into alphabetical order. So, if I scroll down, 

Hawaii and Idaho are going to go in here. So, with Row 15 selected, I'm just going to press + 

Shift ++ to add 2 Blank Rows, and then simply going to copy the information from the 

screenshot into the Table.  

The next thing I asked you to do was to apply Number Formatting to Column E. And I asked 

you to apply the Number Formatting that lines up the decimal places. And hopefully you 

have remembered that that is Accounting Format. So, let's add that and I'm going to keep this 

with 2 decimal places.  
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Next, we need to apply Bold Formatting and a Background Fill to the heading Row. So, Ctrl 

+ Shift Right Arrow. Let's make those headings bold. And let's give it a Background Fill. So, 

I'm just going to go with this light Blue colour. I then asked you to centre this title in Row 3 

across all of the Columns.  

Now if you recall, we discussed the difference between the merge and centre option and 

Centre Across Selection. And Centre Across Selection is by far the safer one as it means 

you're still able to make selections and complete Formulas.  

So, let's press Ctrl+1 to open up Format Cells. We're going to jump into Alignment. And in 

the horizontal dropdown, we're going to choose Centre Across Selection. Let's click on OK 

and you can see that that's centred in the middle. And the final thing I asked you to do here 

was simply apply bold and Italic Formatting to that header. That is it. I hope you got on OK 

with that. I will see you in the next section. 
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Section 9: Excel Lists 

Video: How to Structure a List  

Deb: In this section of the course, we're going to start to talk about Excel Lists, because 

Excel Lists really are the backbone of working with data in Excel. So, we need to understand 

exactly what they are, and how best to structure our data.  

 

When we have our data in List form, we can do many things with that data. We can add 

Filters, we can sort the data, we can create Tables, or maybe even analyse the data using other 

Excel tools like Pivot Tables. But in order to do any of that, we need to make sure that we 

have our data in the correct format first of all.  

 

So, if you take a look at the spreadsheet on the screen, you can see that we have some List 

data. And List data really is just anything that is in Columns and Rows. And for the most 

part, the majority of the data you're going to be working with is going to be in this structure, 

where we have Column Headings at the top, and then we have our records or our Rows 

underneath. And that is the first really important point.  

 

When you're working with List data or if you want to do anything with your data, you need to 

make sure that you have a heading Row at the top. Because a heading Rows serves a few 

different purposes. The most obvious purpose is that the heading Row acts as an identifier for 

the data contained below.  

 

So, we can see very quickly that this Column contains Employee Names. This Column 

contains Departments, this Column contains Job Titles. If we didn't have a heading Row in 

here, like that, it makes it a lot harder to identify what type of information we have. For 

example, if you take a look at Column F, it's not particularly easy for me to ascertain what 

this number actually represents. So, I'm going to Ctrl + Z just to put those headings back into 

my data.  

 

Now when it comes to adding a heading Row up here, there's no standard naming convention. 

You can literally name your Columns whatever you like. I would say though, try to keep 

them reasonably short, you don't want extremely long Column Heading names, because that's 

just going to make your Column really wide, your data is going to start to run off the page, 
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and you're going to need to use your horizontal scrollbar. So, keep the headings short and 

sweet.  

 

Another reason why it's beneficial to add a heading Row into your data is that Excel uses the 

heading Row for many different things. For example, if we were to create an Excel Table out 

of this data, Excel uses that heading Row to structure the Table. Also, if we're working with 

Formulas, the Formula identifies information based off of the heading Row.  

 

Now currently, we don't have any formatting applied to our heading Row. I would always 

advise that you do format this top Row just to make it stand out from the rest of the data. That 

might be as simple as making the text bold, or you could get a little bit fancier by adding a 

Background Fill Colour. So, now it really does just identify that heading Row from the rest of 

the data, and just makes it a lot easier to read.  

 

Now another thing you want to make sure that you get rid of when you're working with your 

datasets is any Blank Rows in your data. You can see that I have a few Blank Rows scattered 

throughout this dataset. Now this is a very small dataset just for demonstration purposes. But 

imagine if you had a dataset that maybe had 20, 50, 100,000 Rows, and you have Blank 

Rows scattered throughout.  

 

Now you could go through and manually start removing these Rows by simply selecting the 

Row, right clicking your mouse, and choosing Delete. But again, if you have a very large 

dataset and lots of Blank Rows that you need to remove, that's going to be very time 

consuming.  

 

So, I just want to show you a really quick trick when it comes to removing all of those Blank 

Rows. If you have a reasonably small dataset, you can simply select everything like that. Or 

if you have a larger dataset, you could select all of the Columns like that.  

 

Now I'm going to make my selection like this. And what we can do here is we can go up to 

the Home Tab, go across to Find & Select, and choose Go To Special. Now, it's worth noting 

that there is a shortcut key for this as well. If you press Ctrl + G, and then click on Special, 

it's going to take you to the same place.  

 

Now in here, this is where we can select different things that meet these pieces of criteria. 

And notice that one of the options that we have in here is Blanks. So, if I select this, it’s 
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going to select any blank Cells within our selection. So, let's click on OK, and you can see it 

automatically highlights all of those Blank Rows much quicker than going through and doing 

it all manually.  

 

Once we have these highlighted, we can go back up to the Home Ribbon, go into the Cells 

group and click the Delete dropdown and simply say Delete Sheet Rows. That's going to get 

rid of all of those blanks in a fraction of the time. So, make sure that you're removing Blank 

Rows from your dataset.  

 

And another thing I would advise that you do before you start to analyse your data is make 

sure that you spellcheck your data and make any corrections. So, if we go to the Review Tab, 

notice in the Proofing group, the first option we have here is Spelling. There is also, a 

Keyboard Shortcut for this of F7. So, let's click on Spelling, and it's going to search through 

our data to find any spelling errors. It's really important that you do fix spelling errors, 

because this can throw up unexpected results.  

 

For example, when you're filtering your data, you can see here it's found that I've spelt the 

word ‘representative’ wrong. So, you can imagine if I was filtering this List for sales 

representative, it's not currently going to find this record just here. So, I want to make sure 

that I correct that.  

 

I'm going to select one of the suggestions below and click on Change. It’s then going to move 

on to the next incorrectly spelt word. And you can see here that I've spelt ‘analyst’ wrong. So, 

again, I'm going to choose one of the suggestions, click on Change. I'm going to say yes, let's 

check from the beginning. And you can see Spellcheck is now complete. So, make sure you 

spellcheck your data.  

 

Another thing I would always do prior to any analysis is make sure that I have the correct 

formatting applied to each Column. Now, most of this looks fine. However, the Salary 

Column just here, I'm not particularly happy with how these numbers are formatted.  

 

So, I'm going to select this data; Ctrl + Shift + Down Arrow, I'm going to go to the Home 

Tab, and I'm going to have a Comma Separator in there, and I'm going to take those decimal 

places down to 0. You could even add a currency symbol if you wanted to. So, let's actually 

do that; it makes a bit more sense. I'm going to apply Accounting Number format, take those 

decimal places down, and that looks good.  
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So, now that I have some semblance of structure to my data, it's pretty much ready for me to 

go in and start to use other Excel analysis tools. And that's exactly what we're going to move 

on to in the next lesson. 
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Video: Sort a List: Single-Level Sort  

Deb: In the previous lesson, we started to speak about how to structure Excel List data. And 

we also, spoke about the importance of having Column Headings in your datasets. So, now, 

we're going to move on to analysing our data. And we're going to take a look at some of the 

most common utilities and tools that we have for really refining our Excel Lists. And we're 

going to start out in this lesson by talking about sorting.  

 

Now sorting is really a way to make sense of data that's a little bit all over the place. When 

we add records into a dataset, we're not particularly adding them in any specific order. For 

example, in this dataset, I haven't gone in and added all of the people in HR first of all, and 

then all of the people in IT, and then all of the people in Sales, I kind of have these 

sporadically entered.  

 

Now, in this case, I've entered them using their Employee IDs. So, these are going up in 

ascending order. So, we do have a little bit of a sort applied here, because they're sorted 

chronologically by the Employee ID. But it might be that I want to sort this data in a different 

way. Maybe I want to sort by the Salary Column, and have the salaries listed in descending to 

ascending order. Or maybe I want to sort everybody by their Department. Or, maybe I want 

to sort them alphabetically by Employee Name. 

 

Now when it comes to sorting Excel data, there are a few different types of sort that we can 

do. We can do a Single-Level Sort, a multi-level sort, and we can even do a Custom Sort 

using Custom Lists. We're going to discuss all of these different methods in this section, but 

we're going to start out in this lesson by just doing a Single-Level Sort.  

 

Now, the first thing I would always recommend that you do prior to sorting, filtering, or 

analysing data is put your dataset into an Excel Table. And we've seen how to do this before; 

we can simply click in our dataset and press the Keyboard Shortcut Ctrl + T. It's asking me if 

my Table has headers. Well, yes, it does, we made sure of that in the last lesson.  

 

I'm going to click on OK, it’s going to put my data into a Table, and it's given it not a very 

nice colour, so, let's go in and change that. I want something fairly plain here. Let's just go for 

Plum, Table Style Light 13. I'm also, going to name my Table to make it easy to identify. So, 

once again, let's jump up to the Table Design Ribbon in the first group just here, I'm just 

going to call this Employees and hit Enter.  
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Now one of your advantages of putting your data into a Table is that it will automatically 

apply these Filters on the top of each Column. And we can use these to filter our data which 

we'll get onto a bit later. We can also, use these to sort our data as well. So, maybe I want to 

sort this data by the Salary Column. I can click the dropdown just here, and notice I have Sort 

Smallest to Largest, or Sort Largest to Smallest. We also, have a Sort by Colour option that 

we'll get onto a little bit later.  

 

Now in this first instance, I just want to Sort Largest to Smallest; I want to see who has the 

highest salary in this list of employees. So, we're going to say Sort Largest to Smallest. And I 

can see that Michael Williams is currently earning the most out of everybody.  

 

You can see that as soon as I applied that sort, if you take a look at the Filters on the Column 

Headings, I now have a little Down Arrow on the Salary Column to show me that I have a 

sort applied. And it's also, showing me a downward facing arrow because we're sorting from 

Largest to Smallest.  

 

So, now that I've sorted this data, it's rearranged all of these records. If you take a look at the 

Employee ID Column, you can see that these are now no longer in chronological order, 

because we're sorting by the Salary Column.  

 

Now if I decide that I want to sort by an entirely different Column, it's worth noting that 

when we click the dropdown, we don't actually have a Remove Sort button. What we could 

do here is toggle between Smallest to Largest or Largest to Smallest. If we go up to the Data 

Tab on the Ribbon, also, notice we have a Sort & Filter group just here. So, this is where we 

can also, perform the same sorts. We can do Sort Smallest to Largest, or Sort Largest to 

Smallest.  

 

Now we do have a Clear button just here. And while that will clear the sort, you can see that 

that little downward facing icon has been removed from the Filter button, it doesn't remove 

the actual sort. So, my data is still sorted by the Salary Column Largest to Smallest. But if I 

wanted to resort my data, maybe by Department instead, I can click the dropdown, I can sort 

A to Z by Department.  

 

So, now we have Finance grouped together, HR, IT, Marketing, so, on and so, forth. Let's 

clear this sort. So, applying a sort to individual Columns, that's what we call a Single Sort. 
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We can also, right click in any Column and we have Sort options just here as well. So, just be 

aware of all those different methods that you can sort your data by one Column.  

 

Now if we want to sort our data by multiple Columns, maybe we want to sort by Salary in 

ascending order, and then by Employee Name A to Z, that is where we would use a Multi-

Level Sort. And we're going to cover that in the next lesson. 
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Video: Sort a List: Multi-Level Sort  

Deb: In the last lesson, I showed you how you can do a single sort on a Column of data in 

Excel. And you can see currently, we still have the final sort we did in the last lesson applied 

to Column D; we're sorting by Department A to Z.  

 

Now quite often, you'll not only want to sort on one Column, but you'll want to sort on 

multiple Columns. So, you might think it's going to be a simple case of just going in and 

applying a second sort to another Column of data. For example, maybe I want to sort A to Z 

by Department first of all, but then I want to Sort Largest to Smallest by the Salary Column.  

 

Now what happens if I click the Salary dropdown and choose Sort Largest to Smallest? Well, 

it effectively removes the sort from the Department Column and switches it to the Salary 

Column. So, I'm not getting the result that I wanted, because I wanted to sort by Department, 

and then I wanted to sort by salary.  

 

So, if you want to sort by multiple Columns, you need to go about this in a slightly different 

way. So, this time, what we're going to do is we're going to go up to the Data Ribbon. And in 

the Sort & Filter group, notice that we have this big sort button. Now when we click this, it’s 

going to open up the Sort dialog box. And this is where we can add in all of the different 

Columns that we want to sort by.  

 

Now notice below, it's got ‘Sort by’, and then it has Salary, Sort On, and Order. Now what 

you see in here is basically going to be determined by where you're currently clicked in your 

data. So, because I was clicked in the Salary Column, that's why it's sorting by default by the 

salary. But let's say I want to do a sort by the Department first of all, I can simply click the 

dropdown, and it's going to show me all of those Column Headings in my data; another 

reason why it's so, important to have Column Headings.  

 

If I hadn't structured my data correctly, and I'd omitted the heading Row, it would just say 

Column 1, Column 2, Column 3, Column 4 in here. So, it makes it really hard to identify. But 

we can select Department, I want to sort on the values in the Cells, so, that's fine. And then I 

can choose the order that I want to sort in. So, I want to sort A to Z.  

 

Now once I have this first sorting here, I can then add another level of sorting. So, notice, we 

have an Add Level button just here. If we click that, it's going to open up another box. And 
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notice it says ‘Then by’. So, now, I can go in and say that I then want to sort by the Salary 

Column, I want to sort on the Cell Values, and I want to Sort Largest to Smallest. And I could 

carry on going, I can add in as many sorts as Columns that I have in my data.  

 

So, I could add another level and then say, once we've done those sorts, we then want to sort 

by Job Rating on the Cell Values. And let's do Largest to Smallest. So, when we click on OK, 

it's going to run those 3 sorts.  

 

Now if you take a look at the Filter Icons at the top of each Column, you can see that we have 

little arrows on all 3 of those Columns. So, the first sort that we did was to sort the 

Department Column A to Z. So, we have all of Finance at the top here. We then sorted by the 

Salary Column Largest to Smallest.  

 

So, if we take a look at this block of 3 Finance records, and then go to the Salary Column, we 

should find that these are sorted into the order Largest to Smallest, which they are. We then 

sorted by Job Rating. And again, we're going Largest to Smallest. And if we take a look at 

that Column, we can see that that is sorted in that way. So, we've performed a sort on 

multiple Columns in our dataset.  

 

Now before we leave this lesson, I just want to show you another little trick. Notice that I've 

added some data into this Worksheet in Columns I to L. And this data is structured in a 

slightly different way. You can see that in Column I, we have the Column Headings, and in 

Columns J to L, we have the actual data. So, instead of having our data running vertically, we 

have our data running horizontally.  

 

Now this is by far not the normal way to structure data, most people would structure it like 

we have in the first Table. But you will come across this occasionally, where we have our 

Column Headings in the Row as opposed to in the Columns.  

 

Now this is just a very small dataset just to show you the potential here, because we can still 

use sort even if we don't have our Column Headings in the Columns but we have them in the 

Rows instead. But we need to go about this in a slightly different way.  

 

So, maybe I want to sort this data by Employee Name, Z to A. Now the most important thing 

here is when you're doing this, make your selection but don't include those Row Headings. If 

you include these it's going to include those in the sort. So, I'm going to select my data just 

http://www.simonsezit.com/


 

 

 

 

 

 

       © Copyright 2023 Simon Sez IT, INC. All Rights Reserved. 146 

here, we're going to go to the Data Column, and we're going to go into our Custom Sort 

button.  

 

Now notice here, just above Sort by, it says Column, because that is the default. But if we 

want to sort by Row instead, we can simply click on Options, and instead of Sort top to 

bottom, we can say Sort Left to Right. Let's click on OK. So, now, it switches to Row as 

opposed to Column, and we can choose which Row we want to sort on.  

 

So, I'm going to say Row 4 for the Employee Name, I want to sort on the Cell Values, and I 

want to sort Z to A. Let's click on OK, and you can see that it performs that sort. And we now 

have those records organized by the Employee Name Z to A. So, just be aware that you have 

that option underneath the Sort button as well. 
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Video: Sort a List: Sort with Custom List  

Deb: Towards the beginning of this course, we did a lesson on Custom Lists, I showed you 

why Custom Lists are useful, we took a look at some of the inbuilt Custom Lists that come 

with your copy of Excel, and I showed you how you can create your own Custom Lists so, 

you can quickly fill down Lists of data. But did you know that you can also, use Custom Lists 

when it comes to sorting? So, let's take a look at this example.  

 

Now, notice here, we're using the same Table of data, but I've actually removed all of the 

sorts. So, we're just back to basically sorting by Employee ID chronologically; Smallest to 

Largest. Now, we've already seen how we can do Single-Level Sorts on one Column, we've 

seen how we can do Multi-Level Sorts where we combine lots of different Columns.  

 

But what about if we want to sort our List in a very specific way, and simply sorting Columns 

A to Z, or Z to A doesn't quite give us the result that we're looking for? Well, this is where we 

can utilize a Custom List in our sort.  

 

So, if you take a look over in Column I, you can see that I've just listed out the Employee 

Names from the Table. But the difference here is that the Employee Names are in a 

completely different order in Column I to what they are in the Table. You can see in the 

Table, the first Employee Name is John Smith, whereas in Column I, the first Employee 

Name is Michael Williams.  

 

Now maybe I want to sort my data in this specific order by Employee Name. I'm not going to 

be able to do that because there is no pattern to this sort order, they're not listed A to Z, or Z 

to A. However, I can achieve this by creating a Custom List and using that as my sort. So, 

let's create our Custom List first of all. We're going to jump up to the File Tab, we're going to 

go down into Options, and we're going to go straight to the Advanced page.  

 

If we scroll pretty much all the way down to the bottom, we're going to find the Edit Custom 

Lists button. So, here it is; ‘Create lists for use in sorts and fill sequences’. So, we're going to 

choose Edit Custom Lists, we can see all of the Custom Lists that we currently have set up, 

and you can see I have quite a few in here. And now, we can add in our Custom List.  
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Now remember with Custom Lists, you want to make sure that you have New List selected at 

the top here, you can type in your entries. But for us, that's going to be a bit tedious because 

we have quite a lot of Employee Names.  

 

Alternatively, we can import the List from Cells. So, that sounds like what we want to do. 

Let's click down here. I'm going to select my List of names in Column I. And I'm going to 

click on Import. So, that's now imported all of those names, and I've effectively created a 

Custom List. Let's click on OK and OK again.  

 

So, now that we have our Custom List created, how can we use that to sort our data into that 

order? Well, it's really simple. Let's make sure that we're clicked in the Employee Name 

Column, we're going to go to the Data Tab, and we're going to click the big Sort button just 

here. Because now what we want to do is we want to say Sort by Employee Name, we want 

to sort on the values in the Cell. But when it comes to the order, if we click this dropdown, 

notice that we have a Custom List option in here.  

 

So, when we select this, it’s going to open up our Custom Lists. We can go through, select 

the list we want to sort by, click on OK, click on OK again. We should now find that this 

Table is sorted in exactly the order that we have in Column I, and I can see that it is.  

 

So, Custom Lists are super useful when you want to sort your data into a very specific order 

that isn't covered by the other options. 
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Video: Filter a List – Numbers and Text  

Deb: In the last few lessons, we have very much been focused on sorting data. So, now, it's 

time to move on to another really important analysis tool in Excel, and that is filtering our 

data. Sorting and filtering are 2 entirely different things.  

 

As you've seen, when we sort our data either by one Column or multiple Columns, it just 

rearranges the way that these records are displayed making them easier to read. Whereas 

when we filter data, we're actually hiding records that don't meet the criteria that we've 

specified, enabling us to focus on exactly what we're most interested in.  

 

Now, a couple of things to note about filtering before we begin. If you recall, we put this 

dataset into a Table. And by default, when you turn your data into an Excel Table, it’s going 

to apply these Filter dropdowns to the Column Headings. So, if you can see these, then you're 

pretty much ready to get started with filtering your dataset. But what if you don't have these 

in your data? What if your data isn't in a Table?  

 

So, I'm quickly going to take this data out of a Table and show you how you can apply these 

Filter dropdowns without necessarily having to convert your data to an Excel Table. And this 

is another quick tip that is definitely worth covering, because this might be something that 

you do want to do in the future.  

 

If you have your data in an Excel Table, and you want to just convert it back to a regular 

range, all you need to do is jump up to the Table Design Ribbon, and in the Tools group, we 

have a Convert to Range button. So, if I do this, it's going to say; ‘Do you want to convert the 

Table to a normal range’? We're going to say ‘Yes’. And now, it's no longer in a Table. 

Notice that when I click inside the data, I no longer have access to the Table Design Ribbon. 

So, we're back to this just being a regular range.  

 

But also, notice that when I took this data out of the Table, it removed those Filter dropdowns 

from the heading Row. So, if I now want to filter this dataset, what I can do is make sure that 

I'm clicked in the heading Row, go up to the Data Tab, and in the Sort & Filter group, we 

have a Filter button just here.  
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If I click this, that's going to bring those Filter dropdowns back. Worth noting, it hasn't put it 

back into a Table, it's just adding those Filters. So, once we have our Filters applied, we can 

then go in and start filtering our data.  

 

So, maybe I am the head of the IT team. So, I'm only really interested in employees that work 

in the IT team. So, what I could do is I could remove all of the records that aren't related to IT 

and just see those employees that work for me.  

 

So, I'm going to go to the Department Column, I'm going to click the Filter dropdown just 

here. And notice right at the bottom, we have a list of every unique item that is in this 

Column. So, we've got Finance, HR, IT, so, on and so, forth.  

 

Now notice that all of these checkboxes are selected because I'm displaying all records. But if 

I only wanted to see people who are in the IT team, I could choose Select All to deselect 

everything, and select IT only. So, once I specify that piece of criteria, when I click on OK, 

it's going to filter the List. And notice what it's done.  

 

Now it looks like it's deleted those Rows, it hasn't. It has simply hidden them from view. 

How do we know that they're hidden? Well, cast your eyes over to where we have our Row 

numbers. Can you see that some of the Row numbers are now showing in Blue, and they're 

no longer consecutive? So, we have 1, 2, 3, then it jumps to 6, 7, and then it jumps all the 

way to 16, 17, and then it jumps to 24. So, basically, we can see the Row numbers that is 

hidden.  

 

Now you can apply Filters to multiple Columns. So, I've got this filtered list; it's filtered by 

the IT Department. But maybe now I want to see just the employees in the IT Department 

who have a Job Rating of 4. So, I can go to the Job Rating Column, and I can do exactly the 

same thing. I can deselect everything, and just choose 4. Click on OK, and it's refined that list 

down even further.  

 

Now what about if I want to filter this list even more? Maybe I'm only interested in seeing all 

of the employees in the IT Department with a Job Rating of 4 who have the word ‘Software’ 

in their Job Title. Now you can see here at a glance, we have 2 people; Software Engineer 

and Software Developer. So, they don't have exactly the same Job Title, but both of their Job 

Titles contain the word ‘Software’. So, how could we go about filtering this?  
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Well, if we click the dropdown, we can't do it from these checkboxes. But what we can do is 

go to Text Filters and then we have a few different Filters that we can apply. So, I could say 

here ‘Begins with’, and then I could type the word ‘Software’. Click on OK, and now, I've 

refined my list just down to the 2 people that I'm interested in.  

 

Notice that wherever I have a Filter applied to the Column, we have a Filter Icon in that Filter 

dropdown List at the top of the Column. So, I can see very clearly which Columns have 

Filters applied.  

 

Now once you have your Filters applied and your dataset refined, if you want to clear those 

Filters, you can clear them from individual Columns. So, maybe I want to clear it from the 

Job Title Column, I can click the dropdown, Clear Filter from Job Title. Now it's going to 

clear the filter from that Column only if we use the Dropdown Arrow.  

 

If I want to clear all Filters, I would need to go up to the Data Tab, into the Sort & Filter 

group and click on the Clear button. That's going to remove any filter I have applied and put 

everything back to how it was originally. Let's take a look at another way to filter.  

 

Maybe this time, I want to filter for everybody who has a salary over 65,000. So, I'm going to 

click the Salary Column dropdown, we're going to go to Number Filters, and again, we can 

choose one of these options.  

 

Now I want to filter for everybody with a salary of over 65,000, but I also, want to include 

anyone with a salary of exactly 65,000. So, I'm going to choose Greater Than or Equal To, 

and we're just going to type in 65,000, and click on OK. And you can see it's refined that list 

down. Let's clear that filter.  

 

So, there are lots of different Filters that you can play around with in here. I'm going to show 

you one more, because I think this is pretty cool. Sometimes maybe you only want to see the 

top 5 employees by salary. If we want to do that, we can use something called the Top 10 

Filter. And this is useful for many different kinds of datasets.  

 

For example, if you had a dataset that maybe contained sales information, you might want to 

see who the top 5 sales agents were for the month. This is where you could utilize a Top 10 

Filter. Now we're going to do it by Salary, we're going to see the top 5 people by the salary 
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amount. So, let's click the Salary dropdown, we're going to go to Number Filters, and notice 

towards the bottom, we have Top 10.  

 

Now even though it's called Top 10, you can refine this. So, if I only want to see the Top 5 

items, I can click on OK, and you can see now it's just showing me those. Now, you might be 

wondering; ‘How did it do that’? Because it didn't ask us to select which Column to filter by. 

Well, that's because I was clicked in the Salary Column. So, it's going to apply that filter to 

whichever Column you're currently clicked in. Once again, we can click the Clear button to 

remove that filter.  

 

So, those are the different methods that you have when it comes to filtering data. You can 

utilize these checkboxes on one or more Columns or you can use the Text and Number Filters 

if you need to get a little bit more granular. 
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Video: Filter and Sort by Color  

Deb: In the final lesson of this section, we're going to focus on something that we briefly 

touched on earlier on. And that is how to Sort & Filter by Colour.  

 

So, you can see here on the spreadsheet, I have some crazy formatting going on. Now, once 

this looks crazy, you will encounter spreadsheets that kind of looks similar to this. So, we've 

got a few things going on here.  

 

We have everybody who's in the HR Department highlighted with a Green Background Fill, 

we have everybody in the Marketing Department highlighted with a Blue Background Fill, 

and then we have everybody in finance, they don't have a Background Fill, but the font is a 

different colour.  

 

Now what about if I want to sort or filter this list based on either the Background Fill Colour 

of the Cell or the font colour? Well, the good news is, of course, we can do that in Excel. So, 

let's take a look at how we would filter by background colour first of all.  

 

Now, because I have this background colour applied to all of the Columns, I could choose 

any of these Column dropdowns in order to filter this List. So, I'm just going to go for 

Employee Name. If we click the dropdown, notice that we have a Filter by Colour option. 

And when we hover our mouse over that option, we get a little menu shoot out to the side, 

where we can choose to Filter by Cell Colour.  

 

So, if I just want to filter for everything with a Green Background Fill, I can simply select 

that from the List, and that is exactly what I'm going to get. And it works exactly the same 

way as any other filter in Excel. If I want to clear that filter, I can click the dropdown again 

and choose Clear Filter from Employee Name. Similarly, if I wanted to filter for everything 

with a Blue Background Fill again, I can go to any of these dropdowns, go into Filter by 

Colour, and choose Blue, and we've filtered our List.  

 

Now, sorting by colour works in a similar way. So, let's clear the filter from the Department. 

And this time, I want to sort my List so, that everything that has a Blue Background Fill 

shows at the top. So, I can select any of these dropdowns again, and I can Sort by Colour. So, 

I'm going to choose Blue, and it's going to put those at the top.  
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Now what if I want to sort this List that I have everything with a Blue Background Fill, 

followed by everything with a Green Background Fill? Well, once again, we can go into Sort 

by Colour. But this time, we want to do a Custom Sort.  

 

So, I already have my sort applied here for everything with a Blue Background Fill, I can 

then add another level. And it doesn't matter which Column I select because the Background 

Fill applies to all Columns. But then I can choose Cell Colour in the ‘Sort On’ area, and I can 

choose Green. Let's click on OK. And you can see it's now pulled all of those records to the 

top of my List.  

 

Now when it comes to sorting and filtering based on the font colour, that works in a very 

similar way. So, let's go up to Sort, I'm just going to delete these Filters, and resort this List 

from Smallest to Largest to put everything back to how it was. So, if I wanted to filter this 

List so, that I only see the records that have a Purple font colour, I can go up to any of the 

Columns, go to Filter by Colour, and notice we have a Filter by Font Colour option.  

 

So, when I select this, that's exactly what I'm going to get. Once again, I can clear the filter 

from the Employee Name. And it works the same with Sort. So, if we go to any of the 

Columns, we can Sort by Colour. And once again, we can sort by the font colour, which is 

going to put those at the top of the List.  

 

So, just be aware of those options that you have if you happen to have Rows in your dataset 

that have a different style of formatting. 
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Video: Add Subtotals to a List  

Deb: In this lesson, I'm going to show you how you can apply Subtotals to a dataset. Because 

Subtotals effectively allow us to group together data, and then see totals for that specific 

group. So, what do I mean by that?  

 

Well, if we take a look at this spreadsheet, you can see that I have just some basic sales data. 

So, we have Region in Column A, we have Country in Column B, Department in Column C, 

Sales Period in Column D, and the Sales Amount in Column E.  

 

Now, maybe my manager has asked me to analyse this data, and extract from this dataset the 

total amount of sales per Region. Now if you take a look at the Region Column; Column A, 

you can see that these Regions aren't sorted in any way. In fact, this entire Table is sorted by 

Column D alphabetically. So, we have all of the sales for April, then August, then December, 

so, on and so, forth. So, I don't want to sort this data in that way, I want to sort by Region.  

 

So, the first thing we're going to do here is we're just going to apply a sort to Column A. Now 

we've seen before how we can do this, there are a few different methods, I'm going to right 

click my mouse, let's go down to Sort, and I'm just going to choose Sort A to Z.  

 

So, now you can see that that's put those Regions in alphabetical order A to Z. So, now, what 

I want to do is that every time the Region changes, I want to see what the Subtotal is for that 

particular Region. So, when we get down to the bottom of Africa, I want to see a Subtotal for 

all of these Sales Amounts.  

 

Now in Excel, we do have a Subtotal utility. So, I'm going to make sure that I'm clicked in 

the Region Column, we're going to jump up to the Data Tab, and all the way over in the 

Outline group, notice we have a Subtotal button just here. So, let's click on this. And now, we 

can choose our options for our Subtotal. So, notice at the top, it says; ‘At each change in’, and 

then it's selected Region.  

 

Now the reason why it's selected the Region Column is because that's the Column I was 

clicked in. But if I wanted to apply this Subtotal to other Columns in the data, for example, 

every time the Department changes, I could click the dropdown and choose Department from 

this List. Now we're doing Subtotals for the Region, so, let's keep it on that. We can then 

choose what function we want to use.  
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Now, notice here, the default selected is SUM. But I could choose COUNT, AVERAGE, 

MAX, MIN, PRODUCT, so, on and so, forth. So, maybe instead of seeing the total amount 

of sales for each Region, I want to see the count of the sales. Or maybe I want to see an 

average of the sales, so, on and so, forth. We're going to leave ours on SUM.  

 

We then get to choose which Column we're going to add the Subtotal to. So, where do we 

want this Subtotal to appear? Now, for me, because I'm totalling the Sales Amount, it's going 

to make more sense if I add it into that Column. So, you can see here I have Sales Amount 

selected in this List. And then underneath we have 3 additional checkboxes. The first one is 

‘Replace current subtotals’. So, I have this selected. If I already have Subtotals in my data, 

it's going to replace the current ones.  

 

I could choose to have a ‘Page break between groups’. So, if my manager wanted me to 

create multiple reports, where we just have the results for Africa on one page, and then we 

just have the results for Asia on another page, I could choose to add a page break so, that 

when I print this out, it's going to take on that format. 

 

Now, I don't want to do that in this case, so, we're going to deselect that box. And then we 

can choose if we want a ‘Summary below the data’. Now I'm going to keep this selected, just 

so, you can see what that does. So, once we've set all our options, let's click on OK, and you 

can see exactly what we get.  

 

We now have our Region Africa. And notice in Row 20, we now have Africa Total, and you 

can see over in the Sales Amount Column, there is the total for Africa. If I scroll down, we 

get the same for Asia, Australia, so, on and so, forth. So, this is a really nice way of quickly 

being able to group your data and perform calculations.  

 

Another thing you'll notice with Subtotals, is that we get these little outlines over on the left 

hand side. So, these are just here to enable us to change the way that we're viewing our 

dataset. Now, notice at the top, we have 1, 2, and 3.  

 

If I click on 1, it is simply going to show me the top level. So, that is the grand total of all 

Regions. If I click on 2, it's going to expand that out one level. So, now I'm seeing just a 

summary of all of the Regions and the Sales Amount without all of the records getting in the 

way. Notice that it's actually hiding those Rows. You can see our numbers, our Row numbers 
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are not consecutive. And if we click on 3, that's going to give us our bottom level, and this is 

where we can basically see all of our data.  

 

We can also, use the Collapse and Expand buttons on these outline levels. So, if I click on the 

little minus just here, it's going to collapse up that particular group. So, you can see it's 

collapsed up all of the Africa records.  

 

So, if I just wanted to focus maybe on the Asia Region, I could go through and I could 

collapse up everything else just by clicking on the minus, and I can really focus in on the 

information that I'm interested in. Remember, just click on the number 3, and that's going to 

put everything back again.  

 

So, that's basically how Subtotals work. If you have applied Subtotals and you want to 

remove them from your dataset, just make sure you’re clicked in your data, go back to 

Subtotal, and we have a Remove All button in here, and that's going to put your data back to 

how it was originally. 
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Video: Exercise 09  

Deb: It's time now to do Exercise 09. And in this exercise, I'd like you to practice some of the 

skills that you've learned in this section of the course.  

 

So, the first thing I need you to do is open the exercise file ‘Exercise09.xlsx’. I’d then like 

you to sort the data in the Table by ‘Pizza ID’ (Z-A), and then by ‘Pizza Size’ (A-Z). I'd like 

you to filter the data to only show sales for ‘The California Chicken Pizza’. And once you've 

got those results, I'd like you to clear the filter.  

 

And then finally, I'd like you to apply another filter to the data to only show sales where the 

total price is greater than $20. Once you have that result, I'd then like you to clear the filter. 

So, a few different things to do there. If you'd like to see my answer, then please keep 

watching.  

 

So, the first thing I asked you to do here was to sort this pizza data by the Pizza ID Column, 

and then by the Pizza Size Column. So, we're going to click in the data, we're going to go to 

the Data Tab, and we're going to click on the Sort button because we're applying multiple 

sorts.  

 

So, the first sort that I want to do is I want to sort by Pizza ID on the Cell Values, and I asked 

you to sort Z to A. We're going to add another level because we then want to sort by Pizza 

Size on the Cell Values A to Z. Let's click on OK to apply that sort. So, we should find that 

the Pizza ID Column, we have the ones that are towards the end of the alphabet first of all 

going down to the ones near the beginning, which is correct. And then we're sorting by pizza 

name, which goes in the opposite direction.  

 

I then asked you to apply a filter to only show orders for ‘The California Chicken Pizza’. So, 

let's click up in the heading Row, and we need to turn on Filters. We're going to click the 

dropdown next to Pizza name, I'm going to deselect everything, and we're only going to 

choose ‘The California Chicken Pizza’. Let's click on OK, and I can see that we have 4 

orders. I then asked you to simply clear the filter.  

 

And the final task in this exercise was to apply another filter to the Total Price Column to 

only show orders that were greater than $20. So, once again, we're going to click the 

dropdown in the Total Price Column, we're going to go to Number Filters, and we're going to 
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say ‘greater than’, and we're going to choose $20. Click on OK, and I can see that we have 19 

orders that were greater than $20. The final thing to do here was simply clear the filter.  

 

So, that's how we solved that exercise. I will see you in the next section. 
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Section 10: Move and Link to Data 

Video: Cut, Copy, and Paste  

Deb: One of the most basic and fundamental skills when you're working in Excel is knowing 

how to move and copy data around by utilizing cut, copy and paste. And as with most things 

in Microsoft, there are numerous different methods that you can employ to get this job done.  

Now in this first lesson, we're going to start out super basic and take a look at the simplest 

way to cut copy and paste data from one location to another. And then throughout the balance 

of this section, we'll take a look at a few more options you have such as paste options, and 

also, pasting from the clipboard.  

Now, notice here on the left-hand side, I have some Column Headings. And then over on the 

right-hand side, we have some data that corresponds to some of these Column Headings. So, I 

basically want to move or copy this data from the right-hand side over to the left-hand side.  

Now when you're thinking about working with cut, copy and paste, you're going to find all of 

these options on the Home Ribbon. In the Clipboard group just here, we have a big old Paste 

button, we have a pair of scissors that represents cuts, and then we have copy underneath. 

And you'll notice as I hover over each of these that we have a Keyboard Shortcut in brackets. 

And these are 3 of the most common Keyboard Shortcuts that you'll find yourself using all 

the time.  

Now, what's the difference between cutting and copying? Well, when we cut information, 

we're effectively moving it. And when we copy information when making a copy, so, let's 

take a look at that, first of all. So, let's copy these regions from Column F into Column A, I'm 

going to make my selection.  

Remember, if you have a much longer list, you can use the Keyboard Shortcut Ctrl + Shift 

+down arrow. And then we can either use the Keyboard Shortcut to copy these, or we can 

click on the button on the Ribbon.  

http://www.simonsezit.com/


 

 

 

 

 

 

       © Copyright 2023 Simon Sez IT, INC. All Rights Reserved. 161 

So, let's click on the button on the Ribbon first of all. I'm going to go up to copy, let's click 

Copy. Now as soon as I do that, notice what happens to the data in Column F, we get this 

little Green Border around the outside. And you'll commonly hear these referred to as 

marching ants, because that's exactly what it looks like. Now, all this means is that we have 

an active selection, and we need to do something with this selection.  

So, we have our copy data, let's move across to the Cell where we want to paste it. And then 

again, let's jump up to the home Ribbon. And we're going to click the top half of this Paste 

button. And that is simply going to paste that information in, we can press Escape to remove 

the marching ants from around our original selection. So, we now have a copy of that data 

really straightforward. I'm going to Ctrl + Z to undo because let's use Keyboard Shortcuts this 

time.  

Once again, we're going to make our selection. This time, I'm going to press Ctrl + C, we get 

the marching ants again. And then we can go to the Cell where we want to paste and press 

Ctrl + V to do a simple paste escape to remove those marching ants.  

So, copying data really simple. It is also, worth noting that if you make your selection, you 

can right click, and you're going to have cut, copy and paste at the top of the Contextual 

Menu as well. So, use whichever method you prefer.  

Now another way that we can copy data is we can I drag and drop it. So, if I take the 

countries this time, I'm going to press Ctrl + Shift + Down Arrow to make my selection. If I 

hover my mouse over the Border of this selection, until I get that double headed arrow, hold 

down the control key on my keyboard, I can then literally just drag this and drop it. And that's 

going to make a copy as well. So, you basically have 4 different methods for copying.  

Now what about cutting, I'm going to press Ctrl + Z to undo because when we cut, we're 

actually moving the information. And we can use all of the same methods just here. So, I'm 

going to press Ctrl + Shift + Down Arrow, I could choose to use the Cut button on the Home 
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Ribbon, I could right click my mouse and choose Cut from here. Or I can use the Keyboard 

Shortcut Ctrl + X.  

Once again, that's going to put the marching ants around the outside, I can then go to where I 

want to paste it and press Ctrl + V. Now notice this time we have something slightly different 

because we cut it it's actually moved it as opposed to making a copy. Let's Ctrl + Z to put that 

data back because we can drag and drop as well. So, Ctrl + Shift + Down Arrow to make our 

selection.  

This time we're going to hover our mouse over the Border. But instead of holding down the 

Ctrl key, we're going to hold down Shift and drag and drop. And this time it's going to move 

that data and the final one we're going to do is just the departments just here. I'm going to 

press Ctrl + C to make a copy Ctrl + V to paste those in.  

Now notice when you do a paste you get this little tag pop up at the side and if I hover my 

mouse over it, it says paste options because they there are numerous different ways that we 

can paste our information and that is exactly what we're going to cover in the next lesson. 
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Video: Paste Options  

Deb: In the previous lesson, we saw how we can use numerous different methods to move 

and copy data in our Worksheet. And we finished that lesson by briefly discussing paste 

options. So, now is the time to delve into that a little bit deeper.  

Now with all of the methods that we looked at in the last lesson related to cut, copy and paste, 

we were just doing a very basic cut, copy and paste. And what I mean by that is that we're 

using the Keyboard Shortcut to execute the command. And it's just going to do a default 

paste.  

Now if you go to the Home Ribbon and take a look at this Paste button, this is what we call a 

double headed button. And that means that it has a top half that is independent from the 

bottom half. Now if we click the top half of this button, that's just going to do a plain old 

paste. Whereas if we click the lower half of the button, this is going to open up our paste 

options. Now notice we don't have a great deal in here at the moment because we don't have 

anything copied.  

So, let's change that. Let's take this little dataset here, this little Table, and then press Ctrl + C 

to copy. When we click the lower half of the Paste button, notice that we now have many, 

many different options. And these are our paste options. And we're going to go through and 

take a look at a few of these.  

Now before we get onto that, if I just escape out of here, a few things to know about this little 

Table of data that we're going to be using in this example. You can see here, we just have 

some months, we have some sales figures, we have the tax, and then we have the total. And 

you can see that the total is actually a Formula, we're doing sum B6 × C6, and then we're 

adding B6. And that's given us the sales total inclusive of tax. And you can see that these 

have also, been formatted using a counting number format.  

Now what else do we have in this dataset? Well, we have a heading Row, and that has a 

Background Fill applied. And we also, have some Borders around the outside of our data.  
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If you recall, if we were to remove the Gridlines, adding Borders helps that information stand 

out from the page. Now if I want to copy this entire Table and paste it somewhere else, I 

could just do a plain old copy and paste. Or I could use paste options to kind of pick and 

choose what exactly I want to paste.  

Now you can see just next to this, I have a little heading called paste Formulas. So, if we 

make our selection, let's do Ctrl + C to copy it, I'm going to click in Cell F 5, which is where 

I want to paste it, go to the Home Tab, click the dropdown underneath paste. And if I hover 

my mouse over this first icon, you can see that that is simply doing a plain old paste. So, this 

is exactly the same as if you were to press Ctrl + V. But the next one along is paste Formulas.  

Now notice what happens when we select this. This is a paste where we're basically removing 

all of the formatting, but we're keeping the Formulas. Now remember, this already had a 

Grey background. But you can see that it's removed the formatting from the header Row, it's 

removed the Borders, it's even removed the formatting that I've applied to the sales and total 

Column.  

It's also, removing percentage formatting from the tax Column just here. But if we click on 

one of these totals, notice that the Formula is still there if we look in the Formula Bar, so, if 

you just want to take some data, but you don't want the formatting, but you do want to 

preserve the Formulas, then this is a good option to use. Let's do it again.  

Let's copy Ctrl + C, this time, we're going to paste just the formatting. So, I'm going to click 

in Cell k 5, let's go to our paste options. And if we hover over the next icon, notice this says 

Formulas and number formatting.  

So, if you take a look at how this is displaying in the Worksheet, you can see that it is 

keeping the Formulas and it's keeping the number formatting, it's not bringing across with it 

that Yellow Border like Background Fill, and it's also, not bringing across the Borders. So, 

again, this is another really good one to use if you've been sent a messy dataset. And whilst 
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you want to keep the actual values and all of the Formulas, you want to remove all of the 

formatting and apply your own. This is a good option to use in that scenario.  

If we hover our mouse over the next icon along this is Keep Source Formatting. So, if you 

just want to paste it as is as it looks in the original, you would use Keep Source Formatting. 

Again, this is very similar to simply doing a paste or Ctrl + V.  

There's also, another one related to formatting underneath paste values. You can see here we 

have values and source formatting. So, that is going to keep the values it's going to bring 

across the source for formatting. So, we have our Yellow title, but one thing is not going to 

do is bring across the Formulas.  

So, if we click on the total Cells look in the Formula Bar, it's actually removed that some 

calculation. So, we still have the actual total, we just don't have the Formula underneath. So, 

just be aware of those 3 different options. When it comes to pasting formatting. Let's select 

our original Table again, Ctrl + C, because this time, we're going to paste Column Widths.  

Now, one thing you may or may not have noticed is that in the last example, notice that the 

month Column is slightly narrower than the original that we copied from. And you'll often 

find this you might create a Table and you'll adjust your Column Widths to suit whatever data 

you have.  

Now, if you just copy data and paste it in using Ctrl + V, it's not going to bring across the 

Column Widths, and it will literally auto fit all of the common weights to accommodate the 

data within your Cell. And if you have a very specific set of Column weights that you want to 

bring across, then that's going to be a little bit tedious, because we're going to have to go in 

and manually adjust those Columns.  

So, if I wanted to paste this data and keep the exact Column weights that I have set here, this 

is where we can go to add paste options, and we can choose keep source Column wits. When 

we click that option, you'll see that those Column weights are exactly the same as the 

original.  

http://www.simonsezit.com/


 

 

 

 

 

 

       © Copyright 2023 Simon Sez IT, INC. All Rights Reserved. 166 

What's the next one? Well, let's select our data again. And this time, I'm going to click in my 

data and press Ctrl + A, Ctrl + C to copy, I'm going to click in the Cell. And this time, we're 

going to do paste no Borders, this option, just here will do exactly what you might expect, it's 

going to paste everything, but it's going to remove those outside Borders that we set, let's Ctrl 

+ A, Ctrl + C to copy once again, the next option we have is paste values.  

Now paste values is this icon just here. And if we select this again, you're going to see 

exactly what that's going to do is going to paste just the values and it's going to remove any 

underlying Formulas. This is sometimes useful if you have quite a complex Formula, but then 

you just want to remove all the Formulas and just have the number like we have here. That's 

quite a good one, because it will remove everything.  

You can see I'm clicked on one of these total Cells, and in the Formula Bar, we no longer 

have that Formula sitting there. And then the final option I really want to speak to you about 

is the transpose option. Now transpose you're going to find underneath Paste Special. So, if 

we click in our first Table Ctrl + A, Ctrl + C, and click down here. Let's go back to paste. 

Now you won't find transpose as one of these little icons, we need to jump in to Paste 

Special, which is going to give us more ways that we can paste.  

Now this is where we're going to find the transpose option. So, let's click on transpose, click 

on OK. And you can see what that does the transpose feature will basically flip your data 

around. So, instead of having these Column Headings running across the Columns, we now 

have them sitting in the Rows and the data has been flipped around the other way. This is 

super useful if you quickly need to do that. Or if you have data that starts out in this format, 

and you want to switch it back round, you could use transpose then as well.  

Now with that Paste Special Menu, we have a lot of repeats of the icons that we have 

underneath paste. For example, we can paste Formulas, values, formats, comments and notes. 

That's another one. We can paste data validation. We can paste everything except the 

Borders, so, on and so, forth. We also, have an operation section in here.  
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Now that is outside the scope of this particular lesson, but we will get onto that a bit later on. 

So, just be aware that pasting is a lot more complex than it might first seem. We have lots of 

different options that will help us out when we don't just want to do a straight copy and paste 

of the original source data. 
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Video: Paste from Clipboard  

Deb: When you're working with cut, copy and paste, it's important to understand exactly 

what's happening behind the scenes. Because understanding what's going on is really going to 

help you when it comes to copying or cutting and pasting multiple pieces of data in a 

Worksheet.  

So, what do I mean by that? Well, we have a small amount of data, just here, we have some 

employee names, and we have their department.  

Now, it might be that I just want to extract all of the employees who were in the IT 

department, and I need to produce a list just here. Now, of course, there are various different 

Formulas that we could use to do this. And I would always recommend automating this by 

using a Formula if you have a very long list. But just in this example, this is a good way to 

demonstrate how we can use the clipboard.  

Now, notice here that in the original list, employee name is Column one, and department is 

Column 2. Now when I paste, I want to have the department in Column one and the 

employee’s name in Column 2. So, if I was copying and pasting these manually, I'd go to 

department Control C, I'd go over here, control v, then I'd go and grab the employee’s name, 

Ctrl + C, go over here, Ctrl + V, so, on and so, forth. But that is all extremely slow.  

Now when you copy something, so, let's say Ctrl + C, just here, Excel places it onto the 

clipboard, and the Clipboard is something that kind of sits in the background. However, we 

can see all of the items that we currently have held on the clipboard ready to paste.  

If we go up to the Home Tab in the Clipboard group, let's click on the little diagonal arrow, 

this is going to open up the clipboard. And you can see on here the last things that we copied 

to the clipboard, and this clipboard can hold up to 24 items.  

Now you might be thinking, Okay, that's great. But why is this useful? Well, I'm going to 

clear out everything that we have in here so, far, let's leave the clipboard open. Because what 

we can do is basically copy multiple items to the clipboard, and then choose which ones we 
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want to paste. So, this is really useful if you're doing this kind of task. So, I'm going to grab it 

Ctrl + C, let's grab the employee’s name, Ctrl + C, go to the next one, Ctrl + C, Ctrl + C, so, 

on and so, forth.  

So, we can basically collect everything on the clipboard, and then we can go in and paste. So, 

I'm going to click in department, I can then go in and I can click to paste it in, I can go to the 

next one, I can click to paste in the next one clicks to paste in, so, on and so, forth. And then 

we can paste the employee names into here.  

So, in general, using the Clipboard is a little bit quicker than doing it manually. It's also, 

worth noting that when you hover over any of these items on the clipboard, we have a little 

drop-down arrow where we can choose to paste it or we can choose to delete.  

Now you don't have to go in here to paste as you saw, when I did this, I simply just clicked 

on the name that's going to do a paste as well. And if you click options at the bottom, we 

have some different items that we can toggle off or toggle on. For example, we can show 

clipboard automatically.  

So, if you find yourself using the clipboard all the time, you might want to have this 

automatically show as soon as you start copying information. Or you can show the office 

clipboard when Ctrl + C is pressed twice, so, on and so, forth. So, take a look at these options 

and modify according to your needs.  

It's also, worth noting with any of these little panes that you see on the side, we can click and 

drag them out and make them a little floating pane. So, you can choose to place this wherever 

you like or if you drag it all the way back over to the left-hand side it's going to dock that 

pane. And if you want to clear all of the items that you currently have held on the clipboard 

and start again, we have a Clear All button. And obviously we can click the cross to close that 

pane down.  

So, don't forget about the clipboard. It can be really useful when you're trying to copy cut or 

paste multiple selections. 
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Video: Move and Copy Worksheets  

Deb: In the last few lessons, we've been taking a look at how we can move and copy 

information from one Cell to another. So, in this lesson, we're going to move on from that, 

but still stay within the same subject. 

I want to show you how you can move and copy Worksheets. So, I've got a Workbook open 

on the screen here that has quite a few different Worksheets. If you take a look at the bottom, 

we have a talk or a Table of contents. And then we have some region Tabs.  

So, on the UK Tab, I can see an image of UK and I can also, see a small dataset that shows 

all of the months of 2022 and the sales generated. So, maybe these are sales for a particular 

global company, we have pretty much exactly the same format on all of these Tabs.  

I have a USA Tab with the USA sales. We have Germany, we have Japan, and we have 

Australia. And then finally we have a total sales Tab that hasn't got any totals completed as 

yet. And we are going to get on to that in a couple of lessons time. But in this lesson, let's talk 

about how we can move and copy Worksheets.  

So, if we click on the UK Tab, for example, maybe I want to add another country. And 

instead of just adding a new blank Worksheet by clicking on the plus, I could choose to copy 

the Tab instead, so, that I'm not starting from a completely blank canvas. So, let's delete out 

the Worksheet that we just added. Because I want to copy this one.  

Now the reason why I'm copying it is because it just makes it a little bit quicker for me to add 

information. I already have the correct formatting applied to this Worksheet; I already have a 

space for the Picture. And I already have my Column Headings. So, all I would really need to 

do if I was using this for a different country is update the sales figures and the total, 

everything else would be done for me.  

Now when it comes to copying a Worksheet, of course, there are a couple of different ways 

that you can do this, we could right click on the UK Tab, and go to move or copy. So, this 
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will open up the Move or Copy dialog box. So, effectively, we can do either operation here, 

we can either move the Worksheet or we can copy it.  

Now it's worth noting that when you're in here, the default action is to move the Worksheet. 

If you want to create a copy, you need to make sure you select create a copy at the bottom 

just here. Once we have that selected, we can then choose where we want to copy this 

Worksheet to. So, we could choose to keep it within the same Workbook. And you can see 

my Workbook is titled working with Worksheets. Or if I wanted to copy this to a completely 

new Workbook, I could choose new book just here.  

So, let's go for new book, click on OK. And you can see what it's done. It's opened up a 

brand-new Workbook, you can see that it just says booK1 at the top. And the only Worksheet 

that we have in this Workbook is the UK Worksheet. So, very simple to copy to a brand-new 

Workbook. I'm going to close this down, and we're not going to save.  

Now what about if we use this method again, it's going to move or copy create a copy. But 

this time, I'm just going to keep it within this Workbook, we can then choose where we want 

to place the copy of this Worksheet. And you can see here it says before sheet. And then we 

have all of the sheets now Workbook listed out.  

Now if I wanted this right at the end, I can simply select Move to End, click on OK. And you 

can see what it's done, we now have another copy. And this one is called UK 2, I can then go 

in and I can rename this to whatever I want to name it too.  

So, let's go for China and hit enter. I would then go in and I would update the title just here. 

So, I want to change this to China region. And then I can simply switch out the Picture and 

go in and add my totals. Now let's delete this China Worksheet out. Because I want to show 

you another method you can use.  

Now this tends to be my go-to method simply because it's a lot quicker. If I want to copy this 

UK Worksheet, all I need to do is hold down the Ctrl key and drag and drop that Worksheet 
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to the site. When I let go is going to create an exact copy, then I can go in, I can rename and I 

can switch out my data. So, control drag and drop is in general a lot quicker.  

Now we can do this for multiple Worksheets as well. So, if I wanted to maybe create a copy 

of the UK, USA and Germany Worksheets, I could select UK hold down Shift and select 

Germany which is going to select all the Worksheets in between. Now with this method, we 

can't hold down Ctrl and drag that doesn't actually work we would need to right click Go to 

move or copy. And then we can choose where we want to move these 2.  

So, let's do new book. I'm going to say create a copy. Click on OK. And it's going to copy 

those 3 Worksheets across to a brand-new Workbook. So, copying is really simple. But what 

about moving? Well, again, that is also, very simple. If I want to move the UK Worksheet 

right to the end, I can simply click drag and drop it wherever I want it to be.  

Notice as I click and drag, I get that little arrow, that's going to show me where it's going to 

appear when I drop it. So, I could drop it in between Germany and Japan. And it's going to 

move it just there. So, really nice and simple.  

If you do want to use the right click method to move, you can do that as well. So, maybe we 

want to move all 3 of these, I can right click, move or copy. And this time, because move is 

the default action, we don't need to select the Create a Copy dialog box, I can choose to move 

these to a new Workbook or move them somewhere within the same Workbook. I'm going to 

say Move to End click on OK. And you can see it's done exactly that.  

Now it's worth noting that we can drag and drop multiple Tabs if we're doing a move. So, I'm 

going to hold down Shift and select UK, USA and Germany, I can simply drag and drop to 

the new location and it's going to move those 3 Worksheets. And of course, if you want to 

move or copy Worksheets that aren't necessarily next to each other, you can do that as well.  

So, maybe I want to select the UK, Germany and Australia. I can simply hold down Control, 

select Germany, select Australia, and then I can move or copy. So, those are the methods that 
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you have when it comes to moving and copying Worksheets either to a completely new 

Workbook or to a different location within the same Workbook. 
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Video: 3D Referencing  

Deb: In this lesson, we're going to take a look at how we can utilize 3d referencing to 

effectively consolidate totals across Worksheets.  

So, we're going to stick with working with the Workbook that we were looking at in the 

previous lesson. This is the one with all of the different Tabs at the bottom, where we have 

sales figures for different regions.  

Now, one difference that I've made since the last lesson is that I've removed the totals from 

all of these Cells. So, in the UK region, you can see the total here is blank. If I go to the USA 

Tab, the total is blank, so, on and so, forth. And the first quick tip here is that if you have 

consistent data, and what I mean by that is, if you have a Worksheet like I have here with 

month, and sales, and then we have exactly the same on the next Worksheet, you can see 

month and sales, those are located in the same Columns on every single Worksheet. 

 Now if you do have your dataset up like this, we can very easily calculate the totals across all 

of these Worksheets without having to do it manually. Now when I say manually, what I 

mean is we could start in the UK Worksheet, we could type in equals (꞊) sum (+), open a 

bracket, we could select all of the sales, close the bracket, hit enter to get the total, we can 

then move on to the next Worksheet and do exactly the same.  

Of course, alternatively, instead of typing in some, we could simply do Alt equals, that's 

going to give us the total as well. But it still only completes it for the first Worksheet, I would 

need to go to the next Worksheet, do the same thing, the next one, do the same thing, so, on 

and so, forth.  

Now that can be pretty tedious, particularly if you have a lot of Worksheets that you need to 

add the total for. So, let me show you a much quicker way. All we need to do here is make 

sure that we've got the first Worksheets selected, and that we're clicked in the Cell where we 

want the total to be, we can then select all of the Worksheets where we want to add a total. 

So, for me, that is UK to Australia.  
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So, I'm going to hold down Shift to select all of those Worksheets, and then I can simply 

press alt equals, and enter. And because I've done this calculation with all of these 

Worksheets selected, it means that when I go to the USA Tab, the total is completed. The 

same for Germany, the same for Japan, and the same for Australia. So, we've added a total 

across multiple Worksheets in one go. How cool is that?  

Now that we have these totals, if we jump across to the total sales Worksheet, notice that this 

is where we consolidate all of the sales from across the different regions. So, in here in Cell 

B4 I want the total sales for January for all of the different region’s UK, USA, Germany, 

Japan, and Australia.  

So, you might think that the way that you do this is to type in =SUM, open a bracket, then 

click on the first Tab UK, select the sales total, for January, comma, jump across to the USA, 

select the sales total for January and carry on going. So, let's jump across to Germany, select 

the January total. We're going to go to Japan, select the January total. And finally, we're 

going to go to Australia and select the January total.  

Let's close off the bracket and hit enter. It does give us the total. But again, this was quite a 

slow method. And if we take a look at the Formula, you can see that is reasonably long. This 

would be even longer if we had more Worksheets.  

So, let's take a look at a better way. I'm going to delete this total out because what we can do 

is employ 3D referencing. So, what we can do instead here is we can click in Cell before we 

can type in =SUM, we can select the first Worksheet, which is the UK Worksheet, hold down 

Shift and select the last Worksheet which is Australia.  

Now if you just take a moment to look in the Formula Bar, you can see it says sum. And then 

we have UK 2 dots Australia. So, that basically just means UK to Australia Worksheet, you 

can then see that we have an exclamation point. Now this exclamation point is purely here to 

separate the Worksheet names from the Cell Reference that we're going to provide in a 

moment.  
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So, it's going to sum everything on the UK to Australia Worksheets. We don't want it to sum 

everything in this case, we just wanted to sum the January sales. So, I'm going to select the 

January Cell just here. Now notice it does put in again, UK to Australia f4. You don't actually 

need all of this; we just need the Cell Reference.  

So, we can literally delete out everything else that we have up here and just have f4 Let's 

close the bracket, hit enter. And you can see what it's done there. It's consolidated all of those 

totals, again, if you glanced in the Formula Bar with summing the f4 Cell on all of the 

Worksheets between the UK and Australia inclusive, and just to make sure that's correct, I've 

quickly gone in I've just copied and pasted all of the January totals into a Column.  

So, now if we add those up, or equals and hit enter 84318, it should be exactly the same as 

what we have on the total sales Worksheet, which it is. So, now that I have this Formula up 

here, and because the format of my data is the same on every single Worksheet, I can simply 

use the AutoFill handle to copy this down.  

Now I could also, include the totals so, if I copy down again, it's going to give me the total. 

Alternatively, I could just stop there, do Alt equals hit enter, and I get the total at the bottom.  

So, using 3D referencing can be a really quick and simple way to total up values across 

different Worksheets. 
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Video: Insert Hyperlinks to Worksheets  

Deb: Hyperlinks are another really useful way that we can link to other Worksheets within 

our Workbook. And it is worth noting that you can use hyperlinks to link to many things, not 

just Worksheets within a Workbook, but that's what we're going to focus on in this particular 

lesson.  

Now we're working in the same Workbook. This is the one with the region Tabs at the 

bottom with our sales totals. Now notice at the beginning of this Workbook, we have a 

Worksheet called it TOC. And that stands for Table of contents. And this is a summary page 

that I always like to have at the beginning of my Workbooks.  

A summary page can contain all different kinds of information to really help out anybody 

who's looking at this Workbook. We might have things on here like legends, which explain 

the Background Fill Colours that we've used, maybe we have instructions on the summary 

page as to where to save the Workbook, or how often it should be updated. And another thing 

that's always really useful to have on your cover page or your summary page are quick links 

to other Worksheets. And this is particularly useful if your Workbook is reasonably large, and 

maybe you have 20, 30, 40 different Tabs, you want to ensure that you and anybody else 

looking at this Workbook can navigate easily and efficiently. And one way to do that is to 

create links to the different Worksheets.  

So, you can see here on this Table of contents page, I have just the sheet names. So, we have 

UK, USA, Germany, Japan, Australia, and total sales. These correspond to my Worksheet 

Tabs at the bottom, and I want people to be able to very easily jump to the Worksheet that 

they're interested in.  

Now, notice here that I have a Column called link. Now you don't necessarily have to have a 

Column called link. In fact, I think I'm going to delete this out. And let's just clear the 

formatting from that Cell. Because what I'm going to have instead is I just want the sheet 

names to be hyperlinks, which we can click on to jump to the specific Worksheet. So, let's 

click on the first one here, UK.  
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Now when you're inserting hyperlinks, you can insert them from the Insert Tab. Notice we 

have a links group just here, which will allow us to insert hyperlinks. Alternatively, we can 

right click, and we have a link option just here with a little menu that shoots out to the side. 

Well, the quickest way to do this is to use the Keyboard Shortcut Ctrl + K, that's going to 

open up the Insert Hyperlink dialog box.  

Now the first thing to note about this little dialog box here is that on the left-hand side, we 

have a link to section. As I mentioned, you can link to other things aside from other 

Worksheets in the Workbook, we could choose to link to an existing file or a webpage.  

So, if I wanted this link to go to an external website, I could use this option and simply copy 

and paste the URL of the website in this address bar at the bottom, I can also, link to an 

existing file. So, you can see here it's looking in my current folder, which is course files, one, 

and it's showing me all of the different files that I have in that folder.  

So, if I wanted this to be a link that when I click on it, it opens up a specific file, I could 

choose that option. I could also, link to an email address. So, if this was somebody's name, 

and I wanted people to be able to click on the name, and it will automatically open up a new 

Outlook email address to that person, I could use this option.  

Now in this case, we're going to use the place in this document link. Because this is what we 

go to if we want to link to other sheets within our Workbook. You can see as soon as we click 

on Place in this document, it's going to show all of the Worksheets in our Workbook. It's also, 

worth noting that if you have things like named ranges in your Workbook, those will show in 

here as well underneath Defined Names.  

Now, I don't have any in here, but if I did, I would see them listed here, I could also, choose 

to link to those named ranges. Now this first one is fairly simple, we just want to link to the 

UK Worksheet. So, I'm going to select it just here. So, let's just do that. First of all, click on 

OK. And you can see immediately what happens, we now get a little hyperlink. When we 
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click on it, it's going to jump us to the UK Worksheet. So, I could go through and do the same 

for each of these.  

Now it is worth noting that you can't do them in bulk because each one of these is going to a 

different page. So, you have to keep going in Ctrl + K place in document and this time we're 

linking to USA. Now another thing that we can do in here is we can type in the Cell 

Reference that we want to jump to when we go to this particular Worksheet.  

So, currently, it's going to place my cursor in Cell A1, which is a fairly natural place for this 

cursor to be. But say I wanted my cursor to be placed in a very specific Cell. Maybe when I 

click on this link, I want to jump to the USA Worksheet. The Cell contains the total sales 

value. And that is Cell F16. I can type that in there, click on OK, notice what happens, we can 

click, it's going to jump us to the USA Worksheet and check out where my cursor is. It's in 

Cell F 16, where we have that total sales value. Pretty cool. Let's go back Ctrl + K1 more 

time.  

Another thing that we can do in here is we can link to our page. And we can also, change the 

text to display. So, by default is just going to display whatever's in the Cell. But if you 

wanted to change this, you could type in, for example, Germany, let's say, sales, I could type 

that in. And I could also, add a screen tip. So, if you want to add a little pop up, which tells 

people some information or maybe gives them some guidance, then this is a good place to do 

it. So, I could say, click here to jump to the Germany Worksheet. Click on OK. Let's click on 

OK.  

Again, notice it's changed to Germany sales. If I hover my mouse over that link, I get that 

screen tip. And then when I click on it, it's going to jump me to that Worksheet. So, I'm going 

to go through and I'm going to add hyperlinks to Japan, Australia, and total sales.  

Now something else I always like to do is I like to add a back button or a back arrow. So, I 

can quickly jump back to this Table of contents page from any page that I'm on. For example, 

if I click on total sales, that's going to jump me all the way across to here, what I could do is 
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at the top here, I could add a little piece of text, I could add an image, I can add an icon, and 

then I can turn that into a hyperlink. Now we haven't discussed images or icons as yet. So, for 

the time being, I'm just going to type the word home at the top here.  

Now that's a little bit big. Let's take that down. I'm just going to centre it in the Cell. And 

maybe I want to give that a Background Fill of light Purple so, that it stands out. So, what I 

could do here is I could select it Ctrl + K, and maybe when they click this, it jumps back to 

the Table of contents. Let's click on OK, you can see what that does. And now when I click, 

it's going to jump me back to the beginning.  

Now if you're wondering where these hyperlink colours come from, those are controlled by 

your theme. And we're going to be taking a look at themes and how to modify themes and 

hyperlink colours a bit later on in this course, but for the time being, that's how you can add 

hyperlinks into your Workbook to make it easy to navigate to different Worksheets. 
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Video: Exercise 10  

Deb: It's time now to do Exercise 10. And in this exercise, I'd like you to practice some of the 

skills that you've learned in this section of the course.  

So, the first thing I'd like you to do is open the exercise file, ‘Exercise10.xlsx’. I'd like you to 

copy the Worksheet named 2018, 4 times. And I'd like you to name the new Worksheets 

2019, 2020, 2021, and 2022.  

So, you should end up with 5 Worksheets in total. I'd then like you to use Find and Replace to 

change the dates in Column E to match the corresponding year. So, when you copy the 2018 

Worksheet, it's still going to contain at 2018 dates in the Order Date Column. So, just make 

sure that you use Find and Replace to change those to match the Worksheet name.  

I then like you to convert all datasets into Tables on each Worksheet. And I'd like you to 

name the Tables again, according to the Worksheet name, sales_2018, sales_2019, so, on and 

so, forth. Once you have them in Tables, I'd like you to turn on the Totals Row, but ensure 

that it shows the total of the total price Column  

Next on the summary Worksheet, I'd like you to link to the Cells that contain the totals for 

each year on each Worksheet. I then like to use 3d referencing to calculate the total amount of 

sales for all of the years. And I've just got a little note in here, don't just sum the values 

above, I'd like you to practice 3D referencing.  

And then the final part of this exercise is just to add in some hyperlinks to the summary 

Worksheet. So, I'd like you to add hyperlinks to Cells A19, to A20 to that link to the 

corresponding Worksheets. And I'd like you to ensure that those hyperlinks jump directly to 

Cell B4 on each Worksheet. So, we have quite a lot to this exercise, give it a go. If you'd like 

to see my answer, then please keep watching.  

So, the first thing I asked you to do for this exercise was to copy the Worksheet 2018 4 times. 

So, I'm going to hold down Ctrl. I'm going to drag and I'm going to drop, we're going to 
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double click and we're going to rename it 2019. And I'm going to do the same drag and drop, 

then we want 2020 Drag and Drop 2021. And then finally drag and drop, and rename to 2022.  

I then asked you to utilize Find and Replace and update all of the order dates on each 

Worksheet. So, the first one is correct, because these are the dates for 2018. But if we go to 

2019, we want to change these order dates to 2019 dates.  

So, I'm going to select Column II Ctrl + H to bring up Find and Replace, we're going to look 

for 2018 and we're going to replace with 2019 Replace all okay, and close, I'm going to do 

exactly the same on the other 3 Worksheets. I'm going to do off camera just to save a little bit 

of time.  

The next thing to do here was to turn all of these datasets into Tables and give them a name. 

So, let's do the first one, I'm going to click on the Table Ctrl + T, yes, my Table has headers, 

let's click on OK. And I don't particularly like that formatting. So, I'm going to click Table 

Styles and just choose no formatting. And then I'm going to give my Table a name on the 

Table Design Ribbon of sales underscore 2018. Again, I'm going to repeat that process for 

each of these Worksheets off camera.  

The next thing to do here was to turn on the Totals Row for each of these Tables. So, once 

again, let's do it for the first one, I'm going to click in my Table on the Table Design Ribbon, 

I'm going to make sure I select total Row.  

Now notice that by default, it's basically done a count of all of the pizzas. But I asked you to 

change this so, that we're summing the total price. So, I want to change this to none over 

here, I want to go to total price, and we're going to do a sum. That's what I want. Once again, 

I'm going to go through and do this on all spreadsheets.  

The next thing to do here is to link to those total sales in the total Row on the summary 

Worksheet. Now because we've copied this Worksheet, and we haven't really made any 

changes to add data, these values are all going to be the same for each year.  
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Now of course, if you want to make this a little bit more obvious, you could go into these 

other spreadsheets and just change some of these numbers so, that they're a little bit different. 

I'll leave it up to you is a good way of checking if you've done things correctly. But all I 

needed you to do here was simply to use Cell linking.  

So, we're going to type in equals, we're going to jump across to the 2018 Worksheet, and 

we're simply going to select the total Cell. Let's hit Enter to pull that through. And I'm going 

to do the same for all of these. So, let's go equals 2019. Total sell, hit enter. As I said, yours 

will probably be exactly the same. If you haven't made any changes. Let's go to 2020. Hit 

enter, again equals for 2021, select the total Row equals again, for the last one, select the 

Cell, hit Enter. So, that is what I was looking for.  

Now the next part of the exercise was to use 3D referencing to work out the grand total. And 

I was very clear at the beginning that I don't just want you to add up all of the sales above. Of 

course, we could do that. But I simply want you to practice 3D referencing.  

So, remember, with 3D referencing, it's where we were referring to exactly the same Cell 

across all of these different spreadsheets. So, we're going to type in =SUM, we're going to 

open a bracket, I'm going to select 2018, hold down Shift and select 2022. And we're going to 

choose the total price Cell, close the bracket, hit enter. And let's apply some formatting. And 

there we go; we get the total. And if you want to check if that is correct, we can simply 

highlight everything above. And if we look down in the status bar, we should find that the 

sum calculation is the same as our grand total calculation.  

And the final thing to do in this Worksheet was just to simply create some hyperlinks to the 

other Worksheets. And I said that when you create these hyperlinks, I want you to make sure 

that you end up in Cell B4 on each Worksheet.  

So, what we're going to do here again, we'll do it for the first one, we'll right click More go 

into link, we're going to say place in this document, and then we're going to link to the 2018 
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Worksheets. And I want to make sure that we jump to Cell B4 click on OK, we need to do 

exactly the same for all of the others.  

Let's do one more Ctrl + K will also, bring up that Insert Hyperlink dialog box. This time 

we're going to 2019 we want it to go to Cell B4. Click on OK. And that is it. I hope you got 

on OK with that. I will see you in the next section. 
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Section 11: Introduction to Intermediate Formulas 

Video: Lookup Functions: VLOOKUP Explained  

Deb: In this section of the course, we're going to start to explore some of the basics of 

Intermediate Functions in Excel. And whilst Intermediate Functions are outside the scope of 

this beginner’s course, I thought it would be good just to throw in a section where we start to 

take a look and get used to using more complex Formulas.  

 

The Formulas that I've cherry picked essentially for this section are popular Formulas that 

you're going to come across frequently. And we're going to start out in this lesson with 

probably 2 of the most popular functions in Excel; VLOOKUP and XLOOKUP. So, let's start 

out by talking about VLOOKUP. Because normally, when we're discussing the topic of 

lookups, this is the first function that people learn.  

 

Now, if you're not sure what Lookup Functions are in Excel, the first thing to know is that if 

you go to the Formulas Bar, the Functions Library has a Lookup & Reference group. And this 

is where you're going to find all of your Lookup Functions. And there are quite a few of 

them.  

 

You can see that we have HLOOKUP in here, we have LOOKUP, we also, have if we scroll 

down towards the bottom, VLOOKUP, and of course, the newer XLOOKUP. Now we're not 

going to discuss all of these, but we are going to talk about VLOOKUP first of all.  

 

Now if you're not sure what a Lookup Function does, it basically allows us to look up 

information using one Column and return information from another Column. So, what does 

that exactly mean in practice? Well, if you take a look at the spreadsheet just here, I've 

constructed a Movie database. So, we have some Movies, the Year that they were released, 

the Certificate that they've been assigned, the actual Release date, the Runtime, the Genre 

they belong to, and then we have their User Rating.  

 

Now what I want to be able to do here is I want to be able to select a film in Cell J3, and have 

it return the Year that it was released, the Certificate, the Genre, and the Rating. Now I have 

my data and my Table of data on the same Worksheet as where I want my results. You could 

be doing this across different Worksheets, it doesn't make too much of a difference; the 

Formula is the same.  

http://www.simonsezit.com/


 

 

 

 

 

 

       © Copyright 2023 Simon Sez IT, INC. All Rights Reserved. 187 

 

Now the first thing I'm going to do here is I'm going to put my dataset into a Table simply 

because that's going to make my selections a lot easier. So, let's click in the data and press 

Ctrl + T. Yes, my Table has headers, let's click on OK, and now I have my Table. Now, how 

do I feel about this formatting? It's not too bad, I think I'm going to remove Banded Rows just 

to make it a little bit cleaner. I'm also, going to name my Table.  

 

So, let's go to the Table Design Tab, into Table Name, I'm just going to call this Movies, and 

hit Enter. So, now, when I'm constructing my Formula, I'm going to be using Table 

References in the Formula as opposed to Cell References. We've spoken about this 

previously.  

 

Now another thing that we could do here to make our life a little bit easier, is we could create 

a little dropdown there so, that we can select which film we're interested in. And you know 

what, just to avoid confusion, I'm going to change this to Movie as opposed to Film to keep 

things consistent. In the UK, we tend to see Film as opposed to Movie.  

 

Now creating dropdown list is probably one of my favourite things to do in Excel, because it 

makes everything so, much more efficient. And it also, stops errors going into your 

spreadsheet. So, what I could do here is I could type in the Movie names, let's just go for 

Moonlight. But every time I want to change the Movie, I would have to go in and type the 

name of the Movie in. It's going to be much easier just to select from a dropdown list.  

 

So, what we can do here is if we jump up to the Data Tab, and go to the Data Tools group, we 

have a Data Validation option just here. Now, if we click this and go into Data Validation, 

there are many different things that we can do in here. But in this particular scenario, on the 

Settings Tab we want to choose List. We can then choose what we want to include in our list.  

 

So, for me, I want to include all of the Movie names. So, I can simply go across to the Title 

Column, hover over the title heading until I see that Black Dropdown Arrow, click once and 

it's going to select that entire range of Movies. Let's click on OK. And now notice in Cell J3, 

we have a little Dropdown Arrow, and we can select whatever Movie we're interested in.  

 

So, this is a lot quicker and it also, prevents people just from free typing whatever they want 

into the Cell. So, now we have our dropdown, we want to use this information the Movie 
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Title and return the Year, the Certificate, the Genre, and the Rating. So, let's click in Year and 

we're going to go straight into VLOOKUP.  

 

Now with VLOOKUP we have 4 arguments with the last one being optional. The first 

argument is the lookup value. So, this is the piece of information that you want to look up in 

the Table. And this always needs to be a unique value. For example, if I had 2 Movies in 

Column A called Manchester by the Sea, it's going to return the first one it finds in the Table 

and not the second one.  

 

So, in general, your lookup value needs to be unique for this to work correctly. Of course, 

there are workarounds when you're dealing with duplicates. But in this lesson, I know that all 

of the Movies in Column A are unique. So, our lookup value is whatever has been selected in 

Cell J3. Remember, this is dynamic, because we have that dropdown list, this could change, 

comma. Table array; where are we looking up this information?  

 

Well, we're looking it up in the Table on the left hand side. So, I'm going to go in and I'm 

going to select the entire Table. Again, I'm just going to click where we have that Black 

Dropdown Arrow, and I'm going to select all of the Columns.  

 

And you can see here it picks up that this is the Movies Table, because that's what we named 

it. Tab to select and comma. Column index number is the third argument. So, this is where 

we tell Excel which Column of information we want to return. Now in this case, we're 

looking to return the Year of the Movie.  

 

Now one thing you need to understand about VLOOKUP is that it numbers Columns from 

left to right. So, effectively, the Title Column is Column number 1, the Year Column, 

Column number 2, Certificate, Column number 3, so, on and so, forth. So, if we want to 

return the Year, our Column index number is 2 because it's the second Column.  

 

The final argument is an optional argument because it's in Square brackets, and that is range 

lookup. So, are we doing an Approximate Match or an Exact Match? Well, one thing that’s 

worth noting here is that because this is an optional argument, you don't actually need to have 

anything on the end here. If you don't specify then by default, it will do an Approximate 

Match.  
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Now most of the time, you're going to want to do an Exact Match here. It’s a little bit strange 

that Microsoft have made Approximate Match the default, because what we want to do here 

is exactly match the words Manchester by the Sea in the Table. So, we want a false on the 

end here. It's also, worth noting with these trues and falses, you could just type in 1 to specify 

true, or 0 for false.  

 

So, now, when we close the brackets and hit Enter, it's going to return the Year. So, let's just 

do a quick visual check to make sure that this is correct. I can see here, the third one in the 

Table is Manchester by the Sea. And the Year that that was released is in fact 2016.  

 

Now is it possible for us to copy this Formula down? Let's give it a go. I'm going to drag 

down. No, I'm getting #N/A. So, let's take a look at why this isn't working. In this instance, 

the VLOOKUP is looking for information in Cell J4. Now, this is Cell J4, we have nothing in 

there. Now remember, when you drag a Formula down, Excel will adjust the Formula 

references unless you lock them in place.  

 

So, let's go back to the original Formula, let's go to the Formula Bar. And where we have our 

Movie name, let's make this absolute by pressing the F4 key and hit Enter. So, now if we drag 

down, is this going to work? No, it's not working, it's returning the Year, again for all of 

these. So, let's take a look at why that might be.  

 

Well if we take a look in the Formula Bar, it's referencing the correct Cell; J3, it’s referencing 

the Movies Table, which is fine, but it's still referencing Column 2, which is where we have 

the Year. Now if we want to return this Certificate, this is going to need to be changed to 

Column number 3. When we hit Enter, we should now find that that updates and we get the 

correct result. So, for each of these, we're going to need to go in and change that Column 

number.  

 

So, for the next one, if we want to return the Genre, this is Column number 6, so, we're going 

to add a 6 in there. And then for the last one, we want to return a Rating, which is Column 

number 7. So, now, we have all of the correct results. And we should find that if we change 

the Movie in the dropdown, let's just go for the top one La La Land, you can see that all of 

that information is correct as well. So, there is a little bit of a manual element there if you 

want to copy this Formula down because we need to change the Column that we're returning.  
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Now of course, there are ways you can modify this Formula to get around this. We're not 

going to discuss them in this lesson because as I said, these are intermediate Formulas, and 

we don't want to go too far down a very complex road. But that is how you can perform a 

very simple VLOOKUP to return information based on a unique lookup value. 
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Video: Lookup Function: XLOOKUP Explained  

Deb: In the previous lesson, I showed you how you can use VLOOKUP to look up a piece of 

information in the Table, in this case, a Movie Title, and return information from other 

Columns. Now, we're going to move this idea on a little bit and start to take a look at 

XLOOKUP.  

 

Now, XLOOKUP is another Lookup Function, but it's a newer version of Lookup Functions. 

So, XLOOKUP is only available to users of Microsoft 365, Excel 2019, and Excel 2021. If 

you have a much older version, then XLOOKUP isn't available. But as this is an Excel 365 

course, I'm going to assume that everybody does. So, we're going to take a look at how it 

works.  

 

Now you might be thinking to yourself, why do we need XLOOKUP when we've just seen 

how to do a lookup using VLOOKUP? Well, it's because VLOOKUP has a number of 

limitations. Now since the last lesson, I've actually made a change to this Table.  

 

Notice here that previously, we had the Movie Title in Column A. And I've now moved that 

Title Column to Column C. I still have my dropdown list over here, so, I can select the 

Movies. But let's try and use VLOOKUP first of all to perform this lookup again.  

 

So, we want to look up the Year, we're going to go into the lookup, our lookup value is what 

we have in Cell J3, let's press F4 to lock that in place, comma, Table array, well, that is still 

our entire Table. Let's select the Movies Table, comma, Column index number.  

 

Now, as I mentioned, when you're using VLOOKUP, VLOOKUP numbers Columns from 

left to right, and the numbering starts from the Column where you have the lookup value. So, 

for us at the moment, that would be Column C. Now I want to return the Year, which is 

currently in Column A. So, how do I provide a Column index number that says, go back 2 

Columns from the Title Column from where we have the lookup value?  

 

Could I put in a -2 in here? Would that work? Let's see. Comma, we're doing an Exact Match 

of the Movie Title. So, we want a false on the end here. Let's see if this works. Let's hit Enter, 

we get an #N/A. And that is because obviously, we can't have minus numbers as our Column 

index number; we can't count backwards. VLOOKUP can only count from left to right.  
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So, in this scenario, if I was trying to find the Genre, that would work absolutely fine, 

because the Genre exists to the right of where the lookup value Column is. And this is the 

biggest limitation of VLOOKUP; its ability to only count from left to right. And you'll get to 

this stage with your lookups after you've been using VLOOKUP for a while where it just isn't 

flexible enough for what you need it to do. And that is where we generally start to explore 

other ways to perform lookups.  

 

Now previously, in older versions of Excel, we've done a more flexible lookup using Index & 

Match. And you may have heard people speak of these 2 functions. Now I'm not going to 

cover Index & Match in this course, because as I keep reiterating, it is a beginner’s course. 

And this is a Microsoft 365 course, where we have access to XLOOKUP.  

 

XLOOKUP in general is considered to be as flexible as using Index & Match, but it also, has 

lots of useful additional options. And the biggest advantage of XLOOKUP over VLOOKUP 

is that it doesn't matter where the lookup value exists, we can return any Column from the 

Table regardless of its position. So, let's click in Year, we're going to type in =XLOOKUP.  

 

Now the arguments that we have here, we have quite a few more, but 3 of these are optional 

arguments. And in this case, we're not going to use them, we're only going to use the first 3. 

So, the first thing we need to provide is our lookup value, which is going to be this. Again, 

I'm going to lock that in place, comma, lookup array.  

 

Now this time, we need to specify the range of Cells where our lookup value exists. So, our 

lookup value is the Movie, where are we going to find that? Well, we're going to find it in the 

Movie Column, in this case, the Title Column. So, I'm just going to select that entire Column.  

 

Now remember, because we're using Table References, it's not putting the Cell References in 

there, it's putting the name of the Table, which is Movies, and then the Column that I've 

selected, which is Title, comma. We then just need to specify the return array so, the Column 

that we want to return. We want to return the Year Column, so, I'm simply going to select 

that. Close off the bracket, hit Enter, check it out, it returns the correct answer.  

 

Now trust me if you've never used Index & Match, XLOOKUP is so, much simpler. Now 

again, we have a similar issue when we copy this down in that when we pull this down, it's 

going to return the Year for each of these, because in each instance of this Formula, it's 
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referring to fixed Columns. So, it's still referring to the Title Column and the Year Column. 

So, we would need to go in and make some modifications.  

 

Now if we want to return the Certificate, we can simply come up to the Formula. And when 

we backspace, check out what happens; we get a list underneath of all of the different 

Columns. So, we can simply go in and select Certificate, don't forget to close off that Square 

bracket, hit Enter, and we get the correct result.  

 

Let's do the same for Genre. Again, we can just simply select it, close the Square bracket, and 

hit Enter. And then finally we want to return the Rating. So, I'm going to backspace, select 

Rating, close the Square bracket, hit Enter, and all of my lookups are done. And once again, 

if we change this to something else, it's going to completely update.  

 

Now again, there is a certain manual element in there because we're having to go in and 

change the Column that we're referencing in each of the Formulas. Once again, there are 

ways that we can get around this. We're not going to go down that road in this particular 

lesson, but just know that that is how you can perform an XLOOKUP and how it differs from 

VLOOKUP. 
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Video: Logical Functions: IF, AND, OR  

Deb: In this lesson, we're going to start to explore some basic Logical Functions. Logical 

Functions allow us to test some data and output an answer depending on whether the result of 

that test is true or false. And by far, the most well-known Logical Function is IF.  

 

Now, before we get on to using IF, let's first of all get our head around exactly what a Logical 

Function does. So, in the spreadsheet here, I'm just going to type in 2 numbers; we're going to 

go for 5, and we're going to go for 10. Now what I could effectively do here is perform a test 

on these numbers.  

 

So, if I type in equals, I could ask the question is this Cell greater than this Cell, so, is 5>10. 

If we hit Enter, the result is going to be false, because 5 is not greater than 10. Notice that in 

the middle there, I've used what we call a logical operator that is greater than, less than, equal 

to, so, on and so, forth. And if you want to see a full list of operators in Excel, I highly 

recommend you jump into the help files and just do a quick search for logical operators.  

 

If I was to flip this symbol the other way around, we're now saying is E12<E13. And of 

course, the answer to that is going to be true. And it's worth noting that the result of a Logical 

Formula is always going to be either true or false. So, let's take that logic, and let's apply it to 

a real world example.  

 

You can see here that we have a list of expenses for different employees. We have the 

Expense Total. And I want to find out if approval is required for this particular expense. And 

you can see over on the right hand side, it says; ‘Expenses over the following amount MUST 

be approved’. So, the threshold is $1,000.  

 

So, effectively, what we want to do here is we want to test these Cells. We want to say if this 

value is greater than this value, then approval is required. If it's not, then it's not required. So, 

let's just do a very basic logical test first of all. We're going to type in equals, we're going to 

ask the question is this Cell greater than this Cell?  

 

Now we want to pull this Formula down, I don't want this Cell to move. So, we need to make 

an absolute by pressing the F4 key. So, if I hit Enter here, I'm just going to get a result of true 

or false. Now, it might be that you're perfectly happy with having true or false listed out in 
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this Cell. But a lot of the time, people want a more meaningful result. It's going to make more 

sense if I have yes or no in the Cells as opposed to true or false.  

 

Now, this is where if statements come in. If statements basically take a Logical Formula, like 

we have in this Cell just here, and allow us to effectively customize what the output is going 

to be for the true and false results. So, if we go up to the Formula Bar, what we could do here 

is wrap this in an IF. So, we're going to type in IF, press the Tab key, the first argument of IF 

is the logical test.  

 

Well, we have our logical test just here. So, we can click on the end, comma, we can now 

specify what we want it to say in the Cell if the result is true. So, if it's true, I want it to say 

‘Yes’, approval is required. If it's false, it's going to say ‘No’ approval is not required. We can 

close the bracket, hit Enter, and now when we double click to copy down, we have a much 

more meaningful result. So, remember that IF really just adds meaning to logical tests.  

 

Let's move on to the next spreadsheet and take a look at some other options. We're going to 

do a couple more examples of IF just so, you can practice and really get your head around 

what's going on here. Now in example number 1, we have a list of student names, and we 

have their score in a test. And I want to find out if they passed or failed. And notice over here 

in Cell H3, the pass mark is 85. And in this example, we're going to say that students that 

scored 85 or above are going to pass.  

 

So, let's come back to here, we can type in =IF, our logical test is if this score is greater than 

or equal to the pass mark. Remember, we need to lock in F4 if we want to copy down, if that 

is true, then they have achieved a ‘Pass’. If it's false, then they've achieved a ‘Fail’. Close the 

bracket, hit Enter, and now when we copy this down, we should find we have a meaningful 

result. And again, because we used greater than or equal to, this student here who scored 

exactly 85 has achieved a pass.  

 

Let's take a look at a slightly different example where we're including a Formula in our true 

or false result. So, here we have a small list of products. We have the weight of that product 

in kilos, we have the price of the product, and we need to calculate what the shipping fee is 

going to be. And you can see over in Columns G and H, what we're saying here is that 

anything that has a weight of 30 kilos or above, there's going to be a 20% shipping fee.  
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So, if we click just here, let's type in =IF, our logical test is if the weight is greater than or 

equal to 30 kilos, F4 to lock. Now, if that is true, we need to perform a calculation, we want 

to work out what 20% of the price is, because that's going to be the shipping fee. So, our true 

result is going to be this calculation; price*20%. And again, we want this to be locked into 

place. So, we want to press F4.  

 

If the result is false, so, if the weight is under 30 kilos, then we just want nothing in there 

because there's no shipping fee. Let's close the bracket. And we should find that wherever the 

weight is 30 kilos or above, and that is for these 2 just here, we have a shipping fee that is 

20% of the price. So, you can also, use Formulas within those arguments.  

 

Now the final 2 examples in this lesson are 2 other Logical Formulas. And that is AND, and 

OR. So, let's take a look at AND first of all. Again, we have a list of student names, and we 

have the results that they achieved in Test 1 and also, Test 2. And we can see the pass mark 

for both of these tests listed out in Column H. So, for Test 1, it was 75. And for Test 2, it was 

65.  

 

Now over here, they need to have passed both tests in order to get an overall result of pass. 

So, if they've just passed one of them, they're going to have failed. So, this is where we would 

use an AND condition. So, if we type in =AND first of all, this is where we can add in 

multiple logical tests. Because the first test we want to perform is, is this score greater than or 

equal to the pass mark, F4 to lock, comma, our second logical test is, is this score greater than 

or equal to this pass mark for Test 2; F4 to lock.  

 

Now if I just close the bracket just here and hit Enter, of course, I'm going to get a result of 

true or false. Now this is working. But if I wanted to add pass or fail in here, we would need 

to again wrap this in an IF Formula. So, if we go up to the Formula Bar, I'm going to type in 

=IF and press the Tab key, our logical tests will then be generated by the AND function.  

 

So, all we need to do is add on to the end here; “Pass”, “Fail”. So, if the result of both of 

these logical tests is true, they're going to achieve a pass. If one of these is false, or both of 

them are false, they're going to get a fail. Let's hit Enter, double click to copy down, and we 

should find now that the students that have passed in the Result Column, this is where their 

scores are greater than or equal to the pass mark for both tests. Where we have failed, for 

example Julie, you can see that in Test 2 she passed, but she failed Test 1, so, her overall 

result is Fail.  

http://www.simonsezit.com/


 

 

 

 

 

 

       © Copyright 2023 Simon Sez IT, INC. All Rights Reserved. 197 

 

Now the OR function is kind of the opposite of that. Here, we're going to say that if they 

passed Test 1, or Test 2, they're going to get a result of pass. So, let's type in =IF, we're going 

to go straight into OR, and the arguments are the same as AND. We're going to perform our 

first logical test, which is; is this score greater than or equal to the pass mark, F4. Or, is this 

score greater than or equal to the pass mark in H32, F4.  

 

We can close off OR and then we can define what we want it to say in the Cell. So, if either 

of them are true, they're going to get a pass. If both are false, they're going to get a fail. Let's 

close the bracket, hit Enter, double click to copy down, and you can see that the only one 

that's a fail is Courtney just here. You can see that both of her tests came in under the pass 

mark.  

 

So, IF, AND, and OR are 3 really useful functions that you need to get comfortable with 

using. That's it for this lesson. I will see you in the next one. 
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Video: Text Functions: PROPER, TRIM, CLEAN  

Deb: In this lesson, we're going to take a look at 3 really useful Text Functions that can help 

us clean up a dataset. So, if you take a look in the spreadsheet right now, you can see that I 

have quite a long list of data. And this is just showing Order Numbers for different Countries, 

different Products, and various different Metrics, Unit Sold, Sale Price, Profit, Date, so, on 

and so, forth.  

 

Now, this dataset isn't too untidy; I've seen a lot worse than this. But this isn't an entire 

session on how to clean up a dataset from scratch, I really just want to showcase for you a 

few useful Text Functions. Now the first thing you'll notice about this dataset is that it's not 

particularly consistent. We have some Blank Rows in our data. And if you take a look in 

Columns B and C, we have a few different issues going on here.  

 

I can see that in Column B, we have some line breaks in here. For example, United Kingdom 

should be all on one line like this record down here. But somebody has put in a line break, or 

a line break has been inserted in the download process. So, we're probably going to want to 

remove those line breaks just to make this all a bit more consistent.  

 

And if you take a look in Column C, you can see that for these products, we've got some of 

them in here in uppercase, some of them in what we call proper case where the first letter is 

capitalized, and then we have some that are all in lowercase. So, again, we want to make this 

consistent and have everything in our chosen case. And for us, that is going to be a proper 

case where the first letter is capitalized.  

 

You'll also, notice that some of these have picked up what we call erroneous spaces. So, for 

example, you can see here in record 5, we've got a gap at the beginning. For this record just 

here we have a space in between the words Royal and Oak, and you can see that we have 

these throughout this dataset. Now we can deal with all of these issues by simply knowing 3 

Text Functions. And the good news is we can combine all of these functions together in one 

Column to completely fix and tidy our dataset.  

 

Now before we do that, I'm going to remove these Blank Rows. So, this isn't a function but 

see this as a little extra added tip, because this is something that you'll probably have to do on 

a fairly frequent basis. So, what I'm going to do here to delete these Blank Rows quickly is 
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I'm going to select all of my data like so, I'm then going to press Ctrl + G, which is going to 

bring up the Go To dialog box. And we're then going to click Special.  

 

We can select Blanks from here and click on OK, and it's going to highlight all of those 

Blank Rows in my selection. I can then simply go to the Home Tab, and choose Delete, and 

choose Delete Sheet Rows. So, that is a super quick way of getting rid of those Blank Rows. 

So, now that we've done that, let's deal with some of these issues.  

 

Now when you're using functions to tidy up a Column of data, you want to insert what we 

call a Helper Column in the middle. So, I'm going to click where we have Product, I'm going 

to press Ctrl + Shift + +, that might be Ctrl + for you depending on your keyboard, and this is 

going to be a Helper Column where we're going to clean up Column B.  

 

Now in Column B, the only issue we have going on here is that we have some line breaks in 

some of these Cells. Now a function we can use to get rid of line breaks and non-printing 

characters is CLEAN. So, if we type in CLEAN, there's only one argument for CLEAN; we 

need to supply the text that we want to clean, close the bracket, I'm going to do Ctrl + Enter 

to stay in the same Cell, and then we can use the fill handle, double click to copy down. And 

notice here United Kingdom is now all on one line. The same thing down here with the 

United States of America. It's cleaned up that line break.  

 

So, now that we have this CLEAN Column, you might think that you can simply go in and 

delete Column B. Let's right click and choose Delete. We're getting #REF! So, I'm going to 

undo Ctrl + Z. Why are we getting those errors? Well, it's because we have a Formula in 

Column C that refers to Column B. So, when we remove Column B from the dataset that is 

why we're getting the error.  

 

Now a way to get around this is to simply copy the clean data in Column C and paste it over 

the top without the Formulas. So, this is where we can use one of our Paste Special options 

that we looked at earlier on in this course. So, I'm going to select Column C, we're going to 

press Ctrl + C to copy and then we can go to the Home Tab, click the lower half of the Paste 

button, and choose Paste Values.  

 

It's also, worth noting that in Excel for Microsoft 365, we now have a new shortcut to paste 

values and that is Ctrl + Shift + V. Let's click to paste just the values. That will keep the text, 

but notice it's now removed the Formula from underneath. So, now, we can move across this 
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heading, I'm just going to drag it to move it, and then we can right click and delete out 

Column B, and we have a perfectly clean Column.  

 

Now we're going to do something similar to clean up Column C, we're going to click Column 

D, Ctrl + Shift + + or Ctrl + to insert a Helper Column. Now we've got 2 issues that we need 

to sort out in Column C; we need to change the case so, that it's consistent, and we also, need 

to remove these weird spacing issues that we have.  

 

Now to change the case, there are 3 functions you can use; PROPER, UPPER, and LOWER. 

And this depends on what you want to convert it to. So, if I wanted everything to be 

uppercase, I would use UPPER, if I wanted everything to be lowercase, I would choose 

LOWER, and if I want everything to appear with just the first letter capitalized, we would use 

PROPER.  

 

Again, the only argument we have is the text that we want to change. Let's close the bracket, 

Ctrl + Enter, and then when we double click to copy down, you can see that the case is now 

consistent. Now that has only dealt with our case issues, it hasn't removed any of these weird 

spacing issues.  

 

Now to get rid of these spaces, this is where we can use the TRIM Function. And the good 

news is we can combine it with the PROPER Function and basically do both of these things 

at the same time. So, if we go to the first Cell and go to the Formula Bar, all I'm going to do 

here is add TRIM on to the front, and then we just need to close off a bracket on the end.  

 

We don't need anything else because the PROPER command is already referring to the Cell 

that we want to clean. So, we don't need to add it again for TRIM. Ctrl + Enter to stay in the 

same Cell. And this time when we double click to copy down, check it out, we now have a 

perfectly consistent Column when it comes to case and erroneous spaces.  

 

Now we're going to have the same issue here. If we try to delete out Column C, because we're 

referring to Column C in this Formula, we're going to get #REF! So, we want to do as same 

little trick, I'm going to select the entire Column Ctrl + C to copy. And this time, I'm going to 

use the Keyboard Shortcut to paste the values; Ctrl + Shift + V, press Escape. And now, we 

should find that those Formulas have been removed.  
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I'm going to grab the Column Heading and I'm just going to drag that across to move it and 

then we can safely right click and delete out Column C. And just like that, we've used Text 

Functions to tidy up our dataset and make it consistent.  

 

And of course the final thing I would do here to ensure that our data is ready for analysis is 

put my dataset into a Table; Ctrl + T. Let's click on OK, and we're pretty much ready to 

analyse this data. 
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Video: Time and DATE Functions: TODAY, NOW, WORKDAY  

Deb: In the final lesson of this section, we're going to explore some useful TIME and DATE 

Functions. And we're going to start by taking a look at a function that is a little bit unusual 

compared to the other functions that we've looked at so, far in this course.  

 

Now, the reason why it's unusual is that it doesn't have any arguments. So, you can see here 

right at the top of this spreadsheet, in Cell A1, we have a current date. And in Cell B1, I want 

to just input today's date into a Cell. And this is something that you'll need to do fairly often.  

 

Now obviously, we could type the date manually into the Cell. But a much better way of 

doing this is to use the TODAY Formula. So, if we type in =TODAY, notice the little 

ScreenTip underneath. It says; ‘Returns the current date formatted as a date’.  

 

Now the thing with this Formula is that if we press the Tab key, it's going to add in an open 

bracket, but there aren't any arguments. So, all we need to do is close off this bracket, hit 

Enter, and it's going to input today’s date into the Cell.  

 

Now one thing to note about the TODAY Function; when you use TODAY in a spreadsheet, 

it's going to automatically update depending on what the current day is. So, if I was to open 

this spreadsheet tomorrow, this date is going to say, the 10/10, as opposed to the 10/9. So, it 

dynamically updates according to today's date.  

 

Now in a lot of scenarios, that's exactly what you want it to do. But you will find that there 

are some spreadsheets where you actually want to hard code the current day’s date into the 

spreadsheet and always refer to that date for historical purposes.  

 

Now, if you do want to do that, and you don't want this to change, what you can do is use the 

Keyboard Shortcut instead; Ctrl +; That's going to put today's date into the Cell, but it's not 

going to change when we open up the spreadsheet on subsequent days. So, just remember 

that there's a difference between the TODAY Function and using the Keyboard Shortcut Ctrl 

+;  

 

Now what about if we want the current date and time in a Cell? Well, for that, we can use the 

NOW Function. And this is very similar to TODAY in that it doesn't have any arguments. So, 

we simply just need to close off the bracket, hit Enter, and let's just widen out that Cell. That's 
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going to give us today's date, but it's also, going to give us the current time. And again, this is 

one of those Formulas that will automatically update.  

 

Now if you just want the time in that Cell as opposed to the date and the time, if we delete 

this out, we can use the Keyboard Shortcut Ctrl + Shift + ;. That's just going to give us the 

time. And using this Keyboard Shortcut, again, we've hard coded it into the Cell, it's not 

going to automatically update.  

 

Now what if we want the date and the time in a Cell, but we want to hard code them in? Well, 

we can simply combine our shortcuts. So, Ctrl +; for the date, I'm going to put a space in 

there and do Ctrl + Shift +; which is going to give me the time. So, a few different methods 

there depending on whether you want it to update constantly or not.  

 

Now with things like the TODAY Function, that can be used in lots of different scenarios. 

And again, we're not going to dive too deep into this in this particular course, but if I wanted 

to work out what the date was going to be in 7 days’ time, we could simply type in TODAY, 

press the Tab key, close the bracket, +7. And that's going to give us the date in 7 days’ time. 

So, you can use TODAY to perform calculations as well.  

 

Now let's take a look at another Formula that can be really useful. Now if you look at the 

Table below, you can see that I have a list of Task Names. So, this looks like some kind of 

wedding planner. I have some Start Dates for those tasks, and then I have the number of days 

it's going to take to complete those tasks. And maybe I want to find out what the Finish Date 

is going to be.  

 

Now let's say that all of these tasks need to be completed Monday to Friday, so, we're not 

going to do any work on the weekends. We're also, not going to do any work when it's a 

public holiday in the UK. And you can see on the right hand side I have a Table that lists out 

all of the UK public holidays.  

 

So, what we can do here is if you do need to work out a Finish Date that excludes weekends 

and also, any public holidays, you can use a function called WORKDAY. You can see there 

it is at the top of the list. Let's press the Tab key. We have 3 arguments. Now notice holidays 

is an optional argument so, you don't have to add the holiday in.  
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If you just provide the Start Date, and the number of days the task is going to take to 

complete, the WORKDAY Formula will give you a Finish Date that doesn't exclude 

holidays, but will still exclude weekends. So, our Start Date is Cell B6, the number of days to 

complete this task is 5, Cell C6. Now we do have our holidays listed out. So, I'm going to 

press comma, and we're just going to select all of these holiday dates.  

 

So, I'm going to press F4 to lock those Cell References, close the bracket, hit Enter, and then 

when we copy down, we should find we get the correct results. And we can do a quick spot 

check. Let's just choose this one. This is a task that takes 3 days. We start it on 1/9 and we 

finish it on 1/12.  

 

You can see this one here more than likely runs across the weekend because this task starts 

on 1/13. It's only a 2-day task, but it doesn't finish until the 17th. So, there's going to be some 

weekend days in there. So, the WORKDAY Formula is really good for calculating the Finish 

Date when you know the Start Date, the working days, and also, if you want to exclude things 

like weekends and holidays.  

 

And then finally, right at the bottom, we kind of have a different variation of this. So, again, 

we have some Task Names just here, we have the Start Date for each of these tasks, and the 

End Date. And we want to calculate how many days it's going to take to complete these tasks. 

And once again, we want to exclude weekends and holidays.  

 

So, for this, we can type in equals and we can use the NETWORKDAYS Formula. Notice it 

says; ‘Returns the number of whole workday is between two dates’. And you'll see here we 

have 3 arguments; we have Start Date, comma, End Date, comma, and again, that holidays 

argument is optional. But if you do have your holiday days, you can simply select them. Let's 

do F4 to lock that in place, close the bracket, hit Enter, and then we can drag down and we 

can see very easily the number of days it took to complete this task.  

 

So, these are some of my favourite TIME and DATE Functions. Have a little play around 

with them, see what you think, and I will see you in the next section. 
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Video: Exercise 11  

Deb: It's time now to do Exercise 11. And in this exercise, we're going to practice some of 

the skills that we've learned in this section of the course.  

 

So, the first thing I'd like you to do is open the exercise file, ‘Exercise11.xlsx’. And then 

using XLOOKUP, I'd like you to create a Formula in Cell M6 that returns the ‘Pizza Name’ 

from Column J, depending on which ‘Pizza ID’ has been selected from the dropdown list in 

Cell M4. And I'd like you to make sure that you add error handling to the Formula that 

accounts for #N/A errors. I'd like you to use the text ‘Pizza Not Found’.  

 

Now the second part of this exercise is to practice logical statements. So, on the Worksheet 

named ‘Logical’, I'd like you to create a Formula in Column G that will return a result of 

‘Complete’ or ‘Incomplete’. Now to achieve a result of ‘Complete’, the employees must have 

attended all webinars, otherwise, they're going to receive a status of ‘Incomplete’. So, a 

couple of things for you to practice there. If you'd like to see my answer, then please keep 

watching.  

 

So, we're in the lookups Worksheet, and we're still using our pizza data. And what I asked 

you to do here was construct a LOOKUP Formula in Cell M6 that updates depending on what 

Pizza ID we've selected from the dropdown list above. So, we're going to use XLOOKUP. 

So, we're going to type in =XLOOKUP, our lookup value is what we've selected in Cell M4.  

 

Our lookup array, well, where are we going to find this value? Well, we're going to find it in 

the Pizza ID Column. So, we're going to select this Column just here, comma. What do we 

want to return? Well, we want to return the ‘Pizza Name’. So, I'm going to click in this top 

Cell Ctrl + Shift + Down Arrow, and then we're going to go up to the Formula Bar and just 

close off that Formula and check to make sure this is working.  

 

And I can see there we go, five_cheese pizza. If we change this to Hawaiian, yes, this looks 

to be working. Now, I also, asked you to account for any #N/A errors in the Formula. So, if 

for example, somebody enters in a Pizza ID that doesn't exist in the Table, this is going to 

return a #N/A.  

 

Now, #N/A errors aren't very meaningful. So, we want to give this a better message and have 

it say ‘Pizza Not Found’. Now when we're using XLOOKUP, this is really simple. Let's go to 
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the Formula Bar and click at the end, because we have an argument just for this. So, you can 

see here it says; ‘if_not_found’. So, in quote marks, we're going to say; “Pizza Not Found”, 

and hit Enter. That's all I needed you to do.  

 

So, let's just test if that's working. I'm going to go to the Table, I'm just going to remove the 

_m from Hawaiian. And you can see it now no longer matches, and we get the result of 

‘Pizza Not Found’. Let's add the _m back in again, and the Formula is working again.  

 

Let's jump across to the logical Worksheet. Now in this exercise, I asked you to return a 

status of ‘Complete’ or ‘Incomplete’. And you see according to the notes on the side there 

that those employees who attended all webinars will have a status of ‘Complete’. If they 

didn't attend all webinars, they're going to have a status of ‘Incomplete’.  

 

So, for this, we're going to utilize IF and AND. So, let's type in =AND first of all, because we 

want to perform multiple logical tests. So, we want to test if this webinar is = ‘Yes’, then we 

want to test if this webinar is = ‘Yes’. And we're going to go through and do exactly the same 

for all of these. So, is this one = ‘Yes’? And finally, is this = ‘Yes’.  

 

So, it's checking those Cells to see if the value inside is = ‘Yes’. If they're all = ‘Yes’, then 

we're going to get a result of ‘Complete’. If even one of them is ‘No’, it's going to be 

‘Incomplete’. So, if we just hit Enter here, we're simply going to get a result of true or false. 

Now we can get it to say ‘Complete’ or ‘Incomplete’ by wrapping this in an IF.  

 

So, let's go up to the Formula Bar, we're going to type in IF on the front. Our logical test is 

just here; it's been generated by the AND Formula. So, we can click at the end here, and we 

want to say that if this is true, so, if all of them are = ‘Yes’, we want it to say ‘Complete’. If 

even one of them is ‘No’, it's going to say ‘Incomplete’ in the Cell.  

 

Close the bracket, hit Enter, and now we can double click to copy this down, and we have the 

result that we're looking for. That is all I needed you do to do, I will see you in the next 

section. 
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Section 12: Analyze Data 

Video: Quick Analysis Button  

Deb: In this section of the course, we're going to take a look at some of the tools that we have 

available to us in Excel for analysing data and presenting it visually. And we're going to start 

out in this first lesson by taking a look at the Quick Analysis button because this button can 

be a godsend if you just want to get very quick insights into a dataset.  

 

So, on the screen here, I have some Global Megastore Sales for the USA. And what you can 

see is in Column B, we have the names of the States, we then have the State Code in Column 

C, we have the Region that that state is in in Column D, and then we have the Sales.  

 

Now it might be that I want to perform some kind of analysis on this data. And when you 

think about analysing data, your first thought might be something like maybe a Pivot Table or 

a Chart. And those are definitely extremely valid tools when it comes to analysing data, but 

there are lots of other things we can use as well.  

 

The Quick Analysis button gives us access to all of those in a helpful little pop out. So, what 

I'm going to do here is I'm going to select everything in this Sales Column; Ctrl + Shift + 

Down Arrow. Now notice right at the bottom of my selection, can you see we have this little 

tag?  

 

If I hover my mouse over it, we get a little pop up that says Quick Analysis. Notice the 

Keyboard Shortcut Ctrl Q. And it says; ‘Use the Quick Analysis tool to quickly and easily 

analyse your data with some of Excel’s most useful tools such as charts, color-coding, and 

Formulas.  

 

So, if we click this Quick Analysis button, it opens up this little pop up window, and we have 

lots of different sections that we can choose from. So, this really depends on exactly what it is 

that you want to do with this data.  

 

So, if we go to the Formatting Tab, you can see from here, I can quickly apply Data Bars, 

Colour Scales, Icon Sets, so, on and so, forth. Now, we haven't spoken about any of these 

things yet in this course, but we are going to cover these in the next section.  
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If we move across, I could choose to create a Chart very quickly based off of the data that I 

have selected. I can create a Line Chart, a Scatterplot, a Clustered Column, Clustered Bar, so, 

on and so, forth. We have a Totals Tab just here where I can perform very quick calculations. 

For example, maybe I want to very quickly sum all of these numbers in the selection, or 

maybe find out the average or the count.  

 

Now, notice here with these Totals, we have SUM, AVERAGE, and COUNT. And then if we 

use this little scroll arrow, we have SUM, AVERAGE, and COUNT just here as well. So, 

what is the difference between SUM, AVERAGE, and COUNT that you can see in Yellow, 

and SUM, AVERAGE, and COUNT in Blue?  

 

Well notice where the shaded area is in the little image. If I was to choose SUM from here, 

it's going to place the total at the bottom of the Column. Whereas if I was to use this SUM 

over here, you can see in the live preview, it places the summit to the side. Now in this case, 

that's not particularly useful. You can see it's just summing whatever's on that line, which is 

exactly the same number. But what about if I want to add a Running Total? That can 

sometimes be very helpful.  

 

Well, I'm going to move across, and I'm going to choose a Running Total, and I want to 

display it to the right of my data. Let's select it, notice that I'm getting these little hash 

symbols, that simply means we need to widen the Column, double click to do that, and check 

out what we have. We now have Running Totals. And if you're not aware of what a Running 

Total is, it basically adds up as it goes.  

 

So, we have 62,345 is the first value. The next value of 149,468 is basically 62,345 added to 

the next one in the list, and it carries ongoing. We then have 149,468 + 75,321. It’s going to 

give us 224,789. So, Running Totals can be really useful. And using this Quick Analysis 

button, we can add those in an instant.  

 

Now one thing to note here is that once I've done that, can you see all of these little Green 

triangles in the corner of the Cell? Now whenever you see a Green triangle like this, it's 

normally some kind of warning that Excel is giving you. So, what I'm going to do is I'm 

going to select all of these Cells Ctrl + Shift + Down Arrow where we have this little Green 

triangle, and notice at the top this time we have another little pop out tag that has a Yellow 

warning triangle on it.  
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Now invariably, when you click on this the first item that you see in this menu is going to 

give you some idea as to why you're getting this warning. So, it's telling me; ‘Formula Omits 

Adjacent Cells’. Now in this case, it’s basically telling me that this Running Total Formula 

that I've added is not using all of the data on the Worksheet. Now, in this case, that is 

absolutely fine. So, I can choose to ignore this error, and that's going to get rid of those Green 

triangles.  

 

Now to make this look integrated with the Table, I'm going to do a little bit of formatting 

here. Let's select the entire Column and turn off Bold Ctrl + B. I'm going to use my Format 

Painter, I'm going to click it once to copy the Cell formatting across, and we're going to say 

Running Total; double click to widen up the Column.  

 

I'm also, going to copy this Border formatting as well. So, let's use the Format Painter. Click 

and drag all the way down. And now, everything is integrated into the original dataset. And if 

you take a look in the Formula Bar, you can see the Formula that the Quick Analysis tool has 

added.  

 

Now let's select our Sales data again; Ctrl + Shift + Down Arrow and click our Quick 

Analysis button. I could also, add things like Pivot Tables from here, or Sparklines. Now all 

of these things we haven't covered so, far in this course. But if we jump back to the 

Formatting Tab, I'm going to make this look a little bit more interesting by very quickly 

adding Data Bars.  

 

So, I'm going to select Data Bars, check out what that does. We now get a visual 

representation of the number in the Cell with this in-Cell bar. Now, you may or may not like 

the way that this looks. And of course, there are things that we can do to customize this and 

make it look a little bit nicer.  

 

As I mentioned, we have a whole lesson dedicated to Data Bars a bit later on where we're 

going to take a look at these in more detail. Just be aware that whenever you make a selection 

of data, that little Analyse button is going to be available at the bottom, and it just serves as a 

quick way of executing common tasks on your dataset. 
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Video: Choose the Right Chart Type  

Deb: A fundamental aspect to being able to analyse data in Excel is knowing how to use 

Charts. And more importantly, knowing which Chart type to choose for which dataset. 

Because not all Charts are created equal.  

 

Some Charts that you'll find in Excel are definitely more suited to certain types of data than 

others. And in this lesson, we're just going to explore some of those Charts so, you can start 

to understand which Charts you might want to use for which job.  

 

Now the first thing to mention about Charts is that you insert them from the Insert Tab just 

here. You'll see in the middle, we have a big Charts group where we have Recommended 

Charts, and then we have our different types of Charts all split down into different groups. 

For example, this top one just here, this is where we're going to find all of our Column and 

Bar Charts.  

 

If we click the dropdown, we can see we have quite a few different choices in here. We can 

have 2-D Column Charts, 3-D, 2-D Bar, 3-D bar. And you can see that the real difference 

between Column Charts and Bar Charts are really whether they're laid out horizontally or 

vertically. We have Line Charts, we have Pie and Donut Charts, and we have Area Charts, 

Scatterplots, and all kinds of things in here. We can even create things like Map Charts.  

 

Now in order to create any Chart, you first need to start off with a dataset to represent in that 

Chart. Now notice on this Worksheet, I have a very small Table of data, we have a Gender 

Column; Female and Male, and then we have No of Employees. So, maybe this is some HR 

data where we're trying to find out how many males we have versus females in the company, 

because we might want to think about changing our policies if we don't have adequate 

representation.  

 

Now notice next to this little Table, I've chosen to display this data using 2-Different Charts. 

We have a Pie Chart on the left, and we have a Donut Chart on the right. Now you can see 

the difference between the 2; the Donut Chart has a hole in the middle, hence why it's called a 

Donut Chart.  

 

Now for the type of data that we're representing here, Pie Charts and Donut Charts work 

really well. These tend to be better for smaller datasets where we're comparing values. If I 
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had a much larger dataset, what generally tends to happen is that the slices of the pie gets so, 

small that it makes it really hard to interpret what's going on.  

 

We have other Chart types that are much better at handling larger datasets. But if you simply 

have a few items, and you want to do a direct comparison between the 2, then Pie and Donut 

Charts are worth considering.  

 

Now the next type of Chart that I'd like to highlight is a Line Chart. And you can see here, 

this is what a Line Chart looks like. This is just representing Sales by Month for 2022. And in 

general, Line Charts are best for time-based data.  

 

For example, Sales figures that change over the different months of the year. It might be that 

we have years in here or quarters, and then our Sales data. A Line Chart would be good to 

represent that as well. Line Charts in general show us trends over time. So, if you do have 

time-based data, consider a Line Chart.  

 

The next 2 types of Charts are probably the most common. That is Column Charts and Bar 

Charts. And really, these are just the same Chart, but one is horizontal and one is vertical. 

Now I've applied some formatting, so, you can see this Bar Chart doesn't have any gaps in 

between the bars, whereas the Column Chart does, but effectively, they are a very similar 

Chart.  

 

Now these are pretty much good for most types of data. I always say to people; ‘If in doubt, 

use a Column or a Bar Chart’. Column and Bar Charts allow us to see a direct comparison 

between different values. And these can work well for larger datasets as well. I would say 

that for all of these different Chart types, if you have a very large dataset, maybe I've got 

20,000 Rows, we wouldn't want to be displaying all of that information in a Chart.  

 

If that is the case, I would probably apply something like a Top 10 filter so, we can see the 

top 10 results and then display that in a Chart instead. Too much data is going to make your 

Charts really difficult to read.  

 

Another type of Chart that we have is the Stacked Column Chart. So, this is where we have 

our values stacked on top of each other. And again, this can offer a nice way to compare, in 

this case different Regions and also, see the value by adding Data Labels.  
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This is also, a much tidier way of displaying this data because we're effectively displaying 3 

different things in this Stacked Column Chart. We're displaying the Regions, we're displaying 

the Quarters, and then we're displaying the Values.  

 

If we had this in just a regular Column Chart, there's going to be a lot more bars on the 

screen. Whereas with a Stacked Column Chart, it just looks a lot neater. So, this could be a 

Chart type that you also, want to consider.  

 

Now the final one I want to highlight here is a Map Chart. And this is best for displaying 

geographical data. So, you can see here I have a list of states in the US, I have the State Code, 

and then I have Sales. And you can see those plotted on a map of the US.  

 

Now, Map Charts in Excel will display the geographical location of the data that you've 

created the Chart from. So, if instead of States of the US, I had countries around the world, 

when I add my Map Chart, it’s going to show me a map of the world as opposed to just the 

US. So, this Map Chart will change depending on what you have in your dataset. But clearly, 

this is best for geographical data.  

 

Now, these are just a few Chart types that I've mentioned. But these tend to be the most 

common ones that you're going to use. If we click on the little diagonal arrow in the bottom 

corner of the Chart group, you can see it opens up this pop up window. It's going to show us 

the Recommended Charts Tab, first of all, and this is showing me at the top the matchup 

based on the data that I clicked in.  

 

But if you want to see all Charts, you can click that Tab, and this is the full list of Charts. And 

we have a lot of newer ones in here as well in Excel 365. We have things like Tree Map 

Charts, we have Sunburst Charts, Histograms, which are great for showing things like 

distribution, we have Box and Whisker Waterfall, Funnel Charts, and we even have 

Combination Charts.  

 

So, if you want to combine 2-Different Chart types into one, maybe you want a Column 

Chart and a Line Chart, you could use Combo Charts for this. So, lots of different Chart types 

to explore.  

 

As I mentioned, the ones we've gone through here are the main ones that you're going to use 

and we tried to highlight what situation is best for which Chart. 
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Video: Present Data with Charts  

Deb: In the previous lesson, we spoke about how important it is to choose the correct Chart 

type for your data. And in this lesson we're going to go through and I'm going to show you 

how to create all of those different Charts that we looked at in the last example.  

 

So, let's start out on this first Worksheet. We're going to create a Pie and a Donut Chart. If 

you recall, we have a very small Table of data just here that is just showing the No of 

Employees who are female, versus the No of Employees who are male.  

 

Now when you want to insert a Chart, there are a couple of different methods that you can 

use. You can use a Keyboard Shortcut, Alt + F1, and that will insert the Default Chart Type, 

which is a Column Chart. The other way that you can do this and actually choose the Chart 

you're inserting is to jump up to the Insert Tab, and choose the Chart from the Charts group.  

 

Now, it's worth noting, you need to make sure that you are clicked in your data, you don't 

necessarily have to highlight the whole thing. And we're going to go in and we're going to 

insert a Pie Chart, first of all. So, let's click the dropdown. You can see the first group here is 

2-D Pie. So, we're going to go for this one.  

 

Now, we do have another group here, which is A3-D Pie. I always say to people; ‘Never use 

Charts that are 3-D’. Because in general, the perspective of these is a little bit off. So, again, 

it makes it quite hard to interpret your numbers. So, if you're going to use a Pie Chart, go for 

a 2-D Pie Chart. Let's select it, and you can see exactly what that does.  

 

So, we're going to get a basic Pie Chart using our Theme Colours, and by default, we get the 

Chart title. And it's just taking that Chart title from the Column Heading and Column B, and 

we get a legend at the bottom.  

 

Now all of the elements that you see here are completely editable. So, we can change the 

name of the Chart, we can change the colours that we're using, we can change the style, we 

can add other things in. So, I could add Data Labels if I want to show the actual count on 

these slices of the pie. I can move the legend around, I can add other things. Now we're going 

to get on to all of that in the next lesson when we take a look at formatting.  
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But it is worth noting that as soon as you add a Chart into your spreadsheet, you then get 2 

Contextual Ribbons. If you cast your eyes up to the top of the screen, notice that we now 

have a Chart Design Ribbon where we have all of our Design options.  

 

This is where we can come in and choose different Chart Styles, we can change the colours 

from here, we can switch the Row and Column, we can select data, and we can even change 

the Chart type from here. And then we also, have a Format Tab, which allows us to get a little 

bit more granular about the formatting that we're applying. And we're going to explore this 

fully in the next lesson.  

 

In this lesson, we just want to focus on getting these Charts into our spreadsheet. So, that's 

our first Chart; a Pie Chart. Let's insert another one. So, I'm going to click in my dataset, 

jump up to Insert and this time, we're going to insert a Donut Chart.  

 

Now again, what we're going to get is just a very basic Donut Chart using our Theme Colours 

with no customizations. In the next lesson, we're going to see how we can jazz this up and 

make this look a little bit nicer. Let's move on to the next Tab. This is where we want to 

create a Line Chart. So, once again, click in the data, Insert, we're going to go to Line Chart.  

 

Now with these 2-D Line Charts at the top here we have a few different styles that we can 

choose from. So, if we were to choose this one, it's just going to give us a plain old Line 

Chart. If we wanted to have things like markers at the different points, then we would choose 

Line with Markers. And I am actually going to choose this one just because I like this a little 

bit better. So, we can now see our data represented, and it's very easy for us to pick out high 

points, low points, and trends.  

 

Let's move on to the next Worksheet. On here, we're going to create 2 Charts; we're going to 

create a Column Chart and also, a Bar Chart. So, let's click in our data, let's go to Insert, and 

before we insert our Column and Bar Chart, I just want to highlight to you this little thing 

here; Recommended Charts, this is really good.  

 

If you're not entirely sure what Chart to use for your dataset, Excel will look at the data that 

you've got selected, and it will recommend to you Chart types that it thinks best suit this data. 

And you can see right at the top here, it's giving us a Clustered Column Chart.  
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So, I'm going to choose this one, let's click on OK, and now we have a very basic Clustered 

Column Chart. I'm going to insert another Chart, but this time we're going to insert a 2-D Bar 

Chart. So, you can see it's basically very similar to the Column Chart, it's just displaying it 

the other way around.  

 

Let's do the final 2. I’m going to go to Stacked Column. Now this one, we have kind of 2 sets 

of data. If I highlight these to make it a bit more obvious, we have our Regions and then we 

have Quarters, and then some values. So, I'm going to click inside the data, let's go to Insert, 

and this time, we're going to choose a Stacked Column Chart. 

 

Now you'll find your Stacked Column Charts underneath the Column Chart dropdown, and 

it's in this 2-D group just here. The first one is just a plain Clustered Column, the second one 

is a Stacked Column Chart. That's the one that we want. Let's grab it and place it just here.  

 

And then the final Chart that we have is this Map Chart. Now this time, we want to go up to 

the Insert Tab, and we want to click the Maps dropdown. And we're going to choose Filled 

Map. And you can see straightaway Excel has picked up based off of my data that I'm trying 

to create a map of the US and that's exactly what it's given me.  

 

So, really simple to add Charts into your spreadsheet. In the next lesson we're going to run 

through and we're going to jazz these Charts up a bit by applying formatting. 
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Video: Format a Chart  

Deb: In this lesson, we're going to take a look at how we can jazz up our basic Charts and 

make them look a lot more engaging and interesting. Now in the last lesson we went in, and 

we just added in a few different Chart types. And when you do add a Chart in, it's going to 

look fairly plain and basic.  

 

The colour schemes that you can see in use in here are very much related to the theme that 

you're using in Excel. So, if we jump up to Page Layout, and click Themes, I'm actually using 

the older Office Theme in this particular spreadsheet. Now, I'm going to change this to the 

new Office Theme. And you can see as soon as I do that the colours of my Charts update.  

 

Now, one really important point about Charts; if you want to make sure that these 

dynamically update when you add new items into your dataset, then you need to make sure 

that you put your data into a Table when you create your Chart.  

 

For example, this little Table here, we just have a count of employees depending on whether 

they're female or male. But if I wanted to add another category in here, so, let's just say 

Other, and maybe we have 50, people that identify as Other, notice that even though I've 

added this into the dataset, it's not updated in either of my Charts.  

 

Now, if we put our data into a Table, we're going to press Ctrl + T to do that. Let's click on 

OK. Now, when I add in a new Row of data, you can see that both of my Charts 

automatically update. So, save yourself some time and put your datasets into a Table when 

you create your Charts. So, now that we have our Charts, and they're all dynamically 

updating, what else can we do to make these look a little bit better?  

 

Well, the first thing we can do here is we can click in the Title area, and we can change the 

Chart title. So, I might want to make this a little bit more explanatory. So, No of Employees 

by Gender. This is just a floating Text Box. You can just select it and you can use your font 

formatting tools. So, if we wanted to change the font here, we could do that. I can maybe 

change it to Aptos Black, and maybe I want to make it a slightly lighter Grey, I can do that as 

well. So, really nice and straightforward.  
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You'll also, notice that we have a legend at the bottom here. And this is what we call a Chart 

element. Now if you click the + next to your Chart, you can see the Chart elements that are 

available for this Pie Chart.  

 

We have Chart titles selected, we don't have Data Labels selected, but we do have legend 

selected. And notice there is an offshoot menu, so, we can determine the location or the 

position of this legend. So, maybe I want to display this at the top instead, I can very easily 

move it. Again, this is just a Text Box; you could drag and drop it to wherever you want it to 

be.  

 

Now the other item we have in here is Data Labels. So, if I select this, you can see what 

happens; it adds the actual values into the Pie Chart. Now when I added these, it makes the 

Pie Chart a little bit smaller. So, I'm going to click on the Plot area, and I'm just going to drag 

this Pie Chart out to make it a little bit bigger.  

 

And of course, we can format these Data Labels simply by selecting them, clicking on one or 

select them all, and I'm going to make these White, and I'm going to make them bold, so, they 

stand out a little bit more. So, very quickly there, we've just been able to apply a few 

formatting options to make this Chart look a little bit nicer. Now if we go to the Donut Chart, 

we could do a similar thing here. So, I'm going to update the same elements that we updated 

in the Pie Chart.  

 

Now a couple of other things we could do here is we could reduce the size of the hole in this 

Donut Chart. So, if we click on the Chart, right click and go to Format Data Series, this is 

going to open up a pane on the right hand side where we have some more formatting options. 

And you can see we have different categories across the top here related to Fill Colour, 

Border colour if we want to apply those, we can add things like Shadows, Glow, Soft Edges, 

3-D format. And on this Data Tab, this is where we can define the donut hole size.  

 

So, if I drag this down, it's going to make that hole in the middle a little bit smaller. And then 

if I wanted to make this even more interesting, I could maybe add an icon inside the donut 

hole just to add more of a visual element. So, let's move on to our Line Chart.  

 

Now if we click on the Line Chart just here and jump up to the Chart Design Contextual 

Ribbon, notice that we have a Chart Styles group and in this gallery, this is where we can 

quickly apply lots of different Chart elements in one click.  
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For example, if I hover my mouse over this Chart just here Style 7, you can see that that's 

going to apply some effects to the line. We have a little bit of a Shadow, we have a Gradient 

Fill background, and we have White font. So, any of these will apply different elements to 

your Charts. So, I quite like Style 10, I'm going to keep it on that.  

 

Now even after you've added a Chart Style, you can edit any individual elements simply by 

selecting it. So, if I wanted to edit the colour of this line for example, I could select 

everything here, go to Format, and then I can choose a different colour from Shape Outline. 

So, let's go for a bright pink. And I'm going to change the shape effect here, I'm going to 

change the Glow to bright pink as well. So, that makes that line stand out a lot more.  

 

Now, if I wanted to format the markers, you can see those highlighted, I would need to right 

click and go into Format Data Series. From here, we can click on the little Paint bucket icon 

and we have a section for markers. So, this is where we can choose how we want the markers 

to look.  

 

So, I'm going to expand Marker options, I'm going to say use a Built-in Marker, and we're 

going to use this little circle, but I'm going to make it a little bit bigger. Let's go for that. And 

I'm going to change it to a Solid Fill. And we'll make this a bright Blue colour. And I'm going 

to say No Line for the Border. Click away, and we now have a completely different effect.  

 

We can also, do things like modify the number formatting. So, for example, if I wanted to 

remove the $ from this Chart to make it look a little bit cleaner, once again, if we select the 

Chart element, which is the vertical axes in this case, right click and go into Format Axes, 

this is where we can go all the way down to the bottom, Expand Number, and we can choose 

the formatting we want to use.  

 

So, I could say that I just want a number here, which is going to remove that currency 

symbol. And then, I'm just going to go in and I'm going to change the title of this Chart, like 

so. I think you'll agree that looks a lot more effective.  

 

Now let's move on to the Column and the Bar Charts. Again, we have a plain old Column 

Chart just here, I'm going to go to Chart Design and take a look at my Chart Styles. So, we 

could go in and choose any one of these. So, I quite like that one just there. Remember, we 

can switch up the colours by changing the colour palette that we're using in our theme.  
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Now what you're seeing here are basically different variations of our Theme Colour palette. 

So, this is really going to depend on what colour you want to pick out as the main colour in 

your Chart. So, I'm going to go for this Orangey colour just here.  

 

Now when we're working with Charts, our main goal is really just to make these as easy to 

read as possible and as clean looking as we can. So, removing any unnecessary data is always 

the first thing that I do. So, for example, with this Column Chart just here, what I'm going to 

do is I'm going to click on the bars, and I'm going to add some Data Labels.  

 

Now I can right click and add my Data Labels this way, I'm going to say Add Data Labels. 

And then I'm going to click on these Data Labels, and in the pane on the right hand side, I'm 

going to expand Label Options. And I'm going to say change the label position to the inside 

end, which is going to move those down.  

 

I'm going to then format these labels, let's make them White font and make them bold. And 

once we have our Data Labels actually on the bars, we don't really have a need for this 

vertical axes. So, I can select it, press Delete, and our Chart looks a lot cleaner.  

 

I can even go a stage further and remove these Gridlines. So, if I select the Gridlines by 

clicking on them and press Delete, I now have a nice plain background. And if I wanted to, I 

could right click, go to Format Data Series, and I can change the Gap Width as well. So, if I 

want to make these bars skinnier I can. Or if I want to make them closer together and make 

them a bit wider, I can do that as well. And once I've done that, maybe I want to make these 

Data Labels a little bit bigger. So, there really are so, many elements you can change when it 

comes to these Charts.  

 

The main thing you need to remember is that when you click on a Chart, you have options on 

the Chart Design Ribbon, you have options on the Format Ribbon, and if you right click on 

any element in your Chart, you're going to have a Format Data Series option, which will open 

a pane on the right hand side with more Chart formatting options.  

 

Now if you have formatting applied to a Chart and you want to copy across to another Chart, 

for example, this Bar Chart just here, we can do that but there is a little trick to it. So, what 

we can do is select this Chart and press Ctrl + C to copy. Click on the Chart we want to copy 
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the formatting to, go to the Home Tab, click the lower half of the Paste button, and go to 

Paste Special.  

 

Now notice here we have a Paste Formats option. Now when we select this and click on OK, 

it's actually going to effectively duplicate what we have. But if we use the Undo button, 

check out what happens; it allows us to keep that formatting. So, that can sometimes be a 

little bit of a quicker option.  

 

Now the final one we're going to talk through is just the Map Chart just here. Again, we can 

click on Chart Design, and for Map Charts, we don't have as many Chart Styles. But there are 

some that I like a little bit better. I quite like this one just here. And I'm going to change the 

colour of this to Orangey colours. Once again, we could right click and add some Data 

Labels. And for these ones, it's only going to add where it can actually fit it. Some of these 

states are so, small, it can't fit the text on.  

 

And if at any point, you want to switch out your Chart type, so, let's use this Stacked Column 

Chart as an example, if we click on the Chart and go to the Chart Design Tab, notice we have 

Change Chart Type. So, this is going to bring up the Change Chart Type dialog box; I can 

select Clustered Column, and I can very easily switch that Chart to a different type.  

 

So, those are some of the options that you have when it comes to formatting Charts. There are 

so, many in here. I definitely recommend you take a little bit of time just to have a play 

around, and really see what you can do. That's it for now, and I will see you in the next 

lesson. 
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Video: In-Cell Charts: Sparklines  

Deb: Sometimes when we're trying to visualize our data using Charts, we don't necessarily 

need a big Chart displaying everything in our Worksheet. Sometimes we just want to be able 

to see the trend have a series of data over time.  

 

Now a good alternative to just using this data and inserting a Line Chart is to use Sparklines. 

If you've never heard of Sparklines before, they're basically mini Charts contained within a 

Cell. Now, that's pretty hard to visualize if you've never seen them before. So, let me show 

you an example.  

 

Now on the Worksheet here, we have some names of 10 phone apps. And then we have the 

amount of Sales from January to June. So, we're dealing with time-based data just here. Now, 

maybe I want to determine if there was a trend in Sales between January and June. So, this 

data is perfect for Sparklines.  

 

Now, notice, I've added a Column; Column C called Trend, this is where we're going to put 

our Sparklines. You don't necessarily have to have them here, a lot of people like to have 

their trends at the end, so, maybe in Column J. I'm just going to put mine here, because I 

think they look quite effective.  

 

So, I'm going to click in the first Cell, let's go up to Insert, and then notice that we have a 

Sparklines group just here. Now we have 3 different kinds of Sparkline that we can insert; we 

have a Line, a Column and Win/Loss.  

 

Now it's worth noting that Win/Loss is most appropriate when you have negative numbers in 

your dataset. And if you take a look at our data, we currently don't have any negative 

numbers. So, we're going to focus on Line and Column. So, let's click on Line. It's asking me 

for my data range. So, where is the data that I want to represent in this Sparkline?  

 

Now I could do this in one of 2 ways; I could select just this first series of data just here, and 

say I want to put this Sparkline into Cell C4 and click on OK, and it's going to give me a 

Sparkline. I can then use the fill handle to drag this down.  

 

Now I'm going to undo that for a second Ctrl + Z, and delete because we can do this in a 

slightly different way. Let's go back to Insert and Line, and this time, I'm going to say that my 
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data range is everything just here. And my location range, where do I want these Sparklines 

to appear? Well, I want them to appear here. Let's click on OK, and I get the same thing. So, 

2 slightly different selection techniques just there.  

 

Now notice what we get, we get this line. Now my numbers are, it seems gradually sloping 

up, there isn't too much variation. So, I'm just going to mess this data up a little bit. Let's add 

in some random numbers to make these look a little bit pointier. Now once you have your 

Sparklines in your Cells, you can apply some formatting to them. So, let's select them.  

 

Notice we have a Sparkline Contextual Ribbon. And from here we can do things like change 

the style, we can even mark specific points. So, I'm going to change the style of my 

Sparklines to Orange to make those really stand out. I can then choose what I want to mark in 

this Show group.  

 

For example, if I select High Point, you can see in the Sparkline, it's going to mark where it 

finds the highest value. I could do Low Point; it's going to mark where it finds the lowest 

value. Now if I want a marker on every single data point, I could choose Markers, and it's 

going to put those in. And it just gives a really nice way to visualize your data.  

 

And of course, if I wanted to change the Marker Colour, I have a Marker Colour option just 

here. So, let's go to markers, and I'm going to make these markers Blue. So, very quickly, 

we've managed to add in 10 Mini Charts to show the trend of this data. And I think 

Sparklines look really effective.  

 

Now before we leave this lesson, let's select all of these Sparklines again and go back to the 

Sparkline Ribbon. Because what we can also, have in here instead of Line is a Column 

Sparkline. So, if we go to the first group Type, you can see we have Line currently selected. 

But if I choose Column, you can see that that's going to display that in a slightly different 

way.  

 

And in this case, we can't do all markers, I'm just going to mark the High Point and the Low 

Point. And I'm going to change the Marker Colour. I'm going to set the High Point to Green, 

and let's set the Low Point to this Yellowy Orange colour. So, if you prefer to have your 

Sparkline displayed as a Column as opposed to a Line, you can do that as well.  
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Now, as I mentioned, the other option that we have when it comes to Sparkline is Win/Loss, 

and this is for negative numbers. So, I'm quickly going to go in and add some negative 

numbers into my dataset. So, now I have some negative numbers; you can see those 

represented in brackets in the dataset.  

 

I'm going to clear out these Sparklines let's go back to the Sparkline Ribbon. And if you want 

to delete these, it's worth noting that you can't just press the Delete key on your keyboard, 

you need to click on Clear and then Clear Selected Sparkline Groups.  

 

So, now I'm going to go to Insert, and this time, we're going to choose the Win/Loss 

Sparkline. So, let's select our data range, we're going to go for this. And then our location 

range is going to be these Cells just here. Let's click on OK, and you can see what that does. 

So, wherever we have a minus figure, you can see that that's showing in a slightly different 

colour.  

 

So, these blocks are all the same, but it really just highlights any negative values that you 

have in your dataset. And of course, you can customize the colours of these as you might 

expect, by using one of these styles just here maybe, or you can set the individual Marker 

Colours. So, I think you'll agree Sparklines are a pretty cool way to visualize data and 

recognize trends. 
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Video: In-Cell: The REPT Function  

Deb: In the final lesson of this section, I'm going to show you how you can create an in-Cell 

Chart using a function called REPT. Now, the REPT function is probably one that you 

haven't come across before.  

 

Now the REPT function stands for Repeat. And what it basically allows us to do is insert a 

symbol or a piece of text, and then repeat it a specified number of times. Now, you might be 

thinking to yourself; ‘Okay, well, that makes sense. But how on earth is that going to create a 

Chart in a Cell’?  

 

Well, let me show you. So, on this first Worksheet, we have a list of Employee Names in 

Column B, we have their Photo in Column C, and then we have their Review Score out of 

100 in Column D. Now maybe I want to get some kind of visual comparison between each of 

these employees by adding a Bar Chart in here. So, what we can do is we can type in = and 

choose REPT.  

 

Now notice the ScreenTip there. It says; ‘Repeats text a given number of times. Use REPT to 

fill a Cell with a number of instances of a text string’. So, if we select this and take a look at 

the arguments, we have 2 arguments; text and number of times. Now there are all different 

kinds of things that you could put in here. You could use symbols as your piece of text.  

 

Now, in this example, in order to get a bar, we're going to use the pipe symbol. And because 

this is text, it needs to go inside quote marks. So, I'm going to open a quote. And then we're 

going to type pipe, which is just that straight line, and we're going to close our quotes. So, 

that is our text, comma. Now we just need to specify the number of times we want to repeat 

this pipe symbol in the Cell. So, for this, we're going to choose the Review Score.  

 

So, for this first one, I should get that pipe symbol 85 times in this Cell. Let's hit Enter. And 

you can see that we do. Now, you might be thinking to yourself; ‘Well, okay, but that doesn't 

really look like a bar’. Well, this is where the magic happens. All we need to do is change the 

font, and this is going to magically turn into a bar.  

 

So, if we go up to the Home Tab, and I'm going to click where we currently have Aptos, and 

I'm going to change this to Playbill, and hit Enter. Check it out, it now looks like a bar. We 
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can then drag this down to copy the Formula, and we get a bar representing the Review Score 

in Column E. And if we don't like this Black colour, we can simply change it.  

 

And remember, this is effectively font. So, we need to change the colour of the font in order 

to change the colour of the bar. So, let's go for a Purple bar just here. And the cool thing is 

that these are all dynamic. So, if the Review Score changes, let's take this one down to 30 and 

hit Enter, the bar is going to update. So, the REPT function is a really nice quick way to put a 

simple bar in a Cell using a Formula.  

 

Now we can also, do a SUM calculation along with REPT. So, let's jump across to the next 

Worksheet where we have something similar. We have our Employee Names their Photo, but 

this time, their review has been broken down into each of these areas; Teamwork, Technical 

Skills, Adaptability, and Flexibility. And you can see here they have scores out of 25 for each 

of these.  

 

So, what I want to do is I want to work out the total for each employee, and I want to 

represent it as a bar. Now, because I don't actually have the SUM calculation already in here, 

I'm going to combine it with REPT and do it all in one go. So, let's type in =, we're going to 

say REPT. Our text again is going to be that pipe symbol, we're going to put it in those quote 

marks.  

 

Now when it comes to the number of times, we want to do a SUM, and we're going to select 

all of these Cells D5:G5. We're going to close off SUM, close off REPT, hit Enter, and if we 

widen out that Column, we now have one of these bars repeated depending on what the SUM 

of these numbers is.  

 

Once again, we need to convert this to Playbill font. So, let's jump up to here and type in 

Playbill and hit Enter. And I need to adjust my alignment. So, let's go and align this to the 

left. That looks a lot better. I can now drag this all the way down. And now, we have a bar 

representation of those totals and we can get a good comparison between the different 

employees.  

 

Once again, if anything changes just here, so, let's take this up to 25, then that bar is going to 

dynamically adjust. And of course we can change the colour; Ctrl + Shift + Down Arrow of 

the font. And this time let's make these Green. So, that is a neat little trick of how to create an 

in-Cell bar using the REPT function. 
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Video: Exercise 12  

Deb: It's time now to complete Exercise 12. And in this exercise, we're going to practice 

some of the skills that we've learned in this section of the course.  

 

So, the first thing I'd like you to do is to open the exercise file ‘Exercise12.xlsx’. And I'd like 

you to look at the data on the Sales Tab, and determine which Chart type would best 

represent the values. I'd like you to also, ensure that the data is dynamic, so, that if a new 

company is added to the Table, the Chart will update. And then I'd like you to insert a Chart.  

 

And I'd like you to format the Chart however you please. But I would like you to ensure that 

the Chart does not contain any unnecessary items, and it's easy to read. And then I'd like you 

to add another company to the dataset and make sure the Chart updates. And you can make 

up your own company name and values.  

 

And then finally, using the dataset at the bottom of the Worksheet, I'd like you to insert an in-

Cell Line Chart into Column F that shows the trend of rainfall over a period of 3 years. And 

I'd like you to make sure that you display all markers for each year on that line. So, a few 

things to do here. If you'd like to see my answer, then please keep watching.  

 

So, the first thing I asked you to do was to look at this first Table and think about what Chart 

would be most appropriate for this data. Now, this is a geographic based data. It's not data 

that changes over time, it's pretty standard data. It's just a list of companies, their revenue, 

and their profit. So, probably the most logical Chart to use here would be either a Column 

Chart or a Bar Chart, which is exactly what we're going to use.  

 

Now, I did mention that I also, want you to make this dynamic so, that if we add a new 

company into the bottom, the Chart is going to automatically update. So, we're going to start 

here by making this a Table; Ctrl + T. Yes, my Table has headers. Now I'm just going to 

leave the banding, that's fine.  

 

Let's insert our Chart. We're going to go to the Insert Tab, I'm going to go to the Column 

Chart dropdown, and I'm going to choose 2-D Column Chart. I think that represents this data 

really nicely. I then asked you to do a little bit of formatting.  
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Now I don't really mind what formatting you applied, I just wanted you to have a little bit of 

a practice. So, maybe we'll apply a Chart Style. Let's take a look at some of these. I think that 

one looks pretty nice. I'm going to give this a Chart title. So, let's just double click, and this is 

Revenue vs Profit. And let's also, just change the colour scheme that we're using here. So, I'm 

going to go for these colours. Now, of course, I could spend a lot more time formatting this, 

but we're going to leave it there.  

 

I then asked you to make sure that this Chart is automatically updating when we add a new 

company to the bottom. And I didn't mind what company name you used, you could use 

anything. So, let's go for Finstagram, press Tab, and you can see as soon as I do that, it's 

added it to the Chart. I can then add in my numbers. Let's just go for 50,000, and then we'll 

go for 20,000, like so. So, that is all working perfectly.  

 

The second part of this exercise was to add an in-Cell Chart to Column F in this Table at the 

bottom. So, for this, we want to use Sparklines to show the rainfall for these different cities 

over A3-year period. So, what I'm going to do is I'm going to select all of my data, we're 

going to go up to Insert and then in Sparklines, we're going to click on Line. Now my 

location range is going to be this Cell range just here. Let's click on OK, and then we can 

apply our formatting.  

 

Now, I did ask you to mark all year points. So, if we take a look in the Show group, I'm going 

to go for Markers; that will add those points in for each of the years, and then we could 

choose a different style if we wanted to. I'm going to go for dark Grey. And that is all I 

needed you to do. I hope you got on okay with that. I will see you in the next section. 
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Section 13: Conditional Formatting 

Video: Highlight Cell Values  

Deb: In this section of the course, we're going to start to take a look at how we can use 

Conditional Formatting. Conditional Formatting is brilliant for highlighting values or text that 

meet specific criteria in a spreadsheet. We're going to start out in this lesson by taking a look 

at Highlight Cell Values.  

 

Now you're going to find all of your Conditional Formatting options on the Home Ribbon, in 

the Styles group underneath this Conditional Formatting dropdown. And you can see that we 

have quite a few different options in here, and we're going to be exploring all of these 

throughout the balance of this section. But let's first start out with this top one just here, 

Highlight Cells Rules. What exactly does this do?  

 

Well, you can see as I hover over this option in the menu, we get another menu shootout to 

the right hand side where we have a few more options. So, if we take a look at the 

spreadsheet, you can see here that I have some states in the US, I have the months of the year 

running across the top, and then we have some values in the Table. So, maybe I want to 

highlight in this Table of data, all of the values that are greater than 2000.  

 

So, what I could do here is select all of the data, go up to Conditional Formatting, Highlight 

Cells Rules, and I could choose Greater Than. I get this little Greater Than box pop up, and 

this is where I can enter the value. So, we want to highlight everything that's over or greater 

than 2000. I can then choose what type of Background Fill I want to use. And you can see the 

default, there is Light Red Fill with Dark Red Text.  

 

But we could have a Yellow Fill, a Green Fill, a Light Red Fill, a Red Border, or we could 

choose our own Custom Format; which we're going to do in a moment. Let's just first start 

out with the default Light Red Fill with Dark Red Text, click on OK, and you can see it does 

exactly that; we now have all of those values highlighted.  

 

Now one thing to note here is that we do have some text entries in here as well. You can see 

that a few of the Cells have the word; ‘No Data’. And with this particular option, it's also, 

highlighted those. And I'm going to show you in a moment how you can deal with that.  
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Now one thing to remember here is that when you're applying Conditional Formatting to a 

dataset, you're essentially setting up a rule. So, if I wanted to make any changes to this rule, I 

would need to go back into Conditional Formatting, go down to Manage Rules, and it's going 

to take me into the Formatting Rules Manager. And you can see there is our Conditional 

Formatting rule.  

 

If I wanted to make changes to it, I have an Edit Rule button just here, which allows me to 

choose a different rule type, or I can edit the Rule Description. So, I could change this to 

Format Specific Text, I could change this to a different operator, so, Less Than a value, and I 

can even change the value in here. I can also, click the Format button if I want to apply a 

different style of formatting.  

 

So, if we go to the Fill Tab, maybe I decide that I want these to have a Background Fill of 

this Blue colour instead. Let's click on OK, and OK again, and you can see that's exactly what 

it does. So, Highlight Cells Rules really useful.  

 

If you want to clear the rule and get rid of it, we have a Clear Rules option just here, and we 

could say Clear Rules from Entire Sheet, and that's going to get rid of that Conditional 

Formatting. We can do something very similar for values that are less than a specific number.  

 

So, if we go back into Conditional Formatting, Highlight Cells Rules, we could say Less 

Than, and maybe this time, I want to highlight everything that's less than 1000, with a Yellow 

Fill and Dark Yellow Text, click on OK, and we have our new rule set up.  

 

And if I wanted to apply both of this rule and another rule, I can simply reselect everything, 

go into Conditional Formatting, and I've got 2 options; I could go back into Highlight Cells 

Rules, or I could go down to Manage Rules, and I could say, New Rule, or I could duplicate 

this rule.  

 

So, if we duplicate the rule, and then edit this rule, I could go in here and change this to 

greater than, and we're going to put 2000 again. And then I can change the formatting. So, 

let's go for a Green fill instead this time, click on OK, and you can see exactly what that does. 

So, you can have multiple rules applied to the same dataset.  

 

And if we go back into Conditional Formatting, Highlight Cells Rules, the rest of these rules 

work in a very similar way. So, with Between, this is where we can highlight Cells that 
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contain values that fall between 2 specific values, for example, between 1000 and 2000. Or, 

we could say highlight Cells that are equal to a specific number. So, maybe we want to 

highlight all of the Cells that are exactly equal to 1000.  

 

We even have an option in here specifically related to text. So, if I select my datA1 more 

time, let's do Text that Contains, and I'm going to say, No Data. Click on OK, and you can 

see it's highlighted those Cells with the text No Data in them.  

 

And then the final couple of options we have in here, ones related to Dates. So, for this one, 

this is where you can highlight Cells that contain a date that occurred Yesterday, Today, 

Tomorrow, the last 7 days, so, on and so, forth.  

 

And then the final option in here is related to Duplicate Values. This one will highlight any 

duplicate values that you have in your selected range. So, let's delete our rules. So, I'm going 

to go to Clear Rules and from Entire Sheet. Let's select everything one more time, and let's go 

into Duplicate Values. And you can see here that wherever it finds duplicates, it highlighted 

them.  

 

So, I know that I'm going to have more than one occurrence of 2913 in this dataset. And I can 

see that yes, I do. If we look over in the November Column, there is 2913. So, if you quickly 

just want to highlight any duplicate entries, that's a great option to use. Let's go into 

Conditional Formatting and clear the rules.  

 

Now the final thing I want to show you here is how we can get around that issue that we had 

at the beginning of this lesson, where when we highlight all of the Cells that are greater than 

2000, it's also, picking up the Cells that contain the word No Data.  

 

So, for this, we're going to use a combination of 2 rules; we're going to select everything, 

we're going to go to Conditional Formatting, and we're going to highlight the Cells that are 

greater than 2000. Let's just leave them on a Red fill and click on OK. And then we're going 

to add another piece of formatting. We're going to say Text that Contains, we're going to say 

No Data, but this time, we're going to choose a Custom Format.  

 

So, on the Fill Tab, we're going to choose No Colour. And we also, don't want the font to be 

Red. So, we're going to go to the Font Tab, and we're going to make sure that the colour is set 
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to Automatic. Click on OK and OK again, and you can see that those Cells are now no longer 

highlighted.  

 

So, that's how you can use Highlight Cell Rules to highlight Cells in a Worksheet that meets 

specific criteria. 
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Video: Data Bars  

Deb: In the previous lesson, we saw how we can use Conditional Formatting to highlight 

Cells that meet specific criteria. But if you recall underneath this Conditional Formatting 

dropdown, we have all of these other options in here as well. In this lesson, we're going to 

focus on some of the more visual ways to format our data using Conditional Formatting. And 

we're going to check out Data Bars.  

 

Now before we get on to that, I just want to quickly talk about this Top/Bottom Rules, 

because this is kind of related to Highlight Cells Rules, and it's pretty much what it says on 

the tin. We can select our dataset. And if we want to, we could highlight the top 10 items, or 

the Top 10%. We have the same for the bottom 10 items, or the Bottom 10%.  

 

So, if I wanted to see what the Top 10% values were in here, I could select my data 

Top/Bottom Rules, Top 10%, I can then choose the percentage. It doesn't have to be the Top 

10%, it could be the Top 5, the Top 20. And then I can choose my Fill Colour. And you can 

see what that does in the Worksheet. So, just remember that you have that option as well. 

Now I'm not going to apply this, let's just click on Cancel, because what I want to talk about 

in this lesson is Data Bars.  

 

Now Data Bars are basically a visual representation of an in-Cell Bar Chart within the Cell. 

And the length of the bar is determined by the value that we have in the Cell. So, if we go to 

Data Bars, you can see that we have 2 different groups; Gradient Fill and Solid Fill. And this 

is entirely personal preference.  

 

Gradient Fill, you get a gradient bar, whereas with Solid Fill, you get a Solid Fill Colour. And 

of course right at the bottom, we have More Rules. If we went into here, we can completely 

customize how our bar looks.  

 

So, if you want a completely different colour or something that matches your branded 

colours, then you can select another colour from the dropdown. Alternatively, you can go to 

More Colours. And you can choose using this slider, or you can type in the hex code just here 

if you need to get really specific. 

 

Now let's not jump too far ahead of ourselves, let's just go back to Data Bars. And I'm just 

going to apply these Green Data Bars to my Cells. And you can see what that looks like, we 
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now get a really nice visual representation. Notice that where we have No Data, we have No 

Data Bar in there, which is exactly what I wanted to do.  

 

Now with things like Data Bars, these are also, rules. So, if we go into Conditional 

Formatting and Manage Rules, we're going to be able to see our Data Bar in here. So, if I 

click Edit Rule, I can pretty much edit every single element of this Data Bar.  

 

So, at the top here, where it says Format Style, I'm using a Data Bar, but I could choose to 

use Colour Scales or Icon Sets. And we're going to get on to those in the next few lessons, I'm 

going to leave it on Data Bar.  

 

We also, have an option here to show the bar only. So, this is quite interesting. If we click 

this and select OK and OK again, it's actually going to remove the value from the Cell and 

just show the Data Bar. So, this is quite useful if you have a situation where maybe you're 

presenting confidential data.  

 

So, if you imagine you're in HR, and you're doing some kind of presentation where you're 

talking about people's salaries, you might not want to show the actual salary of the individual 

person, but you might want to show it in relation to other people's salaries. So, the bar is 

going to be helpful, we don't need the value, we can keep that confidential. So, just be aware 

that you have that Show Bar Only option in here as well. I'm going to deselect it.  

 

Now another thing to be aware of in here are these Minimum and Maximum fields. Notice 

that these are both set to Automatic. Now what that means is that Excel is basically going to 

look at the data that you've selected, it's going to work out what the minimum value is, it's 

going to work out what the maximum value is, and it's going to adjust the length of the bar 

based on those 2 values.  

 

So, my lowest value in my Worksheet might not be 0, it might be 500. And the maximum 

value might be 3000. So, because 500 is my lowest value, the bar is going to be very, very 

short. Now it might be in some situations that you don't actually want Excel to determine the 

length of the bar based on the minimum and the maximum value.  

 

For example, if we click the dropdown, we have some options. So, maybe I want to define 

this by specific numbers. So, I'm going to change both of these to Number. So, maybe I want 
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to say that the minimum is 0 and the maximum is 3000. Let's click on OK and OK again, and 

it's going to adjust those bars accordingly. They adjusted very, very slightly.  

 

Let's manage our rule one more time and edit the rule. Maybe this time, I want to say that the 

lowest value is 500 and the highest value is 6000. Now, I don't have values up to 6000 in this 

spreadsheet, so, we should see a bit more of a dramatic change. So, let's click on OK and OK 

again, and you can see what that's done. It's adjusted those values accordingly.  

 

So, anything that's closer to 500, like this Cell just here, we barely have a bar. You can see 

here for 502, because my lowest value is 500, again, we barely have a bar. So, just be aware 

that the minimum and maximum values will affect the length of your bar. Now I'm going to 

put mine back to Automatic.  

 

And then finally at the bottom, we can customize the Bar Appearance. So, we have 2 choices; 

Solid Fill and Gradient Fill. And then we can choose the colour. So, I'm going to do 

something a bit different here. I'm going to make the bar White, but I'm going to give it a 

Border. So, let's say Solid Border. And I'm going to go into More Colours, and let's choose a 

dark Purple. Click on OK, click on OK again, and you can see we get a completely different 

effect.  

 

Now, I'm not saying that that looks amazing, but I just wanted to show you some of the other 

options that you have. Now I think I'm going to manage the rule, I'm going to edit it, and I'm 

going to give it a Solid Fill Colour of a very light pink. Click on OK, OK again, and there we 

go.  

 

So, just be aware that you can use Data Bars to visually represent a value in a Table. 
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Video: Color Scales  

Deb: In the last lesson, we saw how we can apply Data Bars to a dataset to visually represent 

the value in a Cell. And in this lesson, we're going to stick with the topic of Visual 

Conditional Formatting, and I'm going to show you how you can use Colour Scales to 

effectively create a heat map helping you highlight and see trends.  

 

Now the first thing I'm going to do here is I'm going to clear out this Data Bars formatting 

just so, that we start with a clean slate. So, let's select everything, and I'm going to say Clear 

Rules from Entire Sheet. So, this time, what we're going to do is we're going to select 

everything again.  

 

Now I'm using my mouse to make my selection. Remember, you could do Ctrl + Shift + 

Right Arrow, and then keep Ctrl and Shift, hold down and press the Down Arrow to make 

your selection if you like Keyboard Shortcuts. We're going to go up to Conditional 

Formatting, but this time, we're going to go to Colour Scales.  

 

Now notice, when we select Colour Scales, we get another little menu shoot out to the right 

hand side, where we have a gallery of 12 different Colour Scales. Now, these varies, some of 

them are 3-Color Colour Scales, and some of them are 2-Color Colour Scales. So, again, this 

is really personal preference. So, let's start out with one of these in the top Row, I'm going to 

go for the second one along it just here.  

 

Now, you'll notice a dramatic change as soon as I hover my mouse over this option. Notice 

what the ScreenTip says. It says; ‘Red - Yellow - Green Colour Scale. Apply colour gradient 

to a range of Cells. The colour indicates where each Cell value falls within that range’. So, 

basically, because this is Red - Yellow – Green, Red represents the highest value in the 

spreadsheet, whereas Green will represent the lowest.  

 

Now because we have a range of different values, the Cells are going to be coloured 

depending on where they fall within that range. So, I think our highest value is up towards 

3000; 2963, I think is the top value. You can see that in the middle, it's in the month of June, 

that one is a very dark Red. So, let's apply this Colour Scale.  

 

Because you can see that something like 2398, which we have here in the August Column, 

that's kind of an Orangey colour, because it's not the top value, but it's also, not the lowest. 
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So, these numbers are kind of graded between the highest and the lowest value. And because 

we're using A3-Color Colour Scale, we have Red, Yellow, and Green as our markers.  

 

Now I could change that. If we go into Conditional Formatting and manage the rule, there's 

my Graded Colour Scale. I could edit the rule, and I could change this from A3-Color Colour 

Scale to a 2-Color Colour Scale. If I click on OK and OK again, you can see that it's now just 

grading these colours between Green and Red. And we have various different shades between 

those 2. And of course, we don't have to use those default colours.  

 

If we go into Manage Rules again and edit the rule, we can choose our own Colour Scales. 

So, I'm going to set this back to A3-Color Colour Scale. Again, it's using the minimum value, 

the midpoint, and the maximum to work out how to fill in the background colour. So, for this, 

I could go for my own set of colours.  

 

So, let's go to More Colours. I'm going to go to the Standard Palette. Let's choose a Blue 

colour for our lowest value, I'll keep it on Yellow for the midpoint, and let's go for Purple. 

Click on OK. When I click on OK and OK again, you can see it applies those colours. And 

those are pretty crazy colours. But hopefully, you get the idea.  

 

Now I'm going to select my data again, let's go into Conditional Formatting and Colour 

Scales, because notice we have some other default ones in here. So, I could choose this Green 

- Yellow Colour Scale, which matches a little bit more with my overall theme. So, if I select 

this one, it’s going to apply those colours to my dataset. And once again, notice that where 

we have a Cell that contains No Data, those are not highlighted at all.  

 

So, that's basically Colour Scales. They work like a heat map. Have a little play around with 

them, and see what you think. 
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Video: Icon Sets  

Deb: In this lesson, we're going to take a look at the final piece of Visual Conditional 

Formatting in the list, and that is Icon Sets. And we've switched to a slightly different dataset 

to demonstrate this.  

 

So, you can see here that I have a list of companies, we have their Company budget, and we 

have their actual figures. And what I've got in Column D is just the difference between the 

actual and the budget. So, I can see if we're under budget, or if we're over budget.  

 

So, you can see here for Company A, the difference is 266. It's a positive value, so, it means 

that we're over budget. You can see our budget for Company A is 143, whereas our actual 

was 409. Wherever we have a minus value in here, we're under budget. So, for Company B, 

our budget was 471, and our actual was 230. Now this Column here, the Difference Column 

is just a calculation, it's a very simple minus calculation; C6 – B6, so, Actual – Budget. 

 

So, now that I have my values here in the Difference Column, I could use Icon Sets to 

represent these values. So, once again, I'm going to select my dataset, we're going to go to 

Conditional Formatting, and we're going to choose Icon Sets. Now we have quite a few 

different Icon Sets that we could use here. So, this really, again, is personal preference, use 

whichever one you like.  

 

Now, I think I'm going to use Directional. And notice again, that we have 3-Icon Icon Sets, 4-

Icon Icon Sets, and 5-Icon Icon Sets. So, I'm going to stick with the 3-Icon Icon Sets, and 

we're going to use Arrows. So, let's select and see what that does. Now, the way that these 

Icon Sets are applied is that Excel will look at the values in our selected range, so, these 

values in this case, and it will try to work out which Arrow to apply.  

 

Now, because we've chosen A3-Icon Icon Set, it essentially divides your values up into 

thirds. So, it will find the lowest value, which in this case is going to be a minus figure, it will 

find the highest value, it will divide them into thirds and assign an icon based on that.  

 

So, you can see here that for the values that are positive, we have a Green Arrow, for the ones 

that are negative, and the difference is great, we have a Red Down Arrow, and then the values 

that kind of fall in the middle there have this Yellow Arrow. So, again, this is just a really 

nice visual way of representing this data.  
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And of course, much like Data Bars, we can choose to show just the Arrow and not the value. 

So, if we go into Conditional Formatting and Manage Rules, there is our Icon Set rule. We 

can choose Edit Rule, and we can say Show Icon Only. Click on OK and OK again, it's going 

to remove those values, and we just have the icons in the Cell.  

 

Now I'm going to go back into manage this rule, let's edit it, and I'm going to deselect that. 

Now it might be that I don't necessarily always want Excel to work out which Arrow to apply 

to my dataset. In this particular dataset that we're using, it's going to make much more sense 

for us just to have a Green Up Arrow when it's a positive value, and a Red Down Arrow 

when it's a negative value.  

 

So, I'm going to change my Conditional Formatting rule. Let's go into Manage Rules. I'm 

going to select it and I'm going to edit it. Now what I'm going to do here is I'm going to 

change the Icon Style; I want to use a different Icon Set, let's go for these ones just here. And 

what we're going to do is we're going to change the type to Number for both of these. And I 

only want a Green and a Red Arrow for positive or negative values. So, we don't essentially 

need this Yellow one in the middle.  

 

So, what we can do here is we can click the dropdown, and we can say No Cell Icon. So, 

what we have now is a Green Arrow when the value is greater than or equal to zero, and then 

we just have a Red downward Arrow when it's less than zero. Let's click on OK and OK 

again, and that represents my numbers in a much clearer way.  

 

I could even go a stage further and manage the rule. And let's just say that we want to show 

the icon only. Let's select that checkbox, click on OK and OK again. And now what I'm 

going to do is I'm just going to align these to the middle. So, on the Home Tab, I'm going to 

click the Centre Align button, and now it's very easy for people to see at a glance if the 

difference is positive or negative.  

 

So, just remember that when you're working with Icon Sets. You can customize these so, that 

they suit the data that you're using so, that they represent the data in a much clearer way. 
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Video: Exercise 13  

Deb: It's time now to do Exercise 13. And in this exercise, we're going to practice the skills 

that we've learned in this section of the course.  

 

So, I'd like you to add A3-Color Colour Scale to Table 1. And I don't mind which one of the 

Colour Scales you use, as long as it's got 3-Colors. In Table 2, I'd like you to highlight all 

Cells where the values for between 35.0 inches and 45.0 inches, and I'd like you to use a 

Yellow Highlight.  

 

And in Table 3, I'd like you to use Icon Sets and add a Red traffic light where the value is 

negative, and a Green traffic light where the value is positive to the ‘Difference Column’. 

And you can see a little screenshot there of the Icon Set that I'd like you to use.  

 

Once you've done that, I'd like you to change the settings of the Icon Set to show the icon 

only, and centre align the icon in the Cell. That's it. If you'd like to see my answer, then 

please keep watching.  

 

So, the first thing to do here is to add A3-Color Colour Scale to this little dataset just here. 

So, with everything selected, we're going to go to the Home Tab and Conditional Formatting, 

we're going to go to Colour Scales, and we're going to choose one of these 3-Color Colour 

Scales. So, this is mostly these ones on the top Row, we do have a few more down here. Let's 

go for the first one.  

 

In the second Table, I asked you to highlight all of these Cells where the rainfall is between 

35.0 and 45.0. So, we're going to select our data, up to Conditional Formatting, but this time, 

we're going to go to Highlight Cells Rules, and we're going to say Between. So, we want to 

format all Cells that fall between 35.0 and 45.0. And I asked you to fill these with a Yellow 

highlight. So, from the dropdown, I'm going to select Yellow Fill with Dark Yellow Text. So, 

let's choose that one and click on OK. That's all I needed you to do there.  

 

And for the final Table right at the bottom, I asked you to use Icon Sets. And we want to 

show a Green traffic light for positive values in this Difference Column, and a Red traffic 

light for negative values. So, we're going to select our range of Cells; that's everything in the 

Difference Column. This time, we're going to go to Conditional Formatting, and I'm going to 

say New Rules simply because I find doing it this way a little bit quicker.  
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Now the Format Style we're going to use is Icon Sets, and I'm going to choose these traffic 

lights just here. Now remember, we're only using 2 icons as opposed to 3, we don't really 

need this Yellow one in the middle.  

 

So, the first thing I'm going to do here is click the dropdown and change this to No Cell Icon. 

I'm then going to go to the Type Column because we want to use Number as opposed to 

Percentage. Anything that is greater than or equal to zero, it's going to show a Green traffic 

light. Anything that is less than zero is going to show a Red traffic light. Let's click on OK. 

And that's exactly what we get. We can see here, all of the ones which have a Red traffic light 

are negative values.  

 

The final couple of things I asked you to do here, I asked you to show the icon only. So, I'm 

going to go back into Conditional Formatting, let's manage our rules. There are our traffic 

lights, I'm going to edit the rule, and I'm going to say Show Icon Only, and click on OK. And 

then I just wanted you to make sure that these were aligned to the centre of the Cell.  

 

So, that is it. That is all I needed from you. I hope you got on okay with that, and I will see 

you in the next section. 
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Section 14: Insert Pictures and Other Graphics 

Video: Add Interest with Pictures and Icons  

Deb: Whilst it is true to say that Excel is a very data-driven and logical application, it doesn't 

mean that we can't add a little bit of interest and personality to our spreadsheets. And one 

way to do that is by including Pictures and Icons.  

 

Now I will say that if you've ever inserted Pictures or Icons into other applications like Word 

or PowerPoint, it works pretty much the same way in Excel. So, if you already have those 

skills, then you're going to get a little bit of a head start.  

 

There are, however, a few differences when it comes to working with Pictures in Excel. And 

some of these differences are very new changes or updates that have been made to the 

application. Now, I don't want to get too far ahead of ourselves just here. Let's start with the 

basics of how to insert Pictures into a spreadsheet.  

 

Now you're going to find your Insert Pictures option on the Insert Ribbon. And notice here 

we have an Illustrations group. Now, when we click the Pictures dropdown, we have a couple 

of different options. And these are brand new in Excel 365. We have Place in Cell or Place 

over Cells. So, what is the difference between these 2?  

 

Well, we're going to start out with Place over Cells, because this was kind of the default 

behaviour before this latest update. So, what we can say here is Place over Cells, and then we 

get to choose the location of our Image. So, it might be that you have Pictures saved off to 

your C drive, maybe you have them stored on your Mobile Device, maybe you want to 

choose a Picture from Excel’s inbuilt Stock Image library, or maybe you want to grab a 

Picture from a website or from Google.  

 

Now we're going to use Images that we have saved off to our device. And all of the Images 

that I'm going to be using in this lesson you'll find in the Course Files folder. So, let's go to 

This Device. And you can see I have some Images stored off here. So, let's select this first 

Image of Amy, and choose Insert.  

 

Now because we've chosen Place over Cells, that's exactly what it's going to do. You can see 

this Image is pretty large, and it's on top of all of the Cells. So, if I wanted to fit this exactly 
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within a Cell, I'm going to have to do some resizing just here. Now to resize an Image, it's 

fairly simple; we can simply grab any of these little Circles that you see in the corners or at 

the sides, and we can drag in. So, let's make Amy a little bit smaller.  

 

Now another thing to know about Images is that when you place one in a spreadsheet, you're 

going to get a Picture Format Contextual Ribbon. So, if you take a look at your Ribbons, 

here, we have a new one appear. And this contains all of the formatting options for this 

particular Picture.  

 

So, we can do things like change the Picture style, so, maybe I want to make this a different 

Shape, I could choose any of these from the gallery. If I just want a plain thin Border around 

the outside, I could choose to add a Picture Border, I could choose the weight, let's go for a 

very thin Line. And I could also, choose the colour. So, I'm going to keep it on Black. And 

you can see that we now have a very thin outline around the outside of this Picture.  

 

We can choose Picture effects. So, maybe I want some kind of glow around the outside. Or 

maybe I want to apply a reflection. You have lots of different Picture effects to choose from 

in here. I can also, make changes to the colour or the transparency of this Image.  

 

In the Adjust group, we can apply different corrections. So, we can soften or sharpen, we can 

change the brightness or the contrast, and we can even recolor the Image. So, I can make it 

more saturated than it currently is. Or I could recolor it. These can be quite nice effects 

sometimes, particularly if you want all of your Images to look reasonably similar. You could 

recolor them in this Blue colour just here. Or you could even have them as Black and White. 

If you want to.  

 

You can set the transparency. So, if you don't want it to be completely opaque, you could 

choose one of these options as well. And as with most things that you insert into a 

spreadsheet, if you right click on the Picture, you're always going to have a Format Picture 

option right at the bottom. And this is going to open up a pane on the right hand side where 

we can see a lot of the options that we have on the Ribbon, but also, some additional options 

as well.  

 

So, you can expand any of these and you can get very granular about the transparency, the 

colour, you can apply pre-sets, so, on and so, forth. So, so, many different options when it 

comes to formatting Pictures. We can even crop our Image. So, you can see she's not quite in 
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the centre there. I might want to choose the crop button. I might want to crop this Image by 

clicking the dropdown underneath Crop and I could choose Crop just here.  

 

You can see that that puts those Black handles around the outside and then I can drag this 

side in and click the top half of the Crop button, which is basically going to crop that Image. 

And I'm going to Ctrl + Z to undo that, because we can also, crop to a Shape.  

 

So, if I wanted her to be more of a Rounded Rectangle, I could choose Rectangle Rounded 

Corners. And you can see what that does to the Image; we get a completely different effect. 

Ctrl + Z a couple of times to undo. So, just be aware of all of these different options.  

 

Another thing we could do is switch out this Picture. So, if I decided that I wanted to choose 

a different Picture, I could go to Change Picture, This Device, and I could use a Picture of 

somebody else. And you can see that's going to switch that out.  

 

Now the advantage of changing the Picture as opposed to going back to Insert and Pictures is 

that it will keep the settings of the previous Picture that was there. So, you can see it's the 

same size, we haven't had to resize, and it still has that Border around the outside. So, this can 

sometimes be a little bit quicker.  

 

Now, as I mentioned, this Image is currently sitting on top of the Cells. So, if I wanted to 

drag this over to Column C, and let's just pretend that this is a photo of John Smith, I will 

need to drag it over here, and then I would drag in, and I'd sort of fiddle around trying to get 

this to the correct size of the Cell.  

 

Now the problem with doing that is that if this Cell was to resize, if I was to drag this down, 

the Image isn't going to resize with the Cell. So, that is where the other option comes in Place 

Image in Cell. As I said, this is a brand new option in Excel.  

 

So, let's go up to Insert, let's go to Pictures, Place in Cell this time, we're going to choose This 

Device. And I know these names are different, but we're going to choose Ken again. We're 

going to pretend his name is John Smith in this instance. But you can see what that does in a 

moment. It loads it into the Cell, so, it's exactly the right size. And if I were to resize this 

Row, drag this down a little bit, the Image resizes with the Cell.  
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So, that option really just makes it quicker and easier to insert Pictures and photos into Cells. 

And if I wanted to fill the Pictures for the rest of these names in here, I could select all of the 

Cells, go to Pictures, Place in Cell, This Device, and then as long as I have them in a folder, I 

can add them in the order that I select. Now, these are probably not going to marry up with 

the names, but let's just select a few of these. I'm going to select 6 Images, let's click on 

Insert, and it puts all of those Images into the Cells.  

 

Now of course, these look a little bit strange because we have a mixture of portrait and 

landscape. If you're doing this at your company, probably everybody has a standard headshot 

that's exactly the same size. So, this will look a lot neater. But hopefully, you can see how 

quick that actually is. As I said, these Images don't match up with employee names. But 

hopefully, you get the idea.  

 

And the other thing that you can insert into spreadsheets are Icons, and Excel has its own 

Icon library. If we jump up to the Insert Tab, in the Illustrations group again, notice we have 

Icons just here. So, if we click this, it's going to open up the Icon library, and this is a whole 

host of different Icons that you can use in your spreadsheets. Icons are a really nice way to 

add interest and personality to your spreadsheets.  

 

Now the Icons are divided down into different groups, you can see those groups running 

across the top. For example, if I click on Education, we get all of the Icons related to 

education. We can also, search for specific Icon. So, I'm going to type in ‘people’ and hit 

Enter. And I get all of the Icons related to people.  

 

Now I'm going to choose this Icon just here. Let's click on Insert, you can see there it is. I can 

then drag it over to where I want it to be, and I can resize it. So, let's just make this quite 

small, and I'm going to put it in Cell A1.  

 

Notice also, that with Icons, we get a new Contextual Ribbon. This time the Graphics Format 

Ribbon. So, from here, I can do things like change the Fill Colour. So, maybe I want this to 

be a Purple colour, I can do that, and it's going to change the colour of the Icon. So, again, 

lots of different options on here for modifying any Icons that you have in your spreadsheet.  

 

So, just be aware that you have access to that Icon Gallery, and that it's perfectly fine to add 

Images and Pictures to liven up your spreadsheets. 
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Video: Insert Shapes and Text Boxes  

Deb: Aside from inserting Pictures and Icons into a spreadsheet to add a bit of personality, 

we can also, insert Shapes and Text Boxes.  

 

Now you'll find both of these options again on the Insert Ribbon in the Illustrations group. 

Notice here we have a Shapes dropdown. Now when we click this dropdown, it's going to 

open up the Shapes Gallery, and the Shapes are divided down into different categories. So, it 

really depends exactly what it is that you're looking for.  

 

Now at the top, you're always going to see your Recently Used Shapes. So, this is a really 

good area, because normally you'll find in here, the Shapes that you use most frequently. But 

notice that we also, have a Lines category, Rectangles, Basic Shapes, Block Arrows, so, on 

and so, forth. We can even do things like build Flowcharts from scratch, because we have a 

group here called Flowchart with different Flowchart Shapes in it.  

 

Now let's just start out with a really Basic Shape. We're just going to go for this one just here, 

the Rounded Rectangle. Now when we select a Shape from the Shapes Gallery, our cursor 

immediately changes to a small crosshair. So, in order to draw the Shape, all we need to do is 

click and drag, and it's going to allow us to free draw that Shape.  

 

Notice as I move around, there are no restrictions, there's no locking on this Shape; I can 

literally make it as tall or as wide as I like. So, I'm going to make it about that big, let go, 

there is my Shape. Now notice that the colour of the Shape is very much determined by the 

theme you have in use in this specific Workbook.  

 

For example, if I was to go to Page Layout and change my theme to the new Office Theme, 

you can see that that will effectively change the colour of the Shape. But of course, we can 

also, click on the Shape. Notice we have a brand new Contextual Ribbon called Shape 

Format. And this is where we're going to find all of the options that we need in order to fully 

customize this Shape.  

 

Notice we have some Shape Styles. Again, these are very much based on our Theme Colours. 

But we can very quickly apply different styles to this Shape. So, maybe I want it to be Blue 

with a dark Blue Border, maybe I want it to have a bit of a Gradient Fill. Maybe I want it to 
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be blank, but any Text I put inside is going to be Blue. So, we have lots of different options in 

here.  

 

Now I think I'm going to go for this one just here the Gradient Fill - Turquoise Accent 4 No 

Outline. Let's click to select, and there we have our Fill Colour. Now if I don't like any of 

these Shape Styles, I can of course go to the Shape Fill dropdown, and I can choose any 

colour from my Theme Colour palette.  

 

I can choose a standard colour, no fill if I didn't want any fill in there at all. Or if I can't find 

exactly the colour that I'm looking for from here, I can go to More Fill Colours and choose a 

colour from the palette, I can choose a colour from my custom palette by dragging this little 

option around dragging the slider up and down.  

 

Or, if I know the specific hexadecimal code for a particular colour, maybe a branded colour, I 

could type it into this box just here. Now I'm going to leave this on this dark Purple. Let's 

click on OK, and you can see that that colour has changed.  

 

Now if I wanted to add an outline to this Shape, again, make sure we’re clicked on the Shape, 

go to the Shape Format Ribbon, and we have Shape Outline options just here. And from here, 

we can choose the weight. So, how thick do we want the Border around the outside?  

 

So, let's do something that's reasonably thick. I'm going to go for 2¼ points, and you can see 

what that does. And of course, if you want to change the Outline Colour, then you can just 

select a different colour from the palette. So, let's go for a light Blue.  

 

Now with Shapes, you can pick them up and you can move them wherever you like. You can 

also, add Text inside Shapes as well. So, if you double click, you can see my cursor appears. 

Alternatively, you can right click and choose Edit Text, and you can start to type whatever 

Text you like.  

 

Our Alignment options work in the same way. We just have to make sure we have the Shape 

selected, go to the Home Tab and we can move that Text so, that it's dead in the centre. We 

can make it bigger, we can change the font colour, so, on and so, forth. So, Shapes are really 

simple to use.  
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Now notice when you are clicked on a Shape, you have these little handles around the 

outside, which will allow you to resize the Shape just by clicking and dragging. But also, 

notice we have a Yellow handle just here.  

 

Now the way that this Yellow handle works is different for every Shape. Because we have a 

Rounded Rectangle in our spreadsheet, if I was to grab this Yellow handle and drag it in, it's 

going to make those corners more rounded or less rounded. So, just be aware of that when 

you see this little Yellow handle. We can also, rotate the Shape by using the rotation handle 

just above and we can rotate it however we like.  

 

Now I'm going to duplicate this Shape simply by pressing Ctrl + D; that's going to give me 

another copy. Because what I could do here is I could join these 2 Shapes using a Line. So, 

let's go back to the Insert Tab, go back into the Shapes Gallery, and here you can see we have 

a selection of different Lines.  

 

So, if I select Line, and then hover my mouse over this first Shape, notice that I get these 4 

Grey handles. So, if I click on this handle just here and drag, I can then connect it to the other 

handle and the other Shape. When I let go, these 2 Shapes are connected. And when I drag 

any of these Shapes around, you can see that it remains connected. So, it kind of sticks like 

glue, which is really helpful if you want to connect 2 Shapes together. So, just be aware of 

that as well.  

 

Now if we draw another Shape, let's go back to Insert, and I'm just going to draw an Oval. 

Now the Oval tool is what you also, use if you want to draw a Circle. The default is an Oval. 

So, you can see here, it's going to draw an Oval. Now if you want a perfect Circle, you need 

to make sure you hold down Shift as you're drawing.  

 

So, let's select our Shape again; I'm going to select the Oval. When we hold down Shift and 

draw, it's going to lock that so, that we always get a perfect Circle. And another thing to 

remember is that if you have quite a few Shapes on your spreadsheet, we can change the 

order that we're seeing the Shapes. So, you can see that if I placed a Circle over this Text 

Box, it's in front of it. And this is what we call the Z Order.  

 

If I wanted this Circle to be behind the Rounded Rectangle, again, I would go up to Shape 

Format, and in the Arrange group, we can choose to send it backwards or bring it forwards. 

These options have dropped down menus just here. So, we have Send Backwards, which will 
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send it behind the next Shape, or we can send it directly to the back. So, if I choose this 

option, you can see that it puts that Circle at the back and the Rounded Rectangle is now at 

the front. So, don't forget about these arrange options.  

 

Another useful tool when dealing with Shapes is the Selection Pane. You may be more 

familiar with using this in PowerPoint, we can also, use it in Excel. Now the Selection Pane is 

this little pane that you can see on the right hand side. And this enables us to do a few 

different things; we can name our Shapes. So, you can see by default, Excel just gives our 

Shapes very basic names. And if you have quite a few Shapes in your spreadsheet, it makes 

them quite hard to identify.  

 

So, what I could do here is just give these more meaningful names. For example, where we 

have Straight Connector 4, which is our Line, I could double click and change this to 

something else. So, I'm just going to call this Blue Line. I could change the next one. So, let's 

double click, and I'm going to call it Rounded Rectangle 1, so, on and so, forth.  

 

We can also, reorder our Shapes in here. So, like I showed you the Send to Back, we can also, 

do that from here as well. So, where we have the Oval, I could drag this above the Rectangle, 

and it's going to pull that to the front. And notice also, in the Selection Pane, we have this 

little Eye Icon. So, this basically allows us to hide or unhide Shapes.  

 

So, if I have this scenario here, where I have my Circle on top of my Rounded Rectangle, if I 

want to make edits to the Rounded Rectangle Text, that's a little bit difficult to do because the 

Circle is on top. So, instead of rearranging the order, I could simply choose to hide the Circle 

by clicking on the eye. That's going to reveal the Rounded Rectangle behind. I can make my 

changes, and then I can unhide the Oval. So, that Selection Pane can be really helpful.  

 

Now aside from Shapes, we also, have Text Boxes that we can add into our spreadsheet. And 

these are particularly good if you want to add any notes, but you don't necessarily want to be 

putting those notes in Cells in the spreadsheet. So, let's go up to the Insert Tab again, all the 

way over on the right hand side, we have a Text option just here. And when we click the 

dropdown, we have Text Box.  

 

So, when I click this, my cursor changes and I can simply click and draw my Text Box 

wherever I need it to be. I can then type in my Text. All of the same formatting options apply. 

Notice when we click on the Text Box, we still have access to the Shape Format menu. So, if 
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I want to change the Background Fill Colour, I can do that. I could change the Shape outline 

to a different colour. I can format the Text so, on and so, forth.  

 

I can also, click and I can drag this wherever I need it to be. So, let's place it under our little 

Table of information. I'm going to make it wider and then I can add my Text. So, that is how 

simple it is to add Shapes and Text Boxes into an Excel spreadsheet. 
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Video: Create Diagrams using SmartArt  

Deb: In this lesson, we're going to take a look at a couple of examples of how we can work 

with diagrams in Excel. Now when we were looking at Shapes in the last lesson, if you recall, 

we would go up to the Insert Tab. And then from the Shapes dropdown, we can choose any 

Shape from this gallery.  

 

So, if you wanted to build a diagram manually just using the Shapes and drawing them on the 

page, then that is absolutely fine. Also, notice towards the bottom of the Shapes Gallery, we 

have a Flowchart section as well. So, this is very specific to creating different types of 

Flowchart.  

 

So, if you wanted to do a Flowchart or maybe a Hierarchy Diagram, or a Process Flowchart, 

something like that, you could do this entirely manually just using Shapes, Lines, and 

Connectors. However, why would we do it manually when there is a much quicker way? And 

that quicker way is by utilizing SmartArt.  

 

Now SmartArt is available across the 3 main Microsoft applications. So, Word, Excel, and 

PowerPoint. So, you might have come across this before. And you can see an example of a 

SmartArt diagram in the spreadsheet just here; I just have very basic helpdesk Process Flow 

chart. And this is made up of different Shapes and Text. But instead of drawing all these 

Shapes manually, I just created a SmartArt object. So, let's jump across to the next 

Worksheet, and I'll show you how I created this Process Flowchart because it is so, simple.  

 

Now we're staying on the Insert Ribbon. In the Illustrations group, notice we have an option 

for SmartArt. So, if I click this, it's going to open up the SmartArt Graphic Library. And we 

have all different types of SmartArt that we can add. And they're all divided down into 

categories to make them a little bit easier to find. So, if I want to insert a Process Flow, I'm 

going to select the Process category. And I have all of the different types of SmartArt I can 

use just here.  

 

Now for the specific one that I created on the previous page, it was this one just here that I 

used; Continuous Block Process. And if I click on this, you can see that I get a little bit more 

information plus a preview in the right hand side of this dialog box. And this is a Process 

Flowchart that is used to show a progression or sequential steps in a task, process, or 
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workflow. So, that sounds pretty much like what I want. Let's click on OK. And straightaway 

it adds in all of those Shapes for me.  

 

And of course, I can use these resize handles to make it bigger or to make it smaller. I have 

placeholders for Text, which makes it super easy to add in the different steps of my process. 

And of course, if we take a look up on our Ribbons, we have 2 new Tabs; SmartArt Design 

and Format.  

 

So, if we go to the SmartArt Design Tab, this is where we can do things like add additional 

Shapes. So, it might be that the process that I'm trying to depict here has more than 3 steps, 

maybe it has 4, maybe it has 5, maybe it has 7, it's this Ribbon that I can add more steps to 

this process. If you take a look in the Create Graphic group on the left hand side, you can see 

we have an Add Shape option just here. And if we click the dropdown next to it, I can choose 

to Add a Shape After or Add a Shape Before. Now this will add a Shape after or before 

whatever Shape you're currently clicked on.  

 

So, if I click on the last step in the process, I can then say Add Shape After, and it's going to 

add another one in. I can drag this out to make it a little bit bigger and then add my Text. So, 

adding Shapes before or after is really simple.  

 

If I decide at this stage, I want to change the layout, I can select a different layout from the 

dropdown gallery just here, and I can also, change the colours. And once again, this is going 

to be based on the theme that we have in use.  

 

So, I think I used this one in the last Worksheet; Colourful Range - Accent Colours 3 to 4. 

And if I wanted to add some styling to my SmartArt Object, I could do that from SmartArt 

Styles. We have different styling options just here. So, if I quite like this polished look, I 

could select that and it's going to apply.  

 

Now to add Text in, very simple; just click on the Shape and start typing. So, I'm going to go 

through and I'm going to add some Text to all of these different Shapes. And there we go. In 

a few minutes, we've created a really nice looking Process Flowchart.  

 

Let's take a look at one more example. And then I'll leave you to have a play around with 

some of the other SmartArt types because one that’s really popular that people like to use is 
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the Hierarchy Diagram. So, this might be if you need to create some kind of diagram that 

shows the organizational structure or maybe even just the structure of your team. 

 

You can see here we have the CEO at the top Matt Simpson, Julie Waters is his PA, and then 

we have the 3 heads of department. And this is also, really easy to create. So, let's jump 

across to the Hierarchy to Tab and just very quickly recreate this. So, we're going to go up to 

Insert again, we're going to go back into SmartArt, and this time, we're going to choose 

Hierarchy.  

 

Now one thing to know about the SmartArt diagram that we just looked at is that it contains 

Pictures. And it's actually this one just here that I used; Picture Organization Chart. Now, if 

you are looking specifically for SmartArt that has placeholders for Pictures, we do have a 

Picture group just here. So, that allows you just to refine all of these graphics down into just 

the ones that accommodate Pictures.  

 

So, I'm going to go back to Hierarchy, let's choose this Picture Organization Chart and click 

on OK. And we get a very similar thing, we can drag this out. But notice this time, we have 

little placeholders for people's Pictures.  

 

So, if we want to add a Picture, I'm just going to add a Picture from the Course Files folder, 

we just click on this little Picture Icon. And it's going to ask us where we want to insert our 

Pictures from; From a File, from the Stock Image library online, or we can even just insert 

Icons. So, I'm going to choose From a File, and I'm going to go to the Images folder for 

Section 14. You'll find all of these Images in the Course Files folder if you want to recreate 

what I'm doing.  

 

So, this time, let's put Julie at the top of the tree, I'm going to click on Insert. And there she is. 

So, very, very simple. I'm going to add some Text. So, we'll just say this is Julie Simpson. 

And I would repeat this process to add the other Images into this Hierarchy Diagram.  

 

And once again, we have very similar options. I could jump up to the SmartArt Design 

Ribbon and apply a SmartArt style. Or I could choose a different colour from my Theme 

Colours colour palette, and you can see as we hover over we have different colour sets.  

 

If I want to have completely different colours that are outside my designated theme, I can 

select each Text Box individually, go to the Format Tab and just simply change the Shape 

http://www.simonsezit.com/


 

 

 

 

 

 

       © Copyright 2023 Simon Sez IT, INC. All Rights Reserved. 255 

Fill Colour. Now I'm not going to do that I'm actually going to select or change the colour 

from here, so, that the CEO Julie Simpson is a different colour to everybody else.  

 

Now when you're dealing with Hierarchy Diagrams, the way that we add more people is 

slightly different. So, if I wanted to add another assistant, so, maybe Julie has an assistant and 

a PA, let's say, I would select Julie at the top of the tree and when I go to Add Shape, notice I 

have some additional options, and one of them is to add an Assistant. And you can see it's 

going to add another one that kind of branches off.  

 

If I wanted to add somebody who worked for Molly Jones, I could select her go to Add 

Shape, and say Add Shape Below. So, we can build up our Hierarchy Diagram simply by 

adding Shapes.  

 

So, those are a couple of examples of how you can use SmartArt in your Excel spreadsheets. 

These can be super useful and save you a lot of time. 
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Video: Insert Screenshots and Clips  

Deb: In this very quick lesson, we're going to take a look at how we can insert Screenshots 

into an Excel spreadsheet. And you might recall the olden days when we used to take a 

Screenshot of something using the Print Screen button on our keyboard. Well, the good news 

is we now have that feature inbuilt into Excel.  

 

So, if you need to quickly grab something off a web page or another application, you can take 

a Screenshot of it, and it will insert it into your Excel spreadsheet as a Picture. Now we have 

a couple of different options when we're inserting Screenshots. So, let's take a look at both of 

them.  

 

So, we're going to jump up to the Insert Tab. And in the Illustrations group, notice we have a 

Screenshot button just here. And if we hover our mouse over it, the ScreenTip says; ‘Quickly 

add a snapshot of any window that's open on your desktop to your document’. So, that is 

really important. You have to have what you want to Screenshot or take a snapshot of open 

behind your Excel spreadsheet.  

 

Now if we click the dropdown just here, we have 2 options, we can select an Available 

Window, or we can choose Screen Clipping. So, what is the difference between these 2 

options? Well, notice underneath Available Windows, I have the Excel spreadsheet that I 

currently have open, but I also, have this SimonSezIT website. So, this is opened directly 

behind my Excel spreadsheet.  

 

If I had other things open, so, maybe if I had a PowerPoint presentation open or another 

webpage, those would show in there as well. And I can select any Available Window and it 

will basically take a Screenshot of the entire thing, and insert it directly into my spreadsheet.  

 

So, I'm going to select the SimonSezIT website. When I click it, it takes that Screenshot and 

check it out, we now have the entire webpage as a Screenshot pasted into our Excel 

spreadsheet. And of course, I can resize this to make it a little bit more manageable.  

 

And the good news with this is that it basically inserts as a Picture. So, we get our Picture 

Format Tab at the top, and we have access to all of the Picture Formatting tools that we've 

looked at in previous lessons. So, really straightforward just to take a full Screenshot of the 

entire window.  
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Now I'm going to click and I'm going to delete this out. Because maybe I don't want to take a 

Screenshot of the entire webpage, maybe I'm just interested in a certain part of that webpage. 

Maybe I want to grab the logo, for example. Well, if that's the case, that's where we can use 

the Screen Clipping option. So, let's click the dropdown next to Screenshot and this time, 

we're going to go to Screen Clipping.  

 

Now notice what happens here; it minimizes down the Excel spreadsheet to reveal whatever 

we have behind. And I can't reiterate this point strongly enough, you must have what you 

want to clip open directly behind the Excel spreadsheet, because all it does is minimize that 

spreadsheet to reveal whatever is directly behind. So, if you have the wrong application open, 

it's only going to allow you to Screen Clip that application.  

 

Now I did have this web page open behind. Notice that we now have this kind of 

transparency or this ghosting over the entire webpage. And my cursor has changed to a 

crosshair. So, what this means is I can now go and select the part of the window that I want to 

Screen Clip. So, I'm going to clip the logo.  

 

So, let's go up to the corner. I'm going to click and drag an area over the logo, let go, and you 

can see it immediately jumps me back to Excel and I now have a perfectly clipped logo. I can 

then remove the Gridlines from this page, and you can see how seamless that looks. I can 

place it underneath the title and we have a nice logo in there.  

 

So, that's it really when it comes to Screenshots. It's really simple and straightforward. You 

can either clip the entire screen. Alternatively, you can take a Screen Clipping of parts of the 

webpage. Have a little play around, and I will see you in the next lesson. 
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Video: Insert and Respond to Threaded Comments  

Deb: In the final lesson of this section, we're just going to briefly discuss Comments. 

Because Comments can be a really useful way of leaving notes or helpful updates for other 

team members. 

 

If you can imagine this scenario that we have this Leaver’s List shared with all of the 

members of our team. And it might be that I want to leave a little note for somebody that this 

department needs to be updated because it's changed its name from Creative to Design.  

 

Now, of course, I could send them an email and let them know, I could use Teams to maybe 

start a chat. But a really nice quick way of doing this is simply to add a Comment into the 

spreadsheet that everybody can see. And in Excel 365, we have the new Threaded Comments 

system. So, let me show you how it works.  

 

Now if I want somebody to change the department Creative to Design, I could choose to 

select one Cell, I could select multiple Cells to apply my Comment to. Up on the Insert 

Ribbon, we have a Comments group. So, I'm going to click on Comments. And notice what it 

does here; it opens up a little popup window, you can see my name at the top so, everybody 

knows that I'm the person who's making the Comment, and I can simply type in whatever I 

need it to say.  

 

Also, notice that within Threaded Comments, we can use @mentions as well. So, if there's a 

specific person on my team that is responsible for making these updates, I could direct this to 

them, and then they'll get a notification that they need to check out this spreadsheet and make 

a change.  

 

So, I'm going to say that I want Adele, we're just going to start to type her name. And if you 

are looking for people within your organization, they should pop up in a list underneath. Let's 

select and I'm going to say to Adele; ‘Please update the Department from Creative to 

Design’.  

 

Now notice here we can press Ctrl + Enter to post. Alternatively, we can click on the little 

Green paper plane arrow to send that Comment through. So, let's do Ctrl + Enter. And you 

can see what happens here. Because I've @mentioned somebody who currently doesn't have 

access to this spreadsheet, it's asking me to share the spreadsheet with Adele, and let her 
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know that that's what I've done. So, I'm going to say yes, share and notify. And we will talk a 

lot more about sharing in later lessons.  

 

But for now, you can see that once you add a Comment in, you get this little Purple tag in the 

top corner. If I hover my mouse over it, I can see any Comments that have been made. And if 

I want to edit the Comment, I have a little Edit Comment button just here that will allow me 

to go in and make some changes. Or, I can click the 3 dots and I can choose to resolve the 

thread or delete a thread.  

 

Now what do we mean by thread just here? Because these are Threaded Comments, well, 

anybody can come in here, and they can reply to the Comment. So, take a look what's 

happening here. Because I shared this Workbook with Adele, I can now see that Adele has 

arrived in the spreadsheet.  

 

Notice up in the top corner, I can see Adele’s Icon. And if I hover over, it's telling me that she 

is currently clicked in Cell C4. So, on her PC or on her mobile, she's more than likely 

responding to the Comment that I've just sent through. And we can also, see in the 

spreadsheet, the Cell that she's working on is highlighted in Red, and I can see her initials.  

 

So, this is kind of your introduction to co-authoring in Excel 365. If we share a Workbook 

with other people, we can all dive into that document and start to make changes. So, now let's 

see, Adele has in fact responded. She said; ‘No problem. I'll do this shortly’.  

 

So, I can now see that Adele has in fact made those changes. And I can now see that Adele 

has also, left the spreadsheet; she's closed it down. So, this is what we refer to as Threaded 

Comments. It just means you have this conversational style and you can @mention other 

people.  

 

Now once a Comment is resolved, effectively, you can remove these Comments simply by 

clicking the 3 dots. And you can choose to resolve the thread or delete the thread. So, what is 

the difference between these 2?  

 

Well, if you want to keep track of what Comments were made within this spreadsheet, you 

would simply resolve the thread. That's going to keep the Comments in here, but they're not 

active; we don't require any action. Whereas if we delete the entire thread, it's going to delete 
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all of the Comments and nobody would ever know that there were any Comments in the 

Workbook.  

 

So, I'm going to choose Resolve Thread. We can see that's now been tagged as resolved. But 

we still have that little Purple Icon in the top corner indicating that there were Comments in 

this Cell. And we can go in and we can see what those Comments were.  

 

So, sometimes, that can be really useful to keep those in even if the issue is resolved. If you 

want to get rid of them entirely, we can simply click on the Delete Thread Icon in the top 

right hand corner, and that's going to delete out all of those Comments.  

 

So, that is how you can add Comments to a Workbook, how you can reply to Comments, and 

it's a little bit of an introduction into collaboration in Excel 365. We're going to speak a lot 

more about that later, but for the time being, we're going to move on to the next section. 
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Video: Exercise 14  

Deb: It's time now to do Exercise 14. And in this exercise, we're going to practice some of 

the skills that we've learned in this section of the course.  

 

So, the first thing I'd like you to do is to download the Images of the ‘big five’ safari animals 

from the Exercise Files folder. And you can see I've listed out the 5 Images that you need to 

download. I'd then like you to open the exercise file, ‘Exercise14.xlsx’. And I'd like you to 

insert the Images into the corresponding Cells in Column C, and you need to ensure that the 

Images are placed in the Cell and not over the Cell.  

 

Once you've done that, I'd like you to insert a Comment in Cell D6 that says; ‘Please change 

this to No. it was a lioness we saw, not a lion’. And in Cell A1, I'd like you to insert an Icon 

of a pair of binoculars. And I'd like you to format the Icon so, that the graphic is Purple.  

 

And in the final part of this exercise, I'd like you to go to the following website. And this is 

just a link to the big five game page on Wikipedia. And I'd like you to take a Screen Clipping 

of the first paragraph on that web page and insert it into the Excel spreadsheet. And I’d just 

like you to position it somewhere on the right of the grid. That is it. A few things to complete 

there. If you'd like to see my answer, then please keep watching.  

 

So, the first thing I asked you to do here was simply download those Images from the 

Exercise Files folder of the Big five safari animals; I've already downloaded them. We then 

need to insert those Images into Column C. So, let's start with the first one.  

 

I asked you to place the Image in the Cell as opposed to over the Cell. So, I'm going to click 

in the first one, C5, we're going to jump up to Insert, go to Pictures, and Place in Cell. And 

I'm going to browse This Device.  

 

So, the first one to insert here is the elephant. Let's select him and click on Insert. And you 

can see it puts that perfectly within the Cell. Let's do one more, and then I'm going to do the 

rest off camera. So, we need the Picture of the lion at this time. There he is, click on Insert. 

I'm simply going to go through and do exactly the same for the rest of these.  

 

The next thing that I asked you to do was to insert a Comment into Cell C6 that basically 

says; ‘Change this to no as it was a lioness that we saw’. And in fact, this is probably better 
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in Cell D6. If you put it in Cell C6, that's not a problem. I'm going to select D6, let's jump up 

to Insert, and we want to go all the way across to Comment. Let's add in our Comment. And 

remember to send a Comment, you can press Ctrl + Enter just to post it.  

 

The next thing to do here was to add an Icon of a pair of binoculars into Cell A1. So, let's 

click in the Cell. Again, we're going to stay on the Insert Tab, go to Icons, and we are simply 

going to search for binoculars. There we go.  

 

Again, I don't mind which one of these you chose, I'm going to go for this one. And then I'm 

just going to resize that so, that it fits nicely into Cell A1. And I asked you to change the 

colour of this to Purple. So, we're going to go up to Graphics Format, Graphics Fill, and let's 

just choose this Purple colour.  

 

And in the final part of this exercise, I asked you to open up a browser and go to the big 5 

game page of Wikipedia. This is the page that I wanted you to go to. And I asked you to take 

a Screenshot of this first paragraph just here, and insert it into the Excel spreadsheet. So, 

remember, when you're dealing with Screenshots, you need to have exactly what you want to 

screenshot directly behind your Excel spreadsheet.  

 

So, I've got this page open, and I have my Excel spreadsheet directly over the top. Let's go to 

the Insert Tab, we're going to go to Screenshots and I don't want to take a Screenshot of the 

entire page, I want to do a Screen Clipping. You can see it's minimized down Excel, and it's 

taken me to whatever I have behind which for me is the Wikipedia page.  

 

I can now simply choose what I want to Screenshot which is this first paragraph, let go, and 

it's going to insert that into the Excel spreadsheet. That's all I needed you to do here. I will see 

you in the next section. 
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Section 15: Work with Views 

Video: Workbook Views and Zoom  

Deb: In this section of the course, we're going to shift our focus a little bit and start to take a 

look at some of the options that we have when it comes to Page Layout and generally 

preparing our spreadsheets for printing. And we're going to start out in this lesson just simply 

by discussing some of the options that we have when it comes to Workbook Views.  

 

Now, if you're saying to yourself; ‘Well, what is a Workbook View’? Well, what you're 

looking at right now is a Workbook View. This is what we refer to as Normal View. And 

Normal View is the general view; the default view that you see when you open up an Excel 

spreadsheet, and it's generally the view that you work in when you're working in Excel. Now, 

how do I know that I'm in Normal View?  

 

Well, there are a couple of ways that I can tell. If we jump up to the View Tab, notice we 

have a Workbook Views group just here. And you'll notice that Normal is highlighted in 

Grey. So, we're currently in Normal View. Also, note that down the bottom in the corner of 

the Status Bar, we have Views down here as well. And again, you'll notice that the one that is 

highlighted in Grey is the one we're currently working in, which is Normal View.  

 

So, I would say that the majority of the time you're using Excel, this is the view that you're 

going to be working in, and it's also, the default view. But we do have other Views that we 

can switch to which are better in certain circumstances.  

 

For example, we have a Page Break Preview. And if I hover my mouse over this command, 

you can see it says in the ScreenTip; ‘See where the page breaks will appear when your 

document is printed’. So, let's just say that I wanted to print this document. If I was to go to 

File and down to Print, I'm going to get a preview as to what's going to print out on the page 

currently.  

 

Now this Leavers List, I'm not quite fitting on everything in the Worksheet. It’s only show 

me the Table in Blue. But if we check out my spreadsheet, I also, have these Tables here in 

Orange. So, currently, not everything is fitting on the Page. Now I'm going to show you how 

to deal with situations like this a bit later on.  
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But if I wanted to see where these pages are actually breaking, I could switch into Page Break 

Preview. You can see here that the page breaks are now highlighted in Blue, and I can see 

exactly what's going to be printed on what page. So, it's showing me that this Blue Table just 

here, this is going to be on Page 1. But if I scroll down, it's also, a bit too long for one page, 

so, the bottom 3 Rows of this Table is going to be on Page 2.  

 

We're then going to have the Orange Tables on Page 3, and we're going to essentially have 

nothing on Page 4. So, if we go back to File, and Print, we can see that reflected by scrolling 

through the pages. Check out at the bottom, we have Page 1 of 5. If I move to Page 2, we just 

have those 3 Rows at the bottom of that Blue Table. Go to Page 3, we get our Orange Tables, 

Page 4 is blank. But what is Page 5? Let's check it out.  

 

It's showing me any comments that I have in this spreadsheet. And I still have the comment 

left in here where I @mentioned Adele and asked her to update the Department. So, your 

comments will also, print out on the last page. Now let's go back. Because this Page Break 

Preview is really useful if you want to start adjusting and fitting more on each page.  

 

For example, if I want to have both the Blue Table and these Orange Tables just on one page, 

I could drag out this page break to the edge here, and it's going to move everything onto one 

page. So, if I now go to File and down into Print, I can see what that's going to look like. And 

notice that I now just have 2 pages; so, I have this page which has everything on it, and then I 

just have a page with all of the comments. So, that's going to be a lot better.  

 

What I'd probably also, do is I might consider switching the orientation of this page. So, you 

can see currently it's in Portrait orientation. But this might look a little bit better if I switch it 

to Landscape. But now that we've switched it to Landscape, check it out, I have 3 pages. So, 

what's on the second page just here?  

 

I can see that now we have it in Landscape, I can't quite fit all of the Rows on the page. So, if 

I was to go back, because I'm still in Page Break Preview mode, I can see that these Rows are 

on Page 2. So, I could adjust this again. I could grab the page break, drag it down to fit 

everything on one page. Now remember a quick Keyboard Shortcut to jump to Print is Ctrl + 

P. And now I can see I'm back to 2 pages. I have all of my contents on the first page, and then 

I have my comments on the second page.  
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So, Page Break Preview is a really great way of seeing where those page breaks are and 

making adjustments so, that you can fit the maximum amount of information on a page when 

you print. Now the final Workbook View that we have is Page layout. Let's click this.  

 

This is a View that I like to go into if I want to quickly add things like headers. You can see 

here right at the top, we have 3 areas, I could add some text into here, I could maybe add 

some dates into this header, and it's a nice quick way of doing that.  

 

Now when you switch into Page Layout View, it appears quite zoomed in. If you want to 

zoom out a little bit, you can use your Zoom options. Now notice on the View Ribbon a bit 

further along, we have a Zoom group just here. So, if I want to quickly zoom to 100%, I can 

do that. I can zoom to a specific selection, or I can just choose to zoom to a level that's right 

for me.  

 

Alternatively, in the bottom right hand corner, we have this little Zoom Slider. So, if I wanted 

to zoom out a little bit, I can simply drag it so, I get more of an idea as to what that page 

looks like. So, I'm going to click in the middle here, and I'm going to add a header. And I'm 

just going to say Leavers List 2019.  

 

Now notice, as soon as I start to add headers up here, I now get access to the Header & Footer 

Contextual Ribbon. So, this allows me to add all different kinds of things into the header area 

just here. And we're going to talk more about headers and footers a bit later on. Just know 

that when you switch to the Page Layout View, that's just going to allow you to do things like 

add headers, and it makes the whole process a little bit easier.  

 

Now I'm going to switch back to Normal View, because I just want to finish this lesson by 

speaking a bit more about zoom. So, we saw how we can use the Zoom Slider in the bottom 

right hand corner to zoom in and out of our Worksheet. But notice that we have something up 

here called Zoom to Selection.  

 

So, if I was just focusing on, let's say, all of the people in the design Department, I could 

select them all, click on Zoom to Selection, and it's going to zoom me right into whatever I've 

selected. Now you might think, ‘That's a little bit too close’, we can of course, zoom out very 

slightly to add desired zoom at level. So, this is great if you have trouble seeing the 

spreadsheet when it's quite so, small, and you just want to focus on one particular section.  
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Now, if you are zoomed in or maybe even zoomed all the way out, and you want to just get 

back to the 100% View, which is the Normal View, you have an 100% icon just here, that's 

going to take you back to Normal.  

 

We also, have a Zoom icon just here, which will allow us to customize the specific level of 

zoom. For example, maybe I want to zoom in to 200%. I can click on OK, and it's going to do 

that. Click 100% again to go back again.  

 

So, that is a brief look at how you can switch between different Workbook Views, why each 

of those Views are useful, and how you can utilize Zoom to make it easier to see whatever it 

is that you're interested in. 
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Video: Arrange Workbooks and Worksheets  

Deb: More often than not, we find ourselves working on multiple Excel Workbooks at the 

same time. I know that for me, I often find myself jumping between different Workbooks. 

And I will say that if you tend to work with lots of Workbooks all the time, you're most likely 

going to have a second monitor to help you manage all of those Workbooks.  

 

Now, the good news is that we do have a feature within Excel that kind of works a little bit 

like a second monitor. Now, you can see here, if I hover over the Excel icon, I have 3 

different Workbooks open, and maybe I want to be able to see all of these at the same time.  

 

There's nothing more frustrating when you have one Worksheet open. And then you want to 

jump to something else, you have to minimize this down and then go back and open up the 

other one. And if I'm doing something like a comparison between 2 Worksheets, that's not 

going to be the most efficient way of working. So, what I could do here is I could go to the 

View Tab, and notice in the Window group, we have an Arrange All option.  

 

Now it says here; ‘Stack your open windows, so, you can see them all at once’. Now if we 

click on Arrange All, we have a few different options. We can arrange them in a Tiled layout, 

Horizontal, Vertical, or Cascade. Now I'm going to choose Tiled, let's click on OK, and you 

can see exactly what that does. I now have one spreadsheet taking up half the screen, and 

then I have the other 2 contained within windows in the corners.  

 

So, even though these windows are kind of small, we could collapse up the Ribbon for each 

of these. So, I'm going to click the little Dropdown Arrow, and I'm going to say ‘Show Tabs 

Only’. And I'm going to do the same on this one just here just to give me a little bit more 

room. So, now, I can see a bit more of the spreadsheet.  

 

So, if I was trying to do a direct comparison between this spreadsheet and this one, it's going 

to be a lot easier when we have them displayed one on top of the other like this. Now I'm 

going to close down one of the spreadsheets and I'm just going to minimize the other one. 

And let's just make this one a full window’s size. Because another option that we have is this 

View Side by Side.  

 

So, if I click on this is going to display my open Excel Workbooks side by side. And if I put 

the Ribbons back, so, I'm just going to choose the dropdown here and say Always Show 
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Ribbon and go to the View Tab just here, we also, have this option selected; Synchronous 

Scrolling.  

 

So, this option works with View Side by Side. And what it basically means is that we can 

scroll 2 documents at the same time. And you can see it says; ‘This is a great way to compare 

documents line by line or scan for differences. To use this feature, turn on View Side by 

Side’. So, it means that when we scroll both spreadsheets scroll at the same time.  

 

Now obviously these 2 are different. But if we had 2 spreadsheets that weren't virtually the 

same, maybe there were a few differences between the 2, it's going to be a lot easier for us to 

scroll line by line to see what those changes are. So, View Side by Side is a great way of 

doing this if you don't have a second monitor.  

 

Now some of the other options that we have here when it comes to Arrange All, we already 

looked at Tiled, what about if I was to choose Horizontal? Well, you can imagine what that's 

going to do; it’s going to display them on top of each other, and you can see that these also, 

scroll together.  

 

Go back to Arrange All > Vertical. So, this is very similar to Side by Side. So, you can 

choose which one you want to use. Also, note here that if you don't want these to scroll 

together, you can simply deselect Synchronous Scrolling to turn that off. And then, they'll 

scroll independently of one another.  

 

The final option of arrange all is Cascade. So, let's click on OK. And I don't find this option 

particularly useful, but it's going to cascade all open Workbooks. So, you can see here I've 

got one at the front here, but there's the other one just kind of poking behind. So, if I needed 

to switch to it, I could simply click to select it, and it will bring it to the front.  

 

Now the final 2 commands that are worth mentioning in here are Split and Hide. Now, Split 

will essentially divide the window into different panes that each scroll separately. Now when 

you're using this option, it really does matter where you're clicked when you click on Split. 

So, I'm going to click somewhere down here.  

 

Let's click on Split because that's where it's going to apply this split. So, I now have 4 

different sections and each 1 scrolls independently of the other. The top can scroll, and also, 
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if we click down here, the bottom can scroll as well. If we want to remove that split, we can 

just click on Split again.  

 

And of course, if you want to quickly jump between Workbooks, you don't necessarily want 

to arrange them or split them on the screen, you can press Alt + Tab, which will allow you to 

cycle through all open Workbooks. Or alternatively, you can click on Switch Windows, and 

any Excel spreadsheets that you have open will be listed just here, and you can simply select 

to jump to that specific Worksheet.  

 

So, those are some of the options that you have when it comes to arranging your windows, 

and viewing Excel Workbooks side to side, which is particularly useful when you don't have 

a second monitor. 
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Video: Freeze Panes  

Deb: In this lesson, we're going to take a look at another really useful option, and that is 

Freezing Panes. So, what exactly is Freeze Panes? Well, if you take a look at this spreadsheet, 

you can see that it's reasonably long, we have quite a few Rows of data, and notice as I scroll, 

those Column Headings disappear off the Page.  

 

So, where we have Employee Name, Department, Years, Salary, Bonus and New Salary, if I 

was to scroll down, I can no longer see those headings. So, if I was down here for example, 

it's pretty hard for me to know what these values in Columns D, E, and F are representing 

without those Column Headings being there. So, this is where Freeze Panes can come in 

really handy.  

 

What we can do is we can scroll up to the top, and I'm just going to click in Cell A1 where 

we have our Heading Row. But if we go up to View, notice in the Window group, we have a 

Freeze Panes option. Now we can click this dropdown and you can see that we have 3 

different menu items in here.  

 

Now notice we have Freeze Panes, Freeze Top Row, and Freeze First Column. So, if I simply 

wanted to freeze that top Row, I could select this option. And what that means is that when I 

now scroll, that Row is going to stay put. So, I can always see those Column Headings. So, 

that can be super useful. If you want to unfreeze, you can click the dropdown again and just 

use Unfreeze Panes, and we're back to normal.  

 

So, Freeze Top Row is pretty self-explanatory. But what do these other ones mean? Well 

Freeze First Column, that's pretty easy to understand. It will do exactly the same as freezing 

the top Row, but it's going to work with the Column.  

 

So, if I wanted to freeze the first Column so, that it's always visible when I do a horizontal 

scroll, I could choose that option from the menu. And now when I scroll across, you can just 

about see that that Employee Name Column is staying put. And once again, if we want to 

unfreeze, we just use Unfreeze Panes.  

 

Now the final option, which is simply Freeze Panes, this essentially allows us to customize 

where we want to freeze the panes. So, if we want to freeze maybe multiple Rows and maybe 

2 Columns, we could use Freeze Panes to define that.  
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Now the important thing to note here is that you need to click your mouse wherever you want 

to freeze the Columns and the Rows. For example, if I wanted to freeze, let's say the first 7 

Rows, so, everything above where I'm clicked, and also, freeze the first Column, I would 

need to click in Cell B8.  

 

Because then when I click on Freeze Panes, it's going to freeze the top 7 Rows, but it's also, 

going to freeze the Employee Name Column. So, where you're clicked is super important. 

Similarly, if I was to click down here in Cell D18, and choose Freeze Panes, it's going to 

freeze everything above and everything to the left. So, now, you can see that we have the first 

3 Columns frozen, and if I scroll down, I have the first 17 Rows also, frozen and visible.  

 

So, you can really customize this and set it up to suit your needs. The most common one by 

far is to simply freeze the top Row. I'll leave you to have a little experiment and play around, 

and I'll see you in the next section. 
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Video: Exercise 15  

Deb: It's time now to complete Exercise 15. And in this exercise, we're going to practice 

some of the skills that we've learned in this section of the course.  

 

So, the first thing I'd like you to do is to open the exercise file ‘Exercise15.xlsx’. And I'd like 

you to freeze Row 1 and Column 1. I'd then like you to switch to Page Break Preview and 

adjust the setup so, that all Columns fit on the page. That is it; a pretty short exercise. See 

how you go with that. And if you'd like to see my answer, then please keep watching.  

 

So, the first part of this exercise is to freeze Row 1 and also, Column 1 just here. Now if I 

want to freeze both of these at the same time, I just need to select the Cell where they 

intersect. So, Row 1 and Column A intersect basically where Cell B2 is.  

 

So, we need to select Cell B2, go to the Data Tab, go to the View Tab, and then we can 

choose Freeze Panes. And we should find that now when we scroll, those headings stay there. 

And if we scroll horizontally, the first Column doesn't move.  

 

And then the next thing I asked you to do was simply to switch into Page Break Preview. So, 

let's do that. And I asked you to modify this setup so, that all Columns appear on one page. 

So, all we need to do here is find this first page break, click it and drag it all the way out. As 

soon as we do that, we can now see that everything fits on one page. That's all I needed you 

to do. I will see you in the next section. 

 

  

http://www.simonsezit.com/


 

 

 

 

 

 

       © Copyright 2023 Simon Sez IT, INC. All Rights Reserved. 273 

Section 16: Prepare for Printing 

Video: Set Margins and Orientation  

Deb: In this section, of course, we're going to start to take a look at how to prepare a spreadsheet 

or a Workbook for printing. Because there are a few things, a few techniques that you can 

employ, which is going to make your life a lot easier. And also, ensure that you're getting the 

maximum amount out of each page.  

Now, we're going to jump straight across and take a look at a preview of how this is going to 

print. So, you could go up to File and select Print, or alternatively, you can press the Keyboard 

Shortcut Ctrl + P, which will jump you directly there. And this area in the backstage really 

serves 2 purposes, it's where we come to adjust our printing settings. But it's also, where we 

can see a preview of how our Worksheet is going to print.  

So, you can see currently, my data is spread across 4 different pages, I don't have enough room 

for all of the Columns. If we go across to the second page, you can see that that is the rest of 

the Rows. And then we have one Column on Page 3, and the rest of that Column on Page 4. 

So, if I was to print this in its current form, it's going to be quite confusing for anybody trying 

to read this. So, let's go back because there are a couple of things that we can do.  

Now most of our Layout options will find on the Page Layout page. And you'll find them in 

the Page Setup group just here. Now currently, my spreadsheet is set to Portrait mode. And if 

you recall, because it's cutting off one Column, we're probably going to find it's going to be 

better if we switch this to Landscape, because we're going to be able to fit more on the page.  

So, all we need to do here is click the dropdown underneath Orientation and choose Landscape. 

Now if we press Ctrl + P and take a look at it in the preview pane, we can see that we now have 

all of the Columns on one page. And it's also, worth noting that if you come to this Print Area, 

you can change the Orientation from this dropdown just here as well. So, now we have 3 pages. 

And that looks a lot better because we don't have one of the Columns cut off.  
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Now another thing you can do from this area is you can change the Margins. So, you can see 

currently it says narrow Margins. And Margins are really the amount of space that we have 

around the outside of our data and the edge of the page. So, because we have narrow Margin 

set, we have a very, very narrow Margin between the first Column and the edge of the page.  

Now we can change our Margins, we can choose one of the pre-sets in here, or we can get 

really granular and jump across to Custom Margins and type in exactly the distance we want 

each Margin to be. Now it's also, worth noting that if we go back, we can adjust our Margins 

from the Page Setup group just here as well.  

So, notice we have Margins dropdown, we have those same settings. And we can also, go into 

Custom Margins. So, I'm going to say let's say that we want a 1.75 Margin around the outside. 

So, I'm going to change all of these to 1.75. And I'm also, going to say centre on the page 

horizontally. 

Let's click on Print Preview and take a look at it. And you can see what that looks like. So, now 

I have a lot more space around the outside and my information is centred on the page. Now I 

think that's a little bit too wide.  

So, let's go back to our Margins dropdown and I'm going to choose Normal. Now don't get 

confused here. Even when we set this back to normal. We still have a lot of space down each 

side. But that is simply because we've centred the information across the page.  

And if you decide that you don't like that, once you've switched it to Normal Margins, we can 

jump back into Custom Margins, deselect this, it's going to put it back over to the side. We can 

click on OK. And now we have our Normal Margins. So, I think that looks a little bit nicer.  

So, that is pretty much how simple it is to change the Orientation and adjust your Margins. 

Have a little play around with it and I will see you in the next lesson. 
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Video: Set and Clear the Print Area  

Deb: Another thing that can be really handy to know when you're thinking about printing, 

particularly large spreadsheets is how to set and clear the Print Area.  

So, by default, when we press Ctrl + P to jump into our Print Area, if we were to click the Print 

button up here, it's going to print out the entire active sheet. So, that's the sheet that I'm currently 

clicked on. Now, in a lot of cases, I will want to print out the entire thing. But sometimes it 

might be that I only want to print out a certain section of a spreadsheet. 

So, let's go back. And let's do something just here. What I'm going to do is I'm going to sort 

this list of employee names by department. So, we're going to right click, we're going to go 

into sort and I'm going to say sought A to Z. So, now I can see all of the different departments 

grouped together. So, we don't want to waste paper by printing the entire list and just referring 

to the top nine Rows, I could simply set the Print Area to print just the first nine Rows, and 

that's going to be a lot more efficient and waste less paper.  

So, what we can do is we can select what we want to print, go to the Page Layout Tab, and 

notice we have a Print Area dropdown. And from here we can choose Set Print Area. So, now 

when we press ctrl P to jump into print preview, you can see that that is all its going to print 

those top nine Rows, and it's all contained on one page.  

Now once you've printed this, and you go back to your Worksheet, it's worth noting that that 

Print Area will stay set until you choose declare it. So, don't think that it's A1time deal that you 

set it once, print your document and then everything goes back to normal, it's going to stay with 

that printer is selected until you clear the Print Area. And to clear the area, it's very simple 

backup to the Print Area dropdown and choose clear Print Area. So, that option is kind of 

permanent until you choose to remove in.  

Now there is another way that you can print just a section of a Worksheet. And it only applies 

to that one time that you're printing it. So, it's more of a temporary solution. What we could do 

here is select the same nine Rows. And instead of setting a Print Area, we could say Ctrl + P. 

http://www.simonsezit.com/


 

 

 

 

 

 

       © Copyright 2023 Simon Sez IT, INC. All Rights Reserved. 276 

And in settings instead of Print Active Sheets, we could choose Print Selection. So, that is only 

going to print the Rows that we've selected.  

Now notice here I have accidentally not selected the header. So, let's go back and let's select 

the header as well. Ctrl + P Print Selection. There we go. That looks a lot better. So, now when 

I print this and go back, I don't have to clear anything.  

The next time I go to print, all I would need to do is make sure that I changed this back from 

Print Selection to Print Active Sheets, and we're back to printing everything again.  

So, that is the difference between the 2-Options Print Area and Print Selection. They can be 

super useful, particularly if you don't want to waste paper. 
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Video: Insert Page Breaks  

Deb: In a previous lesson, we briefly looked at Page Break Preview, and we saw how we can 

make some modifications to where the page is breaking when it comes to printing.  

So, let's just very quickly remind ourselves of that option. And then we're going to take a look 

at some more options that we have when it comes to adding in Page Breaks. So, currently, I'm 

working in normal view in this Workbook. But if we jump up to the View Ribbon, in the 

Workbook Views group, we could switch into Page Break Preview. And it's worth noting that 

prior to this lesson, I switched the Orientation of this Workbook back to Portrait.  

So, in Page Break Preview, we can see exactly where the page is going to break when we print 

the document. So, I can see here, because we have this Blue dashed line in between Columns, 

E and F, I know that everything up to Column E is going to print on page one, but then we're 

just going to have, but then we're just going to have one Column printed on another page.  

So, we can see here, this is page one, the rest of the Rows are on Page 2. And then we're going 

to have this is part of Row F on Page 3, and then this part on Page 4. So, what is a fairly 

reasonably sized Workbook is essentially going to take up 4 pages if we were to print it in its 

current state.  

Now, that is definitely not ideal. But what we saw in the previous lesson is that we can simply 

drag these Page Breaks around to customize how much we're fitting on one page. So, what I 

could do here is I could grab the dashed line in between Columns E and F, click and drag it 

out. And that instantly means that all Columns A to F, are going to be on page one, and Page 

2. So, Page Break Preview gives you great visibility when it comes to what's going to print on 

which page.  

Now if we jump back to the Page Layout Tab for a moment, notice in page setup, we have a 

breaks option. So, what we can do here is we can insert our own Page Breaks. Because when 

we switch into Page Break Preview, Excel automatically applies Page Breaks for us. And we 
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can then go in and adjust them. But it might be that we're looking at this spreadsheet and we 

think to ourselves, right, I only want the first 20 Rows on the first page.  

So, what I could do here is I could select Row 20. And I could insert my own manual Page 

Break. And you can see what that does, it puts that line in there. If I want to include Row 20, I 

can simply drag it down one, and the first 20 Rows will be printed on page one, we then have 

everything else on Page 2, and also, Page 3. And I can carry on going inserting Page Breaks. 

So, let's go down to Row 40. I'm going to insert a Page Break again, drag it down if I want to 

include Row 40, so, on and so, forth. So, I'm going to select Rows 61. This time, let's insert 

another Page Break. And there we go. I could carry on going, we could do the same thing with 

the Column.  

So, if I wanted to maybe just have the first 3 Columns on a page, I could select Column C go 

to breaks, Insert Page Break, and you can see what that does. So, once again, I need to move 

that. And now we're going to have this on page one, this on Page 2, Page 3, so, on and so, forth. 

And if you want to remove a Page Break, you can simply drag it off, or we have a Remove 

Page Break option in here.  

So, if we press Ctrl + P, we can see exactly how that's going to print, we have the first 20 Rows 

on the first page, second 20 on the next page, so, on and so, forth. And if you want to reset all 

Page Breaks, we have a reset Page Breaks option. If we click it, it's going to set it back to how 

it was previously. And I might decide that I want to switch the Orientation to Landscape so, 

that I can fit all of those Columns onto one page.  

So, that's how Page Breaks work and how you can insert them to split the page up into sections 

ready for printing. 
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Video: Set Print Titles and a Background  

Deb: In the previous lesson, we saw how we can insert our own Page Breaks and also, adjust 

any automatic Page Breaks. The spreadsheet currently is pretty much where we left off in that 

last lesson.  

Now if we jump across to print this Ctrl + P, we can see that we have all of our Columns on 

our page, which is fine. But notice one thing here, if we scroll through and check out Page 2 of 

this printout, whilst we have all the data there, one thing that is missing are the Column 

Headings.  

So, again, like when we were looking at Freeze Panes, when we scroll down, those headings 

disappear. Now, if I'm printing this document out and giving it to someone, and they're looking 

at Page 2, it's going to be quite hard for them to decipher particularly what these numbers in 

the last 3 Columns relate to. So, what we can do here is we can set the top Row to print on all 

pages. So, let's go back. And let's take a look at that.  

Now I'm going to switch back into normal view, and we're going to select the top Row. Now 

if we jump to Page Layout, notice that we have a print titles button in the Page Setup group. 

And if we hover our mouse over it, it says choose Rows and Columns, you'd like to repeat on 

each printed page, such as those with labels or headers.  

So, if I click on Print Titles, it's going to open up the Page Setup dialog box. And it's worth 

noting here that we can also, do things like adjust the Margins from here on the Sheet Tab. This 

is where we can define which Rows we want to repeat at the top, or even which Columns we 

want to repeat at the left. So, let's say Rows to Repeat at Top, all I would need to do here is 

select that first Row.  

Notice as I hover my mouse over Row 1, I get that little Black arrow, when I click, it's going 

to put in those Cell References. Now look at the Cell References here; it says dollar one colon 

dollar one. So, the dollar means that this is an absolute reference, it's fixed, and it’s always 

going to refer to Row 1. Let's click on OK. And now when we press Ctrl + P, if we were to 
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scroll to Page 2, you can see that on every single page, we have those Column Headings. So, 

this instantly makes our printout a lot easier to read and interpret. Let's go back.  

Now another thing we could do here is we could add a background colour to our spreadsheets. 

Notice that we have a background option in Page Setup and it says choose a Picture for your 

background and add some personality to your Worksheet.  

Now whilst this option is available in Excel, I always tell people to very much proceed with 

caution. Adding a Picture, particularly Pictures that are quite busy, can be a huge distraction 

when it comes to the data in the Workbook. And a lot of the time. Particularly if you have a 

Picture that has lots of different colours in it, it's going to make the tax and the data in your 

Cells really difficult to read.  

This generally tends to work best if you have a very transparent light image that just adds a 

little bit of character to your spreadsheet, but doesn't distract away from the information. So, 

let's click on background. And as you would imagine, is going to open up the Insert Pictures 

dialog box where we can choose a Picture from a file.  

So, let's say browse, and I'm going to select this Picture just here. And you will find this in the 

Course Files folder. Let's click on Insert. And you can see what that looks like. So, it doesn't 

look too bad, we can still pretty much see the data behind.  

Now of course, if you wanted to, you could then apply some formatting to your actual dataset. 

So, if we click in this and press Ctrl + A to select everything, we could go to home and we 

could choose a different Fill Colour.  

So, maybe I want to fill everything with a light Grey fill so, that the data still stands out. But I 

have this nice image in the background. And of course, I probably might want to change the 

font colour of these headings as well. So, let's just make those Black. So, this can sometimes 

give a really nice effect, but just be a bit careful as to the image that you're choosing and if 

necessary, even change the Background Fill of your Cells.  
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Now also, notice with this background image, we have the Gridlines showing over the top. So, 

you can of course always remove those by clicking on the View Tab and D selecting Gridlines 

and then we just simply have that image in the background.  

Now I think you'll agree this does add quite a bit of personality and interest to the spreadsheet. 

So, it's definitely worth exploring this option. But that's how you can print titles and also, add 

a background image 
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Video: Insert Headers and Footers  

Deb: In this lesson, we're going to explore how to add headers and footers into an Excel 

spreadsheet. And headers and footers are extremely useful when it comes to displaying 

important information that the reader might need to know.  

For example, it could be extremely useful for the reader to be able to see the page numbers, 

particularly if it's a very long printout, we don't want those pages getting into the wrong order. 

Or it might be that we want to be able to see the file name in the header, or maybe the date, all 

of these things we can add into our header or our footer in our Excel spreadsheet. And of course, 

as always, in Microsoft, there are a couple of different methods we can use in order to get this 

task completed.  

Now if we go up to the View Tab, one thing you'll notice in here is that we don't have a header 

or a footer option. And that is because headers and footers are a Contextual Menu that only 

appear when needed. So, in order to see our header and footer menu, we need to actually switch 

the view that we're working in. So, instead of working in normal view, we need to switch across 

to Page Layout View. And if you recall, when we were looking at views, this is where we can 

actually see our header. And also, if we scroll down our footer.  

Now I'm going to use my Zoom scroll just to zoom out a little bit, so, we can see that a little 

bit clearer. But there is the header. Now we're going to start with the header, we're going to add 

a piece of information into the middle here. And you can see that your header is kind of divided 

down into 3 different sections. So, it means you can add some information on the left some 

information in the middle and some information on the right if you want to.  

Now for this header, we're just going to add one piece of information in and we're going to put 

it in the middle just now as soon as I click in this header, that is when I get access to the header 

and footer Ribbon. You can see now we have the Contextual Ribbon at the top. And then we 

have a header and footer elements group, which allows us to add all manner of different things.  
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Now what piece of information do I want in the header just here? Well, I want to show the file 

name. Now notice in Header and Footer elements, we have exactly that option. Let's click on 

it. And notice it puts in a weird piece of code it puts in ampersand Square brackets with file in 

the middle. So, this is effectively a piece of code, which will pull the file name into the file 

when we go to print it.  

So, now if I click outside of that header area, there is the file name prepare for printing. Let's 

click in here again, we could switch this out What about if I put file paths in there? Notice we 

now have a different piece of code that says path and file. So, if I click outside of the header, 

it's going to show me the entire path of where this document is stored.  

So, again, that can sometimes be a really useful piece of information so, that people know 

where this file is saved. Now that's a bit long for me, let's click in the header again and go back 

to header and footer. What else could we put in here? Well, there's numerous different things. 

And we're going to add some of these into the footer. For the time being, I'm just going to stick 

with filename in the middle there, click away. And there it is. And the cool thing with this is 

that it will repeat on all pages. So, if we scroll to the next page, you can see there it is in there 

prepare for printing.  

Now if you're up here working in the header area, and you want to quickly jump down to the 

footer, you do have a little navigation group in the middle here with a go to footer option. And 

that's just going to jump you straight down to the bottom of the page. Now for my footer, I'm 

going to add a piece of information into each one of these sections.  

So, let's start out by clicking in the left-hand section of the footer. And I'm going to put in the 

current date, space current time. If we click away, we can see exactly what that looks like. And 

this current date and current time is going to update depending on what the actual current date 

and time is. So, this will be different tomorrow.  

Now let's click in the middle section just here. Because something else that we can do is if you 

take a look at the header and footer group, the first group on this Ribbon, and we click the 
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dropdown next to footer, you can see we kind of have some pre-set information that we could 

possibly add in. For example, maybe I want to add in the sheet name, which is employee bonus, 

I want to let people know it's confidential and maybe I also, want the page number.  

I could add that in. Or maybe I want it to say my name as the author, page one and then the 

date. So, let's just go for this one employee bonus which is the sheet name confidential page 

one, and you can see what that does. It will apply all 3 pieces of information into the different 

sections of the footer, we have employee bonus confidential, and then we have the page 

number. So, that's a really nice quick way of getting information into your footer.  

Now when it comes to things like page numbers, I'm actually just going to delete that out. And 

we're going to go back to header and footer. Because notice here, if you do want to put in the 

page number, you can simply click Page number. And when we click away, it's going to tell us 

that that is page one. But maybe we want this to say page one of 5 or however many pages 

there are. So, let's double click to edit this because if we go to the end and press space, we have 

a number of pages option in here as well.  

Now if I just select number of pages and click away, that doesn't look quite right, what we 

would need to do in here is add a piece of text that says of, and then when we click away, it 

says one of 4, we can even add the word page at the beginning here and click away.  

So, then it says Page one of 4. If we scroll down, we should find we then have Page 2 or 4, 

Page 3, so, on and so, forth. So, now when we press Ctrl + P to take a look at this, you can see 

exactly what that looks like. And I think this makes it look really smart and really finished, we 

have the Workbook name at the top.  

Then we have the Worksheet name confidential and page one of 4 in the corner. And this flows 

through to every printed page.  

So, headers and footers are definitely worth including in your documents because they really 

do give it a polished look and provide useful information to anybody who may be reading the 

Workbook. 

http://www.simonsezit.com/


 

 

 

 

 

 

       © Copyright 2023 Simon Sez IT, INC. All Rights Reserved. 285 
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Video: Print a Workbook  

Deb: In the final lesson in this section, we're just going to take a look at some of the options 

we have when it comes to printing our Workbook. So, we're going to jump straight into our 

print options by pressing Ctrl P. This is the same as doing a File Print.  

Now we've been in and out of here quite a bit so, far. But this is effectively where you come to 

actually click the Print button and send the Workbook off to the printer. So, on the right-hand 

side of this screen, obviously we have the print preview, we can see exactly what's going to 

print and how it's going to print. And then on the left-hand side of the screen, and this is where 

we can set our print options.  

So, notice at the top, here, we have a big old Print button that's fairly self-explanatory, that's 

what we click on to send it off to the printer. We can also, specify up here how many copies 

we won't have this particular printout, and then directly underneath this is where we can choose 

our printer.  

If you click the dropdown, you might find you have quite a few options in here. But if you're 

connected to your office printer, you should see that in here. If you're working from home 

again, as long as you've installed and set up your printer correctly, you should see your printer 

listed just here. And this will accommodate printers that have a cable or printers that are 

connected to the Wi Fi.  

Now I don't actually currently have a printer setup. But notice that we can also, print a PDF 

from here. So, if I wanted to create a PDF file from this spreadsheet, I could print it out to a 

PDF essentially, as opposed to a printer. This is one of the many ways in Excel that you can 

create PDF files. So, I'm going to choose Print to PDF. And then notice underneath you have a 

link to Printer Properties.  

Now what you see in here will differ depending on what printer you've selected in the 

dropdown. Now, because I don't actually have a printer selected, and we're only printing to a 

PDF, I don't get too many Printer Options, I can choose to print in Landscape or Portrait. But 
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if you aren't connected to a printer, you will see a lot more things in here, which will allow you 

to effectively customize your individual printer settings. So, just be aware of that. And then 

underneath in this settings area, this is where we can get quite granular about exactly what it is 

we're printing and how.  

Now the default here is to Print Active Sheets. So, that's basically going to mean the sheet 

you're clicked on. So, if you had a Workbook that contained let's say 6 Worksheets, if you're 

clicked on sheet 2, that is the active sheet. And that's what will be printed by default, if you 

leave it on Print Active Sheets.  

If you want to print the entire Workbook, so, all of the sheets one to 6, you would need to click 

the dropdown and choose print the entire Workbook. And then of course, we've already seen 

what Print Selection does in a previous lesson.  

If we have a section of our Workbook selected, we can use this option to just print the selection. 

And notice also, we have ignored Print Area. Again, in another lesson, I showed you how you 

can set a Print Area and just print that Print Area.  

Now it might be that you've set that but one time you want to actually print the entire thing. So, 

instead of clearing the Print Area, you could simply come into here and choose to ignore the 

Print Area and print everything else. So, don't forget about that little option in there.  

Now we can also, specify pages that we want to print. So, I currently have 4 pages, maybe I 

just want to print pages 1, 2, 3, I could type in 123, just here. And that's all it's going to print; I 

can then choose if I want to print with my pages collated or on collated.  

Now, this really refers to multiple copies. So, if you are printing 3 copies of this particular 

sheet, do you want them to come out the printer, the first copy first, so, pages one, 2, and 3, 

then the second copy pages one, 2, and 3, then the third, copy pages one, 2, and 3? Or do you 

want them unplaited. 

 So, it's effectively going to print 3-page ones, first of all 3-Page 2s, and then 3-Page 3s. This 

choice is entirely up to you. I'm going to keep mine on printing the whole thing 3 times, we 
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can then choose our Orientation, Portrait or Landscape. I'm going to leave mine on Landscape. 

And we can also, choose our paper size. And remember different parts of the world use different 

paper sizes by default. For example, in the US the standard default paper size is US Letter 

which is the top one just here.  

Whereas in the UK and many parts of Europe, the standard paper size that we use is A 4 so, 

make sure that you have this set to the correct size of paper that you currently have in the 

printer. So, I'm going to say Select A4.  

Again, we can change our Margins. From here, we looked at this earlier, I have mine set to 

normal. And then we can choose if we want scaling or not. So, do we want to print sheets at 

their actual size? So, this will basically print them at 100% Zoom, it might be that you want to 

change that.  

So, maybe you want to fit the sheet on one page. So, it will shrink the printout so, that it fits on 

one page. Now my data currently is running across 4 pages. So, if I choose this option, you can 

see what that's going to look like it's squished it up so, that we managed to fit absolutely 

everything on one page.  

Now, that's great in terms of paper wastage, but not so, great in terms of readability. So, I might 

want to change that I could say fit all Columns on one page, that's fine.  

That's pretty much what I had before I still have 4 pages, I could say fit all Rows on one page, 

that's going to make it very small once again. So, just be aware of your scaling options. I'm 

going to set my back simply to 100%. And then finally, the bottom here, we just have a quick 

way to get back into our Page Setup dialog box where we have a few other options. And most 

of these we've already explored across the balance of this section.  

So, once you've set your print options, the final thing to do is simply click on the Print button 

to send that off to the printer, or in my case to send this to a PDF. And of course, if you are 

printing to a PDF, it's going to ask you where to save and you need to give your spreadsheet a 

name.  
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So, I'm going to say employee bonus is going to save as a PDF that's fine click on save and it's 

now printing all of those pages.  

So, that's how you can print your document and the options that you have when it comes to 

defining how your printer and your printing is set up. 
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Video: Exercise 16  

Deb: It's time now to do Exercise 16. And in this exercise, we're going to practice some of the 

skills that we've learned in this section of the course.  

So, the first thing I'd like you to do is open the exercise file, ‘Exercise16.xlsx’. I'd like you to 

change the Margins to narrow and switch the Orientation to Landscape. I then like you to ensure 

that the heading Row which is Row 1 is printed on all pages.  

Once you've done that, I'd like you to download the file supplies_bg.jpg from the Exercise Files 

folder. And I'd like you to set that image as the spreadsheet background, I'd like you to apply 

a light Grey Background Fill to the dataset and apply all Borders. Finally, make sure you turn 

off Gridlines a few things to practice that. If you'd like to see my answer, then please keep 

watching.  

So, the first thing I asked you to do here was to change or Margins to narrow and change the 

Orientation to Landscape. So, we're going to jump across to the Page Layout Tab, we're going 

to select Margins and we're going to switch these to narrow and we're going to switch the 

Orientation from Portrait to Landscape.  

I then asked you to make sure that the heading Row is printed on all pages. So, I'm going to 

select it lets click on Print Titles. And where it says Rows to Repeat on the top, we want to 

make sure we're selecting Row 1 and click on OK.  

The next part of this exercise was to download the file supplies_bg.jpg from the exercise files 

folder and set it as the background for this Worksheet. Now I've already downloaded the file. 

So, what we can do here is click on background. I'm going to choose from File and browse. 

And there are the file supplies. Let's click on insert.  

Now you can see with this particular image, it makes it really hard to read the data underneath. 

So, I asked you to set a light Grey Background Fill on the dataset and apply Borders. So, I'm 

going to click in the dataset. Let's do Ctrl + A.  
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Let's go to the Home Tab and we're going to set a light Grey Background Fill like that, that 

looks much better. And let's apply all Borders. Now this particular dataset is quite large, so, we 

can't really see anything of that background image, you can just see the bottom of it lurking 

just there. But if for example, we hit a few Columns, let's just hide some of these so, you can 

see the effect. That image is still there in the background.  

The final thing I asked you to do was simply turn off Gridlines so, we're going to go to the 

View Tab and deselect Gridlines. That's all I needed you to do. I will see you in the next lesson. 
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Section 17: Finalizing the Spreadsheet 

Video: Protect Cells, Worksheets, and Workbooks  

Deb: In this lesson, we're going to take a look at Workbook protection. And when I say 

Workbook protection, I'm really referring to 3 different elements; protecting Cells, protecting 

Worksheets, and Workbooks, and protecting the Workbook structure.  

 

Now, let's start out by discussing why we would want to protect a Workbook. And if you're 

not familiar with protection, all that means is that we're locking this Workbook down so, that 

edits can't be made. For example, you can see in the spreadsheet just here, I have an example 

of an invoice. And this is an invoice for the electronics company. So, we've got some Items 

listed out here, the Quantity that's been purchased, the Shipping costs, which is actually a 

calculation, the Price Per Item, and then we have the Line Total.  

 

Now, it might be that I don't want anybody to be able to edit these Line Totals just here, 

which contain a Formula. But I do want them to be able to add more line items into this 

Table. So, effectively, what we would need to do there is lock the Line Total Cells so, that 

they can't be modified, but keep everything else unlocked. And this is what we refer to as 

protecting Cells. So, let's take a look at that first of all.  

 

Now for the example that we've just spoken about, there is one really important point you 

need to remember. When you're working in an Excel Worksheet, every single Cell is locked. 

Now, you might think that's a little bit strange, because we can click in any Cell, and we can 

start to type into it. So, if every Cell is locked, how can we type into Cells? Well, it's because 

that locking on the Cells doesn't take effect until we protect the Workbook.  

 

Now, if you don't believe me, let's just click in a random Cell and press Ctrl + 1. Notice we 

have a Protection Tab up here. And if you take a look at this, it says Locked, we have a 

checkmark in that box. And you'll find that that is the same no matter what Cell we click on 

in the Worksheet. So, every Cell is locked, they just don't appear to be locked until we protect 

the Worksheet.  

 

So, if I wanted to Lock Column E, but I wanted to keep everything else editable, all I would 

need to do is select the Cells that I want people to be able to type into. So, I'm just going to 
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select everything like that Ctrl + 1, to jump into Format Cells, make sure you're on the 

Protection Tab, and we're going to unlock these Cells. Let's click on OK.  

 

Now notice that as soon as I've done that, I now have these little Green warning triangles in 

this shipping Column. Now, if I click on the little triangle, just here to take a look at this 

error, it says; ‘Unprotected Formula’. So, this is really just a warning from Excel letting me 

know that these Cells are no longer locked, and there is a Formula in this Cell. Now in this 

case, that's absolutely fine. So, I'm just going to select this entire Column, and we'll just say 

Ignore Error.  

 

So, now we have these Cells unlocked. These Cells aren't locked at the moment because we 

need to protect the Worksheet. So, let's jump up to the Review Tab. And notice in the Protect 

group, we have a Protect Sheet option. So, let's click this. And this is where we can choose 

exactly what we want to lock. We can also, add a password up here if we want to. So, a 

password to unprotect the sheet. So, this is another level of security; only people who have 

the password can actually access the Worksheet.  

 

Now I'm going to leave the password blank. And then if I wanted to, I could choose to allow 

users of this Worksheet to do specific things, even though the Worksheet is locked overall. 

Now I'm going to keep the 2 default options selected. So, even when this Worksheet is 

protected, I'm still going to allow users to select locked Cells. They won't be able to edit 

them, but they can click on them. And I'm also, going to allow them to select unlocked Cells. 

So, let's click on OK.  

 

So, now what we should find is that if we go to this Line Total Column, I can click in Cell 

E4, that's not a problem. But if I double click to try and edit the Cell, I'm going to get an error 

because these Cells are now locked. I can however still type into the rest of the invoice. So, 

that is how you can protect specific Cells in a Worksheet.  

 

Now if you want to unprotect the Worksheet, it's simply a case of going up to Unprotect 

Sheet, clicking it, and that Worksheet is now unprotected, and we can edit every single Cell 

in the Worksheet. Now the second option that you have is to protect the entire Workbook.  

 

So, if you have multiple sheets down here, maybe you want to protect all of them. 

Remember, Worksheets are contained within a Workbook. So, we could click on the Protect 

Workbook button in the Protect group on the Ribbon. And then we could enter a password. 
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We need to re-enter the password, click on OK, and now if we were to close this Workbook 

down, I'm going to go to File and Close, I'm going to say Yes to save the changes.  

 

Now when we go to reopen it, and I've got mine down here in my Recent List, you can see 

it's going to ask for a password. So, the entire Workbook is essentially protected unless you 

have the password. Like so. And of course, if we go back to the Review Tab, we can deselect 

Protect Workbook to unprotect it.  

 

Now another thing that you may not have noticed when we clicked on Protect Workbook is 

that we had this option selected; ‘Protect Workbook Structure’. So, what exactly does that 

mean? Well, let's click on OK, we're not going to add a password this time.  

 

What that means is it's going to protect the actual structure of the Workbook. So, whether 

somebody can do things like add new Worksheets or delete Worksheets. Because I've now 

protected the Workbook structure, if I right click on the Invoice Tab at the bottom, notice that 

most of the options in this right click menu are Greyed out. So, I can't insert a new 

Worksheet, I can't delete, I can't rename, I can't move or copy.  

 

So, maybe you just want to lock that down and protect the structure and not lock anything 

else down. That's absolutely fine. You don't have to add a password; you can simply protect 

the structure. Now I'm going to unprotect this Worksheet, and when we right click, we should 

find that those options are now back.  

 

So, those are the 3 different ways that you can protect Cells in a Worksheet, the entire 

Workbook, and also, the structure. 
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Video: Inspect the Workbook for Issues  

Deb: An important thing to do prior to sending a Worksheet to a client or other team 

members is to inspect the Workbook. And this is a feature that a lot of people simply don't 

know exist or ignore, but it is so, important. Now why is it important to inspect our 

Workbook before anybody else sees it?  

 

Well, let me show you an example. You can see here we have some sales data for a company 

that sells furniture. Now I can see that I have some comments in this Workbook. And if I 

hover my mouse over this first comment, you can see what that comment is; ‘Can we please 

update the name. Management have changed it from Kensington to Buckingham. 

Management don't know what they're talking about’.  

 

Now, why would somebody put this type of comment in a spreadsheet? Well, if it's just being 

passed around amongst your team, maybe you have a little in-joke about management, but 

you wouldn't really want anybody else to see that comment. And if you forget to remove the 

comments from the spreadsheet before you send it out, that could get you into a lot of trouble.  

 

So, there are always things like this, which you really do need to be checking for. Because a 

lot of the time, particularly if we've created this Worksheet many months ago, we might 

forget things like comments; what we've actually said or added into this Worksheet. So, it's 

always recommended that you inspect the Workbook, first of all, which will pick up any of 

these things.  

 

So, if we go to the File Tab, we're going to jump into Info. Now notice here we have a section 

called Inspect Workbook. And it says; ‘Before publishing this file, be aware that it contains 

comments, invisible objects, content that people with disabilities find difficult to read, and a 

setting that automatically removes properties and personal information when the file is 

saved’.  

 

So, inspecting the Workbook doesn't just check for comments, it also, checks for other items 

as well, things that might cause problems. For example, if you have images in your 

Worksheet, and let's just go back, and let's add a quick image in. We're going to go up to 

Insert and into Pictures, I'm going to say Place over Cells. And we'll just grab one from our 

Course Files folder.  
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Now, if we have images in our spreadsheet, and we don't add Alt Text to describe this image, 

then anybody with a disability who uses a screen reader, for example, won't really know what 

that image represents. Any images should always contain Alt Text. And you will find that in 

later versions of Excel, when you add an image into a spreadsheet, it will automatically add 

the Alt Text for you. And it did when I inserted this image.  

 

Now, I've just gone in and removed the Alt Text just to show you what this Inspect 

Workbook will pick up. So, let's go back to File, let's go down to Info, we're going to go to 

Check for Issues, and notice we have 3 different things we can check for. We can inspect the 

document, we can check the accessibility, and we can also, check the compatibility. So, let's 

go for inspect document first of all.  

 

Now it says; ‘Before you use Document Inspector, make sure you save your changes, because 

the Document Inspector might remove data that can't be restored later. Do you want to save 

your file now’? So, I'm going to say yes, and then the Document Inspector Window is going 

to open up. So, it's going to inspect my document for all of these checked items. So, it's going 

to look at the comments, it's going to look at the document properties, it's going to look at any 

add-ins or task panes that we have open.  

 

Now of course, if you don't want it to check for all of these different things, then you can 

deselect as you please, I'm going to leave them all selected. Let’s click on Inspect and see 

what it finds. Now what you should know here is that if the item comes back with a Green 

tick, then it's completely fine. So, if we scroll through, we can see that most of these are fine. 

And that would be expected with such a small Workbook; I only have one page of data.  

 

But notice at the top, it has found comments. So, this is kind of warning me at this stage. I 

might want to go back and take a look at all of the comments in the document, and I'll 

probably think to myself; ‘I don't really want that first comment to be in this document’, so, 

we're going to remove all of them. So, when we click Remove All, it's going to remove the 

comments from the Worksheet.  

 

Notice in Cell C2 where we did have that comment, it's now been removed. And we now 

have a Green tick next to comments. So, anytime you see one of these items with a Red 

exclamation point next to it, it means that it's found that property in your document and you 

might want to check it and remove it. So, just be aware of that.  
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Let's go back into File and down into Info. We're going to go to Inspect Workbook and let's 

go to Check Accessibility this time. So, this is us checking the Workbook for content that 

people with disabilities might find difficult to read. So, let's click on this, and we get a pane 

on the right hand side, which shows us the Inspection Results. So, we've got errors just here 

Review Description.  

 

If I expand this, it's picking up that Picture that I inserted into this document. And it's 

basically telling me that we don't have any Alt Text applied. So, what I would do here is click 

the dropdown, I would say Add Description. And then I can describe this image so, that 

people with screen readers know what it is; ‘7 people in an office looking at a laptop and 

smiling’. And as soon as we close, you can see that that warning has now disappeared, 

because we have the Alt Text added.  

 

So, now, we have Hard-to-Read Text Contrast. Let’s open it up, it says A1:K1. So, it's 

picking up that my Heading Row in my Table is using colours that might be hard for some 

people to read. So, I could go in and I could make this a little bit more obvious. So, let's 

change the Fill Colour from Green, I'm going to change it to Black, and we'll leave the text 

on White.  

 

So, we have high contrast there, which is a lot easier for people to read. When we close this 

down, you can see that those issues have been fixed. So, this is a really nice quick way of 

picking up on any issues you have in your document and fixing them on the spot before you 

send it out.  

 

Let's go back into File and into Info, because the final one we have in here is Check 

Compatibility. So, this is going to check if your Workbook is backwards compatible for older 

versions of Excel. So, we're using Excel 365, which is the latest version. But it might be that 

I've used Formulas in this Workbook that aren't compatible with older versions of Excel.  

 

For example, if I've used something like XLOOKUP, or maybe FILTER or SORTBY, those 

are only available in Excel 365 and Excel 2021. So, if I was to send this spreadsheet to 

somebody with Excel 2016 or 2013, those Formulas are not going to work. So, we can check 

for compatibility by clicking this button. And I can see that I have no compatibility issues 

currently.  
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Now just to demonstrate this, when there is a Formula in the Workbook that isn't backwards 

compatible, I've just very quickly added an XLOOKUP Formula into Cell M14. So, now if 

we go back to File and into Info, Check for Issues, Check Compatibility, you can see that it's 

picked it up.  

 

So, it's saying; ‘One or more functions or operators in this Workbook are not available in 

earlier versions of Excel. When recalculated in earlier versions, these Formulas will return a 

name error instead of calculated results’.  

 

And you can see here that it's telling me all of the versions that this XLOOKUP Formula is 

not available in. Now this might be fine; if I'm just sending this spreadsheet to somebody else 

within my organization, it's more than likely that we're all using the same version of Excel, in 

this case, Excel 365.  

 

However, if I'm sending this to a client, it might be that I know that they're using Excel 2016. 

So, I'd probably want to think about modifying this Formula if I want them to be able to see it 

and work with it. So, instead of XLOOKUP, I might use something that's available in older 

versions like VLOOKUP or Index and Match.  

 

So, those are the 3 options that you have for inspecting your Workbook prior to sending it 

out. I hope you can see how useful they are, and they will definitely help you avoid 

embarrassment when sharing spreadsheets with others. 
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Video: Save the Workbook in Different Formats  

Deb: When we're working with an Excel spreadsheet, and we save it to a folder, in general, 

we save using the default Excel file format, which is .xlsx. And you can see, in fact, in this 

spreadsheet, if you take a look in the title bar, it's called Save in Different Formats.xlsx. That 

is your standard file format.  

 

But it is also, worth noting that you can save your Excel spreadsheets in other formats as 

well. And some of these can be super useful, particularly if you want to convert your 

spreadsheet to a PDF file. Now if we go up to the File Tab, and let's go into Save a Copy, 

now notice at the top here, we've got the file name, Save in Different Formats, and then we 

have Excel Workbook (*.xlsx) underneath.  

 

Now, if I click this dropdown, I could choose to save this spreadsheet; this Workbook in any 

one of these file formats. And of course, some are going to be more appropriate than others. 

For example, I could save this as an Excel template. So, if I wanted to reuse this over and 

over again, I would save it as a template, it's going to go into my Templates folder, and I can 

then easily access it.  

 

Maybe I want to save it as a CSV file a comma separated value file. Now, that can sometimes 

be useful if you want to upload this data into an external system. A lot of the time those 

external systems will accept CSV files, or maybe even Text files. So, we could convert this to 

a CSV file instead.  

 

I could save it as a much older version of Excel. I could save this as a Macro-Enabled 

Workbook. Now, we're not covering macros in this course; that is more of an advanced Excel 

topic. But if you do have macros in your file, you're going to want to save it with a .xlsm file 

extension. I could save this as a Web Page. So, if this needed to be uploaded to a website, I 

might want to convert it to HTML format and save it as a Web Page. So, there are lots of 

different things we can do in here.  

 

Now by far, the most common one that I see is people saving as PDF files. And if you're not 

aware of what a PDF file is, I think most people are at this point, it basically means that the 

file is not editable, or at least not easily editable. There are of course, third party pieces of 

software that you can purchase, which will allow you to edit PDF files.  
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But in general, a PDF file is a little bit more secure than saving it simply as a .xlsx, which can 

be modified by anybody who goes into the Worksheet unless you've placed some restrictions 

on that file. So, I could go in and I could save this in a different format.  

 

Another option that I have from here is I could choose to Export to a PDF file. So, this is a 

quick way of creating a PDF out of this Worksheet, I'm going to leave it with the same name, 

I'm going to save as type PDF, and click Publish. And you can see what that does; it's created 

a PDF file for me, and I have all of my different pages that I can look through. So, really nice 

and straightforward.  

 

Another thing I can do from this Export page is I can simply change the file type. So, again, 

in here, this is very similar to saving as a different file type, we can choose what we want to 

save this as. For example, a CSV file or maybe even a Text file. So, let's go for Text, I'm 

going to say Save As, I'm going to save it into the Course Files folder, and I'm going to keep 

the file name as it is. But notice the File Tab there is .txt. Let's click on Save.  

 

So, now if I go to the Course Files folder, notice in here we have our PDF, and we also, have 

our Text file that we just created. So, if I double click to open this, because it has that file 

extension, Excel knows that it needs to open up in Notepad. And that's pretty much what 

these file extensions are there for. It basically tells your system which application to open. If 

it's .xlsx, it knows to open an Excel. If it's .txt it knows to open Notepad.  

 

So, don't forget that you have other file formats that you can save your Excel Workbook into, 

which might be more appropriate for what you're trying to accomplish. 
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Video: Exercise 17  

Deb: It's time to do Exercise 17. And in this exercise, we're going to practice some of the 

skills that we've learned in this section of the course.  

 

So, I'd like you to open the exercise file ‘Exercise17.xlsx’. And I'd like you to inspect the 

document for items to remove and accessibility. And I'd like you to remove any comments 

and fix any accessibility issues.  

 

Once you've done that, I'd like you to protect the Worksheet, and you need to ensure that all 

Columns are editable except the ‘Total’ Column which contains a Formula. If you'd like to 

see my answer, then please keep watching.  

 

So, the first thing we need to do here is check our document for accessibility and anything 

that we want to remove. So, we're going to jump up to the File Tab, down into Info, Check 

for Issues, and we're going to inspect the document first of all. So, I'm going to say Yes, let's 

save, and we're going to check for all of these elements. Let's click on Inspect.  

 

Now, you can see here it's found some comments, and it's found some document properties 

that I might want to remove. So, things like my name as the author, and the path to the 

Workbook. These are all things that you might not want to leave in. So, I'm going to say 

Remove All, Remove All, and click on Close.  

 

Now the next thing I asked you to do was to check for accessibility. So, again, we're going to 

go into Info, Check for Issues, Check Accessibility. Now notice that the Accessibility pane 

has popped up on the right hand side, and I have some errors in here. And it's telling me 

Review Description Alt Text.  

 

Now this is because I have an image in this spreadsheet, you can see here Picture 7 is now 

highlighted, which doesn't contain any Alt Text. So, anybody using a screen reader won't 

know what this image is. So, I'm going to click ‘Add a description’, and I'm just going to 

describe this image just here; ‘A White desk with a laptop, notebook, pen, phone, and 

paperclips’. That is it. Let's close this down, and I've resolved all of my accessibility issues.  
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The final thing to do in this exercise is to protect the Worksheet. I wanted you to make sure 

that every Cell was editable except the Total Column. Because in here, we have some 

Formulas that we don't want people changing.  

 

So, what I'm going to do here is I'm just going to select all of the Columns A to H, we're 

going to press Ctrl + 1, go to the Protection Tab, and we're going to unlock the Cells. These 

are the ones that we want to be editable, and click on OK. So, now we protect the Worksheet.  

 

Let's go to Review and Protect Sheet. I'm not going to add a password. Let's just click on OK. 

I should be able to go in and change any of these Cells which I can do. But if I try and edit 

any of the Formulas in the Total Column in Column I, as soon as I double click to try and 

access it, it's telling me that I can't. So, my Worksheet protection is working well. That is all I 

needed you to do. I will see you in the next section. 
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Section 18: Excel 365 Online 

Video: Work with Files in Excel Online  

Deb: In this section of the course, we're going to take a look at some of the features that you 

have available to you when you're working with Excel Online.  

 

Now we access Excel 365 Online through a browser. So, let's go down and let's fire up Bing. 

And all we need to do in the search bar is go to office.com, and hit Enter. Now, if you've 

already signed into Microsoft 365 previously, it's going to take you straight in as mine has 

done here. If this is the first time you're accessing the Online Portal, then it will require you 

to enter in your email address and your password. And that is the email address and password 

that you used when you set up your Microsoft 365 subscription.  

 

Now, if you're not entirely sure what this is, it's basically a way that you can access your 

Microsoft applications on the go from wherever you have an internet connection. So, you no 

longer need to be sitting at your desk with the desktop version of Excel in order to work on 

your files, we can now pretty much work from wherever. For example, if I'm on the train, and 

I've got my laptop, and I want to edit an Excel Workbook, as long as I've got an internet 

connection, I can access everything through my web browser.  

 

So, you can see in here, this is the Microsoft 365 homepage, you're going to see things like a 

quick access menu. So, these are all the files that I've recently worked on. And you can see 

that a lot of these are related to this course.  

 

Also, notice on the left hand side, you have this vertical menu. And this is going to allow you 

to access all of the online versions of your applications. And you can see down there we have 

Excel. So, if I click on Excel, it’s going to open up the online version of Excel. I can create a 

blank Workbook; it’s going to open in a new browser window, and I can start creating my 

Worksheet, all without having to go into the desktop version.  

 

Now, a couple of things to note here about the online version of Excel, it isn't as fully 

featured as the full desktop version. Now this is something which is improving over time; 

Microsoft is adding more and more features into the online version. But if you take a look 

through the Ribbons, you'll see that most of the things that you're going to want to use are 

actually here.  
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It's usually some of the more advanced features like macros, for example, that you won't have 

access to. But if you just want to create a spreadsheet, or maybe work on an existing 

spreadsheet, you have everything in here to enable you to do that.  

 

Another point worth noting about working with Excel Online is that everything automatically 

saves back to the cloud. And in this instance, the cloud is OneDrive. That's Microsoft's Cloud 

Storage. And when you're working in Excel Online, we don't actually have a save button. If 

we go to File, we can Save As. So, I could save this as something else. But pressing Ctrl + S 

to save any changes I've made is now no longer necessary. And that is because it 

automatically saves back to the file in OneDrive every time we make a change.  

 

Now my spreadsheet is simply called Book2. If I want to rename this, I can click on it, and I 

can change it to something else. So, I'm just going to call this Test. I can see the location 

where it's saving it, I'm pretty happy with it being saved into the Documents folder. And if I 

click away, it's going to update and you can see that it's been renamed.  

 

Now it looks like I already had a file called Test in there, so, it's renamed it for me to Test1. 

And now, any change I make is automatically saving back to this file which is stored in 

OneDrive. Now I'm going to go back to File, let's go to Open. I'm going to open something 

that we've opened previously. So, let's go for Save in Different Formats, double click to open 

it up. Again, it's going to save in another Tab and I can simply go in and I can start making 

changes to this spreadsheet.  

 

So, maybe I want to change all of the Kensington products to Buckingham, maybe these 

products have changed names. So, I'm going to use my filter just to select everything that's 

named Kensington, and then I'm going to do a Ctrl + H, I'm going to find the text Kensington 

and I'm going to replace it with the text Buckingham, I'm going to say ‘Replace all’, and you 

can see that those changes have been made, there are 93 changes.  

 

So, now that I've made those changes, I don't actually need to save or do anything else, 

because it automatically saves. So, I could close down this file. Let's click on File and Close. 

Or I can simply close the Tab at the top. And then if I was to reopen this, let's reopen Save in 

Different File Formats, those changes have been saved without me actually having to do 

anything. So, this is a really nice efficient way of working and it means that you're less likely 

to lose your changes.  
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Now pretty much everything else works in exactly the same way as we've seen in other 

lessons; we format in the same way, we can insert different items, we can insert Formulas. 

And the cool thing about this is everything is compatible.  

 

So, I could work on this file in Excel online on the train, and then when I get back to the 

office, let's close down some of these Tabs, I can simply fire up the full desktop version of 

Excel, I can open the same file, so, Save in Different Formats, and those changes are all 

updated.  

 

So, it doesn't matter if you're working in the online version, or if you're working from your 

desk in the desktop version, any changes you make will synchronize between the 2, as long as 

the file is stored in a shared workspace, such as OneDrive. So, that's a brief look at how you 

can work on files from the office.com portal, and how everything synchronizes. 
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Video: Share Workbooks with Others  

Deb: In this lesson, we're going to take a look at how we can share a Workbook with others, 

both in the desktop version and also, in Excel 365 Online.  

 

Now, historically, when it's come to sharing Workbooks with our team, or maybe clients and 

customers, most people have gone the route where they attach the Excel Workbook to an 

email and send it off. Now, that had many disadvantages. When you attach a Workbook to an 

email and you send it, you're effectively sending a copy of that file.  

 

So, if the client was to open the Excel Workbook and make some changes, when they send it 

back to me, I effectively have 2 different copies of the same file on the system; I have the 

original that I sent them, and then I have the copy that they've sent back with all of the 

changes. So, I would then have to merge them together or save them as different versions. So, 

it was all a little bit of a clunky process.  

 

This completely changed with the introduction of Excel 365. Because what we can 

effectively do is we can share a link to a file, so, that if our client needs to make changes, 

they can simply open up the link, and they are effectively working on the original.  

 

Now I will say that in some situations, you won't necessarily want them to be working on the 

original, you might want them to work on a copy, we can also, send a copy from within Excel 

as well. So, let's take a look at both of these methods.  

 

Now when it comes to sharing, for example, if I want to share this Workbook with my 

colleague, Adele, I have a few different ways I can do this. I could go to File, Share, and it's 

going to open up this little Share a Workbook window. Alternatively, I can click on the Share 

button in the top right hand corner and choose Share, and it's going to bring up this same little 

pop up window.  

 

So, in this first field, we just need to type in the names of the people who we want to share 

this Workbook with. So, I'm going to share this Workbook with Adele. Notice that when I 

click in here, it brings up a list of all of the people in my company. So, if you're all on the 

same domain, and you share emails, you'll be able to see people and select them from the list.  
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If you want to share this with somebody outside of your organization, you would need to type 

in their full email address in here. So, I have Adele selected, I can then click the little pencil 

dropdown, and I can choose what level of access she has to this Workbook. So, if I need 

Adele to make some changes to this Workbook, I need to make sure I give her Edit access. If 

I just want her to be able to view the Workbook, I can give her View access. So, we're going 

to say that Adele can edit.  

 

I can then add a message. Once I've added the message, I basically have 2 options when it 

comes to sharing; I could click on the Send button. And what that's going to do is it's going to 

send an email to Adele in this instance, letting her know that I’ve shared this Workbook with 

her. And within that email, it's going to contain a direct link back to this Workbook. So, she's 

getting a link, any changes that she makes will update in the original. Alternatively, I could 

copy the link just here.  

 

So, if I copy the link, it's going to copy the link to this Workbook to the clipboard, and then I 

can go and paste it into another application or maybe another email. So, maybe I want to send 

this out to a huge distribution list, I could copy the link and paste it into an Outlook email. Or 

maybe I want to paste it into a Teams channel, a Yammer conversation, something like that. 

So, this option is always going to send a link to the original. Click on Send to send that off to 

Adele.  

 

So, I'm now logged into Microsoft 365 as Adele, you can see her little profile Picture up in 

the corner just here. Notice that on her homepage where we have Recommended, it says; 

‘Deb Ashby shared this with you’. This is the Workbook that I just shared with her. But if we 

jump across to her Outlook account, this is what Adele will see when I share a Workbook 

with her.  

 

She's got an email just here. If we click on it, it says; ‘Deb Ashby shared a file with you’, and 

there is a link to the Workbook. So, she can click on this to open it up, and she can start 

making her changes. And I'm going to be able to see those changes in real time. We're going 

to talk a little bit more about that in the next lesson. Sharing a Workbook pretty much works 

the same if you're working in Excel Online, as opposed to the desktop version.  

 

Notice we have a Share button at the top here, we can click on Share. And then maybe Adele 

wants to share this with, let's say, Grady, she can do exactly the same thing; add Grady in, 

we're just going to give him View access, she could add a message in here, and she can send 
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that off to Grady. And he will receive an email in exactly the same way so, he can access the 

file.  

 

Now so, far, we've very much been focusing on sharing links to the original file. But as I 

mentioned, there might be some circumstances where you don't want to share a link, you 

want to just share a copy. So, how would we do that? Well, in the desktop version, or the 

online version, it works exactly the same.  

 

If we click on the Share button in the top right hand corner, if we want to share a copy 

instead, we just need to click these 3 dots at the top, and we have a Send a Copy option. And 

we have the option of sending this as an Excel Workbook or we could even send it as a PDF. 

So, it's going to convert it to a PDF file first of all. I can then select Adele in the To field and 

send that off.  

 

So, we're back in Adele's Outlook account. There is the email from me right at the top. And 

you can see there is the attachment and she can click to open and view this PDF file. So, that 

is how you can share Workbooks in the desktop version of Excel and also, in the online 

version. 
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Video: Co-Author Workbooks in Real-Time  

Deb: In the previous lesson, we saw how simple it is to share a link or a copy to a Workbook 

with other people. And in this lesson, we're just going to delve into co-authoring in Excel. 

We've briefly touched on this in a couple of lessons already in this course, but let's delve into 

it in a little bit more detail. Because this is a really awesome function, which really helps 

enable collaboration amongst teams.  

 

Now, once again, we're working with the same Workbook; this is the one with our sales data 

in it. Now I have this Workbook open in the desktop version of Excel. And maybe I'm 

collaborating on this spreadsheet with Adele. So, I need Adele to go in and make some 

changes, but I also, want to make some changes as well.  

 

Now in older versions of Excel, it's not been possible for multiple people to have the same 

file open at the same time, it was very much A1 person can have it open and make their 

changes, and then they need to close it down before somebody else can go in and make those 

changes. The only other alternative was that if somebody was in the Workbook that you 

needed to edit, you would need to save it as something else.  

 

Now with co-authoring in Excel, all of those problems are eradicated; we can have multiple 

people all working at the same time in the same Workbook. And the coolest thing is that we 

can see exactly which Cell everyone is clicked in, and we can see any changes that they're 

making update in real time. So, this is really awesome.  

 

Now in order to enable co-authoring, the first thing you need to do is fairly obvious, you need 

to share the file with other people. And if you recall, in the last lesson, I already shared this 

Workbook with Adele, so, we're not going to go through that part again. Now I'm logged into 

Adele's Microsoft 365 account, so, let's jump across there.  

 

So, I'm logged into Microsoft 365 as Adele, I’ve simply opened up Excel, and you can see 

here there is the document that I shared previously. It says; ‘Deb Ashby shared this with you’. 

Let's click on it to open it. So, now both Adele and I have this same document open and 

check out what we have. Can you see on this Workbook, it's showing Adele the Cell that I'm 

clicked on, and you can see my initials just there? You can also, see my little profile photo up 

here next to comments.  
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So, if you've shared this document with seven people and they all dive into this spreadsheet, 

you'll be able to see their profile icons running across the top, you'll be able to see exactly 

where they're clicked, and you'll be able to see their name.  

 

Similarly, if we switch back to my account, we can see the reverse. So, I can see where Adele 

is clicked, that Cell is highlighted with her initials. And when I hover over, I can see her full 

name. And I can also, see her profile photo at the top here next to comments. And in my 

version, it tells me in that popup exactly the Cell that she's clicked on. So, I can make 

changes to this document, and Adele is going to see those. So, let's just go in here and let's 

just change a few of these Cells to something else. I'm just going to change the name of a few 

of these. Let's go Lyndhurst, Ctrl + Enter to copy that down, and I'm now clicked in Cell E 

64.  

 

If we switch back to Adele's version, you can see those changes have automatically been 

applied, and it's showing her that I'm clicked in Cell E 64. So, this is true collaboration. And 

the question I always get about this is what if 2 people try and update the same Cell at the 

same time? Well, yes, that can happen, but Excel actually won't let you do that.  

 

So, if you're both clicked in the same Cell, whoever starts typing first, they take precedence. 

If you both start typing at exactly the same time, you're going to get a popup error. So, I'm 

sure that one of you can move out of the Cell in order to let the other one make changes. And 

of course, any changes that are made by anybody in this document, automatically saves back 

to the file.  

 

Now, if at any point, I want to remove Adele's access, so, maybe she's making some changes 

that I don't particularly like, maybe she's just a liability in this Workbook, I have complete 

control over whether or not she still has access. So, what I could do here is I could click up on 

Share again and go to Manage Access. And it's going to show me all of the people who have 

access to this particular Workbook. You can see there are myself, Adele, and Grady.  

 

And there are a couple of different ways that I can stop sharing this. I have a Stop Sharing 

button just here. Or if I go to the Links Tab, I could choose to delete the link. So, it means 

that that link will no longer work next time she tries to click on it. Now I'm going to go to 

People, I'm going to click on Stop Sharing, Stop Sharing again, and it's going to remove 

everybody except me as the owner from this Workbook.  
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So, now, when Adele closes this Workbook down, I’m just going to click the cross on the 

Tab, if she tries to go back into it again, it says; ‘Sorry, you don't have access’. And if she 

needs access back to this document, maybe it was an accident, she could choose to request 

access by clicking this button just here.  

 

So, co-authoring is a really awesome way to collaborate on Workbooks in real time with 

colleagues and co-workers. 
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Video: Add an Excel Workbook to Microsoft Teams 

Deb: One of the coolest things about working with Excel for Microsoft 365 is that we can 

collaborate across all of the Microsoft 365 applications. Everything is so, well integrated; it 

makes it really easy to use Excel seamlessly with other applications that we know, love, and 

use every single day.  

 

For example, one of the most popular applications at the moment, particularly since the 

pandemic is Microsoft Teams. Most of us utilize Teams to communicate with our colleagues 

and conduct meetings. So, in the next couple of lessons, I just want to show you a couple of 

really cool things that you can do with Excel in Microsoft Teams. And we're going to start 

out by sharing an Excel Workbook to a channel in Teams.  

 

So, I've logged into my Microsoft 365 account, I'm going to go over to my app launcher on 

the left hand side, and I'm going to open up the online version of Teams. So, now that I have 

Teams open, you can see on the left hand side, I have a list of all of the Teams that I have 

access to. So, I'm just going to choose this team here; US Sales. Let's expand it and we can 

see the different channels underneath. So, I'm going to utilize the General channel just here, 

and this area is where we can have a conversation.  

 

Now of course, if I wanted to share my Furniture Sales Workbook with everybody who's a 

member of this channel, I could go about this in a couple of different ways. I could create a 

new conversation at the bottom here, and I could attach the file.  

 

So, if I click on the Attach button, I can say I want to upload from my computer, or I can go 

directly to OneDrive where I have it saved. I know it's in the Course Files folder. And I'm just 

going to choose this one that just here. Let's upload a copy. There we go, I can click on the 

paper plane to send that through. And that is effectively now shared with everybody in this 

Teams channel.  

 

But another thing I could do is I could add this Workbook permanently as a Tab at the top of 

the Teams channel. So, if this is maybe a Workbook that people need to refer to all the time, 

it would be really useful to have it permanently as a Tab.  
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So, what we can do is we can click on the + button to add a New Tab, and we can choose the 

app that we want to add. So, I'm going to choose Excel. And then we can choose where our 

Excel file is stored that we want to share.  

 

So, I'm going to go to My Files, Course Files 1, and let's go for Product Sales, click on Save, 

and check it out; we now have a new Tab called Product Sales. If you want to rename this, 

you can simply click the dropdown and change it to something else.  

 

But I can see the whole Workbook; I can see all of the Worksheets at the bottom. Now I don't 

have a great deal on any of these other ones. But the Product Sales one we do have some 

information. So, this is now permanently there in the Teams channel for people to refer to.  

 

So, I highly recommend utilizing these Tabs to make it easy for your entire team to access 

files of importance. 
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Video: Excel Live: Share a Workbook in a Teams Meeting  

Deb: A new feature was recently added to Microsoft Teams called Excel Live. And this 

makes it so, much easier to collaborate and work on Excel files when you're in a Teams 

meeting. So, let's check it out and see how it works.  

 

So, I'm back in my Microsoft 365 account, I'm going to go to my app launcher, and we're 

going to launch Teams. Now in order to demonstrate this, I need to start a new meeting. So, 

I'm going to make sure I'm in the correct channel where I want to start the meeting; so, we'll 

stick with this General channel in the US Sales team, and I'm going to go up to the Meet 

button just here. Remember, we have a dropdown, and we can choose ‘Meet now’.  

 

So, this will allow us to start an ad hoc meeting on the fly. I can give my meeting a name, 

let's just say it's a Sales Meeting. And just for this demonstration, I'm going to keep my 

camera off. So, let's click on ‘Join now’; that's going to jump us into this Teams meeting. So, 

let's add a participant. I'm going to add Adele, I'm going to request that she joins. There she 

is. So, now, both I and Adele are in this meeting.  

 

Now it might be that I want to share an Excel spreadsheet with all participants in this 

meeting. So, I'm going to jump up to the Share button at the top here, which is going to allow 

me to share different pieces of content. And if you're familiar with Teams, you're probably 

familiar with everything that we have in here. We can share our screen, a window or a Tab, 

we can share and collaborate on a Whiteboard.  

 

Now this isn't a Teams training session, so, I'm not going to go too much into this. But notice 

also, that below we have PowerPoint Live and we have Excel Live. So, Excel Live will 

basically allow us to share a Workbook with everybody in this meeting. And much like co-

authoring that we saw in a previous lesson, everybody can dive in and start making changes.  

 

So, let's say that I want to share Product Sales. Let's click on that to share it. I'm going to say 

yes, I want to share, the Workbook is going to open up, and I'm just going to close down the 

participants’ pane so, we have a little bit more room. And now everybody in this call can 

basically work on this spreadsheet.  
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You can see at the bottom, it says that I'm presenting it. So, as the presenter, I have full 

control over this Worksheet. And you can see that this works exactly the same way as when 

we were looking at co-authoring.  

 

I can see where Adele is clicked and I can see when she's moving around the screen. And if 

she makes a change to any of these Cells, I can see the changes she's making in real time. Can 

you see those 3 dots just there and moving? So, I know she's typing. And she's just changed 

that Cell to say; ‘Hello World’.  

 

Now if you're wondering why I have 2 Adeles in here, it's because I also, have this open as 

Adele on my PC as well. So, I can pretty much see exactly where Adele is clicking. And that 

would be exactly the same for anybody else who's in this Worksheet. If we had 7 people who 

were working on this, we'd be able to see which Cell they clicked in and what exactly they're 

updating.  

 

So, this is true collaboration within a Teams meeting. Once we're done with this spreadsheet, 

I can simply click on Stop Sharing. It's going to close it down and we're all back to the 

regular meeting. So, that is how you can utilize Excel Live to collaborate on a Workbook 

when you're in a Teams meeting. 
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Video: Exercise 18  

Deb: It's time now to do the final exercise of the course; Exercise 18. And just a very quick 

congratulations for making it all the way through to the end.  

 

Now in this exercise, of course, we're going to practice some of the skills that we've learned 

in this section of the course. Although I will say that this exercise does differ a little bit from 

the other exercises in this course, because some of these items are optional.  

 

I'm very well aware that sometimes you don't have colleagues that you can share documents 

with, and you might not even have access to Microsoft Teams. So, with this exercise, if you 

can work through it, then great, but if you can't, then don't worry too much.  

 

The first thing you need to do is open the exercise file ‘Exercise18.xlsx’ from Excel 365 

Online. So, there's a bit of a difference there; we're not just simply opening up from the 

Exercise Files folder, I want you to log into Microsoft 365 and open it from Excel Online. 

Once you have that Workbook open, I'd like you to share the Workbook with a colleague and 

practice co-authoring.  

 

As I said, this step is optional. And if you have access to Microsoft Teams, practice setting up 

the spreadsheet in its own Tab so, that you can share it with other channel members. Again, 

this is optional. That's all I need you to do. If you'd like to see my answer, then please keep 

watching.  

 

So, the first thing I asked you to do here was login to Excel Online and open Exercise 18 

from here. So, I've logged in to my microsoft.com portal, and I'm going to open up Excel 

Online from the app launcher. Now if I scroll down, I want to open an existing file. And I 

actually have it saved in a different OneDrive account so, I can't just simply select it from my 

Recent List at the bottom.  

 

So, what I'm going to do is I'm just going to create a blank Workbook here. And then we're 

going to go to File and Open, because I want to be able to open files from this device. So, 

that's going to open up File Explorer, and I can then choose whichever folder I want to open 

the file from. So, here are all my exercise files, I want to open up Exercise 18 and click on 

Open. And there we go; we now have that open in Excel Online.  
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I then asked you to share this with a co-worker or a colleague and simply practice co-

authoring. So, I'm going to click the Share button, go to Share, and I'm going to share this 

with Adele. We simply need to type her name in here, we could add a message, and I can 

define the level of access. So, I'm going to say ‘Can edit’, and I'm going to send that off to 

Adele.  

 

So, once she receives this link in her email, she can jump in the document and start making 

changes along with myself, so, effectively co-authoring the document. So, now, you can see 

that Adele has arrived in the spreadsheet and she is currently clicked and editing Cell A5.  

 

The final thing I asked you to do, if possible, was to open up Microsoft Teams, and set up a 

Tab in a Teams channel to display the Exercise 18 file. So, I'm just going to use US Sales the 

General Tab, let's click the +.  

 

We're going to add the Excel app, I'm going to go to My Files, and I'm going to search for 

Exercise 18. So, here it is just there in my ‘My files’ list. Let's select it, click on Save, and 

you can see that that's now been added as a Tab in Teams. That's all I needed you to do. I will 

see you in the next section. 
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Section 19: Course Close 

Video: Course Close  

Deb: A huge congratulations, everybody for making it all the way to the end of this course on 

Excel 365 For Beginners. I really hope you've enjoyed running through this course as much 

as I've enjoyed hosting it for you. And I think you'll agree that we've covered so, much in this 

course.  

 

If you were unsure of Excel when you started this journey, hopefully now you feel that you 

have at least a little bit of confidence when working in Excel. Now, there's not too much else 

for me to say other than thank you so, much for choosing us. But let's just briefly do a quick 

rundown and recap of everything that we've learned in this course.  

 

So, we started out in Section 1 with the course introduction, where we learnt what Excel 365 

is, and I showed you how you can access the Online Portal. We then jumped into Excel and 

the real hard work started.  

 

I showed you how to launch the application, and we did a run through of the Interface, 

Contextual Menus and Ribbons. And I also, showed you some useful things like common 

Keyboard Shortcuts, and how you can customize your Quick Access Toolbar.  

 

In Section 3, we started to take a look at the actual Excel spreadsheet. We saw how we can 

create spreadsheets based off of templates, and all of the different ways that we can work 

with Worksheets. We explored how to save Workbooks to OneDrive and the benefits of 

doing that. And we started to take a look at how we enter basic things into Cells such as text, 

numbers, and dates. I also, showed you how you can utilize Custom Lists to make data entry 

a lot quicker.  

 

Section 4 is where we took our first look at Excel Formulas. We discussed some basic rules 

surrounding Formulas, and then we saw a demonstration of the big 6 essential Formulas in 

Excel. We took a look at Absolute versus Relative Referencing and discussed why that is so, 

important. And then we saw a couple of useful utilities that really quicken the process of 

entering in Formulas such as AutoSum and AutoFill.  
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In Section 5, we talked about Named Ranges. I showed you how you can create Named 

Ranges, why they're useful, and how you can use them to make Formulas more readable.  

 

In Section 6, we moved on to formatting; a fundamental skill in Excel. I showed you how to 

apply different number formats and how you can jazz up your spreadsheet by formatting 

Cells, Rows, and Columns. We looked at Find and Replace and how to quickly copy 

formatting using Format Painter.  

 

In Section 7, we started to explore the wonderful world of Excel Tables. I explained to you 

what an Excel Table is and why it's so, useful. I showed you how to create a Table and how 

you can use Table References in Formulas.  

 

In Section 8, we did some more work on formatting. I showed you how you can do things 

like align text and numbers in Cells, how we can merge Cells, and also, how we can quickly 

apply themes and styles.  

 

Section 9 was all about Excel Lists. We saw how to sort and filter lists, and how we can do 

things like add subtotals.  

 

Section 10 was all about moving and linking to data. So, we saw how to cut, copy, and paste, 

and we explored some of the paste options that we have. I showed you how you can move 

and copy Worksheets and also, how you can utilize 3D Referencing and Hyperlinks in 

Worksheets.  

 

Section 11 is where things started to get a little bit more complex with an introduction to 

Intermediate Formulas. We took a walk through some of the most popular Intermediate 

Formulas like VLOOKUP and XLOOKUP. We also, saw how logical functions work and I 

showed you how to tidy up a dataset using Text functions. We finished this Section by 

delving into some really useful time and date functions.  

 

In Section 12, we took a look at some utilities that we have when it comes to analysing our 

data and interpreting the results. I introduced you to the Quick Analysis button, and we 

explored why it's so, important to choose the correct Chart Type for your data. I showed you 

how to create a Chart, how to format it, and I also, introduced you to In-Cell Charts like 

Sparklines and the REPT Function. 
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In Section 13, we spoke about Conditional Formatting. I showed you how you can use the 

Highlight Cell Values option to highlight Cells that are greater than or less than a specific 

criteria. And we looked at how to visually conditionally format our data using Data Bars, 

Colour Scales, and Icon Sets.  

 

In Section 14, we saw how to insert other things into our Workbook like Pictures and 

Graphics. We took a look at Shapes, Icons, Pictures, Diagrams, and even how to insert 

Screenshots and Comments.  

 

Section 15, we discussed our Workbook Views and Zoom. I showed you the difference 

between the different Views, and how you can zoom in and out of your spreadsheets. We 

also, saw how we can manage our Workbooks and Worksheets a little bit better by arranging 

them correctly, and how we can ease readability by freezing panes.  

 

In Section 16, we started to prepare our Workbook for printing. We took a look at some Page 

Setup options like Margins and Orientation. I showed you how you can set and clear a Print 

Area to print specific parts of spreadsheet. We looked at how to print Titles, and also, add a 

Background Image to our spreadsheet. And we saw how headers and footers can be so, useful 

for providing other people with helpful information. And of course, I showed you the options 

that you have when it comes to printing out a Workbook.  

 

In Section 17, we finalized our spreadsheet. We walked through some of the options for 

protecting Cells, Worksheets, and Workbooks. And I showed you how important it is to 

inspect your Workbook before sending it out to other people to remove anything that 

shouldn't be there and make your Workbook more accessible to everybody. We also, saw 

how we can save our Workbook in different file formats, including PDF.  

 

And then in the final Section, Section 18, we switched our focus to taking a look at the Excel 

365 Online Portal. I showed you how you can work with files online as opposed to in the 

desktop version of Excel. And we saw how everything synchronizes and updates. We took a 

look at how we can share Workbooks with other people and how we can co-author 

Workbooks in real-time.  

 

And in the final 2 lessons, we saw how Excel integrates seamlessly with Microsoft Teams. I 

showed you how to add an Excel Workbook permanently as a Tab in a Teams channel, and 

also, how you can utilize Excel Live to work on Excel Workbooks in Team meetings.  
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I think you'll agree there was quite a lot that we've covered in there. On behalf of myself and 

the rest of the team, it's been an absolute pleasure hosting this course for you. We do hope to 

see you again somewhere down the line. But for now, my name is Deb, see you next time. 
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